





24 Monitoring Oracle Business Activity Monitoring

This chapter describes how to use Oracle Enterprise Manager Fusion Middleware Control to view Oracle Business Activity Monitoring (Oracle BAM) performance statistics and logs, and monitor Oracle BAM web services counters, and Oracle BAM server and web components such as Active Data Cache, Event Engine, Report Cache, Enterprise Message Sources, and Report Server.

This chapter includes the following topics:

	
Section 24.1, "Introduction to Monitoring Oracle BAM"


	
Section 24.2, "Monitoring Oracle BAM Server Components"


	
Section 24.3, "Monitoring Oracle BAM Web Applications"


	
Section 24.4, "Monitoring Oracle BAM Web Services"


	
Section 24.5, "Monitoring Oracle BAM Performance"


	
Section 24.6, "Monitoring Oracle BAM Logs"






24.1 Introduction to Monitoring Oracle BAM

You can monitor several aspects of the Oracle BAM components using Oracle Enterprise Manager Fusion Middleware Control.

The OracleBamServer page in Fusion Middleware Control enables you to monitor each of the Oracle BAM Server Components: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. For more information, see Section 24.2, "Monitoring Oracle BAM Server Components".

The OracleBamWeb page in Fusion Middleware Control enables you to monitor Oracle BAM Report Server. For more information, see Section 24.3, "Monitoring Oracle BAM Web Applications".

In addition, the Performance Summary pages for each component allow you to track specific statistics of your choosing. For more information, see Section 24.5, "Monitoring Oracle BAM Performance".

Also, you can configure and monitor Oracle BAM logs using Fusion Middleware Control. For more information, see Section 24.6, "Monitoring Oracle BAM Logs".






24.2 Monitoring Oracle BAM Server Components

Oracle BAM Server components are monitored on the Fusion Middleware Control page for Oracle BAM Server.

To monitor Oracle BAM Server components:

Go to the Oracle BAM Server home page by selecting BAM > OracleBamServer in the navigation tree.

In the OracleBamServer page, you can select each tab (Active Data Cache, Event Engine, Report Cache, Enterprise Message Sources) to monitor the individual Oracle BAM Server components.




	
Note:

Alternatively, on the farm home page, you can also select the Oracle BAM targets from the right side page content area, where it displays details of the farm.











24.2.1 Monitoring Oracle BAM Active Data Cache

Oracle BAM Active Data Cache (Oracle BAM ADC) is designed and optimized to handle large amounts of data in real time. Data coming into Oracle BAM ADC immediately updates all defined calculations and aggregates in real time in an in-memory cache so that this data can be pushed as quickly as possible to Oracle BAM dashboards and reports. Data fed to the Oracle BAM ADC is received from a combination of sources, from Java Message Service (JMS) topics and queues to more traditional data queries and databases. Oracle BAM ADC ensures that no matter the source, when Oracle BAM Server is aware of the incoming data, it is streamed to Oracle BAM alerts and dashboards as incremental changes.

There are two key components to the Oracle BAM ADC, data sets and view sets. Oracle BAM ADC receives transactions (insert, update, upsert, delete) into the data sets. These data sets are constructed based on the design that an Oracle BAM developer defines for data relationships when data objects are defined in Oracle BAM Architect. Data objects can be reflective of flat tables of data, or more complex, star-schema relationships between data objects, which are represented in Oracle BAM as data object look-ups.

After data is updated in the data sets, view sets that are listening on these data sets go into action. The view sets have knowledge of all of the open Oracle BAM dashboards and alerts that users are viewing in the Oracle BAM system. View sets ensure that data updates to these open objects are incrementally updated first, using a push-based mechanism to publish updates to open dashboards and alerts, providing users with the latest information.

Use the Oracle BAM pages in Fusion Middleware Control to monitor statistics for all data objects in Oracle BAM ADC as a group, or select a particular data object from the Data Objects list to monitor.

[image: Description of bam_server_adc_tab.gif follows]
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Note:

When you select a data object from the list, cached data is displayed to preserve performance. You must refresh the page (using the Refresh icon) to display the latest data associated with the selected data object.

[image: Description of bam_em_refresh.gif follows]
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View Sets

Active view sets are those which are typically seen in Oracle BAM reports. Open view sets are the sum of active and static open view sets.

Oracle BAM reports and alerts use active view sets. Oracle BAM Server uses static view sets for internal process. There are also internal parts of the code that use static view sets on system objects (metadata tables). It is possible that if Oracle BAM Server is not closing the static view sets, you observe different values for them.

Static view sets do not support active data generation and are used to fetch data from data objects, therefore, they are kept open for only a very short time when data is fetched. For that reason, in the Open counter, the values appearing most of the time are from active view sets.


View Set Count Variation

You can monitor the view set count for Oracle BAM components Active Data Cache, Report Cache, and Report Server. You may see that view set counts do not match between Active Data Cache, Report Cache, and Report Server metrics.

The Report Server opens view sets through the Report Cache for all of the views contained in the reports opened in browsers. The Active Data Cache opens more view sets than the Report Cache. One such view set opened is in the Active Data Cache through the Event Engine.

Whenever the Event Engine starts, it loads all the defined alerts, and for those alerts that are defined to monitor data changes in the Active Data Cache, corresponding view sets are opened in the Active Data Cache. That is why more view sets are displayed in the Active Data Cache monitoring page than on the Report Cache and Report Server pages.

For most of the views in a report, there is a corresponding view set in the Active Data Cache. View sets opened by the report are shared with the subsequent instances of that report, except for Crosstab views. In reports using the Crosstab view, the view set call is different than the one used by other views. When a report containing a Crosstab view is opened, three view sets are opened in the Active Data Cache. Two of the view sets are closed immediately after fetching the data, while one is kept open to monitor the incoming changes.


Operations Per Second

This statistic includes all of the insert, update, upsert, and delete operations occurring on the selected data object. The accompanying graph displays statistics for the last 5 minutes.


Average Batch Size for Operations

This statistic is the average number of records included in each batch operation on the selected data object. The accompanying graph displays statistics for the last 5 minutes.


Waiting Threads

Certain operations must be synchronized, requiring a data object to be locked. This statistic displays the number of threads that are blocked, waiting for the data object to be unlocked to perform subsequent operations.


Total Transactions

This statistic displays the number of transactions on Oracle BAM data objects. It is the sum of committed and rolled back transactions. The accompanying graph also displays the number of open and completed transactions.

For example, if you add a row in an Oracle BAM data object and save it (commit), it is one transaction. This metric is useful only if the client of Oracle BAM Server is using transactions.

Transactions can also be used by an EMS, when connecting to a JMS topic or queue.

You can configure this metric to track transactions in the Oracle BAM sensor actions in BPEL and in the Oracle Data Integrator knowledge modules.

In regard to Rolled Back Transactions, if an invalid insert operation is attempted on an Oracle BAM data object, Oracle BAM Server rolls back the transaction.






24.2.2 Monitoring the Event Engine Component

The Event Engine is used by Oracle BAM Server to evaluate and execute Oracle BAM alerts. The Event Engine monitors complex data conditions and implements specified rules. Rules can include a series of conditions and actions attached to an event. The Event Engine continuously monitors the information in the Active Data Cache for certain conditions and executes the related actions defined in associated rules.

The Event Engine is responsible for tracking events based on date, time, or data changes. The Event Engine design employs a satellite concept, in which there are four different systems (satellites) within which event clauses can be registered and tracked.

The Date and Time satellites are both based on a scheduler, and they are used for time based alerts, for example, "Email a snapshot of this Oracle BAM dashboard to me every morning at 8 a.m."

The Manual satellite is use to manually send alerts by name (using a web service call).

The Data satellite is used to track alerts that are based on specific changes in the data of a given data object, such as "Call this web service when SUM(Sales) > 10000 in the MediaSales data object," or "Let me know when anything in this dashboard changes."

You can monitor statistics for active Event Engine rules, condition met rates, and processing queues.

[image: Description of bam_server_eetab.gif follows]
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Active Rules

This statistic displays the number of alert rules that are active (not expired or invalid) in Oracle BAM Event Engine. It displays the total number of alert rules in Oracle BAM Event Engine, which is the sum of alerts created for all of the Oracle BAM users.


Rule Fire Rate Per Second

This group of statistics displays the rates of events over the last 5 minutes for Actual, Events Accepted, and Events Rejected rates.

Actual rule fire rate per second is the number of events fired per second in Event Service. It is the number of events fired per second, taking into account number of times alerts fired events in the previous 5 minutes. For example, if when the OracleBamServer page was loaded, only 2 alerts fired in previous 5 minutes, the value shown would be 2/(5 X 60), that is 0.0067. So, if fired twice in 300 seconds, it would fire 0.0067 times in one second.

Events Accepted is the number of events fired per second from the satellite. That it, the number of events fired per second from alerts configured, that were accepted (for further processing), taking into account events that were accepted in the previous 5 minutes. The value shown is calculated in the same way as Actual. Unless the Event Engine's queue thresholds are exceeded, all events fired are accepted and processed further.

Events Rejected is the number of rejecting events per second. That is, the number of events fired per second from alerts configured, that were rejected (for further processing), taking into account events that were rejected in the previous 5 minutes. The value shown is calculated the same way as Actual. Fired events are rejected when the Event Engine's queue thresholds are exceeded. Ideally this value should be zero.


Processing Queues Sizes

This graph displays the size of the event processing queue, that is, the number of events waiting to be processed. These queues are emptied as soon as the events are processed, so there would have to be a large number of events being generated simultaneously to see alerts waiting for processing in the queues.

The Processing Queues Sizes graph displays statistics for the last 5 minutes. The graph displays Rules Fired Queue, Alert Actions Queue, and Alerts History Queue health.

The Rules Fired Queue displays the number of events that were fired that are waiting to be processed. The Event Engine maintains internal in-memory queue for fired events where all the events are placed temporarily, before being pulled out from here for further processing, as soon as the Event Engine resources are available. This metric shows the number of events fired waiting in queue to be picked by the system.

The Alert Actions Queue displays the number of actions waiting to be processed. The Event Engine maintains internal in-memory queue for actions where all the actions are placed temporarily, before being pulled out from here for further processing, as soon as the Event Engine resources are available. This metric shows the number of actions waiting in queue to be picked by the system.

The Alerts History Queue displays the number of alert history items to be saved. The Event Engine maintains internal in-memory queue for all history items, where all the items are temporarily placed, and before picking them up to save to back end. This metric shows the number of history items waiting in queue to be picked by the system.






24.2.3 Monitoring the Report Cache Component

The Report Cache assists the Active Data Cache with maintenance of the view set snapshots in memory. The Report Cache opens view sets in the Active Data Cache for the Report Server (an Oracle BAM web applications component). It then caches the snapshot (in small parts) and the active data before sending it to the Report Server. This allows for random access into the snapshot and recovery from losing the connection to Oracle BAM Server. The Report Cache also, along with the Active Data Cache, supports view set sharing.

[image: Description of bam_server_rc_tab.gif follows]
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Active Data Sessions

This statistic displays the total number of Report Cache sessions with active data.

When a user opens multiple browser windows on a single computer to view Oracle BAM reports, all of the open browser windows share the same active data session. It does not matter whether the user opens the same report or different reports in each browser window, the Active Data Sessions count is always 1.


Active Data Reports

This statistic displays the total number of open reports requesting active data.


Files Count

This statistic displays the total number of files currently managed by FileBasedPersistenceManager when the Oracle BAM Server is configured to use a file-based persistence manager. For more information, see Section 23.3.5, "Configuring the Report Cache Persistence Manager".


Elements Count

This statistic displays the total number of elements currently managed by InMemoryPersistenceManager when the Oracle BAM Server is configured to use a memory-based persistence manager. For more information, see Section 23.3.5, "Configuring the Report Cache Persistence Manager".


View Sets

This group of statistics displays the following counters:

Average Open Time (sec) is the average time taken to open a view set.

Outgoing Message Rate (per sec) is the number of change lists delivered per second by Report Cache to all of its clients.

Message Rate Per Viewset (sec) the number of change lists delivered per second per view set.

Total Open Viewsets is the total number of view sets (that is, the sum of shared, unshared, and inherited view sets) maintained in Report Cache for all of the views contained in the reports opened in browsers.

The Open Viewsets graph displays shared, inherited, and unshared view sets.

Shared Viewsets are the parent view sets (these are the view sets that are opened first).

Inherited Viewsets are the child view sets (these view sets are opened later).

Unshared Viewsets (independent view sets) are neither shared or inherited.

View set sharing occurs whenever possible for performance reasons (the consumers require the exact same view sets, so the view sets can be shared). If the view sets cannot be shared, they are unshared.

When users who do not have any differences in row-level security open the same report at close to the same time, the view sets that are created for them in the Active Data Cache are shared in the Report Cache.




	
Note:

View set counts may not match between Active Data Cache, Report Cache, and Report Server metrics. For more information, see "View Set Count Variation".














24.2.4 Monitoring the Enterprise Message Sources

Enterprise Message Sources (EMS) are used by applications to provide direct Java Message Service (JMS) connectivity to Oracle BAM Server by mapping messages directly to Oracle BAM data objects. Oracle BAM Server can read data directly from any JMS-based message queue or topic. This option offers guaranteed messaging. It is more difficult to configure and not as fast to perform rigorous data transformations in XML Stylesheet Language (XSL) than in an Extract Transform and Load (ETL) tool like Oracle Data Integrator.

The EMS feature does not configure ETL scenarios, but rather maps from a message directly to a data object on Oracle BAM Server; however, you can still use XSL transformations before the data is inserted (updated, upserted, or deleted) into the data object. Each EMS reads from a specific JMS topic or queue, and the information is delivered into a data object in the Active Data Cache. The Oracle BAM Architect web application is used to configure EMS definitions.

For more information about configuring EMS definitions, see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

[image: Description of bam_server_ems_tab.gif follows]
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Note:

Data is displayed in the Enterprise Message Source page only when EMS definitions are created and started in Oracle BAM Architect. Fusion Middleware Control may take some time to fetch the data and display the statistic in the Enterprise Message Source page.

Refreshing the page displays the latest EMS data. You can refresh the page using the Refresh icon.

[image: Description of bam_em_refresh.gif follows]
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Enterprise Message Sources

Select the EMS to monitor from the list. You can choose to display aggregated statistics for all EMS definitions, or select a particular EMS to monitor from the list provided.


Messages

Monitor the number of messages received by the selected EMS. You can find rejection statistics in the Performance Summary metrics page.

The accompanying graph displays the number of Received Messages broken down into Accepted Messages and Rejected Messages, and at the top of the graph the number of Total Received Messages is displayed.


Operations Per Second

Monitor the rate of insert, update, upsert, and delete operations performed by the selected EMS.

The Operations Per Second graph displays statistics for last 5 minutes.

For more granular detail about the rates for each type of operation, go to the Performance Summary page. For more information, see Section 24.5, "Monitoring Oracle BAM Performance".






24.2.5 Monitoring the Client Requests in Progress

The Oracle BAM Client Requests in Progress chart is displayed in the lower right corner of the Oracle BAM Server home page. Client requests include all of the requests made to the Oracle BAM Server Enterprise Java Beans (EJB).

[image: Description of bam_em_server_chart.gif follows]
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There are a lot of internal requests made when opening a single report (for permissions, the report metadata, the views data, and so on); however, the user may or may not see those internal requests displayed in this chart.








24.3 Monitoring Oracle BAM Web Applications

Oracle BAM web applications are monitored in the OracleBAMWeb page of Fusion Middleware Control.

To monitor Oracle BAM Report Server go to the OracleBAMWeb page by selecting BAM > OracleBamWeb in the navigation tree.


Figure 24-1 BAM Web Statistics

[image: Description of Figure 24-1 follows]
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24.3.1 Monitoring Oracle BAM Report Server

Oracle BAM Report Server applies the report definitions to the data sets retrieved from the Oracle BAM ADC for presentation in a browser. It manages information paging for viewing and printing reports. After reports are created, they are stored in the Oracle BAM ADC so that report creation is not repeated each time. Most reporting views are designed to support live, active displays of data changing in real time.

You can monitor statistics for Oracle BAM Report Server connections, view sets, and reports.

[image: Description of bam_web_reportserver.gif follows]
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Connections

This group of statistics displays the following:

Open Connections is the number of connections open on the Report Server. An open connection corresponds to each user per session. It is different from the number of reports opened, because one user could at most have one connection open at a time regardless of how many reports the user has opened.

Message Rate (per sec) is the total number of messages (view set change lists) delivered per second to all users (connections).

Message Rate Per Connection (sec) is the number of messages (view set change lists) delivered per second per user (connection).


View Sets

This group of statistics displays the number of open view sets, and the average amount of time (in seconds) that it takes to open the view sets on the server.

Average Open Time (sec) is a measure of the average length of time the server requires to construct the view set and send it to the web browser. This statistic does not consider the amount of time required to render the HTML and load the Javascript on the client-side web browser.




	
Note:

View set counts may not match between Active Data Cache, Report Cache, and Report Server metrics. For more information, see "View Set Count Variation".










Reports

This statistic displays the total number of open reports. The Open Connections graph displays open connections to Oracle BAM web applications. You can use the zoom axis to zoom in on a particular time in which you are interested to see the open connections statistic.

The total number of reports includes the count of duplicate reports opened by the same user. Even if the same report is opened in multiple browser windows, each instance is considered a separate report, because a new view set is opened in Report Server (through Oracle BAM Report Cache) for each report instance, though the view sets are shared.






24.3.2 Monitoring Open Connections

The Oracle BAM Open Connections chart is displayed in the lower right corner of the Oracle BAM Server home page.

[image: Description of bam_web_openconngraph.gif follows]
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24.4 Monitoring Oracle BAM Web Services

Oracle BAM web services details are not listed in the Oracle BAM pages in Fusion Middleware Control. Oracle BAM web services counters are available by selecting WebLogic Domain > soa_bam_domain > BAM_Server in the navigation tree, and selecting the JEE Web Services tab in the Most Requested region as shown in Figure 24-2.

Oracle BAM provides DataObjectDefinition, DataObjectOperationsByName, DataObjectOperationsByID, DataObjectOperations10131, ManualRuleFire, and ICommand web services. For more information, see "Using Oracle BAM Web Services" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite

You can see the following statistics in JEE Web Services table: Invocation Count, Response Count, Response Error Count, Average Response Time (ms), Average Execution Time (ms), and Dispatch Time Total.


Figure 24-2 Oracle BAM Web Services Counters

[image: Description of Figure 24-2 follows]
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24.5 Monitoring Oracle BAM Performance

The performance of Oracle BAM applications is reflected in metrics and statistics. There are separate Performance Summary pages with appropriate metrics for Oracle BAM Server and Oracle BAM web applications.

When you select the Monitoring > Performance Summary menu item in each of the Oracle BAM component menus (as shown in Figure 24-3), the Performance Summary page appears as shown in Figure 24-4.


Figure 24-3 Monitoring Shortcut Menu
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Figure 24-4 Performance Summary Page

[image: Description of Figure 24-4 follows]
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Many metrics are available for capture and display (most of which are also displayed in the Oracle BAM component home pages). Descriptions of each metric are available in the metrics help pages.

To get the most valuable, focused information, use the Metric Palette. Click Show Metric Palette to display the Metric Palette, shown in Figure 24-5.

Choose the metrics in which you are most interested. As you select or deselect metrics from the palette, the metrics graph at the left is updated automatically.


Figure 24-5 Metric Palette for Oracle BAM Web Applications

[image: Description of Figure 24-5 follows]
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Right-click the metric label and select Help, as shown in Figure 24-6, to find more information about each of the metrics.


Figure 24-6 Metrics Shortcut Menu
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24.6 Monitoring Oracle BAM Logs

Oracle BAM logs are configured and viewed using Fusion Middleware Control.




	
Note:

Despite having separate log pages for Oracle BAM Server and Oracle BAM web applications, each page displays the logs for all Oracle BAM application components.









For information about using the logger features see the online Help page. For information about configuring the logger, see Section 23.4, "Configuring the Logger."

To view the logs, right-click the OracleBamServer node or OracleBamWeb node in the navigation tree and select Logs > View Log Messages as shown in Figure 24-7.


Figure 24-7 Logs Shortcut Menu
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The log viewer page opens as shown in Figure 24-8. Use this page to query for information about the component. Fields and lists are used to customize the query.


Figure 24-8 Log Messages Page
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After entering your search criteria, click Target Log Files. The Log Files page appears as shown in Figure 24-9. You can view specific log information (shown in Figure 24-10) or download the log.


Figure 24-9 Log Files Page
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Figure 24-10 Log File bam_server1.log
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26 Configuring Oracle User Messaging Service

This chapter describes the features and architecture of Oracle User Messaging Service (UMS). It also describes how to configure and secure Oracle UMS in your environment.

This chapter includes the following topics:

	
Section 26.1, "Introduction to User Messaging Service"


	
Section 26.2, "Introduction to Oracle User Messaging Service Configuration"


	
Section 26.3, "Accessing User Messaging Service Configuration Pages"


	
Section 26.4, "Configuring User Messaging Service Drivers"


	
Section 26.5, "Configuring User Messaging Service Access to the LDAP User Profile"


	
Section 26.6, "Securing the Oracle User Messaging Service"


	
Section 26.7, "Troubleshooting Oracle User Messaging Service"






26.1 Introduction to User Messaging Service

Oracle User Messaging Service enables two-way communication between users and deployed applications. Key features include:

	
Support for a variety of messaging channels: Messages can be sent and received through email, instant messaging (IM) (XMPP), short message service (SMS) (SMPP), and voice. Messages can also be delivered to a user's SOA/Oracle WebCenter Portal worklist.


	
Two-way messaging: In addition to sending messages from applications to users (referred to as outbound messaging), users can initiate messaging interactions (inbound messaging). For example, a user can send an email or text message to a specified address; the message is routed to the appropriate application that can then respond to the user or invoke another process according to its business logic.


	
User messaging preferences: End users can use a web interface to define preferences for how and when they receive messaging notifications. Applications immediately become more flexible; rather than deciding whether to send to a user's email address or IM client, the application can simply send the message to the user, and let UMS route the message according to the user's preferences.




	
Note:

The User Messaging Preferences UI is available at:

http://host:port/sdpmessaging/userprefs-ui

The User Messaging Preferences UI is also embedded in Oracle BPM Worklist. You can access it by choosing Preferences > Notification.










	
Robust message delivery: UMS keeps track of delivery status information provided by messaging gateways, and makes this information available to applications so that they can respond to a failed delivery. Or, applications can specify one or more failover addresses for a message in case delivery to the initial address fails. Using the failover capability of UMS frees application developers from having to implement complicated retry logic.


	
Pervasive integration within Oracle Fusion Middleware: UMS is integrated with other Fusion Middleware components providing a single consolidated bi-directional user messaging service.

	
Integration with Oracle BPEL Process Manager: Oracle JDeveloper includes prebuilt BPEL activities that enable messaging operations. Developers can add messaging capability to a SOA composite application by dragging and dropping the desired activity into any workflow.


	
Integration with human workflow: UMS enables the human workflow service engine to send actionable messages to and receive replies from users over email.


	
Integration with Oracle BAM: Oracle BAM uses UMS to send email alerts in response to monitoring events.


	
Integration with Oracle Oracle WebCenter Portal: UMS APIs are available to developers building applications for Oracle WebCenter Portal: Spaces. The API is a realization of Parlay X Web Services for Multimedia Messaging, version 2.1, a standard web service interface for rich messaging.









26.1.1 Components

There are three types of components that comprise Oracle User Messaging Service. These components are standard Java EE applications, making it easy to deploy and manage them using the standard tools provided with Oracle WebLogic Server.

	
UMS Server: The UMS Server orchestrates message flows between applications and users. The server routes outbound messages from a client application to the appropriate driver, and routes inbound messages to the correct client application. The server also maintains a repository of previously sent messages in a persistent store, and correlates delivery status information with previously sent messages.


	
UMS Drivers: UMS Drivers connect UMS to the messaging gateways, adapting content to the various protocols supported by UMS. Drivers can be deployed or undeployed independently of one another depending on what messaging channels are available in a given installation.


	
UMS Client applications: UMS client applications implement the business logic of sending and receiving messages. A UMS client application might be a SOA application that sends messages as one step of a BPEL workflow, or a WebCenter Portal Spaces application that can send messages from a web interface.




In addition to the components that comprise UMS itself, the other key entities in a messaging environment are the external gateways required for each messaging channel. These gateways are not a part of UMS or Oracle WebLogic Server. Since UMS Drivers support widely-adopted messaging protocols, UMS can be integrated with existing infrastructures such as a corporate email servers or XMPP (Jabber) servers. Alternatively, UMS can connect to outside providers of SMS or text-to-speech services that support SMPP or VoiceXML, respectively.






26.1.2 Architecture

The system architecture of Oracle User Messaging Service is shown in Figure 26-1.

For maximum flexibility, the components of UMS are separate Java EE applications. This allows them to be deployed and managed independently of one another. For example, a particular driver can be stopped and reconfigured without affecting message delivery on all other channels.

Exchanges between UMS client applications and the UMS Server occur as SOAP/HTTP web service requests for web service clients, or through remote Enterprise JavaBeans (EJB) and JMS calls for BPEL messaging activities. Exchanges between the UMS Server and UMS drivers occur through JMS queues.

Oracle UMS server and drivers are installed alongside Oracle SOA Suite or Oracle BAM in their respective Oracle WebLogic Server instances. An Oracle WebCenter Portal installation includes the necessary libraries to act as a UMS client application, invoking a server deployed in a SOA instance.


Figure 26-1 UMS Architecture

[image: Description of Figure 26-1 follows]
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26.2 Introduction to Oracle User Messaging Service Configuration

Oracle User Messaging Service enables users to receive notifications sent from SOA applications that are developed and deployed to the Oracle WebLogic Server using Oracle JDeveloper.

At the application level, there is notification activity for a specific delivery channel (such as SMS or email). For example, when you build a SOA application that sends email notification, you drag and drop an Email activity from the Oracle JDeveloper Component Palette to the appropriate location within a workflow. The application connects then sends notifications.

For more information about Oracle JDeveloper, see your Oracle JDeveloper documentation.

To enable the workflow participants to receive and forward notifications, use Oracle Enterprise Manager Fusion Middleware Control to set the Oracle User Messaging Service environment by configuring the appropriate driver instances that reside on the same Oracle WebLogic Server on which you deploy the workflow application (Figure 26-2). Oracle User Messaging Service includes drivers that support messaging through email, IM, SMS, and voice channels. For more information, see Section 26.4, "Configuring User Messaging Service Drivers."


Figure 26-2 Oracle Enterprise Manager Fusion Middleware Control
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For workflow participants to receive the notifications, they must register the devices that they use to access messages through User Messaging Preferences (Figure 26-3).


Figure 26-3 User Messaging Preferences
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26.3 Accessing User Messaging Service Configuration Pages

You configure Oracle User Messaging Service through Oracle Enterprise Manager Fusion Middleware Control.



26.3.1 Setting the Storage Method 

Use the Server Properties page to set the deployment type for the Messaging Server (that is, select the storage method for runtime and management data) and add (or remove) the User Messaging Preference Business Terms that are used for creating message filters.

Select Persistent (the default) to enable entries and the Messaging Store to persist when the server has been restarted. In the Transient mode (which is recommended for lightweight deployments), the Messaging Server does not maintain any data stored in the Messaging Store after a restart.






26.3.2 Adding or Removing User Messaging Preferences Business Terms

The Server Properties page enables you to add or remove the business terms used to construct the message filters in User Message Preferences. For more information about building messaging filters with business terms, see Section 26.3.2.1, "Adding Business Terms."



26.3.2.1 Adding Business Terms




	
Note:

Business terms are stored per server instance. If there are multiple instances (as in a cluster), then new business terms must be added to each instance individually.









To add a business term to User Messaging Preferences:

	
Click Add.


	
Enter a descriptive name for the business term.


	
Select a data type (string, number, or date).


	
Click Apply.









26.3.2.2 Removing Business Terms

To remove a business term from User Messaging Preferences:

	
Select the business term.


	
Click Delete.


	
Click Apply to confirm the new term.













26.4 Configuring User Messaging Service Drivers

Oracle User Messaging Service includes the following drivers.

	
Configuring the Messaging Extension Driver


	
Configuring the Email Driver


	
Configuring the SMPP Driver


	
Configuring the XMPP Driver


	
Configuring the VoiceXML Driver


	
Configuring the Worklist Driver


	
Configuring the Proxy Driver







	
Note:

For the cluster environment, when you use separate messaging drivers for separate managed server nodes, all the drivers must be configured separately.

UMS Messaging Drivers are configured per instance. Configuring only one does not populate the configuration values to the drivers on the other cluster nodes.











26.4.1 Configuring a Driver

To configure a driver:

	
Log in to Oracle Enterprise Manager Fusion Middleware Control as an administrator.


	
Expand the Fusion Middleware folder.


	
Navigate to the User Messaging Service home page.

[image: Description of ns_login.gif follows]
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Click usermessagingserver(soa_server1). The Associated Drivers page appears.

[image: Description of ns_assoc_drv.gif follows]
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Select the Local tab to access the drivers collocated with the UMS server instance. These drivers may or may not be registered with the UMS server depending on whether they are properly configured. The ALL tab lists all drivers that are deployed in the domain and registered to all the UMS server instances.


	
Find the email driver in the list, and then click the adjacent Configure Driver icon.

The configuration page is displayed.

[image: Description of ns_configdriver.gif follows]
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If needed, expand the Driver-Specific Configuration section and configure the driver parameters. For more information, see Section 26.4.1.1, "Introduction to Driver Properties."






26.4.1.1 Introduction to Driver Properties

Oracle User Messaging Service drivers share common properties (listed in Table 26-1) that are used by the Messaging Engine when routing outbound messages. Typically, administrators set such Quality of Service (QoS) properties as driver cost (Cost) and driver speed (Speed), supported carriers (SupportedCarriers), and supported protocols (SupportedProtocols). Driver developers configure properties that typically do not require modification by the administrator, such as supported delivery types (SupportedDeliveryTypes), and supported content types (SupportedContentTypes).




	
Note:

Properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies.










Table 26-1 Common Driver Properties

	Name	Description	Mandatory Property?
	
Capability

	
Sets the driver's capability to send or receive messages. The values are SEND, RECEIVE, and BOTH.

	
Yes


	
Cost

	
The cost level of the driver (from 0 - 10). 0 is least expensive; 10 is most expensive. If the value is not in this range, cost is considered to be 0.

	
No


	
DefaultSenderAddress

	
The default address of the sender. The driver uses these addresses when sending a message that has no sender address specified, or when the specified sender address is not in the sender addresses list and the driver does not support using the application-provided sender address.

	
No


	
SenderAddresses

	
The list of sender addresses that the driver supports. If provided by the driver, the messaging engine can use this to route a sending message to the driver by matching against the sender address of the message.

	
No


	
SendingQueuesInfo

	
The information for the driver sending queue.

	
Yes


	
Speed

	
The speed level of the driver (from 0-10, with 10 being the fastest).

	
No


	
SupportedCarriers

	
A comma-delimited list of supported carriers.

	
No


	
SupportedContentTypes

	
The content type supported by the driver.

	
Yes


	
SupportedDeliveryTypes

	
The delivery types supported by the driver.

	
Yes


	
SupportedProtocols

	
A comma-delimited list of supported protocols. Enter an asterisk (*) for any protocol.

	
No


	
SupportedStatusTypes

	
The status types supported by the driver.

	
No


	
SupportsCancel

	
Supports a cancel operation on a message.

	
No


	
SupportsReplace

	
Supports a replace operation on a message.

	
No


	
SupportsStatusPolling

	
For certain protocols, an active polling of the remote gateway must be performed to check the status of a message previously sent. This property indicates whether the driver supports such status polling. If set to true, the messaging engine invokes the driver connection's getStatus() operation.

	
No


	
SupportsTracking

	
Supports a tracking operation on a message.

	
No












26.4.1.2 Securing Passwords

Sensitive driver properties (namely, passwords) can be stored securely in the credential store using Oracle Enterprise Manager Fusion Middleware Control. Properties are marked with the flag Encoded Credential and have a custom entry form field.

To store a sensitive driver property securely:

	
Go to the driver configuration page of the selected driver.


	
In the Driver-Specific Configuration section, locate the property with the Encoded Credential flag set.


	
Select the credential type. (Depending on the selected credential type, you are prompted to enter the username and/or password.) There are three options:

	
Indirect password, create new user (default option): specify the username and real password; the password is stored in the credential store with the username as part of the key. The key and a fixed folder (map name) are stored in the driver deployment's driverconfig.xml file.


	
Indirect password, use existing user: choose an existing username/key in the credential store (to reference the password you stored previously).


	
User a clear text password: specify the password, and it is stored directly in the driverconfig.xml file.





	
Click Apply to save the changes.


	
Restart the driver application or the container for the changes to take effect.




You can check the password in the driver deployment directory's driverconfig.xml file. For an indirect password, the format is:


value="->mapName:keyName"    (mapName is the driver target name, and the key is <parameter_name>.<username>)


For example, here is a sample entry in driverconfig.xml for an email driver's OutgoingPassword property:


<Property value="-&gt;
/Farm_base_domain/base_domain/server_soa/usermessagingdriver-email:
OutgoingPassword.ouser" encodedCredential="true" 
type="java.lang.String" mandatory="no" name="OutgoingPassword"
description="oracle.sdp.messaging.EmailDriverConfig.outgoingPassword"/>






26.4.1.3 Configuring the Messaging Extension Driver

The extension driver extends the messaging capability of the User Messaging Service by enabling support for arbitrary administrator-defined channels (protocols) and delivering the notifications for such channels to an administrator-defined web service listener endpoint.




	
Note:

An instance of this driver is deployed, but not targeted to any servers in the default installation. To enable this driver instance, it must be targeted to the appropriate servers where UMS (usermessagingserver) is running.











26.4.1.3.1 Driver Application Archive (EAR)

The EAR file is $oracle_home/communications/applications/sdpmessagingdriver-extension.ear.






26.4.1.3.2 Common Properties

These are common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties (such as sendingqueuesinfo) are for advanced use and only require modification for advanced deployment topologies. See Table 26-2. For a complete description of these properties and available values, see the JavaDoc for driverconfigpropertynames.


Table 26-2 Extension Driver Common Properties

	Name	Description	Mandatory?	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Extension-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
URI


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html, text/xml


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	

	
Speed

	
Speed

	
No

	

	
SupportedCarriers

	
Supported carriers

	
No

	

	
SupportedProtocols

	
Supported protocols

	
No

	
popup


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	

	
DefaultSenderAddress

	
Default sender address

	
No

	

	
SendingQueuesInfo

	
Driver sending queue info

	
Yes
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26.4.1.3.3 Custom Properties

This driver supports multiple configuration groups called extension endpoint groups. An extension endpoint group holds the configuration for a remote endpoint at which to deliver extension notifications. Each endpoint must have a distinct combination of protocol and mapped domain. The properties of the extension endpoint group are listed in Table 26-3:


Table 26-3 Extension Driver Custom Properties

	Name	Description	Mandatory?
	
Group Name

	
The name of this extension endpoint configuration group.

	
Yes


	
Endpoint URL

	
Remote endpoint listener URL.

	
Yes


	
Mapped Domain

	
The extension endpoint used to deliver messages where the domain part of the recipient URI matches this value.

	
No


	
Protocol

	
The extension endpoint used to deliver messages where the protocol (scheme) part of the recipient URI matches this value.

	
Yes


	
Security Policies

	
Comma-separated list of WS-Security policies to apply to this endpoint.

	
No


	
Username

	
Username to propagate through WS-Security headers.

	
No


	
Keystore Alias

	
Keystore alias to use for looking up WS-Security policy public keys.

	
No


	
Credential Store Key

	
Key to use for looking up the WS-Security username and password from the Oracle Web Services Management credential store map.

	
No












26.4.1.3.4 Extension Driver Security

If the remote extension endpoint is secured using WS-Security, then additional configuration of the extension driver is required. There are two typical WS-Security configurations that are supported. The extension driver can either use SAML tokens or username tokens.

To use extension driver security:

	
To use SAML tokens, the Security Policies configuration property should contain value oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy, and the Keystore Alias configuration property should contain a valid alias for keystore entries that is accepted by the remote extension endpoint.


	
To use username tokens, the Security Policies configuration property should contain value oracle/wss11_username_token_with_message_protection_client_policy, and the Credential Store Key configuration property should contain a valid alias for a credential store entry that is accepted by the remote extension endpoint.




For more details about using WS-Security policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.






26.4.1.3.5 Client API Messageinfo Support

Table 26-4 describes whether the protocol or driver implementation honors the following message delivery-related properties that are specified through the client API.


Table 26-4 Client API MessageInfo Support

	Name	Description	Supported?
	
Expiration

	
Expiration means how much later in seconds for the message to expire.

	
False


	
Delay

	
Delay means how much later to send the message out.

	
False












26.4.1.3.6 Usage Instructions

Perform the following steps to use the extension driver:

To use the extension driver:


	
Implement and deploy a web service listener endpoint based on the MessagingNotifyService WSDL (umsnotify.wsdl):


<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<wsdl:definitions xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/"
                  xmlns:tns="http://xmlns.oracle.com/ucs/messaging/extension"
                  xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/"
                  xmlns:xsd="http://www.w3.org/2001/XMLSchema"
                  name="MessagingNotifyService"
                  targetNamespace="http://xmlns.oracle.com/ucs/messaging/extension">
 
    <wsdl:types>
 
    <xsd:schema targetNamespace="http://xmlns.oracle.com/ucs/messaging/extension">
      <xsd:element name="notification">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="messageId" type="xsd:string" minOccurs="0"
 maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>Unique message identifier from User
 Messaging Service.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="sender" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The sender address.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="recipient" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The recipient address (typically
 username).</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="subject" type="xsd:string" minOccurs="0"
 maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>The subject of the message, if
 available.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="contentType" type="xsd:string"
 default="text/plain">
              <xsd:annotation>
                <xsd:documentation>The MIME type of the message. e.g.
 text/plain, text/html, text/xml.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="content" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The main body of the message. Textual
 content only (no binary content).</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="parameters" type="tns:parameter" minOccurs="0"
 maxOccurs="unbounded">
              <xsd:annotation>
                <xsd:documentation>Additional key-value pairs. This interface
 does not define any specific key-value pair meanings. Use of such parameters
 is defined on a private basis by particular implementations of this interface.
   </xsd:documentation>
              </xsd:annotation>
            </xsd:element>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
      <xsd:complexType name="parameter">
        <xsd:sequence>
          <xsd:element name="name" type="xsd:string">
            <xsd:annotation>
              <xsd:documentation>Parameter name</xsd:documentation>
            </xsd:annotation>
          </xsd:element>
          <xsd:element name="value" type="xsd:string">
            <xsd:annotation>
              <xsd:documentation>Parameter value</xsd:documentation>
            </xsd:annotation>
          </xsd:element>
        </xsd:sequence>
      </xsd:complexType>
      <xsd:element name="notificationResponse">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="messageId" type="xsd:string" minOccurs="0"
 maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>A message identifier returned in response to
 successfully accepting the message. If returned, the identifier should be
 unique. Note: A fault is raised if the message cannot be
 accepted.</xsd:documentation>
              </xsd:annotation></xsd:element>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
      <xsd:element name="notificationFault">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="code" type="xsd:string"/>
            <xsd:element name="message" type="xsd:string"/>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
    </xsd:schema>
  </wsdl:types>
  <wsdl:message name="notifyRequest">
    <wsdl:part element="tns:notification" name="parameters" />
  </wsdl:message>
  <wsdl:message name="notifyResponse">
    <wsdl:part element="tns:notificationResponse" name="parameters"/>
  </wsdl:message>
  <wsdl:message name="notifyException">
    <wsdl:part element="tns:notificationFault" name="parameters"/>
  </wsdl:message>
  <wsdl:portType name="Notify">
    <wsdl:operation name="invoke">
      <wsdl:input message="tns:notifyRequest"/>
      <wsdl:output message="tns:notifyResponse"/>
      <wsdl:fault message="tns:notifyException" name="NotifyException"/>
    </wsdl:operation>
  </wsdl:portType>
  <wsdl:binding name="NotifySOAPBinding" type="tns:Notify">
    <soap:binding style="document"
 transport="http://schemas.xmlsoap.org/soap/http" />
    <wsdl:operation name="invoke">
      <soap:operation
        soapAction="http://www.oracle.com/ucs/messaging/extension" />
      <wsdl:input>
        <soap:body use="literal" />
      </wsdl:input>
      <wsdl:output>
        <soap:body use="literal" />
      </wsdl:output>
      <wsdl:fault name="NotifyException">
        <soap:fault name="NotifyException" use="literal"/>
      </wsdl:fault>
    </wsdl:operation>
  </wsdl:binding>
 
  <wsdl:service name="NotifyService">
    <wsdl:port binding="tns:NotifySOAPBinding" name="Notify">
      <soap:address location="http://localhost:8001/NotifyService"/>
    </wsdl:port>
  </wsdl:service>
</wsdl:definitions>


	
Configure the extension driver.

	
Target the predeployed extension driver called usermessagingdriver-extension or a new deployment to the appropriate servers where UMS (usermessagingserver) is running and start the driver.


	
In Enterprise Manager Fusion Middleware Control, navigate to the usermessagingserver home page.


	
Click User Messaging Service > Driver Properties.


	
Select and Edit the driver usermessagingdriver-extension or create a new driver with the same name as your new driver deployment.


	
Under Driver-Specific Configuration, add a new extension endpoint configuration group and specify the correct properties: EndpointURL is the URL to the web service listener endpoint created in Step 1. Protocol is the value of the new messaging channel for which you want to add notification support (for example, popup).


	
Under Common Configuration, update Supported Protocols with a comma-separated list of protocols defined in each Extension Endpoint group.


	
Click OK to save the configuration.







This completes the configuration and integration of a new messaging channel (protocol) in UMS using the extension driver.

To send notifications to this new channel (protocol), recipients must be specified for the URI delivery type using the URI addressing format:


URI:scheme:scheme-specific-address-value


where scheme is the protocol. The URI delivery type is optional. For example, if the extension driver was configured to support the protocol popup, an application can compose a message to popup:john.doe@example.com.

End users can also declare their messaging preferences by creating a new messaging channel for the new channel type in the Worklist/UMS Preferences UI. User preferences are only applied when applications send user-based notifications (that is, to recipients of the form USER:username).




	
Note:

Proper configuration of SSL/TLS in the Oracle WebLogic Server container is a prerequisite for secure connections between UMS and the email server. See "Configuring SSL" in Oracle Fusion Middleware Securing Oracle WebLogic Server.
















26.4.1.4 Configuring the Email Driver

The email driver both sends and receives messages (that is, its capability property is set to both by default). The email driver sends messages over SMTP and uses either IMAP or POP3 for receiving messages.



26.4.1.4.1 Email Driver Interoperability

This section details interoperability features of the email driver.

The email driver is compatible with these protocols: POP3, IMAP4, and SMTP.

Email driver features include:

	
Automatic connection retry


	
SMTP for message sending


	
IMAP4 and POP3 for message receiving (using polling)


	
scalable, highly available


	
Message loss prevention and duplication avoidance




The gateway vendors and versions in Table 26-5 have been verified.


Table 26-5 Email Driver Gateway Vendors and Versions

	Vendor	Version
	
Oracle Beehive

	
Release 1 (1.4.3)


	
Oracle Collaboration Suite

	
10g Release 1 (10.1.2)


	
Microsoft Exchange

	
2003


	
Dovecot (IMAP4/POP3)

	
0.99.11


	
sendmail (SMTP)

	
8.13.1












26.4.1.4.2 Common Properties

Table 26-6 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as sendingqueuesinfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of driverconfigpropertynames.


Table 26-6 Common Email Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Email-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
Email


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html, multipart/mixed, multipart/alternative, multipart/related


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE, USER_REPLY_ACKNOWLEDGEMENT_SUCCESS, USER_REPLY_ACKNOWLEDGEMENT_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue info

	
Yes
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26.4.1.4.3 Email Custom Properties

Table 26-7 lists properties specific to this driver and generally associated with configuring access to the remote gateway and certain protocol or channel-specific behavior.


Table 26-7 Custom Email Properties

	Name	Description	Mandatory?	Default Value
	
MailAccessProtocol

	
Email receiving protocol. The possible values are IMAP and POP3. Required only if email receiving is supported on the driver instance.

	
No

	
IMAP


	
RetryLimit

	
This value specifies the number of times to retry connecting to the incoming mail server, if the connection is lost for some reason. The default value is -1, which means there is no limit to the number of tries.

	
No

	
-1


	
MailDelFreq

	
The frequency to permanently remove deleted messages. The unit is in seconds and the default value is 600 seconds. A negative value indicates the messages should not be expunged. For the POP3 protocol, the message is expunged after it is processed.

	
No

	
600


	
AutoDelete

	
This value indicates if the driver should mark the messages deleted after they have been processed. The default is Disabled. For the POP3 protocol, the messages are always deleted right after they are processed.

	
No

	
Disabled


	
Debug

	
This value indicates if the driver is running in Debug mode. When enabled, JavaMail prints out requests and responses between the email driver and the mail server to Fusion Middleware Control. The default is Disabled.

	
No

	
Disabled


	
CheckMailFreq

	
The frequency with which to retrieve messages from the mail server. The unit is in seconds and the default value is 30 seconds.

	
No

	
30


	
ReceiveFolder

	
The name of the folder from which the driver is polling messages. The default value is INBOX.

	
No

	
INBOX


	
OutgoingMailServer

	
The name of the SMTP server. This is mandatory only if email sending is required.

	
No

	
N/A


	
OutgoingMailServerPort

	
The port number of the SMTP server; typically 25.

	
No

	
25


	
OutgoingMailServerSecurity

	
The security setting used by the SMTP server. Possible values are None, TLS, and SSL. The default value is None.

	
No

	
None


	
OutgoingDefaultFromAddr

	
The default FROM address (if one is not provided in the outgoing message).

	
No

	
N/A


	
OutgoingUsername

	
The username used for SMTP authentication. Required only if SMTP authentication is supported by the SMTP server.

	
No

	
N/A


	
OutgoingPassword

	
The password used for SMTP authentication. This is required only if SMTP authentication is supported by the SMTP server. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
No

	
N/A


	
IncomingMailServer

	
The hostname of the incoming mail server. Required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingMailServerPort

	
Port number of IMAP4 (that is, 143 or 993) or POP3 (that is, 110 or 995) server.

	
No

	
N/A


	
IncomingMailServerSSL

	
Indication to enable SSL when connecting to IMAP4 or POP3 server. The default is Disabled.

	
No

	
Disabled


	
IncomingMailIDs

	
The email addresses corresponding to the user names. Each email address is separated by a comma and must reside in the same position in the list as their corresponding user name appears on the usernames list. Required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingUserIDs

	
The list of user names of the mail accounts from which the driver instance is polling. Each name must be separated by a comma, for example, foo,bar. This is required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingUserPasswords

	
The list of passwords corresponding to the user names. Each password is separated by a comma and must reside in the same position in the list as their corresponding user name appears on the usernames list. This is required only if email receiving is supported on the driver instance. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
No

	
N/A


	
ProcessingChunkSize

	
The number of messages processed during each message polling. The default is 100.

	
No

	
100


	
ImapAuthPlainDisable

	
Indication to disable or enable plain text authentication (AUTHENTICATE PLAIN command) for IMAP user authentication. The default is Disabled.

	
No

	
Disabled. When this property is disabled, that means that plain text is allowed.










26.4.1.4.4 Client API Messageinfo Support

These properties are message delivery-related that are specified through client API. Table 26-8 describes if the protocol or driver implementation honors such properties.


Table 26-8 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















26.4.1.5 Configuring the SMPP Driver

Short Message Peer-to-Peer (SMPP) is a popular GSM SMS protocols. User Messaging Service includes a prebuilt implementation of the SMPP protocol as a driver that can send and receive short messages. If the sending feature is enabled, the SMPP driver opens one TCP connection to the Short Message Service Center (SMS-C) as a transmitter for sending. If the driver's receiving feature is enabled, it opens another connection to the SMS-C as a receiver for receiving. Only two TCP connections (both initiated by the driver) are needed for all communication between the driver and the SMS-C.




	
Note:

The SMPP Driver implements Version 3.4 of the SMPP protocol and only supports connections to an SMS-C or an SMS gateway that supports this version.











26.4.1.5.1 SMPP Driver Interoperability

This section details interoperability features of the SMPP Driver.

The SMPP driver is compatible with this protocol: SMPP v3.4.

SMPP driver features include:

	
Automatic connection retry


	
HTTP proxy for firewall traversal


	
Authentication configuration


	
Configurable chunk size


	
Bulk Sending


	
Encoding: UCS2, IA5, GSM_DEFAULT


	
Priority Setting


	
Configurable Window size


	
Plain text content only




The Gateway vendors in Table 26-9 have been verified.


Table 26-9 SMPP Driver Gateway Vendors

	Vendor
	
Syniverse


	
Clickatell


	
Logica CMG


	
OpenSMPP (simulator)












26.4.1.5.2 Common Properties

Table 26-10 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values see the JavaDoc of DriverConfigPropertyNames.


Table 26-10 Common SMPP Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
SMPP-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
SMS


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue info

	
Yes
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26.4.1.5.3 Custom Properties

Table 26-11 lists properties specific to this driver and generally associated with configuring access to the remote gateway and certain protocol or channel-specific behavior.


Table 26-11 Custom SMPP Properties

	Name	Description	Mandatory?	Default Value
	
SmsAccountId

	
The Account Identifier on the SMS-C.

	
Yes

	
N/A


	
SmsServerHost

	
The name (or IP address) of the SMS-C server.

	
Yes

	
N/A


	
TransmitterSystemId

	
The account ID that is used to send messages.

	
Yes

	
N/A


	
ReceiverSystemId

	
The account ID that is used to receive messages.

	
Yes

	
N/A


	
TransmitterSystemType

	
The type of transmitter system. The default is Logica.

	
Yes

	
The default value is Logica.


	
ReceiverSystemType

	
The type of receiver system. The default is Logica.

	
Yes

	
The default value is Logica.


	
TransmitterSystemPassword

	
The password of the transmitter system. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
Yes

	
N/A


	
ReceiverSystemPassword

	
The password for the receiver system. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
Yes

	
N/A


	
ServerTransmitterPort

	
The TCP port number of the transmitter server.

	
Yes

	
N/A


	
ServerReceiverPort

	
The TCP port number of the receiver server.

	
Yes

	
N/A


	
DefaultEncoding

	
The default encoding of the SMPP driver. The default is IA5. Choose from the drop-down list: IA5, UCS2, and GSM_DEFAULT.

	
No

	
IA5


	
EncodingAutoDetect

	
If enabled, the SMPP driver encodes automatically. The default is Enabled.

	
No

	
Enabled


	
LocalSendingPort

	
The local TCP port used by the SMPP driver to send messages to the SMS-C.

	
No

	
N/A


	
LocalReceivingPort

	
The local TCP port used by the SMPP driver to receive messages from the SMS-C.

	
No

	
N/A


	
LocalAddress

	
The hostname (or IP address) of the server that hosts the SMPP driver.

	
No

	
N/A


	
WindowSize

	
The window size for SMS. This value must be a positive number. Default is 1.

	
No

	
1


	
EnquireInterval

	
The interval, in seconds, to send an enquire message to the SMS-C. The default is 30 seconds.

	
No

	
30


	
ThrottleDelay

	
The delay, in seconds, between throttles. Default is 30.

	
No

	
30


	
BindRetryDelay

	
The minimum delay, in seconds, between bind entry attempts. Default is 30.

	
No

	
30


	
ResponseTimer

	
Time lapse allowed between SMPP request and response, in seconds. The default is 30.

	
No

	
30


	
RegisteredDeliveryMask

	
The registered delivery bit mask. The default is 0xFF, which does not change the delivery flag value.

	
No

	
0xFF


	
RangeSetNull

	
Set to true to set the address range field of BIND_RECEIVER to null. Set to false (the default value) to set the address range field to SmsSystemId. The default is Disabled.

	
No

	
Disabled


	
PriorityAllowed

	
The highest priority allowed for the SMPP driver. The range is 0 (normal) to 3 (highest). The default is 0.

	
No

	
0


	
BulkSending

	
Setting this value to enabled (the default) enables sending messages in bulk to the SMS-C.

	
No.

	
Enabled


	
PayloadSending

	
Determines if the message_payload parameter is always used when sending a message to the SMS-C. The default is Disabled.

	
No

	
Disabled


	
SourceTon

	
The type of number (TON) for ESME address(es) served through SMPP receiver session. The default is 0.

	
No

	
0


	
SourceNpi

	
The numbering plan indicator (NPI) for ESME address(es) served through the SMPP receiver session. The default is 0.

	
No

	
0


	
DestinationTon

	
The TON for destination. The default is 0.

	
No

	
0


	
DestinationNpi

	
The NPI for destination. The default is 0.

	
No

	
0


	
ExtraErrorCode

	
A comma-separated list of error codes.

	
No

	
N/A


	
MaxChunks

	
The maximum SMS chunks for a message. The default is -1 (no maximum).

	
No

	
-1 (no maximum)


	
ChunkSize

	
The size of each SMS message chunk. Default is 160.

	
No

	
160


	
LongMessageSending

	
Supports sending long messages. The default is Disabled.

	
No

	
Disabled


	
DatagramMessageMode

	
Supports datagram message mode. The default is Disabled.

	
No

	
Disabled












26.4.1.5.4 Client API MessageInfo Support

These properties are message delivery-related that are specified through client API. Table 26-12 describes if the protocol or driver implementation honors such properties.


Table 26-12 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
True


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False
















26.4.1.6 Configuring the XMPP Driver

The XMPP Driver provides unidirectional and bidirectional access from Oracle Fusion Middleware to end users for real-time IM through the Extensible Messaging and Presence Protocol (XMPP). This driver enables end users to receive alert notifications or interactively chat with applications through their IM client of choice.



26.4.1.6.1 Introduction to XMPP

XMPP is an open, XML-based protocol for IM and Presence. XMPP-based software is deployed on thousands of servers across the Internet and is used by millions of people worldwide. XMPP consists of a client/server architecture, which resembles the ubiquitous email network. XMPP servers are completely decentralized, allowing anyone to set up their own server. Messaging is achieved as in the email network, where recipients are addressed by an XMPP ID (or Jabber ID or JID) with the following form: [username]@domain[/resource]. See RFC 3920 for details on the addressing scheme. 

In an XMPP network, users identified by their XMPP IDs as mentioned above (which typically consist of a username and the domain of the XMPP server to which the user connects). An end user of XMPP connects to an XMPP server using an XMPP client to send instant messages to other XMPP users. XMPP, however, is not the only protocol network available for IM. XMPP has an extensible and modular architecture. It integrates with proprietary IM networks, enabling XMPP users to communicate with those on other networks.

To use the XMPP Driver in UMS, you must have access to a Jabber/XMPP server and an XMPP account for the UMS XMPP Driver instance with which to log in.






26.4.1.6.2 XMPP Driver Interoperability

This section details interoperability features of the XMPP Driver.

The XMPP driver is compatible with these protocols: XMPP (RFC 3920, 3921).

XMPP Driver features include:

	
Automatic connection retry


	
HTTP proxy for firewall traversal


	
Plain text content only




The gateway vendors and versions in Table 26-13 have been verified.


Table 26-13 XMPP Driver Gateway Vendors and Versions

	Vendor	Version
	
ejabberd

	
2.1.3


	
jabberd2

	
2.2.14


	
jabberd14

	
1.6.1.1-p1


	
Oracle Beehive

	
2.0.1.2.1












26.4.1.6.3 Third-Party Software

The XMPP Driver uses or requires the following third-party software (you may optionally choose to install and configure your own XMPP server):


Table 26-14 Required Third-Party Software

	Name	Instructions	Version(s)
	
Apache Smack

	
This driver uses the Apache Smack XMPP Java library to connect to a Jabber/XMPP IM Server. This driver includes a licensed copy of Smack (version 3.0.4).

	
3.0.4











	
Note:

You are not required to install your own XMPP Server if you have access to an existing server. For a list of public servers, see http://www.jabber.org.














26.4.1.6.4 Driver Application Archive (EAR)

The EAR file is $ORACLE_HOME/communications/applications/sdpmessagingdriver-xmpp.ear.






26.4.1.6.5 Common Properties

Table 26-15 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 26-15 Common XMPP Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
XMPP-IM-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
IM


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports a cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports a replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports a tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports a status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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26.4.1.6.6 XMPP Custom Properties

The XMPP Driver includes the custom properties shown in Table 26-16.


Table 26-16 Custom XMPP Properties

	Name	Description	Mandatory	Default Values
	
IMServerHost

	
Jabber/XMPP server hostname.

	
No

	
N/A


	
IMServerPort

	
Corresponding Jabber/XMPP server port. The default is 5222.

	
Yes

	
5222


	
IMServerUsername

	
Jabber/XMPP username with which you log in. You may also enter a complete Jabber ID if its domain name is different from the Jabber/XMPP server hostname (for example: myUserName or myUserName@xmpp-domain).

Note: An attempt is made to register this user account if it does not exist and the server supports account registration.

	
No

	
N/A


	
IMServerPassword

	
Corresponding password for the username listed above. Includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, Use Cleartext Password) and Password.

	
No

	
N/A


	
SecurityMode

	
Security mode to use when making a connection to the server. Available options are: None (Security is disabled and only unencrypted connections are used), TLS (Security through TLS encryption is used whenever it is available), and SSL (Security through SSL encryption is used). The default is TLS.

	
No

	
TLS


	
SASLAuthenticationEnabled

	
Whether to use SASL authentication when logging into the server. If SASL authentication fails, then the driver tries to use non-SASL authentication. By default, SASL is enabled.

	
No

	
Enabled










26.4.1.6.7 Client API MessageInfo Support

These properties are message delivery-related that are specified through the client API. Table 26-17 describes if the protocol or driver implementation honors such properties.


Table 26-17 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















26.4.1.7 Configuring the VoiceXML Driver

The VoiceXML Driver supports the Genesys VoiceGenie gateway's outbound call protocol to send messages authored in VoiceXML. The gateway delivers the message using text-to-speech synthesis.



26.4.1.7.1 VoiceXML Driver Interoperability

This section details interoperability features of the VoiceXML Driver.

The VoiceXML driver is compatible with this protocol: VoiceXML over HTTP (VoiceGenie gateway protocol).

The VoiceXML driver features include:

	
VoiceXML content only




The gateway vendor and version in Table 26-18 has been verified.


Table 26-18 VoiceXML Driver Gateway Vendor and Version

	Vendor	Version
	
Genesys VoiceGenie

	
6.4.2












26.4.1.7.2 Common Properties

Table 26-19 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 26-19 Common VoiceXML Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
VoiceXML-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
VOICE


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/vxml, text/x-vxml


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender Addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default Sender Address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver Sending Queue Info

	
Yes
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26.4.1.7.3 VoiceXML Custom Properties

The VoiceXML Driver includes the custom properties shown in Table 26-20.


Table 26-20 Custom VoiceXML Properties

	Name	Description	Mandatory	Default Values
	
VoiceXMLOutboundServletURI

	
The URL of the VoiceXML gateway.

	
Yes

	
N/A


	
VoiceXMLOutboundServletUserName

	
The user name of the VoiceXML gateway.

	
No

	
N/A


	
VoiceXMLOutboundServletPassword

	
The password of the user of the VoiceXML gateway.

	
No

	
N/A


	
VoiceXMLOutboundServletDNIS

	
The number that should appear in the recipient's caller ID display.

	
No

	
N/A


	
VoiceXMLReceiveURL

	
The URL of this driver's servlet that handles incoming requests from the VoiceXML Gateway. The format is http://host:port/usermessagingdriver-voicexml/receive. The default behavior, if this property is not set, is to use the local container's HTTP listener host and port. The default behavior only works for the first driver instance. For additional instances, the context root is different and this property must be configured using the correct context root replacement for /sdpmessagingdriver-voicexml.

	
No

	
N/A











	
Note:

In a clustered (high-availability) environment with Oracle HTTP Server (OHS) configured, do not use the OHS port to configure the VoiceXML driver receive URLs. Using the OHS port to configure the VoiceXML driver receive URLs causes a conflict with the drivers.

Each VoiceXML driver must be configured with its own WLS server's port.











26.4.1.7.4 Client API MessageInfo Support

These properties are message delivery related which are specified through client API. Table 26-21 describes if the protocol or driver implementation honors such properties.


Table 26-21 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















26.4.1.8 Configuring the Worklist Driver

The Worklist driver enables notifications from all sources to be sent to users in the form of worklist tasks for integration into the users' WebCenter Portal Unified Worklist.




	
Note:

Worklist message tasks are accessible both through an Oracle WebCenter Portal that has been configured to search the BPEL connection to which the worklist message driver is sending messages, and through Oracle BPM Worklist. Oracle BPM Worklist also shows these message-based tasks as worklist items.









This integration is achieved by exposing a worklist channel (delivery type) to applications and end users. Messages sent through the user's worklist channel are processed by the worklist driver.




	
Note:

The worklist channel supports all rich text tags supported by the af:richTextEditor for the text/html content type. For more information about the Rich Text Editor, see <af:richTextEditor>.









The User Messaging Service API semantics are the same as those for existing channels such as IM or email. This driver handles sending messages only. The driver Application Archive (EAR) is located at: $ORACLE_HOME/communications/applications/sdpmessagingdriver-worklist.ear

You can install the Worklist Driver onto an Oracle WebLogic platform, or onto an IBM WebSphere platform. Choose the appropriate installation instructions below.



26.4.1.8.1 Install the Worklist Driver on the Oracle WebLogic Server Platform

To enable the messaging worklist feature, the WebLogic SOA domain must be extended using the extension template available at $ORACLE_HOME/common/templates/applications/oracle.ums.driver.worklist_template_11.1.1.jar. 

To extend a SOA domain using the Oracle Fusion Middleware Configuration Wizard:

	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/config.sh or %ORACLE_HOME%\common\bin\config.cmd).


	
Select the Extend an existing WebLogic domain option.


	
Select the desired SOA domain directory.


	
Select the Extend my domain using an existing extension template option.


	
Click Browse, and navigate to $ORACLE_HOME/common/templates/applications


	
Select oracle.ums.driver.worklist_template_11.1.1.jar


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard, and restart the SOA servers.







	
Note:

Special Considerations if the SOA managed server is on a remote computer: The oracle.ums.driver.worklist_template_11.1.1.jar extension template includes a SOA composite application (sca_sdpmessagingsca-worklist-composite_rev1.0.jar) that is copied to $DOMAIN_HOME/soa/autodeploy, and is auto-deployed by the SOA Infra runtime upon server restart. However, if the SOA Infra runtime is on a remote computer, and the domain is packed with the -managed=true option (the correct option to use), this directory is not included in the archive. Thus, the composite is not deployed upon restarting the SOA managed server.

To complete the installation, copy the contents of $DOMAIN_HOME/soa/autodeploy from the AdminServer computer to the corresponding location on the remote computer with the SOA managed server, and restart the SOA managed server. You may have to create the directory structure soa/autodeploy under $DOMAIN_HOME on the remote computer.














26.4.1.8.2 Install the Worklist Driver on IBM WebSphere Platform

To enable the messaging worklist feature, the WebSphere SOA cell must be extended using the extension template available at $ORACLE_HOME/common/templates/was/oracle.ums.driver.worklist_template_11.1.1.jar. 

To extend a SOA cell using the Oracle Fusion Middleware Configuration Wizard:

	
Set the environment variable CONFIG_JVM_ARGS with the value -DTemplateCatalog.enable.selectable.all=true. For example, in Linux bash shell: exportCONFIG_JVM_ARGS="-DTemplateCatalog.enable.selectable.all=true"

At the Windows command prompt: set CONFIG_JVM_ARGS=-DTemplateCatalog.enable.selectable.all=true


	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/was_config.sh or %ORACLE_HOME%\common\bin\was_config.cmd).


	
Click Select and Configure Existing Cell.


	
Select the desired SOA cell and click Next.


	
Select Oracle User Messaging Service Worklist Driver on the Add Products to Cell screen and click Next.


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard with default selections, and restart the SOA cell.









26.4.1.8.3 Common Properties

The common driver properties shown in Table 26-22 are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 26-22 Common Worklist Properties

	Name	Description	Mandatory?	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Worklist-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
WORKLIST


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
SupportedCarriers

	
No

	
N/A


	
SupportedProtocols

	
SupportedProtocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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26.4.1.8.4 Custom Properties

The custom property shown in Table 26-23 is available.


Table 26-23 Custom Worklist Property

	Name	Description	Mandatory	Default Value
	
BPELConnectionURL

	
The URL of the BPEL server to connect to. The format is 'http://<bpel-host>:<bpel-port>'. The default behavior, if this property is not set, is to use the local container's HTTP connection URL.

	
	











26.4.1.8.5 Client API MessageInfo Support

Table 26-24 shows if the protocol or driver implementation honor the following message delivery-related properties that are specified through the client API.


Table 26-24 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False














26.4.1.9 Configuring the Proxy Driver

The Proxy Driver acts as a Messaging Web Service client to a Fusion Middleware Messaging server hosted elsewhere in the intranet or Internet. It uses SOAP over HTTP (the Parlay X Multimedia Web Service protocol) to send messages and receive messages and return message delivery status. The ParlayX Web Service relays messages from one UMS instance to another. It can relay traffic from multiple instances in an Intranet to a terminating instance that has all of the protocol-specific drivers configured to an external gateway such as an SMSC, or to an SMTP or IMAP mail server.



26.4.1.9.1 Common Properties

Table 26-25 shows common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 26-25 Common Proxy Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Proxy-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
EMAIL, SMS, VOICE, IM, WORKLIST


	
SupportedContentTypes

	
Supported content types

	
Yes

	
*



	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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26.4.1.9.2 Proxy Custom Properties

The Proxy Driver includes the custom properties shown in Table 26-26.


Table 26-26 Custom Proxy Properties

	Name	Description	Mandatory	Default Values
	
GatewayURL

	
The URL to the hosted 11g UMS Web Service gateway. The URL is in the following format:


http://<host>:<port>/sdpmessaging/parlayx/SendMessageService

	
Yes

	
N/A


	
Username

	
Username of the messaging gateway.

	
No

	
N/A


	
Password

	
The password of the username

	
No

	
N/A


	
Policies

	
Comma-delimited list of Oracle Web Services Manager WS-Security policies to be attached to proxy driver requests

	
No

	
N/A










26.4.1.9.3 Client API MessageInfo Support

These properties are message delivery related which are specified through client API. Table 26-27 describes if the protocol or driver implementation honors such properties.


Table 26-27 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False






















26.5 Configuring User Messaging Service Access to the LDAP User Profile

As part of the LDAP provider setup in a SOA deployment, you configure the "User Name Attribute" through the WebLogic Server Administration Console. If you configure that attribute with a value other than the default "cn" or if the user's email address is stored in an LDAP attribute which is different from "mail", you must make an additional configuration change in Oracle Platform Security Services (OPSS) for UMS to successfully access the user profile to obtain the list of communication channels provisioned in LDAP, such as business email.

For more information about Oracle Platform Security Services (OPSS), see Oracle Fusion Middleware Application Security Guide.

To configure access to the LDAP user profile:

	
Modify the jps-config.xml file in the $DOMAIN_HOME/config/fmwconfig directory by adding a <property> element in the idstore.ldap serviceInstance section.

	
To use the value of the User Name Attribute while searching the back-end LDAP server for user profile, add the following element:


<property name=”username.attr” value=”username_attribute_value”/>


where username_attribute_value is the value of the User Name Attribute property in the LDAP provider configuration. For instance, if the value of the User Name Attribute is mail, add the following line:


<property name=”username.attr” value=”mail”/> 


The following sample code shows the above line inserted in the jps-config.xml file:


<!-- JPS WLS LDAP Identity Store Service Instance --> 
  
<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider"> 
 
  <property name="idstore.config.provider"
value="oracle.security.jps.wls.internal.idstore.WlsLdapIdStoreConfigProvide
r"/> 

  <property name="CONNECTION_POOL_CLASS" 
value="oracle.security.idm.providers.stdldap.JNDIPool"/> 
 
  <property name=”username.attr” value=”mail”/> 
 
</serviceInstance>
 


	
If the LDAP attribute containing the user's business email addresses is something other the mail attribute, add the following element:


<property name="PROPERTY_ATTRIBUTE_MAPPING" value="BUSINESS_EMAIL=attr_containing_email"/>


where attr_containing_email is the attribute name in the LDAP provider that contains the user's email address. For instance, if the user attribute containing the email address is externalEmail, add the following line:


<property name="PROPERTY_ATTRIBUTE_MAPPING" value="BUSINESS_EMAIL=externalEmail"/>  


The following sample code shows the above line inserted in the jps-config.xml file:


<!-- JPS WLS LDAP Identity Store Service Instance --> 
  
<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider">  
 
  <property name="idstore.config.provider"
value="oracle.security.jps.wls.internal.idstore.WlsLdapIdStoreConfigProvide
r"/>  

  <property name="CONNECTION_POOL_CLASS"
 value="oracle.security.idm.providers.stdldap.JNDIPool"/>  
 
  <property name="PROPERTY_ATTRIBUTE_MAPPING" value="BUSINESS_
EMAIL=externalEmail"/> 
 
</serviceInstance>
 







	
Note:

You may have other properties defined in the same section.










	
Restart your domain.









26.6 Securing the Oracle User Messaging Service

The User Messaging Preferences User Interface and the Parlay X Web Services can be secured at the transport-level using Secure Sockets Layer (SSL). By default, all deployed web services are unsecured. Web Service Security should be enabled for any services that are deployed in a production environment.

	
To enable SSL in the Oracle WebLogic Server, see "Configure SSL for Oracle WebLogic Server" in the Oracle Fusion Middleware Administrator's Guide. This step is sufficient to secure the User Messaging Preferences User Interface.


	
To secure the Parlay X Web Services, see "Configuring Transport-Level Security" in the Securing WebLogic Web Services.




UMS supports the use of Oracle Web Services Manager WS-Security policies to protect UMS web services. For more information about Oracle Web Services Manager, see "Using Oracle Web Service Security Policies", in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.

The recommended security configuration for web services uses Security Assertion Markup Language (SAML) tokens to pass identities between web service clients and UMS. With SAML tokens, instead of the web service client passing a username and password to UMS, a trust relationship is established between the client and UMS because of exchanging certificates. Once this keystore configuration is in place, the web service client passes only the user identity, and vouches for the fact that it has authenticated the user appropriately.

The recommended policies to use for UMS web services are:

	
oracle/wss11_saml_token_with_message_protection_service_policy (server-side)


	
oracle/wss11_saml_token_with_message_protection_client_policy (client-side)


	
oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy (client-side)




	
Note:

The choice of client-side policy depends on the security context in which your application is executing.

	
If the thread that is making the web service call has the intended Subject associated with it (for example, from a web application that performs user authentication, or a Java EE module with a run-as identity defined), then use the policy oracle/wss11_saml_token_with_message_protection_client_policy.

The current thread Subject is passed through using the SAML Policy WS-Security headers. In this case you should not specify the parameter javax.xml.ws.BindingProvider.USERNAME_PROPERTY when creating your web service client instance.


	
If the thread that is making the web service call has an undefined Subject associated with it, or if you must programmatically supply a different identity, then use the policy oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy, and specify the parameter javax.xml.ws.BindingProvider.USERNAME_PROPERTY when creating your web service client instance. If you want to perform dynamic identity switching, you must grant additional code permissions to your application. For more information, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

















26.6.1 Web Service Security on Notification

The different web services include corresponding notification web services (MessageNotification, PresenceNotification) that run on the client side and receive notifications (message delivery status, message receipt, presence status change) when the appropriate event occurs.

This implementation does not provide for the use of Web Service security (WS-Security) by default during notification of the clients. That is, the server assumes that the notification web services running on the client side do not use WS-Security, and makes no attempt to authenticate itself when sending notifications. If you enable WS-Security on the client side, the notification from the server fails because the notification SOAP request is missing the required headers.






26.6.2 Enabling UMS Service Security 

To enable a policy for a UMS web service, follow the steps in "Configuring Oracle WSM Security Policies in Administration Console" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server, selecting policy oracle/wss11_saml_token_with_message_protection_service_policy. This configuration must be repeated for each service you want to secure.






26.6.3 Enabling Client Security

Web service client security must be enabled programmatically. When using the client libraries described in Parlay X Messaging Client API and Client Proxy Packages (in Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite), WS-Security policy configuration is provided when a client object is constructed. The client constructors take an argument of type Map<String, Object>. In general when using SAML authentication, the key/value pairs (Table 26-28) should be added to the configuration map in addition to other required properties such as the endpoint address.


Table 26-28 Client Security Keys

	Key	Type	Typical Value
	

oracle.sdp.parlayx.ParlayXConstants.POLICIES

	
String[]

	

oracle/wss11_saml_token_
with_message_protection_
client_policy


	

javax.xml.ws.BindingProvider.USERNAME_PROPERTY

	
String

	

<valid username> 


	

oracle.wsm.security.util.SecurityConstants.Conf
ig.KEYSTORE_RECIPIENT_ALIAS_PROPERTY

	
String

	
(optional) keystore alias for target service. See Client Aliases.









Example 26-1 Web Service Client Security


import oracle.sdp.parlayx.multimedia_messaging.send.SendMessageClient
 
...
 
Map<String, Object> config = new HashMap<String, Object>();
config.put(javax.xml.ws.BindingProvider.ENDPOINT_ADDRESS_PROPERTY, ums_url);
config.put(oracle.sdp.parlayx.ParlayXConstants.POLICIES, new String[]
 {"oracle/wss11_saml_token_with_message_protection_client_policy"});
config.put(javax.xml.ws.BindingProvider.USERNAME_PROPERTY, "test.user1");
 
SendMessageClient sendClient = new SendMessageClient(config);








26.6.4 Keystore Configuration

To use the recommended WS-Security policy, you must configure a keystore containing the public and private key information required by OWSM. Refer to "Configuring the Credential Store Using WLST" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server for information on how to configure the keystore and corresponding credential store entries.

	
If both your web service client and UMS server are in the same domain, then they share a keystore and credential store.


	
If your web service client and UMS server are in different domains, then you must import the UMS public key into your client domain's keystore, and must import your client domain's public key into the UMS keystore.









26.6.5 Client Aliases

When using certain WS-Security policies such as the SAML policy recommended here, the client must use the server's public key to encrypt the web service request. However, there is generally only one keystore configured per domain. Therefore, if you have a domain in which there are web service clients that communicate with web services in multiple other domains, then you may be required to override the default keystore entry used by OWSM.

For example, if you have a domain in which application "A" is a web service client to a UMS web service, and application "B" is a web service client to a web service in another domain, then A's requests must be encrypted using the public key of the UMS domain, and B's requests must be encrypted using the public key of the other domain. You can accomplish this goal by overriding the keystore alias used by OWSM for each request:

	
Import (for example) the UMS public key with alias "ums_public_key", and the other public key with alias "other_public_key".


	
When creating an UMS web service client, specify the recipient keystore alias parameter, setting the key to oracle.wsm.security.util.SecurityConstants.Config.KEYSTORE_RECIPIENT_ALIAS_PROPERTY and the value to "ums_public_key" as shown in Example 26-2.


Example 26-2 Client Aliases


import oracle.sdp.parlayx.multimedia_messaging.send.SendMessageClient
 
...
 
Map<String, Object> config = new HashMap<String, Object>();
config.put(javax.xml.ws.BindingProvider.ENDPOINT_ADDRESS_PROPERTY, ums_url);
config.put(oracle.sdp.parlayx.ParlayXConstants.POLICIES, new String[]
{"oracle/wss11_saml_token_with_message_protection_client_policy"});
config.put(javax.xml.ws.BindingProvider.USERNAME_PROPERTY, "test.user1");
config.put(oracle.wsm.security.util.SecurityConstants.Config.KEYSTORE_RECIPIENT_
ALIAS_PROPERTY, "ums_public_key")
SendMessageClient sendClient = new SendMessageClient(config);




	
The other web service client similarly must override the keystore alias, but the exact mechanism may differ. For example if using a JAX-WS client stub directly, then you can add the override property to the JAX-WS request context. See "Policy Configuration Overrides for the Web Service Client" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server for more details.









26.6.6 Securing JMS Resources

This (optional) procedure enables administrators to restrict access to the Oracle User Messaging Service's JMS resources (such as queues) for enhanced security.




	
Note:

This section details steps to follow to secure JMS Resources. If you are starting with a new installation (11g Release 1 11.1.1.3) of Oracle User Messaging Service, then follow these steps.

If you are not upgrading to 11g Release 1 11.1.1.3, then these instructions are not to be used.

If you previously created a domain in an earlier release and are upgrading, but have not already done so, then complete the steps in the latest Release Notes before proceeding.









To secure the JMS system resources, lock all JMS sub-deployments that start with the name UMSJMSSystemResource (there may be multiple automatically-created resources for UMS in a multi-server or cluster deployment) with the role OracleSystemRole. Do this using the Oracle WebLogic Server Administration Console, or you may run a WLST script (available at $ORACLE_HOME/communications/bin/secure_jms_system_resource.py) as follows:


$ORACLE_HOME/common/bin/wlst.sh
$ORACLE_HOME/communications/bin/secure_jms_system_resource.py
--username=<admin_username> --password=<password>
--url=t3://<admin-host>:<admin-port> --jmsSystemResource
<UMSJMSSystemResource> --role OracleSystemRole


For example:


$ORACLE_HOME/common/bin/wlst.sh
$ORACLE_HOME/communications/bin/secure_jms_system_resource.py
--username=weblogic --password=<password> --url=t3://localhost:7001
--jmsSystemResource UMSJMSSystemResource --role OracleSystemRole


By default, the UMS system runs as the user OracleSystemUser for accessing JMS resources. If the user OracleSystemUser does not exist, or you secure the UMS JMS resources with any other role that some other user has been granted, you must override the default user identity used by the UMS system by specifying an alternate username for the following JVM system property when you start the container:


oracle.ums.system.user=<username>


For example, if the user is MySystemUser, you can pass the JVM system property on command line as: -Doracle.ums.system.user=MySystemUser








26.7 Troubleshooting Oracle User Messaging Service

To debug User Messaging Service, first check the server diagnostic logs. The logs may contain exception, error, or warning messages that provide details about incorrect behavior along with actions to remedy the problem. Table 26-29 describes additional methods for debugging common User Messaging Service problems.


Table 26-29 Troubleshooting UMS

	Symptom	Possible Causes	Solutions
	
Notifications are not being sent from BPEL or Human Workflow components in SOA.

	
Notification Mode is set to NONE in SOA Workflow Notification configuration.

	
Change the Notification Mode setting to EMAIL or ALL using Oracle Fusion Middleware Control.


	
Email notification is not being sent.

	
The Outgoing (SMTP) Mail Server settings in the UMS Email Driver are incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
OutgoingMailServer


	
OutgoingMailServerPort




Note: Validate the values by using them in any email client for connecting to the SMTP server.


	
	
The SMTP server requires authentication or a secure connection (TLS or SSL).

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
OutgoingUsername


	
OutgoingPassword


	
OutgoingMailServerSecurity





	
Notifications are not being sent because of error message: No matching drivers found for sender address = <address>

	
The UMS Driver for the appropriate channel is configured with a specific list of SenderAddresses, and the message sent by the application has set a non-matching Sender Address.

Note: UMS Server matches the outbound message's sender address, if set, against the available drivers' SenderAddresses to find a matching driver to use for delivering the message. If a driver has set one or more SenderAddresses, then the UMS Server only sends messages with the matching sender address to it.

	
	
Check the following settings in the appropriate UMS Driver using Oracle Fusion Middleware Control:

SenderAddresses

Note: The format for SenderAddresses is a comma-delimited list of <DeliveryType>:<Address>.

For example:

EMAIL:sender@example.com, EMAIL:sender@example2.com


	
Leave this property blank, if you want this driver to service outbound messages for all sender addresses for this channel (delivery type).


	
If there are multiple driver instances deployed for the same channel (delivery type) with different configurations, use the SenderAddresses to differentiate the driver instances. For example, one instance can be set with a value in SenderAddresses to only service outbound messages with that matching sender address, while the other instance can keep the SenderAddresses blank to service all outbound messages that do not specify any sender address or one that does not match that of the first driver instance.


	
SenderAddresses that are configured with the incorrect syntax (such as missing <DeliveryType>:) are ignored by the UMS Server for driver selection.





	
The email client inconsistently receives notifications.

	
The Incoming Mail Server settings in the UMS Email Driver are configured with the same email account to which notifications are being sent.

If the notification is sent to the same account, the UMS Email Driver may download and process the email before the email client can display it.

	
Use an exclusive email account for Incoming Mail Server settings. Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
IncomingMailIDs


	
IncomingUserIDs





	
SOA Human Workflow notifications are sent, but are not actionable.

	
The Actionable Email Address is not configured in SOA Workflow Notification Properties.

	
Set the Actionable Email Address in SOA Workflow Notification Properties with the address of the email account configured in the UMS Email Driver.


	
	
The Human Workflow task is not set to send actionable notifications.

	
Set the actionable attribute for the Human Workflow task in JDeveloper and redeploy the SOA composite application.


	
SOA Human Workflow actionable notifications are sent, but no action is taken after responding.

	
The Incoming Mail Server settings in the UMS Email Driver are incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
MailAccessProtocol (IMAP or POP3, in uppercase)


	
ReceiveFolder


	
IncomingMailServer


	
IncomingMailServerPort


	
IncomingMailServerSSL


	
IncomingMailServerSSL


	
IncomingUserIDs


	
IncomingUserPasswords


	
ImapAuthPlainDisable




Note: Validate the values by using them in any email client for connecting to an IMAP or POP3 server.


	
	
The mail access protocol is incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
MailAccessProtocol (IMAP or POP3, in uppercase)





	
	
The email server is SSL-enabled.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
IncomingMailServerSS





	
	
The receive folder name is incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
ReceiveFolder




Note: Some email servers may expect the value INBOX to be inbox or Inbox (that is, case-sensitive). Based on your email server, use an appropriate value.


	
	
A nondefault email client is configured for receiving notifications. When the user clicks the approval link, the default mail client page opens, which may send emails to a different email server.

	
Configure the default email client to receive actionable notifications.


	
SOA BPEL User Notification or Human Workflow notifications are sent to the correct delivery type (email, sms, and so on) but to the wrong address.

	
A self-provisioned messaging channel was created by the user in User Messaging Preferences for use in BPEL User Notification or Human Workflow use cases.

Note: The User Messaging Preferences UI allows the end user to create his or her own messaging channel for various use cases, but these are not to be used for BPEL User Notification and Human Workflow.

	
Do not use a self-provisioned messaging channel for BPEL User Notification or Human Workflow use cases (that is, do not set as Default channel, and do not use in a messaging filter for such use cases). BPEL User Notification and Human Workflow use User Messaging Preferences only for the delivery type preference, and the actual address is retrieved from the user profile in the identity management system.

Note: Addresses from the user profile in the identity management system are available through User Messaging Preferences using predefined channel names, such as Business Email, Business Mobile, Business Phone, Instant Messaging. Use these predefined messaging channels instead for BPEL User Notification and Human Workflow use cases.















8  Managing SOA Composite Application Instances

This chapter describes how to manage SOA composite application instances, including initiating a test instance of an application, monitoring and deleting instances, recovering from faults, and deleting rejected messages.

This chapter includes the following topics:

	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Section 8.2, "Monitoring and Deleting SOA Composite Application Instances from the Application Home Page"


	
Section 8.3, "Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level"


	
Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level"


	
Section 8.5, "Recovering from SOA Composite Application Faults in the Application Home Page"


	
Section 8.6, "Deleting Rejected Messages at the SOA Infrastructure Level"


	
Section 8.7, "Deleting Rejected Messages from the Application Home Page"







	
Note:

The procedures in this guide describe how to access Oracle Enterprise Manager Fusion Middleware Control pages from the SOA Infrastructure menu, soa-infra icon in the navigator, SOA Composite menu, and SOA Partition menu. You can also access many pages from the Farm home page. For more information, see Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page."











8.1 Initiating a SOA Composite Application Test Instance

This section describes how to initiate a test instance of a deployed SOA composite application.

To initiate a SOA composite application test instance:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the Composite Menu...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.


	
At the top of the page, click Test.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
At the top of the page, click Test.




	
	
Select Test Service > client.














	
Note:

The Test button is disabled in the following situations:

	
The SOA composite application revision is stopped or retired.


	
There are no web services available for the application. Only composites having services with web service bindings can be tested from this page.













	
If the composite includes multiple services, the Test button has a drop-down list to select the service to test.

The Test Web Service page for initiating an instance appears.

This page provides many options for initiating an instance. At a minimum, you must specify the XML payload data to use in the Input Arguments section.

The WSDL file and endpoint URL are populated automatically based on the service you selected to test. The endpoint URL is derived from the WSDL and can be overridden to invoke that service at a different location. If the service selected has multiple ports, a drop-down list is displayed. Otherwise, the port of the current service is displayed.

[image: Description of sca_test_payload.gif follows]
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Accept the default values for these fields or provide values appropriate to your test environment.


	
If you change the WSDL file, click Parse WSDL to reload the WSDL file.

If the WSDL URL does not contain the revision number, it is processed by the default composite application. For example, if there are two revisions of a composite application named HelloWorld, then the following endpoints are exposed by them:

	
http://host:port/soa-infra/services/default/HelloWorld!1.0/client


	
http://host:port/soa-infra/services/default/HelloWorld!2.0/client




However, if the WSDL specified for web service invocation does not contain the revision details (for example, http://host:port/soa-infra/services/default/HelloWorld/client), it is processed by the composite revision that is set as default.


	
Select the operation that you want to test from the Operation menu. The available operations are determined from the WSDL.

To test a RESTful web service, select the GET or POST service port operation. 


	
If you want to edit the endpoint URL, click Edit Endpoint URL and make appropriate changes.

The lower part of the Test Web Service page consists of the Request tab. This tab enables you to specify security, quality of service, HTTP transport, stress testing options, and XML input arguments:

[image: Description of sca_test_payload2.gif follows]
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The Security section includes the following fields for passing security properties with messages.:


	Field	Description
	
WSS Username Token

	
Inserts a WS-Security SOAP header. The Username field is required, and the Password field is optional.


	
HTTP Basic Auth

	
Inserts the username and password credentials in the HTTP transport header. Both the Username and Password fields are required.


	
Custom Policy

	
Uses a custom policy to authenticate the user (specifies the URI for the custom policy). The Username and Password fields are optional.


	
None

	
Select to not specify security credentials. This is the default selection.








When testing RESTful Web services, because the SOAP protocol is not used, the only security options are HTTP Basic Authentication or None.


	
Accept the default values for these fields or provide values appropriate to your test environment.

The Quality of Service section includes the following fields. Oracle Fusion Middleware uses a policy-based model to manage web services. A policy applies behavior requirements to the delivery of messages. This section is not available when testing RESTful web services. For additional details about using the Test Web Service page, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	Field	Description
	
WS-RM

	
Select one of the following options for testing WS-Reliable Messaging (RM) protocol policies. Reliable messaging policies support this protocol, which guarantees the end-to-end delivery of messages.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-RM policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-RM policy, then reliable messaging is not tested.


	
None: No policy for WS-RM is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-RM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	
MTOM

	
Select one of the following options for testing Message Transmission Optimization Mechanism (MTOM) policies. MTOM policies ensure that attachments are in MTOM format, a format for efficiently sending binary data to and from web services.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to an MTOM policy, then the policy is enforced. If the WSDL does not contain a reference to an MTOM policy, then MTOM is not tested.


	
None: No policy for MTOM is tested, even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If an MTOM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	
WS-Addressing

	
Select one of the following options for testing WS-Addressing policies. WS-Addressing policies verify that SOAP messages include WS-Addressing headers in conformance with the WS-Addressing specification.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-Addressing policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-Addressing policy, then WS-Addressing is not tested.


	
None: No policy for WS-Addressing is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-Addressing policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.











	
Accept the default values for these fields or provide values appropriate to your test environment.

The HTTP Transport Options section includes the following fields:


	Field	Description
	
Enable SOAP Action

	
Specifies whether the WSDL soap:operation has a soapAction attribute. This flag is enabled if a soapAction attribute exists. If you do not want to send a request with the SOAP action HTTP header, then clear the checkbox.


	
SOAP Action

	
Displays the soapAction attribute of the WSDL soap:operation, if one exists. You may specify a different SOAP action in this text box.








This section is not available when testing RESTful web services.


	
Accept the default values for these fields or provide values appropriate to your test environment.

The Additional Test Options section includes the following fields. This section provides a simple stress test that simultaneously invokes multiple instances.




	
Note:

This is not a real stress test tool. Therefore, do not enter huge values for both concurrent threads and the number of times to invoke the operation. Doing so can result in errors. 










	Field	Description
	
Enable Stress Test

	
Click Enable to create a simple stress test. With this enabled, no conversation ID is displayed.


	
Concurrent Threads

	
Enter the number of concurrent threads on which to send the invocations. The default is 5 threads.


	
Loops per Thread

	
Enter the number of times to invoke the operation. The default is 10 times.


	
Delay in Milliseconds

	
Specify the delay of milliseconds to wait between operation invocations. The default is 1000 milliseconds (1 second).








	
Accept the default values for these fields or provide values appropriate to your test environment.

The Input Arguments section includes the following fields for entering XML payload data.


	Field	Description
	
Tree View

	
Displays a graphical interface of text fields in which to enter information. This field automatically generates the required headers and XML structure.


	
XML View

	
Displays the XML file format for inserting values. You can paste the raw XML payload of your message into this field.











	
Note:

If you are using Oracle Enterprise Manager Grid Control, you can save the payload you enter. This feature is not available with Oracle Enterprise Manager Fusion Middleware Control.










	
Click Test Web Service.

The test results appear in the Response tab upon completion.

[image: Description of soaapp_testresult.gif follows]
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Note:

The Response tab does not display payload data if you are performing a stress test or are testing an asynchronous service.










	
Click Launch Message Flow Trace to access the flow trace of the instance.


	
To return to the composite home page, click the name of the composite that appears at the top of the page or select Home from the composite target menu.


	
Return to the Dashboard page of the SOA composite application.

The Recent Instances table lists recent SOA composite application instances. Each created instance has its own unique ID.




For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances" for conceptual details about instances


	
Section 1.4.3.2, "Introduction to Policies" for an overview of policies


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for specific details about policies and testing web services from the Test Web Service page






8.1.1 Specifying RPC/Literal-Style WSDL Files on the Test Web Service Page

If you are specifying an RPC/literal-style WSDL file with a message defined by "element=" in the Test Web Service page in Oracle Enterprise Manager Fusion Middleware Control, use the XML View option of the Input Arguments section to modify the SOAP message. The SOAP body should look as follows:


<soap:Body>
    <ns:initiate>
        <payload>
          <value xmlns="...">3</value>
        </payload>
    </ns:initiate>
</soap:Body> 


where initiate is the operation name, payload is the part name, and value is the element defined in the WSDL message/part.








8.2 Monitoring and Deleting SOA Composite Application Instances from the Application Home Page

Section 7.4, "Managing the State of Deployed SOA Composite Applications" describes how to manage the lifecycle state of SOA composite applications. You can also monitor and delete specific SOA composite application instances from the Instances page of the application home page. 

To monitor and delete SOA composite application instances from the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
SOA composite application instance ID, name, conversation ID, most recent known state of each instance since the last data refresh of the page (for example, completed successfully, running, unknown, and so on), instance start time, and a log file describing any faults. A unique instance ID is created whenever a new instance of a SOA composite application is initiated either automatically by an external consumer of the application, or manually by an administrator from the Test Web Service page.

If a ? icon is displayed, the Capture Composite Instance State checkbox was not enabled on the SOA Infrastructure Common Properties dialog. Therefore, the instance state was not evaluated. Determining the composite instance state requires evaluating the states of the underlying component, Therefore, this can be disabled to improve performance.




[image: Description of soaapp_instance.gif follows]
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Note:

It is possible to generate orphaned service component instances. These instances are generated without any associated composite application instances. The orphaned component instances are generated under the following circumstances:

	
The SOA Infrastructure audit level is set to Off or the composite audit level is set to Off. Even in such cases, the BPEL process service engine can generate instance data for the service components that are included in the SOA composite application.


	
The SOA Infrastructure audit level is set to Off. However, the BPEL process or Oracle Mediator service engine audit level is set to a value other than Off.


	
All the audit levels are set to Off, but some faults are generated in one of the service engines. In these cases, the component instance gets generated.




To delete orphaned instances or large numbers of instances, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts." Selecting the Delete All Instance options in the Delete with Options dialog does not delete orphaned component instances.









If composite sensors are included in your SOA composite application, the Instances tab has the following differences:

	
The Add Fields button appears next to Search and Reset in the search utility. This button enables you to add sensor values to your search criteria.


	
A Composite Sensors column appears in the Instances table. Click the sensor icon in that column to display the details about sensor values available in a given instance of the composite.





	
From the Add Fields list, select composite sensors to add to the search criteria. In this example, four have been selected (CustomerDetails, NameSensor, Datesensor, and Yearsensor).


	
Input specific values by which each sensor searches. Only the composite instances in which the sensor values match your specified criteria are returned.

[image: Description of soaapp_instance2.gif follows]
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The Composite Sensors column indicates that this SOA composite application includes composite sensors.

[image: Description of soaapp_instance3.gif follows]
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Click Reset to remove all composite sensor fields from the search criteria or click the Remove icon to the right of the field to remove an individual sensor.


	
Select a specific instance to delete by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	
Filter By

	
Specify criteria for displaying composite instance states:

	
Execution State

Filter the display of instances by execution state (running, completed, terminated, or stale).


	
Fault State

Filter the display of instances by fault state (with or without faults). You can further customize the faulted state by selecting to display faults requiring recovery or nonrecoverable faults. It you select Stale from the Execute State list, the Fault State list is disabled.


	
BPEL Recovery

Filter the display of instances by whether a recovery action is required. By default, this filter excludes all messages and instances created in the last five minutes, and displays the rest. You can control the number of minutes with the excludeBpelMaxCreationTime key of the AuditConfig property in the System MBean Browser. This property is available in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."





	
Delete Selected

	
Deletes the selected instance.

After deleting an instance, instance details are no longer available for review.


	
Delete With Options

	
Prompts you to first specify criteria for deleting the selected instance directly from the database. 

Use this option to delete running, rolled back instances. However, this option does not delete the associated invoke messages that are awaiting recovery. As a result, there are orphaned messages pending in BPEL message recovery. To delete these messages, go to the Recovery page of the BPEL process service engine.

	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances Of This Composite: Select to delete all instances of the composite. This option deletes the rejected messages associated and all component, service, and reference instances associated with the composite, including those not associated with any composite instance ID.

Note: If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any selections you may have made in the Instances page (such as specifying and executing a search criteria) are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."


	
Abort

	
Terminates the selected instance. However, instance details are still available for review. 








	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instances table, perform the following additional tasks:

	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If an instance ID is listed as unavailable, you can click the Unavailable link for details.


	
In the State column, if an instance state is marked as Unknown, click it to display more details.


	
If the Composite Sensors column is available, click a sensor icon to display details about composite sensors included in the instance, such as name, location, and value.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







	
Note:

Multiple revisions of a SOA composite application that includes inbound JCA adapters are displayed as running. However, only the most recent revision (the default version) is considered active. All previous revisions are not considered active. This is because for inbound JCA adapters, there can only be one active revision of a SOA composite application at any time. The JCA adapter endpoints in all previous revisions are de-activated.












For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances"


	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files






8.2.1 Mismatch Between the Number of SOA Composite Application Instances and Service Component Instances

The number of SOA composite application instances may not always match the number of service component instances displayed in Oracle Enterprise Manager Fusion Middleware Control.

A SOA composite application instance is first created when the composite is invoked. When the service components within the composite receive a subsequent invocation, a corresponding service component instance is created that refers to the composite instance ID previously created.

There can be scenarios under which the composite instance is created, but the underlining service component instance is not created. For example:

	
The composite instance is created, but the invocation has not yet reached the service component due to a system failure.


	
The composite instance is created, but the invocation fails payload validation and is rejected. In this case, invocation does not reach the underlining service components.




You can also have orphaned service component instances for which no SOA composite application instance has been created.






8.2.2 Instance States of Service Components and SOA Composite Applications

Assume you have a SOA composite application with multiple service components (for example, two BPEL process service components). If these service components are marked with the following instance states:

	
Instance state of one BPEL process is marked as completed.


	
Instance state of the other BPEL process is marked as faulted.




This results in the overall composite instance state being marked as faulted. This behavior differs from 11g Release 1 (11.1.1.2), in which the same scenario resulted in the overall composite instance state being marked as completed.

Assume you have a parent SOA composite application that calls a child SOA composite application, and a fault occurs in the child composite (and is handled by the parent composite). This results in the following instance states:

	
The instance state of the child composite is marked as faulted.


	
The instance state of the parent composite is marked as completed.











8.3 Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level

Section 7.4, "Managing the State of Deployed SOA Composite Applications" described how to manage the lifecycle state of all instances of a specific SOA composite application. You can also monitor and delete any number of instances across all deployed SOA composite applications by using the Instances page of the SOA Infrastructure home page. This page lists all SOA composite application instances deployed to the SOA Infrastructure.

To monitor and delete SOA composite application instances at the SOA infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA infrastructure.











	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
All SOA composite application instances in the SOA Infrastructure, including instance and conversation IDs, composite name and revision, SOA composite application instance state, and instance start time. 
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You can also terminate and delete instances from this page.


	
Select a specific instance by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	
Filter By

	
Specify criteria for displaying composite instance states:

	
Execution State

Filter the display of instances by execution state (running, completed, terminated, or stale).


	
Fault State

Filter the display of instances by fault state (with or without faults). You can further customize the faulted states by selecting to display faults requiring recovery or nonrecoverable faults. It you select Stale from the Execute State list, the Fault State list is disabled.


	
BPEL Recovery

Filter the display of instances by whether a recovery action is required. By default, this filter excludes all messages and instances created in the last five minutes, and displays the rest. You can control the number of minutes with the excludeBpelMaxCreationTime key of the AuditConfig property in the System MBean Browser. This property is available in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."





	
Delete Selected

	
Deletes the selected instance. 


	
Delete With Options

	
Prompts you to first specify criteria for deleting the selected instance directly from the database.

Use this option to delete running, rolled back instances. However, this option does not delete the associated invoke messages that are awaiting recovery. As a result, there are orphaned messages pending in BPEL message recovery. To delete these messages, go to the Recovery page of the BPEL process service engine.

	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any instance state selections you made at the top of the Instances page are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."

Notes:

	
If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page.


	
This option does not purge BPEL process service engine recoverable invoke and callback messages. To completely purge those messages, use the purge scripts described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."





	
Abort

	
Terminates the selected instance. However, instance details are still available for review.

Note: If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page. In addition, if a terminated instance (shown as aborted) had a fault, it is not added to the fault count.








	
In the instances table, perform the following tasks:

	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If the instance ID is unavailable, the message flow cannot be accessed. However, you can still click the link for details.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Instance State column, click the Recovery icon to access the Faults and Rejected Messages page with faults filtered based on the composite instance ID. There can be multiple faults for a composite instance ID.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.












8.4 Recovering from SOA Composite Application Faults at the SOA Infrastructure Level

You can monitor and perform individual and bulk fault recoveries for BPEL process and Oracle Mediator service components across any number of SOA composite applications. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Examples of performing both individual and bulk recovery are provided in this section. Human task service component or human workflow service engine faults are recovered from Oracle BPM Worklist.

You can also perform a manual recovery of undelivered BPEL process invoke or callback messages. For more information, see Section 14.4, "Performing BPEL Process Service Engine Message Recovery."

To recover from SOA composite application faults at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.
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Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.









Faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. Fault recovery selection at the SOA Infrastructure level matches the SOA composite application level and BPEL process and Oracle Mediator service component levels.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery:

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 4.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery:

	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.











	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.

	
BPEL process and Oracle Mediator


	
Abort

	
Terminates the entire instance.

	
BPEL process and Oracle Mediator


	
Replay

	
Replays the entire scope again in which the fault occurred.

	
BPEL process


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.

	
BPEL process


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).

	
BPEL process











	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
If you want to delete rejected messages for all composites in the SOA Infrastructure, see Section 8.6, "Deleting Rejected Messages at the SOA Infrastructure Level."


	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of all composites directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.
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Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA Infrastructure level, a check of the state of composites cannot be performed. If the state of a composite is set to off, a recovery of its faults cannot be performed. However, no error or warning message is displayed. Upon submission of the bulk fault recovery request, the server checks if the originating composite's state is set to off. That fact is then noted in the log, and the fault is skipped.

You are also not notified when a fault has been skipped during recovery for any other reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, service component, or reference.


	
In the Composite Instance ID column, click a specific ID to access the flow trace of the instance.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.





	
See the following sections for examples of single and bulk fault recovery with BPEL processes and Oracle Mediator.

	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.4.2, "Examples of Fault Recovery for BPMN Processes"


	
Section 8.4.3, "Examples of Fault Recovery for Oracle Mediator"







For more information about concepts and instructions on designing a fault policy, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section "Using the Fault Management Framework" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






8.4.1 Examples of Fault Recovery for BPEL Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPEL process fault and perform single and bulk fault recovery on a BPEL process service component.

	
Section 8.4.1.1, "Example: Single Fault Recovery for BPEL Processes"


	
Section 8.4.1.2, "Example: Bulk Fault Recovery for BPEL Processes"




In this example, you define a fault policy by specifying that a fault can be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPEL process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPEL instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite application.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpel/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPEL process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For information about BPEL process message recovery, see Section 14.4, "Performing BPEL Process Service Engine Message Recovery."



8.4.1.1 Example: Single Fault Recovery for BPEL Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPEL processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPEL process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
Select None from the Chain Action Upon Successful Retry list. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Select a variable from the Variable list. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
Enter the correct value in the Value field. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, and then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.4.1.2 Example: Bulk Fault Recovery for BPEL Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery, because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry attempts the invocation to the credit rating service through the composite reference again.

To perform bulk fault recovery for BPEL processes:

	
Perform Step 1 and Step 2 of Section 8.4.1.1, "Example: Single Fault Recovery for BPEL Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPEL process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.4.2 Examples of Fault Recovery for BPMN Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPMN process fault and perform single and bulk fault recovery on a BPMN process service component.




	
Note:

When a multi-instance process has met the conditions for its completion, it raises a nonrecoverable system fault (to cancel remaining instances). Although this fault appears in the Oracle Enterprise Manager Fusion Middleware Control, you do not need to take any action. It appears simply to notify you that the multi-instance process was finalized because the condition was completed.









	
Section 8.4.2.1, "Example: Single Fault Recovery for BPMN Processes"


	
Section 8.4.2.2, "Example: Bulk Fault Recovery for BPMN Processes"




In this example, you define a fault policy specifying that a fault be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPMN process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPMN instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpmn/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPMN process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



8.4.2.1 Example: Single Fault Recovery for BPMN Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPMN processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPMN process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
From the Chain Action Upon Successful Retry list, select None. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
From the Variable list, select a variable. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
In the Value field, enter the correct value. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.4.2.2 Example: Bulk Fault Recovery for BPMN Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry re-attempts the invocation to the credit rating service through the composite reference.

To perform bulk fault recovery for BPMN processes:

	
Perform Steps 1 through 2 of Section 8.4.2.1, "Example: Single Fault Recovery for BPMN Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPMN process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.4.3 Examples of Fault Recovery for Oracle Mediator

This section provides an example of how to perform single and bulk fault recovery on an Oracle Mediator service component.

	
Section 8.4.3.1, "Example: Single Fault Recovery for Oracle Mediator"


	
Section 8.4.3.2, "Example: Bulk Fault Recovery for Oracle Mediator"




In this example, a service binding component for an inbound Siebel adapter submits a payload message to Oracle Mediator for transformation. The processed payload message is then delivered to a reference binding component for an outbound file adapter. However, the outbound directory into which to write the payload message is not configured with write permissions. This causes a fault to occur. The fault policy defined during design time specifies that the fault be manually recovered through human intervention. Three retries are attempted, as defined with the retryCount attribute. The condition and action are defined as follows in the fault-policies.xml file.

Recoverable Oracle Mediator faults do not require a fault policy (though it is one way to make faults recoverable, as described through an ora-human-intervention action). Any parallel routing rule that receives a remote fault from the outbound endpoint also creates a recoverable fault (in this specific example, the fault policy is not required if the Oracle Mediator uses a parallel routing rule to invoke the outbound file adapter).


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="ConnectionFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
              <Conditions>
                <faultName xmlns:medns="http://schemas.oracle.com/mediator/faults"
                name="medns:mediatorFault">
                   <condition>
                      <test>contains($fault.mediatorErrorCode, "TYPE_FATAL_
                         MESH")</test>
                      <action ref="ora-retry"/>
                   </condition>
                </faultName>
              </Conditions>
. . .
. . .      <Action id="ora-retry">
        <retry>
          <retryCount>3</retryCount>
          <retryInterval>5</retryInterval>
          <retryFailureAction ref="ora-human-intervention"/>
          <retrySuccessAction ref="ora-terminate"/>
        </retry>
      </Action>
   </Actions>
</faultPolicy>
</faultPolicies>


Processing is set to retry 3 times before terminating.

The fault policies are associated with the ConnectionFaults composite application in the fault-bindings.xml file:


<faultPolicyBindings version="2.0.1" xmlns="http://schemas.oracle.com/bpel/fault
policy" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
        <composite faultPolicy="ConnectionFaults"/>
</faultPolicyBindings>




8.4.3.1 Example: Single Fault Recovery for Oracle Mediator

For this example, the sap output directory is made read-only. An inbound file adapter retrieves the sender.xml file from the siebel directory and the message is routed through Oracle Mediator to an outbound file adapter reference for placing a file in the sap directory.

To perform single fault recovery for Oracle Mediator:

	
Change the directory permissions at the operating system command prompt.


chmod 000 sap
cp sender.xml siebel/


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.

Three faults appear, based on three retries being attempted. In this case, you see three retries only because the fault policy on the Oracle Mediator interaction with the outbound file adapter defines three retries. Without the fault policy, there is only one fault (no automated retries).


	
Click the specific instance ID in the Composite Instance ID column.

The Flow Trace appears. The faults table at the top of the page displays the fault messages. If you want to see where the faulted Oracle Mediator instance is located in the overall message flow, select the fault in the faults table. This highlights the associated instance in the trace table. You can then click the instance to access its audit trail to see more details about the faulted flow.




	
Note:

Steps 4 through 10 represent one way to recover this single fault. The fault can also be recovered directly from the Oracle Mediator faults page through the Recovery Action list.










	
Locate the Oracle Mediator component instance fault you want to recover in the Faults table and click Recover in the Recovery column.


	
Select Sender from the Payload Part list.

The payload is automatically displayed in the Payload field. If necessary, payload modifications can be performed in this field. For this example, payload modification is not necessary.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Return to the Faults tab and click the Refresh icon in the upper right corner of the page.


	
Click Retry.


	
Click Yes when prompted to resubmit the selected fault for recovery.

The page refreshes to indicate that no faults occurred.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was written to the sap directory.
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8.4.3.2 Example: Bulk Fault Recovery for Oracle Mediator

Assume the sap directory to which to write the sender.xml payload message is again configured with read-only permissions at the operating system command prompt. Three copies of the sender.xml file are placed in the siebel directory of the service binding component for the inbound Siebel adapter. This creates three instances.


chmod 000 sap
cp sender.xml siebel/
cp sender.xml siebel/
cp sender.xml siebel/


To perform bulk fault recovery for Oracle Mediator:

	
Change the sap directory to be writable.


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Select all the faults to be recovered.


	
Select Retry from the Recovery Action list.


	
Select Yes when prompted to perform fault recovery.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was successfully written to the sap directory.













8.5 Recovering from SOA Composite Application Faults in the Application Home Page

You can monitor and perform individual and bulk fault recoveries in a SOA composite application. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Human workflow faults can also be recovered, but not directly from Oracle Enterprise Manager Fusion Middleware Control. Instead, the audit trail provides a link to the Oracle BPM Worklist, from which the fault can be addressed.

To recover from SOA composite application faults in the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for the selected SOA composite application:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages in SOA composite application instances, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the fault location, the composite instance ID, and links to log files that describe the fault.




[image: Description of sca_soaapp_search.gif follows]
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Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.









Faults identified as recoverable can be recovered.


	
Select faults for recovery. As with fault recovery at the SOA Infrastructure level and BPEL process and Oracle Mediator service component levels, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 3 of Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level" for instructions on selecting faults to perform these types of recovery.


	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.

	
BPEL process and Oracle Mediator


	
Abort

	
Terminates the entire instance.

	
BPEL process and Oracle Mediator


	
Replay

	
Replays the entire scope again in which the fault occurred.

	
BPEL process


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.

	
BPEL process


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).

	
BPEL process











	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
If you want to delete rejected messages for the current SOA composite application, see Section 8.7, "Deleting Rejected Messages from the Application Home Page."


	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of the current composite directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.

[image: Description of soaapp_recovwithopts.gif follows]
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Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA composite application level, a check of the state of the composite is performed. If the state of the composite is set to off, a message is displayed warning you that a recovery cannot be performed.

You are not notified when a fault has been skipped during recovery for any reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional monitoring tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, component, or reference.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.4.3, "Examples of Fault Recovery for Oracle Mediator"









8.6 Deleting Rejected Messages at the SOA Infrastructure Level

You can delete rejected messages for all composites in the SOA Infrastructure directly from the database by specifying a criteria in the Delete: Rejected Messages dialog.

To delete rejected messages for all composites at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.




[image: Description of sca_faultandmanage.gif follows]
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Click Delete Rejected Messages.




	
Note:

Oracle recommends that you run the purge scripts to delete composite instances in production environments. The purge scripts have better performance and scalability. Only use the Delete Rejected Messages option to manage exceptions not covered by the purge scripts. For more information about the purge scripts, see Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."









This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of all the composites directly from the database.

[image: Description of bp_delrejmess.gif follows]
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Specify criteria and click Delete.




For information about recovering from faults at the SOA Infrastructure level, see Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level."






8.7 Deleting Rejected Messages from the Application Home Page

You can delete rejected messages for the current SOA composite application directly from the database by specifying a criteria in the Delete: Rejected Messages dialog.

To delete rejected messages for the current SOA composite application:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.
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Click Delete Rejected Messages.




	
Note:

Oracle recommends that you run the purge scripts to delete composite instances in production environments. The purge scripts have better performance and scalability. Only use the Delete Rejected Messages option to manage exceptions not covered by the purge scripts. For more information about the purge scripts, see Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."









This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of the current composite directly from the database.

[image: Description of bp_delrejmess.gif follows]
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Specify criteria and click Delete.




For information about recovering from faults in the SOA composite application home page, see Section 8.5, "Recovering from SOA Composite Application Faults in the Application Home Page."









21 Monitoring Human Workflow Service Components and Engines

This chapter describes how to monitor human task service components and the human workflow service engine, including monitoring workflow service component and service engine instances and faults, viewing task status, monitoring active requests and operation statistics, and monitoring deployed human workflows.

This chapter includes the following topics:

	
Section 21.1, "Monitoring Recent Human Task Service Component Instances and Faults"


	
Section 21.2, "Viewing the Status of Human Workflow Tasks"


	
Section 21.3, "Monitoring Human Task Service Component Instances"


	
Section 21.4, "Monitoring Human Workflow Service Engine Recent Instances and Faults"


	
Section 21.5, "Monitoring Human Workflow Service Engine Active Requests and Operation Statistics"


	
Section 21.6, "Monitoring Human Workflow Service Engine Instances"


	
Section 21.7, "Monitoring Deployed Human Workflows in the Service Engine"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






21.1 Monitoring Recent Human Task Service Component Instances and Faults

You can monitor recent instances and faults for human task service components. Each service component in a SOA composite application has its own instance ID. These IDs are different from the overall instance ID of the SOA composite application of which each service component is a part.

To monitor human task service component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
Select the human task service component in the Component Metrics table.

The upper part of the Dashboard page displays the following details:

	
Recent instances of the human task service component, including the instance ID of the service component, the state of the instance (for example, completed or running), the instance start time, the last modification time, and links to log files describing the instances.


	
Recent faults in the human task service component, including the error message, whether the fault is recoverable, the time at which the fault occurred, the instance ID of the human task service component, and links to log files describing the faults.




[image: Description of hwf_comp_dash_upper.gif follows]
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In the Recent Instances section, perform the following tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Instances page of the service component.





	
In the Recent Faults section, perform the following tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
In the Recovery column, click a fault identified as Recoverable to perform fault recovery at the component instance level.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Faults page of the service component.




The lower part of the Dashboard page displays the following details:

	
A graphical representation of business outcomes.


	
Assignees that take the longest time to respond to and act upon tasks.


	
The number of successful, faulted, and instantiated instances processed per minute. Click Table View to display throughput details for the last five minutes, including the throughput for successful instances, the total faults throughput, and the instance throughput.


	
The notification channels used for task approval in the human task service component.




[image: Description of hwf_comp_dash_lower.gif follows]
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For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






21.2 Viewing the Status of Human Workflow Tasks

You can monitor the current status of human workflow tasks being acted upon by participants.

To view the status of human workflow tasks:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
Select the human task service component in the Component Metrics table.

The Dashboard page appears.
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In the Instance ID column, click an instance ID of a service component to monitor the current status of a task on which approval actions are being taken.

The Task Details page displays the following details:

	
Task details about the selected service component instance ID (task number), including the current state (for example, assigned), task outcome (if completed), task priority, creation date, updated date, expiration date, and task assignee.


	
A flow of the current status of a task (for example, assigned or approved).




[image: Description of hwf_mon_taskdetails.gif follows]
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As the task is acted upon by participants, the flow is updated.

[image: Description of hwf_mon_taskdetails2.gif follows]
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In the upper right-hand corner of the page, click Worklist Application to access the login page for Oracle BPM Worklist.




For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






21.3 Monitoring Human Task Service Component Instances

You can monitor human task service component instances. Each service component has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this service component is a part.




	
Note:

Human workflow invocations from the BPEL service engine use different transactions than BPEL processes. Therefore, if a BPEL transaction is rolled back for any reason, the workflow task instances are still created.









To monitor human task service component instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
Select the human task service component in the Component Metrics table.


	
Click Instances.

The Instances page displays the following details:

	
A utility for searching for a specific human task service component instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the state of the instance (for example, completed successfully or faulted), the instance start time, the last modification time, and links to log files describing the instance.




[image: Description of hwf_comp_instances.gif follows]
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In the Instance ID column, click a specific ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.




For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






21.4 Monitoring Human Workflow Service Engine Recent Instances and Faults

You can monitor instances and faults of all human task service component instances running in the human workflow service engine. These human task service components can be part of separate SOA composite applications.

To monitor human workflow service engine instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Human Workflow.




	
	
Right-click soa-infra.


	
Select Service Engines > Human Workflow.











	
Click Dashboard.

The upper part of the Dashboard page displays the following details:

	
Recent instances of all human task service components running in the human workflow service engine, including the instance ID of the service component, the service component, the SOA composite application of which the service component is a part, the state of the instance (for example, completed, running, or faulted), the instance start time, and the last modification time.


	
Service components, including the service component name, SOA composite application, state of the service component, and total, running, and faulted instances.
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In the Recent Instances section, perform the following tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Component column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Instances page of the service engine.





	
In the Components section, perform the following tasks:

	
In the Name column, click a specific service component to access its home page.


	
In the Composite columns, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Deployed Components page of the service engine.




The lower part of the Dashboard page displays the following details:

	
Recent faults, including the error message, the time at which the fault occurred, the SOA composite application, the service component, and the service component instance ID.


	
Task assignees who take the longest time to act upon a task and who have the highest backlog of pending tasks to which to respond.
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In the Recent Faults section, perform the following additional tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery. Clicking this link invokes the human workflow audit trail page for the instance. The audit trail page has a link to Oracle BPM Worklist called Go to Worklist Application, where you can go to recover from the fault. This link does not take you directly to the fault; you must manually locate the fault.


	
In the Recovery column, click a fault identified as Recoverable to perform fault recovery at the component instance level.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Faults page of the service engine.












21.5 Monitoring Human Workflow Service Engine Active Requests and Operation Statistics

You can view details about active requests in the human workflow service engine and operational statistics. such as service used, operations performed, and active and completed requests.

To monitor human workflow service engine active requests and operation statistics:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Human Workflow.




	
	
Right-click soa-infra.


	
Select Service Engines > Human Workflow.











	
Click Statistics.

The Statistics page displays the following details:

	
Active requests in the service engine. Use this graph to get an idea of the current service engine load. Only under extreme load conditions is there data shown in the graph. This is because most requests are processed instantaneously by the service engine. The data is collected by a Dynamic Monitoring Service (DMS) state sensor. Once the requests are processed by the service engine, the count goes to zero. This action enables you to know the current load on the service engine (for example, if it is too high).


	
Average request message processing time in the service engine since the last startup of the SOA Infrastructure. Use this graph to check service engine performance. While the processing time is calculated based on the last startup of the SOA Infrastructure, the data that is displayed in the graph is gathered only from the time at which you first accessed this page. The graph does not continue calculating and displaying data if you have not accessed this page. The DMS phase event sensor calculates the average request processing time and provides the processing time data.


	
Operation statistics about human workflow services used in the service engine, including the human workflow service used, the operation performed by the service, the number of active and completed requests, the count, and the average processing time.




[image: Description of hwf_se_stats.gif follows]

Description of the illustration hwf_se_stats.gif



For more information, see the following documentation:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for details about human workflow services and operations












21.6 Monitoring Human Workflow Service Engine Instances

You can monitor all human task service component instances running in the service engine. These human task service components can be part of separate SOA composite applications.

To monitor human workflow service engine instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Human Workflow.




	
	
Right-click soa-infra.


	
Select Service Engines > Human Workflow.











	
Click Instances.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the service component, the SOA composite application of which the service component is a part, the state of the instance (for example, completed, running, or faulted), the instance start time, the last modification time, and links to log files that describe the instance.
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In the Instances section, perform the following additional tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Component column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






21.7 Monitoring Deployed Human Workflows in the Service Engine

You can monitor all deployed SOA composite applications with human task service components running in the service engine.

To monitor deployed human workflows in service engines:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Human Workflow.




	
	
Right-click soa-infra.


	
Select Service Engines > Human Workflow.











	
Click Deployed Components.

The Deployed Components page displays the following details:

	
A utility for searching for a specific deployed SOA composite application by specifying the full name and clicking Search.


	
Details about deployed human task service components running in this service engine, including the service component name, the SOA composite application, the current status, and the number of total, faulted, and running instances.
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In the Name column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.











Part IX



  Administering Oracle Business Activity Monitoring

This part describes how to administer Oracle Business Activity Monitoring.

This part includes the following chapters:

	
Chapter 23, "Configuring Oracle Business Activity Monitoring"


	
Chapter 24, "Monitoring Oracle Business Activity Monitoring"


	
Chapter 25, "Managing Oracle Business Activity Monitoring"
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The image shows the Oracle BAM Web application home page in Oracle Enterprise Manager Fusion Middleware Control Console. The left side of the page shows the navigation pane. The right side of the page shows Oracle BAM Report Server statistics.
The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages (selected). Below this is the Search section, with fields for Error Message Contains, Fault ID, Name, Fault Time From, Fault Time To, Composite Instance ID, and Composite Name. Search and Reset buttons appear on the right side of the page.
Below this is the Show only re cove able faults checkbox and the Fault Types list. All Faults is selected in this list.
Below this are the Select list, View list, Recovery Actions list, and Delete Rejected Messages button. Below this is a table with the following columns: Error Message, Recovery, Fault Time, Composite, Fault Location, Composite Instance ID, and Logs.
The image shows the web service page displaying the following tabs: Dashboard, Policies, Faults and Rejected Messages, and Properties. The Properties tab is selected and shows the following fields: REST Enabled, WSDL Enabled, Metadata Exchange Enabled, Endpoint Test Enabled, Logging Level, Schema Validation, Atomic Transaction Version, Atomic Transaction Flow Option, Maximum Request Size, and Unit of Maximum Request Size. The Apply and Revert buttons appear at the top right of the tab.
The image shows the Logs Levels page. There are two tabs that display at the top from left to right: Log levels (selected) and Log Files. Below this is a description of what you can accomplish on this page. Below this is a View list, with Runtime Loggers selected. Below this is a Search list with All Categories selected. Below this is a table with the following columns from left to right: Logger Name, Oracle Diagnostic Logging Level (Java Level), Log File, and Persistent Log Level State.
This image shows an audit trail with an if condition.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies (selected). Below this are the View list and Attach/Detach To list. Below this is a table with the following columns from left to right: Policy Name, Attached To, Policy Reference Status, Category, Total Violations, and Authentication.
This graphic shows an instance page. There are three tabs: Audit trail, Flow, and Faults. The Audit Trail page is selected. It contains the following columns: Activity, Loop Count Event, Date, and Copy. These columns are explained in the text.
The image shows the Subscriptions page. The following tabs appear at the top from left to right: Events, Subscriptions (selected), and Faults. Below this is the Search section, with fields for Subscription Type, Event Namespace, Event Name, Subscriber, Consistency Level, and XPath Filter. The Search and Reset buttons display on the right. Below this is the Database Subscriptions section. This section includes the View drop-down list, Create Database Agent icon, Edit Database Agent icon, Delete Database Agent icon, and Manage Database Agents button.
Below this is a table with the following columns from left to right: Event Name, Namespace, Subscription - Database Agent, XPath Filter, Consistency Level, and Failed Deliveries. Below this is the Component Subscriptions section. This section includes a View drop-down list and a table with the following columns from left to right: Event Name, Namespace, Subscription Component, Composite, XPath Filter, Consistency Level, and Failed Deliveries.
The image shows four tabs at the top from left to right: Dashboard, Deployed Composites (selected), Instances, and Faults and Rejected Messages. Below this is the Search field. Search and Reset buttons appear on the right side of the page. Below this are the View, Start Up, Activate, Set As Default, Deploy, Undeploy, and Redeploy buttons. Below this is a table with the following columns: Composite, Partition, Status, Mode, Instances, Faults, and Deployed.
The image shows the BAM Server menu with the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The System MBean Browser menu item is selected.
The image shows the Email Driver Properties page. In the upper left section is the Common Configuration section, which includes a Supported Delivery Types label, Capability label, Cost drop-down list, Speed drop-down list, Sender Addresses field, and Default Sender Address field. To the right are the Supported Protocols field, Supported Carriers field, Supported Content Types label, Supported Status Types label, and Sending Queues Info label.
Below this section is the Driver-Specific Configuration section, which includes a table with the following columns from left to right: Name, Description, Mandatory, Encoded Credential, and Value. Two properties that you can set in the Value column are displaying in the Name column: MailAccessProtocol and RetryLimit.
The image shows the Outbound Connection Groups with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory radio button selected. The Back, Next, Finish, and Cancel buttons appear at the bottom.
The images shows the BAM Web drop-down menu for the Oracle BAM Web Properties page in Fusion Middleware Control. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties (selected), System MBean Browser, and General Information.
This figure displays how to invoke a test instance of the composite.
The image shows the Log Files page showing the available logs for Oracle BAM as a table with the following columns: Name, Directory, Log Type, Last Modified, and Size.
This image shows the Port Name section in the lower right corner of the page. The specific port name has been selected from the list of ports.
The image shows the User Messaging Preferences screen displaying the following tabs: Messaging Channels and Messaging Filters. The Messaging Filters tab is selected. The first area of the tab shows the following fields: Filter Name and Description. The second area of the tab shows the Condition as a table with the following columns: Attribute, Operator, Value, Value2 (if required), and Delete.
The third area of the tab shows the Action as a table with the following columns: Channel, Address, Up, Down, and Delete. The OK and Cancel buttons appear at the top right of the tab.
The image shows the General Information dialog box displaying the following fields: Target Name, Version, Oracle Home, and Host. The OK and Cancel buttons appear at the bottom right of the dialog box.
This image shows the Instances page for a Mediator Component with resequenced messages displayed.
The image shows the Farm_base_domain node expanded to show the following nodes: Application Deployments, SOA, WebLogic Domain, BAM, Metadata Repositories, and User Messaging Service. The User Messaging Service node is expanded and the usermessagingdriver-email sub-node is selected.
The image shows the Dashboard page for the B2B_Send_ebMS_PO (B2B) reference binding component. The following areas are displayed: Instances and Faults, which is a graph showing time on the x-axis (12:59 PM through 01:19) and number of messages on the y-axis (0 through 40); Top 5 Recently Active Trading Partners; and Recent Faults. The fields in these areas are described in the surrounding text.
The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages. Below this is the Search field. Search and Reset buttons appear on the right side of the page. Below this are the View, Start Up, Activate, Set As Default, Deploy, Undeploy, and Redeploy buttons. Below this is a table with the following columns: Composite, Partition, Status, Mode, Instances, Faulted Instances, and Deployed.
The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the distribution list information for myDistList including the Distribution List Name, Distribution List Members, and Last Modified date and time.
The image shows the Oracle BAM Administrator displaying example user information, and the mouse is positioned over the Reassign Ownership link at the top of the page.
The image shows the Outbound Connection Pool Configuration Table and the oracle.bam.adapter.adc.soap.SOAPConnectionFactory. The New and Delete buttons appear above and below the table.
The image shows the two tabs at the top from left to right: Services (selected) and References. Below this is a View list. Below this is a table consisting of the following columns from left to right: Service, Type, Composite, Partition, Total Messages, Average Processing Time (sec), and Faults.
The image shows the Delete: Rejected Messages dialog. Below this is a description of the page. Below this is the Common Delete Options radio button (selected). Below this is the Preset Batches list, with a value of Older than 24 Hours selected. Below this is the Delete All radio button. This deletes all rejected messages of this composite.
Below this is a Delete All Rejected Messages That Match These Criteria radio button. Below this are fields for Start Time From and Start Time To. In the lower right are Delete and Cancel buttons.
This image shows the Create New SOA Partition dialog. The Name field is displayed. Help, Create, and Cancel buttons display at the bottom.
This image shows a fault message for an Oracle Mediator component with resequenced messages. In this case, the resequencer group is faulted with a system error.
The image shows the following tabs from left to right: Dashboard, Instances (selected), Faults and Rejected Messages, Unit Tests, and Policies. Below this is a Search section, with fields for Instance ID, Name, Conversation ID, Start Time From, Start Time To, CustomerDetails, NameSensor, Datesensor, and Yearsensor. Search and Reset buttons and the Add Fields list appear on the right.
The image shows the Performance Summary for the usermessagingserver as a graph. The Show Metric Palette button appears above the graph.
The image shows the Oracle BAM start page with login fields displayed. In the Sign In box there are two fields: User name and Password. A Go button is located to the right of the Password field for submitting the credentials to the Oracle BAM Server.
The image shows the OracleRules1 (Decision Service Component) page which displays the following tabs: Dashboard, Instances, Faults and Policies. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, State, Start Date, Last Modified Date, and Logs. The second section of the page shows the Recent Faults as a table with the following columns: Error Message, Fault Time, Component Instance ID, and Logs.
The final section of the page shows the Instance Rate per Min (Real-Time Data). The top right of the page shows the Related Links drop-down menu.
The image shows the Oracle BAM Administrator function drop-down list displaying the following items: User management, Roles management, and Distribution List management (selected).
The image shows the Instances tab of the Mediator Component Home page. The Search section lets you enter the following details to search for particular Mediator instances: Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State. The View section displays the following information for the instances meeting the specified criteria, from left to right: Instance ID, State, Start Date, Last Modified Date, Source, and Logs.
The image shows the deployed Java EE applications under the Application Deployments folder. The Internal Applications and Resource Adapters subfolders have also been expanded. Internal Applications displays the components such as Oracle B2B. Resource Adapters displays the JCA Adapters. Other applications such as worklistapp display at the top level Application Deployments folder.
The image shows the organizational hierarchy of the demo users. The image is described in the table immediately above the image.
The image shows the Metrics Palette expanded to show the options for the usermessagingserver.
The image shows the Workflow Notification Properties screen. The first area of the screen shows the Notification Mode drop-down list with NONE chosen. The second area of the screen shows the Notification Service with the following fields: Email From Address, Email Actionable Address, and Email Reply To Address. The Apply and Revert buttons appear at the top right of the screen.
The image shows the Create a New Authentication Provider page. The first area of the page. The first area shows the Name field. The second area shows the Type drop-down list. Above and below the two fields are the OK and Cancel buttons.
The image shows the B2B Infrastructure (SOA Binding) page, with a drop-down list of Related Links. The links are SOA Infra Home, B2B Server Properties, B2B Console, and WebLogic Server Console.
The image shows the Oracle Enterprise Manager Select Archive screen. The first area of the screen shows the Archive and Exploded Directory settings with the following radio button selected: Archive or exploded directory is on the server where Enterprise Manager is running. The second area of the screen shows the Deployment Plan settings with the following radio button selected: Deployment plan is on the server where Enterprise Manager is running.
The upper half of the Dashboard page. This illustration is described in the text.
The image shows the Sensor Values page. At the top are the following tabs from left to right: Audit Trail, Flow, Sensor Values (selected), and Faults. Below this is the Activity Sensors section, which includes a table with the following columns from left to right: Sensor and Activity. Below this is the Variable Sensors section, which includes a table with the following columns from left to right: Sensor and Variable.
Below this is the Fault Sensors section, which includes a table with the following columns from left to right: Sensor and Fault. Below this is the Sensor Values section, which includes a table with the following columns from left to right: Sensor and Value.
The image shows the Policies page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies (selected), and Administration. Below this is the View drop-down list and Attach/Detach button. Below this is a table with the following columns from left to right: Policy Name, Policy Reference Status, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns are part of a larger column header entitled Security Violations.
The image shows the JNDI Name field. The Back, Next, Finish, and Cancel buttons appear at the bottom.
The image shows the context menu for the OracleBamWeb node. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Logs menu item is expanded to show the following sub-menu items: View Log Messages and Log Configuration (selected).
The image shows the Policies tab of the Mediator Component Home page. You can view the following details of the policies associated with a Mediator component, from left to right: Policy Name, Policy Reference Status, Category, Authentication, Security Violations, and Integrity.
You can also attach or detach policies from this page by clicking Attach/Detach to the right of the View menu.
The image shows Oracle BAM Server context menu showing the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The Control menu item is expanded and shows the following sub-menu items: Start Up and Shut Down (selected).
The image shows a deployed Java EE application. The Summary section appears in the upper left section. Below this is the General section with details about the state and the location of the deployment. Below this is the Servlets and JSPs section with details about active sessions, request processing times, and requests per minute. Below this is the Work Manager section with details about requests per minute and pending requests. Below this is the Entry Points section. This section includes subsections about Web Modules and Web Services.
The Web Modules section includes columns for Name and Test Point. The Web Services section includes columns for Service Name, Port, and Test. In the upper right part of the page is the Modules section, which includes details about Module Name and Module Type. Below this is the Response and Load section, which includes a graph describing request processing times (in milliseconds) and requests per minute.
This image shows the Watches and Notifications tabs at the top. The watches tab is selected. Below this is the Customize this table section. Below this is the title Watches. Below this are the New and Delete buttons. Below this is a table with the following columns: Name, Type, Enabled, and Alarm Type. This table lists all the currently-defined watches. Below this table are the New and Delete buttons.
The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Statistics tab is selected. The first section of the page shows the Average Request Processing Time as a graph. The second section of the page shows the Business Rules Cache Statistics as a table with the following columns: Cache Name, Object Count, and Object Access Count.
The third section of the page shows the Business Rules Operation Statistics as a table with the following columns: Operation Name, Count, and Average (in milliseconds). The Related Links drop-down menu appears at the top right of the page.
The image shows the information screen for a group, and includes the Group, Attributes, Subtree Access, and Local Access tabs. The Group tab is selected. The first area of the screen shows the following non-editable fields: Distinguished Name, Created by, Created at, Modified by, and Modified at. The Group tab shows the following fields: Owner, Description, and Members. Each field shows plus and minus buttons. At the top right of the screen are the Apply and Revert buttons.
This image shows the Mediator Resequencing Group dialog, which indicates the status of the group.
The image shows the Dashboard page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Recovery. Below this and to the right is the Recent Instances and Faults for the last 10 minutes.
Below this is the Components section, which includes a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances - Non Recoverable).
Below this is the Recent Faults section.
The image shows the Flow Trace page. Below this is the Faults section (currently closed). Below this is the Sensors section, which includes a table that consists of the following columns from left to right: Composite Instances, Name, Value, Location, and Action. Below this is the Trace section, which includes a table that consists of the following columns from left to right: Instance, Type, State, Time, and Composite Instance.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies.
Below this and to the right is the Recent Instances and Faults for the last 10 minutes message. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, State, and Start Time.
Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.
This image shows the Services tab (selected) and the References tab. Below this are the Actions list and View list. The Publish To UDDI option is being selected from the Actions list. Below this is a table with the following columns from left to right: name, Type, Composite, Partition, Total Messages, and Average Processing Time.
The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Event Engine tab is selected and the page shows the following information: General, Rule Fire Rate Per Second, and Processing Queues Sizes.
This image is described in the text immediately above the image.
The image shows the Routing Statistics section of the Dashboard tab of the Mediator Component Home page. It displays the following data: Number of Successfully Processed Messages, Number of Faulted Messages, Number of Incoming Messages, Average Processing Time for Successful Messages, and Average Processing Time for Faulted Messages.
The image shows the OK, Validate, and Cancel buttons in the upper right corner. Below this is the Attached Policies table, with the following columns left to right: Policy Name, Category, Enabled, Description, and View Full Description. The attached policies display in this table.
The image shows a graphical representation of a SOA composite application.
This illustration is described in the text.
This figure displays how to set the audit levels for a SOA composite.
The image shows the Log Messages screen for usermessagingdriver-xmpp. The first area of the screen shows the Search settings including the following fields: Date Range, Time Interval (Start Date, End Date, Start Time, End Time), Message Types (Incident Error, Error, Warning, Notification, Trace, and Unknown), and Maximum Rows Displayed. The first area also shows the Search and Add Fields buttons.
The second area of the screen shows the log messages as a table with the following columns: Incident Errors, Errors, Warnings, Notifications, Traces, Unknowns, and Log File. The Broaden Target Scope drop-down menu and Log Files button appear at the top of the screen.
The image shows the Assertion details for Simple Assertions section. The Show failure only checkbox appears. Below this is a table with the following columns from left to right: Composite Instance, Location, Type, Status, Expected Value, Actual Value, Description, and Error Message.
The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the cn=Users entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.
The image shows a human workflow component. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies, and Administration. Below this is a Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, and Modified Date To. A State list also appears.
Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.
This image shows the Faults page for an Oracle Mediator component instance with resequenced messages.
This image is described in the text immediately above.
The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Notification Management. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox, and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.
Below this is the Components section, which includes a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances - Recoverable and Non Recoverable.
This image is described in the text immediately above the image.
The image shows the Settings for oracle.bam.adapter.adc.soap.SOAPConnectionFactory page displaying the following tabs: General, Properties, Transaction, Authentication, Connection Pool, and Logging. The Properties tab is selected and the page shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Save button appears above and below the table.
The image shows Oracle BAM nodes in the BAM folder in the Oracle Enterprise Manager Fusion Middleware Control navigation tree.
The image shows the Credential Mappings tab selected in the Settings for OracleBamAdapter page.
The image shows detailed information for a non-recoverable fault on the Instance Details page for a Mediator service component.
The image shows the Request Breakdown section of the Statistics tab of the Mediator Component Home page. You can click the Help icon on the top right corner of the section to know more details about this section.
This image shows the Activity Time Distribution table, which includes, from left to right, the Name column, Count column, and the Average Execution Time (ms) column.
The image shows the Flow Trace page. The Faults section includes a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, and Composite Instance.
Below this is the Sensors section (currently closed). Below this is the Trace section, which includes a table that consists of the following columns from left to right: Instance, Type, Usage, State, Time, and Composite Instance.
The image shows the Recent Faults section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, Component Instance ID, and Logs.
Below this is the Users with Highest Backlog section, which includes a table with the following columns from left to right: Assignee, Average Time on Task (hour), Mean Deviation, and Pending Tasks.
The image shows the Log Configuration page displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected. The page shows the Runtime Loggers as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), and Log File. The Apply and Revert buttons appear at the top right of the page.
This image shows the home page of a partition. The Composite Control and Deployment lists appear at the top. In the upper right is the Search field. Below this is a table with the following columns: Composite, Status, Mode, Instances Total, Instances Faulted, and Last Modified Date.
The image shows the eis/bam/rmi instance selected in the Outbound Connection Pool list.
The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Instances tab is selected. The first section of the page shows the Search settings and includes the following fields: Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State (a drop-down list). The first section also shows the Search and Reset buttons.
The second section of the page shows the search results as a table with the following columns: Instance ID, Component, Composite, State, and Start Date. The Related Links drop-down menu appears at the top right of the page.
This image shows the Manage Partitions page. A Search field is displayed in the upper right corner. Below this are the View list, Create Partitions button, Delete Partitions button, Composite Control list, and Deployment list.
Below this is a table with the following columns from left to right: SOA Partition, Active, Composites Retired, View, Instances Total, and Instances Faulted.
The image shows the Select Names dialog opened to display a list of the Oracle BAM users to whom the objects can be assigned.
This image shows the Number of Instances message. The Composite Name field displays the SOA composite application name and revision. The Number of Instances field shows displays the number of instances. The Recalculate button appears in the lower right corner.
The image shows the Statistics page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics (selected), Instances, Faults, Deployed Components, and Notification Management. Below this are the Active Requests and Average Request Processing Time graphs. Below this is the Operation Statistics section, which includes a table with the following columns from left to right: Service Name, Operation Name, Active Requests, Completed Requests, Count, and Average (ms).
The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/https and eis/bam/soap. The New and Delete buttons appear above the table.
The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Policies, Faults and Rejected Messages, and Properties. Below this is the Instances and Faults graph, which shows the total number of outgoing messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.
The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Recovery. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox, and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.
The image shows the Application Policies page for oracle-bam(11.1.1). The Search area shows the data as a table with the following columns: Principal and Permission.
The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Distribution List Name field. The Create and Cancel buttons are below the field.
The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the Log Configuration displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and shows the search information as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), Log File, and Persistent Log Level State.
The Apply and Revert buttons appear at the top right of the Log Configuration display.
The image shows the Settings for myrealm page displaying the following tabs: Users and Groups. The Groups tab is selected. The page shows a list of groups, with each entry showing the name, the description, and the provider. A checkbox appears to the left of each entry. Above and below the list are the New and Delete buttons.
The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs. The second section of the page shows the Components as a table with the following columns: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances (Recoverable and Non Recoverable).
The final section of the page shows the Recent Faults as a table with the following fields: Error Message, Fault Time Composite, Component, Component Instance ID, and Logs. The top right of the page shows the Related Links drop-down menu.
The image shows the Request Processing page. At the top is the Service Engines section, which includes a table consisting of the following columns from left to right: Name, Average Request Processing Time - Synchronous (ms), Average Request Processing Time - Asynchronous (ms), Active Requests, Requests Processed, and Faults.
Below this is the Service Infrastructure section, which includes a table consisting of the same columns as the Service Engines. Below this is the Binding Components section, which includes a table consisting of the following columns from left to right: Name, Average Request Processing Time (ms), Requests Processed, and Errors.
The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/soap. The New and Delete buttons appear above and below the table.
The image shows the BPEL service engine. At the top are the following tabs from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Composites, and Recovery.
Below this is a Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and Component. A State list also appears. Search and Reset buttons appear below this.
Below this is a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.
The image shows the Faults tab for the ValidationRequestProcess BPEL component. The Related Links drop-down menu is expanded and shows the following menu items: SOA Infra Home and BPEL Engine Home.
graphic described in previous and following text.
This image shows from left to right the Dashboard, Policies, Faults, and Properties (selected) tabs. Below this are the General section and HTTP Basic Authentication section. Below this are the HTTP Chunking section and HTTP Proxy section. Below this is the HTTP Timeout section. Each section includes fields of appropriate properties.
The image shows the Instances page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Components, and Notification Management. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State. The Search and Reset buttons display to the right.
Below this is the View drop-down list and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.
The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).
The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).
This illustration is described in the text.
The figure displays the Confirmation dialog.
The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, Policies, and Administration. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox and a table that consists of the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs. Below this is the Show All link. Below this is the Recent Faults section, which includes a Show only system faults checkbox and a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.
The image shows the Log Files tab. A description of what you can do on this page appears below this tab. Below this are the Create, Create Like, Edit Configuration, and View Configuration buttons. Below this is a table with the following columns: Handler Name, Log Path, Log File Format, and Rotation Policy.
This illustration is described in the text.
The image shows the Policies page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, and Policies (selected). Below this is the View drop-down list and Attach/Detach button. Below this is a table with the following columns from left to right: Policy Name, Policy Reference Status, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns are part of a larger column header entitled Security Violations.
Flow Trace page showing a runtime trail of a message flow identified by an execution context ID (ECID) that is displayed in the upper right corner of the page. There are two main sections: one for Faults, the other for Trace.
The image shows the soainfra node in the navigation pane, with the following subnodes: Application Deployments, SOA, WebLogic Domain, Metadata Repositories, and User Messaging Service. The SOA node is expanded to show the soa-infra(soa_server1) subnode.
The image shows the Settings for myrealm page displaying the following tabs: Users and Groups. The Users tab is selected. The page shows a list of users, with each entry showing the name, the description, and the provider. A checkbox appears to the left of each entry. Above and below the list are the New and Delete buttons.
The image shows the Oracle Enterprise Manager Fusion Middleware Control page. The navigation pane on the left shows the Farm_soainfra node expanded with the following subnodes: Application Deployments, Internal Applications, Resource Adapters, SOA, WebLogic Domain, WebLogic Repositories, and User Messaging Service. The SOA node is expanded to show the Project_ebMS_PO [1.0] subnode.
The Project_ebMS_PO [1.0] page on the right shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Dashboard tab is selected. The first section of the Dashboard page shows the Recent Instances as a table, and includes the following columns: Instance ID, Conversation ID, Faults, and Start.
The second section of the Dashboard page shows the Recent Faults and Rejected Messages as a table, and includes the following columns: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs. The third section of the Dashboard page shows the Component Metrics as a table, and includes the following columns: Name, Component Type, Running Instances, and Total Instances. The fourth section shows the Services and References table with the following columns: Name, Type, Faults, Total Messages, Average Processing Time (secs).
The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, Policies. Below this is the Business Outcomes graph, which shows rejections and approvals. To the right is the Highest Time Consuming Assignees, which includes a table with the following columns from left to right: Assignee, Average Time on Task (sec), and Main Deviation.
Below these sections is the Instance Rate per Min (Real-Time Data) graph, which shows instance throughput details. Below this section is the Notifications section, which includes a table with the following columns from left to right: Channel Used and Count.
The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Instances, Faults (selected), and Policies. Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.
Below this is the Show only recoverable faults checkbox and the Fault Type drop-down list, in which All Faults is selected. Below this are the Select, View, and Recovery Actions drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.
This image shows four boxes at the top, from left to right: BPEL Engine, Database, JTA, and Cache. Vertical lines are attached to the bottoms of each box. Below the boxes are several horizontal lines. There is a horizontal line labeled JPA with an arrow pointing from the BPEL Engine box to the Database box. There is a horizontal line labeled alterCompletion with an arrow pointing from the JTA box to the BPEL Engine box. There is a horizontal line labeled put with an arrow pointing from the BPEL Engine box to the Cache box.
The image shows the context menu in the navigation pane displaying the following menu items: Home, Monitoring, Control, Logs, SOA Deployment, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information. The Logs menu item is expanded and shows the following sub-menu items: View Log Messages and Log Configuration.
The image shows the SOA Infrastructure drop-down menu displaying the following menu items: Home, Monitoring, Logs, SOA Deployment, Manage Partitions, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information.
The image shows the Oracle Enterprise Manager Deployment Settings screen. The first area of the screen shows the Deployment Settings and includes the following fields: Archive Type, Archive Location, Deployment Plan, Deployment Target, Application Name, Version, Context Root, and Deployment Mode. The second area of the screen shows the Deployment Tasks as a table with the following columns: Name, Go To Task, and Description. The Cancel, Back and Deploy buttons appear at the top right of the screen.
The image shows the System MBean Browser. On the left is the navigational tree. On the right is the ServerURL property. A description of this property is provided, as well as a field for changing the value.
The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Deployed Components tab is selected. The first section of the page shows the Search settings and includes the following fields: Name and Composite Name. The first section also shows the Search and Reset buttons.
The second section of the page shows the search results as a table with the following columns: Name, Composite, Status, Total Instances, Running Instances, and faulted Instances (Recoverable and Non Recoverable). The Related Links drop-down menu appears at the top right of the page.
The image shows the Task Details section. The first area of the section shows the following fields: Task Number, State, Outcome, Priority, Creator, Created Date, Updated Date, Expiration Date, Assignees, and Acquired By. The second area of the field shows onMessage expanded to show Initiated, Outcome Updated, and Completed.
This image is described in the table immediately above this image.
The image shows the Faults page. The following tabs display at the top from left to right: Audit Trail, Flow, Sensor Values, and Faults (selected). Below this is a table consisting of the following columns from left to right: Error Message, Recovery, Fault Time, and Activity.
The image shows the Instances page. At the top are the following tabs from left to right: Dashboard, Instances (selected), Faults, Policies, and Administration. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State.
Below this is the View drop-down list. Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.
The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults (selected), Deployed Composites, and Recovery. Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons. Below this is the Show only recoverable faults checkbox and Fault Type drop-down list, in which All Faults is selected. Below this are the Select, View, and Recovery Actions drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, and Component Instance ID.
The image shows the Request Breakdown section, which includes a table with the following columns from left to right: Name, Count, Min Request Processing Time (ms), Max Request Processing Time (ms), and Avg Request Processing Time (ms).
The image shows the Application Roles page displaying the Search data as a table with the following columns: Role Name and Members. The Report Architect entry is selected.
The image shows the Metrics context menu showing Help selected.
The image shows the Create Database Subscription dialog box. The first area of the dialog box shows the Event information including the following fields: Event Namespace and Event Name. The second area of the dialog box shows the Agent information with the Database Agent field. The third area of the dialog box shows the Subscription Properties with the following fields: Consistency Level and XPath Filter. The Help, Subscribe, and Cancel buttons appear at the bottom of the dialog box.
This dialog box does not appear for EDN - JMS.
The image shows the Oracle BAM nodes in the Oracle Enterprise Manager Fusion Middleware Control navigation tree. The Farm_soabam node is expanded to show the following nodes: Application Deployments, WebLogic Domain, BAM, Metadata Repositories, and User Messaging Service. The BAM node is further expanded to show the OracleBamServer and OracleBamWeb nodes.
The image shows the Create a New Security Credential Mapping page. The first area of the page shows the Back, Next, Finish, and Cancel buttons. The second area of the page shows the following fields: EIS User Name, EIS Password, and Confirm Password.
The image shows the Settings for the authentication provider page displaying the following tabs: Common and Provider Specific. The Common tab is selected. The main area of the page shows the following fields: Name (non-editable), Description (non-editable), Version (non-editable), and the Control Flag drop-down list. Above and below the four areas is the Save button.
The image shows the Messaging Client Applications screen for usermessagingserver, displaying the data as a table with the following columns: Name, Version, Client Type, Listener End Point, and Receiving Queues. The De-register button appears above the table.
The image shows the Instances page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Components, and Recovery. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, State, and Component. The Search and Reset buttons display to the right. Below this is the View drop-down list and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.
This image shows the Create Watch section. The Back, Next, Finish, and Cancel buttons appear at the top. Below this is the Configure Watch Notifications section. This includes a Notifications Available section and a Chosen section. Between these two sections are >, >>, <, and << buttons. The Chosen section is displaying a notification named FMW-DFW notification. Below these two sections are Back, Next, Finish, and Cancel buttons.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests (selected), and Policies. Below this is the Search section, with fields for Test Run Name, Test Run ID, Composite Instance ID, Start Time, and End Time. The Search and Reset buttons appear in the lower right corner of this section.
Below this are the Test Cases and Test Runs (selected) sub-tabs. Below this is a table with the following columns left to right: Test Run Name, Test Run ID, Start Time, End Time, Status, and Success Rate.
Below this is the Results of Test Run section. In this section are statistics for Total, Running, Passed, Failed, Unknown, and Success Rate. A Refresh Test Status button appears to the right. Below this is a table consisting of the following columns: Test suits and test cases, and Status.
The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the System MBean Browser. The left side of the System MBean Browser shows a navigation pane with the ComponentAdministration bean selected. The right side of the System MBean Browser shows the listDriverInstances operation details and return values.
The image shows a portion of the settings for OracleBamAdapter page. The Properties sub-tab is selected.
This graphic shows the Advanced properties separated into the following sub-areas: Data Sources and Web Service Binding Properties. The Data Sources sub-area shows the following information: Server Data Source JNDI, Server Transaction Data Source JNDI, and the Nonfatal Connection Retry Count field. The Web Service Binding Properties sub-area shows the following fields: Oracle SSL Ciphers, Oracle Wallet Password, Use chunking (a checkbox), and Chunk Size.
The image shows the Log Configuration page displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and the page shows the Runtime Loggers with the Logger Name and Oracle Diagnostic Logging Level (Java Level). The Oracle Diagnostic Logging Level drop-down list is selected showing the selection of levels.
The image shows onMessage expanded to show onCase "SAP.Write" highlighting four errors, all displaying the following error message: "Error during invoking 1-way operation "Write" on target service "SAP".
This image is described in the text immediately above the image.
The image shows the Incoming Notifications section, which includes a Search section with fields for Sender, Date From, Channel, Recipient, and Date To. Below this are the Select and View drop-down lists, the Mark as Spam button, Not Spam button, and Delete button. Below this is a table with the following columns from left to right: Message ID, Channel, Sender, Recipient, Status, Content, and Time.
The image shows the Oracle BAM Server Properties page in Fusion Middleware Control. The first area of the page shows the Data Source JNDI field. The second area of the page shows the Advanced settings including the following fields: Application URL, Viewset Sharing, Report Cache Persistence Manager, ODI User, ODI Password, ODI Work Repository Name, ODI Agent Host, ODI Agent Port, and Outbound Email account.
The image shows the following tabs from left to right: Dashboard, Instances (selected), Faults and Rejected Messages, Unit Tests, and Policies. Below this is a Search section, with fields for Instance ID, Name, ECID, Conversation ID, Start Time From, and Start Time To. Search and Reset buttons appear on the right.
Below this is the Filter By section, with the Execution State and Fault State lists, and the BPEL Recovery checkbox.
Below this is the Show menu, with a value of Any selected. Below this are the View list, and Delete Selected, Delete with Options, and Abort buttons.
Below this is a table with the following columns from left to right: Instance ID, Name, Conversation ID, Instance State, Start Time, and Logs.
The image shows the SOA Infrastructure drop-down menu displaying the following menu items: Home, Monitoring, Logs, SOA Deployment, Manage Partitions, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information.
The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Faults tab is selected. The first section of the page shows the Search settings and includes the following fields: Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, Component Instance ID, and Fault Type (a drop-down list). The first area also shows the Search and Reset buttons.
The second section of the page shows the search results as a table with the following columns: Error Message, Fault Time, Composite, Component, Component Instance ID, and Logs. The Related Links drop-down menu appears at the top right of the page.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies (selected). Below this are the View list and Attach/Death To list. Below this is a table with the following columns from left to right: Policy Name, Attached To, Policy Reference Status, Category, Total Violations, and Authentication. The currently attached policies display in this table.
The image shows the View Log File screen for the soa_server1-diagnostic.log file. The first area of the screen shows the Download button. The second area of the screen shows the following fields: Date Range, Start Date, and End Date. The second area also shows the Search button.
The third area of the screen shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message. The fourth area of the screen shows the error message details including the following fields: Message ID, Message Level, ECID, Relationship ID, Component, and Message.
The image shows the Notification Management page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components, and Notification Management (selected). Below this is the Outgoing Notifications section, which includes a Search section with fields (when expanded) for Channel, Date From, Recipient, Status, and Date To.
Below this are the Select and View drop-down lists, the Resend button, Resend All Similar Notifications button, View Bad Addresses button, and Delete button. Below this is a table with the following columns from left to right: Source ID, Source Type, Channel, Recipient, Status, and Time.
The image shows the SOA Composite drop-down menu displaying the following menu items: Home, Monitoring, SOA Deployment, Export, Test Service, Unit Tests, Policies, SOA Infrastructure, SOA Infrastructure Common Properties, Service/Reference Properties, and General Information.
The image shows the BPEL Message Recovery Required message and icon displayed in the Trace table. The Show Details button displays to the right of the message.
The image shows the Oracle Enterprise Manager Fusion Middleware Control. The navigation pane on the left shows the soa_soainfra node expanded with the following subnodes: Application Deployments, SOA Composite Deployments, and Fusion Middleware.
The Fusion Middleware node is expanded to show the soa-infra(server_soa) subnode, which is selected. The B2B_EDI_X12 [1.0] page on the right shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Instances tab is selected. The first section of the Instances page shows the Search criteria, and includes the following fields: Instance ID, Conversation ID, Start Time From, and Start Time To. The first section also shows the Search and Reset buttons.
The second section of the Instances page shows the search results as a table, and includes the following columns: Instance ID, Conversation ID, State, Faults, Start Time, and Logs.
The image shows the home page of the SOA Infrastructure. At the top are the following tabs from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages. Below this and to the right is the Recent Instances and Faults for the last ten minutes message. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Composite, and Start Time.
To the right is the Deployed Composites table consisting of the following columns from left to right: Composite, Status, Mode, and Faulted Instances. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Fault Location, and Composite Instance ID.
The image shows the Log Messages screen for usermessagingserver. The first area of the screen shows the Search settings including the following fields: Date Range, Start Date, End Date, Message Types (Incident Error, Error, Warning, Notification, Trace, and Unknown), and Message. The first area also shows the Search and Add Fields buttons.
The second area of the screen shows the log messages as a table with the following columns: Time, Message Type, Message ID, Message, and Log File. The third area of the screen shows message details including the following fields: Message ID, Message Level, Relationship ID, Argument 1, Component, Module, Message, Host, Host IP Address, User, Thread ID, and ECID.
The Broaden Target Scope drop-down menu and Log Files button appear at the top of the screen.
The image shows the Workflow Task Service Properties screen. The first area of the screen shows the following fields: Actionable Email Account, Workflow Service Session Timeout (in minutes), and Workflow Custom Classpath URL. The second area of the screen shows the Dynamic Assignment nd Task Escalation Functions as a table with the following columns: Function Name and Classpath.
The final area of the screen shows the Parameters as a table with the following columns: Name and Value.
Below this is the Advanced section (unexpanded).
This image shows three boxes at the top, from left to right: BPEL Engine, Cache, and Database. Vertical lines are attached to the bottoms of each box. Below the boxes are several horizontal lines. There is a horizontal line labeled put with an arrow pointing from the BPEL Engine box to the Cache box. There is a horizontal line labeled object found: JPA- read version attribute with an arrow pointing from the BPEL Engine box to the Database box. There is a horizontal line labeled object NOT found or version did not match JPA - send Object with an arrow pointing from the BPEL Engine box to the Database box.
The image shows the Driver-Specific Configuration section displaying the information as a table with the following columns: Name, Description, Mandatory, Encoded Credential, and Value.
Payload XML page as described above
The image shows the Deployed Composites page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components (selected), and Notification Management. Below this is the Search section with fields for Name and Composite Name. To the right are the Search and Reset buttons. Below this is the View drop-down list.
Below this is a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, Faulted Instances - Recoverable, and Faulted Instances - Non Recoverable.
This image shows the Number of Instances (for the last 10 minutes) section. The following information has been found: the composite name and the number of instances.
The image shows the Message Status screen for the usermessagingserver. The first area of the screen shows the Search Message Status and includes the following fields: Maximum Messages Displayed, Operation, Overall and Status. The first area also shows the Search and Reset buttons, as well as the Add Fields drop-down menu.
The second area of the screen shows the search results as a table with the following columns: Message ID (Recipient), Recipient, Operation, Overall Status, and Timestamp. The Resend button appears at the top of the table.
The image shows the DB Subscriptions icons, from left to right, Create, Edit, and Delete.
The image shows the Dashboard tab displaying the Recent Instances. The Related Links drop-down menu is expanded and shows the following menu items: SOA Infra Home, BPEL Properties, WebLogic Server Console, and BPEL Engine Logs.
The image shows the Oracle Directory Services Manager, displaying the following tabs: Home, Data Browser, Schema, Security, and Advanced. The Data Browser tab is selected. The left pane of the tab shows the Data Tree hierarchy with the cn=oid1 node selected. The right pane shows the Attributes tab displaying the following fields: orclsslPort, orclsslVersion, orclsslWalletURL, orclsslinteropmode, orclstatsflag, orclstatslevel, and orclstatsperiodicity.
The image shows the Business Events page. The following tabs appear at the top from left to right: Events, Subscriptions, and Faults. Below this is the Search field. Below this is the View drop-down list, and Subscribe, Test, and Show Event Definition buttons. Below this is a table with the following columns: Namespaces and Events, Subscriptions, and Failed Deliveries.
The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).
The image shows a trace diagram with an Oracle B2B Binding component, a Mediator component, and a File Adapter. The first area of the page shows the list of Faults, with no faults found. The second area of the page shows the Trace, and includes the Show Instance IDs checkbox and the Instance list.
This image shows the Number of Instances message. The Running Instances field displays the number of running instances. The Total Instances field shows displays the total number of instances. The Recalculate button appears in the lower right corner.
This figure displays the rule execution trace report with the trace level set as Production.
The image shows a portion of the Settings for oracle-bam-adapter page. The Outbound Connection Pools sub-tab is selected.
The image shows the Attach/Detach drop-down list expanded to show the following list items: CreditRatingRules, AutoLoanProcess, LoanApproval, LoanAdvisorRules, and client.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard (selected), Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, Instance State, and Start Time.
Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.
The image shows the Flow page. The following tabs display at the top from left to right: Audit Trail, Flow (selected), Sensor Values, and Faults. Below this is a graphical representation of all the activities in the BPEL process, top to bottom.
The image shows the Instances page of the Mediator service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances, Faults, and Deployed Components (selected). Below this is the Search section with fields for Name and Composite Name. To the right are the Search and Reset buttons. Below this is the View drop-down list. Below this is a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, Faulted Instances Recoverable and Faulted Instances Non Recoverable.
The image shows specific messages in the bam_server1.log file, displayed as a table with the following columns: Time, Message Type, Message ID, and Message.
The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Distribution List Name field and the Select Members list. The Save and Cancel buttons appear below the Select Members list.
The image shows the System MBean Browser navigator on the left. On the right is the setCustomNSDriverPropertyValue operation displaying the following fields: MBean Name, Operation Name, Description, and Return Type. The right side of the screen also shows the Parameters as a table with the following columns: Name, Description, Type, and Value. The Invoke and Return buttons appear at the top right of the screen.
The image shows the BPEL Service Engine Properties and includes the following fields: Audit Level (a drop-down list), Audit Trail Threshold (Byte), Large Document Threshold (Byte), Dispatcher System Threads, Dispatcher Invoke Threads, Dispatcher Engine Threads, Payload Validation (a checkbox), and Disable BPEL Monitors and Sensors checkbox. Below this is the More BPEL Configuration Properties link. The Related Links drop-down menu and Apply and Revert buttons appear at the top right.
The image shows the Credential Mappings table with the following columns: WLS User, EIS User, and Outbound Connection Pool. The New and Delete buttons appear above the table.
This image is described in the text immediately above the image.
This image shows the Faults page for an Oracle Mediator component instance with resequenced messages.
This image shows the Warning message that is displayed when you click Show Details or the recovery icon. The contents of this message are described in the surrounding text.
The image shows the Statistics page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics (selected), Instances, Faults, Deployed Components, and Recovery. Below this are the Pending Requests and Active Requests graphs. Below this is the Thread Statistics section, which includes a table with the following columns from left to right: Name and Statistics.
The image shows the Deployment Completed dialog box. The first area of the dialog box shows the Summary and includes the following fields: Version, Deployed Archive Location, Archive Type, Deployment Mode, Deployment Target, Application States, and Context Root. The second area of the dialog box shows the Progress Messages. The Close button appears at the bottom right of the dialog box.
The image shows the Edit Application Role: Report Architect page. The first area of the page shows the General information and includes the following fields: Application, Role Name, Display Name, and Description. The second area of the page shows the Members and Roles as a table with the following columns: Name and Type.
The final area of the page shows the Users as a table, with the Add User button highlighted.
The image shows the Email Driver Properties page for usermessagingdriver-email. The first area of page shows the Common Configuration and includes the following fields: Supported Delivery Types, Capability, Cost, Speed, Sender Addresses, Default Sender Address, Supported Protocols, Supported Carriers, Supported Content Types, Supported Status Types, and Sending Queues Info.
The second area of the page shows the Driver-Specific Configuration as a table with the following columns: Name, Description, Mandatory, Encoded Credential, and Value. The Apply and Revert buttons appear at the top right of the page.
This image shows the Create Watch page. Below the title are Back, Next, Finish, and Cancel buttons. Below this is the Configure Watch Rule Expressions section. Below this is the Current Watch Rule field, which displays a watch rule. To the right of this section is the Edit button. Below this is the Expression section, with buttons for Add Expression, Combine, Uncombine, Move Up, Move Down, Remove, and Negate. Below this is a checkbox for the rule that is appearing in the Current Watch Rule field. Below this are buttons for Add Expression, Combine, Uncombine, Move Up, Move Down, Remove, and Negate. Below this are the Back, Next, Finish, and Cancel buttons
The image shows the Domain Structure menu expanded to show the following items: Environment, Deployments, Services, Security Realms, Interoperability, and Diagnostics. The Deployments item is selected.
This image shows the Trace section. At the top is the Show Instance IDs checkbox. Below this is a table with the following columns from left to right: Instance, Type, Usage, St, Time, and Composite Instance.
The image shows the Oracle BAM Server menu in Fusion Middleware Control. The following menu items are available: Home, Monitoring, Control, Logs, BAM Server Properties (selected), Security, System MBean Browser, and General Information.
The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances (selected), and Faults and Rejected Messages. Below this is the Search section, with fields for Instance ID, Name, ECID, Conversation ID, Start Time From, and Start Time To. Search and Reset buttons appear on the right side of the page.
Below this is the Filter By section, with the Execution State and Fault State lists, and the BPEL Recovery checkbox.
Below this are the View list, and Delete Selected, Delete with Options, and Abort buttons. Below this is a table with the following columns: Instance ID, Composite, Name, Conversation ID, Instance State, and Start Time.
The image shows the Instances page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components (selected), and Recovery. Below this is the Search section with fields for Name and Composite Name. To the right are the Search and Reset buttons. Below this is the View drop-down list. Below this is a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, Faulted Instances Recoverable and Faulted Instances Non Recoverable.
The image shows the Oracle BAM web services counters, available through the links in the JEE Web Services page. The JEE Web Services page shows a table with the following columns: Name, Application, Port Name, and Invocation count.
The image shows the Dashboard tab of the Mediator Engine home page on Oracle Enterprise Manager Fusion Middleware Control.
The image shows the home page of a SOA composite application. The following buttons appear at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, Instance State, and Start Time.
Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.
The image shows the top of the Test Web Service page. At the far right is the Test Web Service button. Below this is a description of the page. Below this is the WSDL field. To the right of this is the Parse WSDL button. Below this is the Service label, the Port label, the Operation list, the Endpoint URL field, and the Edit Endpoint URL checkbox. Below this are the Request and Response tabs.
The image shows the Instances page. At the top are the following tabs from left to right: Dashboard, Instances (selected), Faults, and Policies. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State.
Below this is the View list. Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.
The image shows the Administration page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies, and Administration (selected). Below this is the View drop-down list, Add URI button, and Remove button. Below this is a table with the following columns from left to right: Application Name, Host Name, HTTP Port, HTTPS Port, and URI.
The image shows the Deployments table with the OracleBamAdapter link selected. The Install, Update, Delete, Start, and Stop buttons appear at the top of the table.
The image shows the Service Engines table, which includes the following columns from left to right: Name, Number of Components, and Faults.
The image shows the Add User dialog displaying the Search settings as the following two lists: Available Users and Selected Users. The Move, Move All, Remove, and Remove All buttons appear between the two lists.
The image shows the Select Archive page. At the top is the Archive or Exploded Directory section, in which you can select an archive that is on the machine where this web browser is running or select an archive or exploded directory on the server on which Enterprise Manager is running. Below this is the Configuration Plan section, in which you can select to not include a configuration plan, select a plan on the machine where this web browser is running or select a plan on the server on which Enterprise Manager is running.
This image is described in the text immediately above the image.
The image shows the context menu in the navigation pane displaying the following menu items: Home, Monitoring, Control, Logs, SOA Deployment, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information. The Logs menu item is expanded and shows the following sub-menu items: View Log Messages and Log Configuration.
This image is described in the text immediately following this image.
The image shows the Associated Drivers screen displaying the following tabs: Local and All. The Local tab is selected and shows the data as a table with the following columns: Name, Driver Type, Status, and Configure Driver.
This illustration is described in the text.
The image shows the Oracle BAM Administrator application showing the function list open and User management option selected.
This figure displays how to enter input parameters for testing the decision trace in a SOA composite.
The image shows the Authentication Providers page. The page shows a list of authentication providers, with each entry showing the name, the description, and the version. A checkbox appears to the left of each entry. Above and below the list are the New, Delete, and Reorder buttons.
The image shows the Application Defined MBeans page. The Attributes tab is selected and the page shows a table with the following columns: Name, Description, Access, and Value. The Apply button appears at the top right of the page.
The image shows the Create a New Security Credential Mapping page with the following options for the WebLogic Server User: User for creating initial connections, Default User, Unauthenticated WLS User (selected), and Configured User Name. The Back, Next, Finish, and Cancel buttons appear above the options.
The image shows the Route Target section of the Dashboard tab of the Mediator Component Home page. It displays the following details of route targets, from left to right: Name, Average Processing Time, and Average Invocation Time.
This image shows the Recover with Options dialog. At the top is the Common Recovery Action list. Retry is selected. Below this is the Common Recovery Options radio button. Below this is the Preset Batches list. Older than 24 Hours is the selected option. Below this is the Recover All radio button. Below this is the Recover All Recoverable Faults that Match These Criteria radio button. Within this section are the Fault Time From, Fault Time To, and Error Message Contains fields.
The image shows the instance rate per min (Real-Time Data) section. On the left is the Instance Rate per Min (Real-Time Data) graph, which shows the throughput of instances in the last five minutes.
Flow Trace page showing Oracle B2B Faults and Trace messages.
The image shows the following tabs at the top from left to right: Dashboard, Instances, Faults and Rejected Messages (selected), Unit Tests, and Policies. Below this is the Search section, with fields for Error Message Contains, Fault ID, Name, Fault Time From, Fault Time To, and Composite Instance ID. Search and Reset buttons appear on the right side of the page.
Below this is the Show only recoveable faults checkbox and the Fault Types list. All Faults is selected in this list.
Below this are the Select list, View list, Recovery Actions list, Delete Rejected Messages button, and Recover With Options button. Below this is a table with the following columns: Error Message, Recovery, Fault Time, Rejected Message, Fault Location, Composite Instance ID, and Logs.
The image shows the Oracle WebLogic Server Administration Console. On the left side from top to bottom is the Change Center, the Domain Structure (with entries for Environment, Deployments, Services, Security Realms, Interoperability, and Diagnostics), the How Do I section (with documentation links), and the System Status section. On the right side of the page are the Configuration, Monitoring, Control, Security, Web Service Security, and Notes tabs. Below this are the General, JTA, EJBs, Web Applications, Logging, and Log Filters tabs. Below this is the Save button. Below this are properties that you can define: Enable Administration Port, Production Mode, and Enable Cluster Constraints. Descriptions are provided for each.
The image shows the Attach/Detach Policies page that appears when you click Attach/Detach on the Policies tab of the Mediator Component Home page. This page displays the following details, from left to right: Name, Category, Enabled, Description, and View Full Description.
Use the Attach or Detach buttons appearing below to attach or detach a policy according to your need.
The image shows the Audit Trail tab for the instance details of a Mediator service component instance.
The image shows the Client Requests in Progress as a graph.
The image shows the Instance Rate per Min (Real-Time Data) section of the Dashboard tab of the Mediator Component Home page. This section displays a graph that shows real-time data for successful, faulted, and incoming instances in the last five minutes. Click Table View to get a tabular representation of the data.
The image shows the Performance Summary page for OracleBamServer showing graphs of Active Data Sessions, Outgoing Message Rate (per sec), and Events Fire Rate (per sec).
The image shows the Recovery Action section. In the upper left is a list with the value of Retry selected. To the right is the After Successful Retry label. A value of None is selected in the list. Below this and to the left is the Variable list. No value is selected. Below this is the Value field.
The image shows the farm home page. The navigational menu appears on the left. On the right is the Deployments section, which shows a deployments graph, and a deployment table with the following columns from left to right: Name, Status, and Target.
The image shows the BPMN Service Engine Properties and includes the following fields: Audit Trail Threshold (Byte), Large Document Threshold (Byte), Dispatcher System Threads, Dispatcher Invoke Threads, Dispatcher Engine Threads, Payload Validation (a checkbox), and Audit Level (a drop-down list). The Related Links drop-down menu and Apply and Revert buttons appear at the top right.
The image shows the OK, Validate, and Cancel buttons in the upper right corner. Below this is the Attached Policies table, with the following columns left to right: Policy Name, Category, Enabled, Description, and View Full Description. Attached policies appear in this table.
Below this table are the Attach and Detach buttons. Below this is the Available Policies section. A Search list is displayed below this. The value of Policy Category is selected. Below this is a table with the following columns from left to right: Policy Name, Category, Enabled, Description, and View Full Description.
The image shows the Operations page for the b2b MBean. The following operations (links) are listed: addProperty, getProperty, getPropertyComment, getPropertyValue, remove, setProperty, setPropertyComment, and setPropertyValue.
The image shows the Oracle BAM Web Properties page in Fusion Middleware Control displaying the following fields: Application URL, Report Loading Indicator, and Server Name.
This illustration is described in the text.
The image shows the Request and Response tabs. The Request tab is selected. The first area of the tab shows the Security settings and includes the following radio buttons: WSS Username Token, HTTP Basic Auth, Custom Policy, and None (selected). The second area of the tab shows the Quality of Service settings and includes the following fields: WS-RM with WSDL Default, None, and Custom radio buttons and Policy URI text field; MTOM with WSDL Default, None, and Custom radio buttons and Policy URI text field; WS-Addressing with WSDL Default, None, and Custom radio buttons and Policy URI text field.
The third area of the tab shows the HTTP Transport Options and includes the following fields: Enable SOAP Action (a checkbox) and SOAP Action. The fourth area of the tab shows the Additional Test Options and includes the following fields: Enable Stress Test (a checkbox), Concurrent Threads, Loops per Thread, and Delay in Milliseconds. The final area of the tab shows the Input Arguments and includes a drop-down list along with Name, Type, and Value fields.
This image shows the defined if condition.
The image shows the Log Messages page showing all message types selected and a few Warning messages in the table.
The image shows the Settings for oracle.bam.adapter.adc.soap.SOAPConnectionFactory page displaying the following tabs: General, Properties, Transaction, Authentication, Connection Pool, and Logging. The Properties tab is selected and the page shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Property Value for the HostName property is selected. The Save button appears above and below the table.
This image shows the partitions in the navigator and in the Manage Partitions page.
The image shows the Oracle Enterprise Manager navigation pane with the User Messaging Server node expanded.
This illustration is described in the text.
The image shows the Faults page. The following tabs appear at the top from left to right: Events, Subscriptions, and Faults (selected). Below this is the Search section, Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Subscription Type, Event Namespace, Event Name, and Subscriber.
The Search and Reset buttons display on the right. Below this is the Select drop-down list, View drop-down list, Retry button, and Abort button. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Event Namespace, Event Name, Subscriber Name, and Subscription Type.
The image shows the SOA Infrastructure Common Properties screen. The first area shows the following fields: Audit Level (a drop-down list), Capture Composite Instance State (a checkbox), and Payload Validation (a checkbox). The second area of the screen shows the UDDI Registry Properties and includes the following fields: Inquiry URL, User, and Password. The third area of the screen shows the Server URLs and includes the following fields: Callback Server URL and Server URL. The fourth area shows the Display Data Counts section with the Disable fetching of instance and fault count metrics. Each metric can still be retrieved on demand checkbox and the Restrict Display on Instances and Faults to the last time_period checkbox.
The bottom area of the screen shows the Advanced properties.
The top right of the screen shows the Related Links drop-down menu and the Apply and Revert buttons.
The image shows Fusion Middleware Control. The left side of the page shows the navigation pane with OracleBamServer selected. The right side of the page shows the BAM Server drop-down menu with the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The Security menu item is expanded and shows the following sub-menu items: Application Policies and Application Roles.
The image shows the Faults tab of the Mediator Service Engine Home page. The Search section lets you enter the following details to search for particular faults that occurred to different Mediator components ran by the Mediator Service Engine, from left to right: Error Message Contains, Fault ID, Fault Time from, Fault Time to, Composite Instance ID, and Component Instance ID.
Below the Search section, the Show Only Recoverable Faults checkbox enables you to view only those faults on which you can perform recovery actions. The Fault Type list enables you to choose the type of the fault.
Below is the View section that displays the following details of all the faults meeting the particular criteria, from left to right: Error Message, Recovery, Fault Type, Composite, Component, Component Instance ID, Case, and Logs.
The image shows the Oracle Enterprise Manager Select Target screen. The screen shows the data as a table with the following columns: Select, Name, Type, and Deployed Applications. The Cancel, Back and Next buttons appear at the top right of the screen.
The image shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, Name, Conversation ID, State, and Start Time. The second section of the page shows the Recent Faults and Rejected Messages as a table with the following columns: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.
The third section of the page shows the Component Metrics as a table with the following fields: Name, Component Type, Total Instances, Running Instances, and Faulted Instances (Recoverable and Non Recoverable). The top right of the page shows the Related Links drop-down menu.
This figure displays how to open the instance details page for viewing the details of the Decision Service Component.
This image shows the Enable/Disable BPEL Monitors and Sensors option being selected.
The image shows the Refresh icon in upper right corner of Fusion Middleware Control Console.
The image shows the Faults tab of the Mediator Instance Details page of a Mediator component instance, where a fault occurred. It displays the following details of a fault, from left to right: Message, Recovery, Time, and Case.
The image shows the Task Details section displaying the following fields: Task Number, State, Outcome, Priority, Creator, Created Date, Updated Date, Expiration Date, Assignees, and Acquired By.
The image shows the two tabs at the top from left to right: Services and References (selected). Below this is a View list. Below this is a table consisting of the following columns from left to right: Reference, Type, Composite, Partition, Total Messages, Average Processing Time (sec), and Faults.
The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Enterprise Message Sources tab is selected and the page shows the following information: Messages and Operations Per Second.
The image shows the BAM Web drop-down menu. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Monitoring menu item is expanded to show the Performance Summary sub-menu item (selected).
This image shows the cursor selecting a partition.
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests (selected), and Policies. Below this are the Test Cases (selected) and Test Runs sub-tabs. Below this is a table with the following columns from left to right: Name, Description and Select (which is a checkbox). In the Name column are two folders: SimpleAssertions and SimpleEmulations.
The image shows the Dashboard tab of the Mediator Component home page. This section displays information about the recent instances of the Mediator component, including a list of recent instances, a list of recent faults, routing statistics, and instance rate per minute.
This image shows a timed-out message for an Oracle Mediator component with resequenced messages. In this case, the resequencer group is timed out.
The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected) and Faults and Rejected Messages. Below this is the Instances and Faults graph, which shows the total number of incoming messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.
This image shows the following tabs at the top from left to right: Dashboard, Policies, Faults and Rejected Messages (selected), and Properties. Below this is the Attach/Detach icon and Disable icon. Below this is a table with the following columns: Policy Name, Category, Policy Reference Status, Total Violations, Authentication, Authorization, and Confidentiality. Below this is the Security Configuration Details section. Which includes Apply and Revert buttons on the upper right side, and a table with the following columns: Name, Value, and Original Value.
The image shows the Recovery Action list with a value of Retry selected. Below this is the Variable list with a value of crInput selected. To the right of this is the Set Value button. Below this is the Value field in which you can enter values.
The image shows the Reorder Authentication Providers page. The main area of the page shows the list of available authentication providers. To the right of the list, an up arrow and a down arrow is shown. Above and below the principal area are the OK and Cancel buttons.
The image shows the Instances page of the Mediator service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances (selected), Faults, and Deployed Components. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, State, and Component. The Search and Reset buttons display to the right. Below this is the View drop-down list and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, Source, and Logs.
This figure displays how to launch the Flow Trace page to view the decision flow trace.
The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, and Policies. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox and a table that consists of the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs. Below this is the Show All link.
Below this is the Recent Faults section, which includes a Show only system faults checkbox and a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.
The image shows the top of the Test Web Service page. At the far right is the Test Web Service button. Below this is a description of the page. Below this is the WSDL field. To the right of this is the Parse WSDL button. Below this is the Service label, the Port label, the Operation list, the Endpoint URL field, and the Edit Endpoint URL checkbox.
Below this are the Request and Response (selected) tabs. Below this is the Test Status label, the Response Time (ms) label, the Tree View list, and the Launch Message Flow Trace link. Below this is a table with the following columns from left to right: Name, Type, and Value.
The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Report Cache tab is selected and the page shows the following information: General and View Sets.
The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the System MBean Browser. The left side of the System MBean Browser shows a navigation pane with the ComponentAdministration bean selected. The right side of the System MBean Browser shows the unregisterDriverInstance operation details and parameters.
This image shows the flow of a BPEL 2.0 process.
This image is described in the text immediately below the graphic.
The image shows the Audit Trail page. The following tabs display at the top from left to right: Audit Trail (selected), Flow, Sensor Values, and Faults. Below this and to the right are the Audit Level Settings and View Raw XML links. Below this is the audit trail of each activity in the BPEL process.
The image shows the Delete: Rejected Messages dialog. Below this is a description of the page. Below this is the Common Delete Options radio button (selected). Below this is the Preset Batches list, with a value of Older than 24 Hours selected. Below this is the Delete All radio button. This deletes all rejected messages of this composite. Below this is a Delete All Rejected Messages That Match These Criteria radio button. Below this are fields for Start Time From, and Start Time To. In the lower right are Delete and Cancel buttons.
The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the dc=oracle entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.
The image shows the web service page displaying the following tabs: Dashboard, Policies, Faults, and Properties. The Properties tab is selected and shows the following fields: Append, PhysicalDirectory, FileNamingConvention, and NumberMessages. The Apply and Revert buttons appear at the top right of the tab.
This image shows the following tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages.
In the upper right is the Recent Instances and Faults for the last 10 minutes message.
Below this on the left side is the Recent Composite Instances section. In this section are the Show Only Running Instances checkbox, and the Number of Running Instances checkbox. Below this is a table with the following columns: Instance ID, Composite, and Start Time. To the right is the Deployed Composites section, which includes a table with the following columns: Composite, Status, Mode, Instances, and Faulted Instances. An entry in the Instances tab is selected. A message is displaying that says the following: Click to calculate the number of instances for this composite (You may experience a delay).
The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, Number of Instances link, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, Instance State, and Start Time. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.
The image shows the Associated Drivers section of the Oracle Enterprise Manager displaying the following tabs: Local and All. The All tab is selected and shows the data as a table with the following columns: Name, Driver Type, Status, and Configure Driver.
The image shows the BAM Web Statistics Report Server page. The first area of the page shows the Connections and includes the following fields: Open Connections, Message Rate (per second), and Message Rate Per Connection (second). The second area of the page shows the Reports and includes the Open Reports field. The final area of the page shows the View Sets and includes the following fields: Open and Average Open Time (seconds).
The image shows the Edit Application Role: Report Architect page with pre-seeded BamReportArchitects group in the Roles list.
The image shows the Recovery page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults, Deployed Composites, and Recovery (selected). Below this is the Search section, with fields for Type, Duration, Message State, Composite Name, Component Name, and ECID. To the right are the Search and Reset buttons.
Below this are the Select drop-down list, View drop-down list, Recover button, Mark Cancelled button, and Reset button. Below this is a table with the following columns from left to right: Conversation ID, Recover, Component, Composite, and Time.
This image shows the BPEL Message Recovery Required message. To the right of this is the Show Details button, the Go to BPEL Recovery Console link, the Set Time Threshold button, and Disable Alert button.
The image shows that to select a composite, you must click to the left of the name.
The image shows the Log Messages page. The first section of the page shows the search settings and includes the following drop-down lists: Date Range and Hours. The first area also shows the following checkboxes: Message Types, Incident Error, Error, Warning, Notification, Trace, and Unknown. The first area further shows the following fields: Message, Composite Name, Component Name, Component Instance ID, and Composite Instance ID. The Search and Add Fields buttons appear at the bottom of the first area.
The second section shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message.
The image shows the Cross References screen. The first area of the screen shows the Select Tables and Columns section and includes the following radio buttons: All tables and Select a table and columns. The section also shows the Tables list and Columns checkboxes. The second area of the screen shows the Select Values section and includes the following radio buttons: All, Marked for delete, and Updated between.
The image shows the UMS architecture diagram connecting the WebLogic Server Web Center Instance and WebLogic Server SOA Instance.
The image shows the navigation tree with the SOA node expanded and the soa-infra (soa_server1) node further expanded to show the child nodes. Running SOA composite applications display under the default partition of soa-infra.
This image shows the Number of Instances (for the last 10 minutes) message. The Running Instances field displays the number of running instances. The Total Instances field shows displays the total number of instances. The Recalculate button appears in the lower right corner.
The image shows the Advanced section of the Workflow Task Service Properties screen displaying the following fields: Worklist Application URL, Pushback Assignee, and Portal Realm Mapping. The section also shows the Task Auto Release Configuration as a table with the following columns: Priority, Default Duration, and Percentage of Expiration.
The image shows the View Log File screen for the soa_server1-diagnostic.log file. The first area of the screen shows the Download button. The second area of the screen shows the following fields: Date Range, Start Date, and End Date. The second area also shows the Search button.
The third area of the screen shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message. The fourth area of the screen shows the message details including the following fields: Message Level, ECID, Relationship ID, Component, Module, Message, Host, Host IP Address, User, and Thread ID.
This image shows the details of a fault message for an Oracle Mediator component with resequenced messages.
The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingdriver-email node selected. The right side of the screen shows Message Latency as a graph.
The image shows the Message Status screen for the usermessagingserver. The first area of the screen shows the Search Message Status and includes the following fields: Maximum Messages Displayed, Operation, Overall and Status. The first area also shows the Search and Reset buttons, as well as the Add Fields drop-down menu.
The second area of the screen shows the search results as a table with the following columns: Message ID (Recipient), Recipient, Operation, Overall Status, and Timestamp. The Resend button appears at the top of the table.
The image shows the Oracle BAM start page displaying buttons for launching Oracle BAM Active Viewer, Oracle BAM Active Studio, Oracle BAM Architect, and Oracle BAM Administrator.
The image shows the Open Connections as a graph.
The image shows the Activity Details alert displaying the invokeCR error message with the following text: 'Faulted while invoking operation "process" on provider "CreditRatingService"'. The Close button appears at the bottom right of the alert.
The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Policies, Faults and Rejected Messages, and Properties. Below this is the Instances and Faults graph, which shows the total number of incoming messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.
The image shows the fully-expanded Metric Palette for Oracle BAM Web.
This illustration is described in the text.
This image shows the Create Watch page. Below the title are Back, Next, Finish, and Cancel buttons. Below this is the Add Expression section. The Select an MBean Type from the following list radio button is selected. Below this is the MBean Type list. Below this is the Enter a custom MBean Type radio button. Below this is the Custom MBean types field. Below this are the Back, Next, Finish, and Cancel buttons
This image shows the Delete SOA Partition dialog. A table with the following columns appears: Composite, Status, Mode, Instances Total, Instances Faulted, and Last Modified Date.
This image shows from left to right the Instance ID, Name, Conversion ID, State, Composite Sensors, and Start Time columns.
The image shows the Composite Instances and Faults graph, which shows the total number of instance and faults since the last server startup.
The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Continue button.
The image shows the Operation: setProperty page. A table lists parameters with the following names: key, value, and comment. The key is the name of the property. The value is the value of the property, and the comment is a comment about the property. All are of type java.lang.String. The Value field for key shows b2b.payloadObfuscation. The Value field for value shows true. The Value field for comment is empty.
The image shows the User Message Email Driver drop-down menu with the following menu items: Home, Control, Logs, Performance Summary, Email Driver Properties (selected), System MBean Browser, and General Information.
This image shows a fault message for an Oracle Mediator component with resequenced messages. In this case, the resequencer group is faulted with a message error.
The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Active Data Cache tab is selected and the page shows the following information: View Sets, Threads, Operations Per Second, Average BatchSize for Operations, and Total Transactions.
The image shows the Mediator Service Engine Properties page. You can set value for the following properties displayed from top to bottom on the page: Audit Level, Metrics Level, Parallel Worker Threads, Parallel maximum Rows Retrieved, Parallel Locker Thread Sleep, Error Locker Thread Sleep, Parameters, Container ID Refresh Time, and Container ID Lease Timeout.
The image shows the Log Configuration displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and shows the search information as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), and Log File. The Oracle Diagnostic Logging Level drop-down list is expanded and shows the possible logging levels.
This image is described in the table immediately below this image.
The image shows the information screen for a user, and includes the Person, Attributes, Subtree Access, and Local Access tabs. The Person tab is selected. The first area of the screen shows the following (non-editable) fields: Distinguished Name, Created by, Created at, Modified by, and Modified at. The first area of the Person tab shows the Basic User Information and includes the following fields: User Name, First Name, Last Name, Title, Manager, Employee Number, Email Address, and Upload Photo (with a Browse button). The second area of the Person tab show part of the Contact Information and includes the following fields: Postal Address, Home Postal Address, Telephone Number, and Mobile. At the top right of the screen are the Apply and Revert buttons.
This figure displays the rule execution trace for the Decision Service Component.
The image shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Property Value for the HostName property is selected. The Save button appears above the table.
The image shows the XML Definition: OrderReceivedEvent dialog box showing the Event Definition (EDL). The OK button appears at the bottom right of the dialog box. The dialog box is identical for both EDN-DB and EDN-JMS.
This image shows the following tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages.
Below this is the Recent Composite Instances section. In this section are the Show Only Running Instances checkbox, and the Running and Total counts. Below this is a table with the following columns: Instance ID, Composite, and Start Time. To the right is the Deployed Composites section, which includes a table with the following columns: Composite, Status, Mode, Instances, and Faulted Instances.
The image shows the Policies page. The following tabs display at the top of the page: Dashboard, Policies (selected), Faults and Rejected Messages, and Properties tabs.
Below this is a table with the following columns from left to right: Policy Name, Policy Set, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns fall under a main header of Security Violations.
Below this is the Directly Attached Policies table. Below this is the Attach/Detach button. Below this are the following columns, from left to right, of the Directly Attached Policies table: Policy Name, Category, Policy Reference Status, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns fall under a main header of Security Violations.
The image shows the System MBean Browser with the Application Defined MBeans expanded (several levels) to show the BAMCommonConfig, BAMServerConfig, and BAMWebConfig beans.
The image shows the Faults tab of the Mediator Component Home page. The Search section lets you enter the following details to search for particular faults occurring to the Mediator instances: Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. Below this section is the Show only recoverable faults check box that lets you see only recoverable faults, if selected. Right to this check box is the Fault Type list that lets you select the fault type. The View section displays the following details of all the faults meeting the particular criteria, from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Case, and Logs.
The image shows the Faults and Rejected Messages page. The following tabs display at the top from left to right: Dashboard, Policies, Faults and Rejected Messages (selected), and Properties. Below this is the Search section with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, and Composite Instance ID. The Search and Reset buttons appear to the right. Below this is the Fault Type drop-down list, with All Faults as the selected value. Below this is the View drop-down list and the Delete Rejected Messages button. Below this is a table with the following columns left to right: Error Message, Fault Time, Rejected Message, and Composite Instance ID.
The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Instances, Faults (selected), Policies, and Administration. Below this is the Search section, with fields for Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.
Below this is the Show only recoverable faults checkbox and the Fault Type drop-down list, in which All Faults is selected. Below this are the Select and View drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, and Logs.
The image shows the context menu for the OracleBamWeb node, showing the following menu items: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Logs menu item is expanded to show the following sub-menu items: View Log Messages (selected) and Log Configuration.
The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the cn=Groups entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.
This figure displays how to enable a more detailed rule execution trace report.
The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/soap (selected) and eis/bam/soap1013 sub-nodes. The New and Delete buttons appear below the table.
This image is described in the text immediately above.
The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults (selected), Deployed Composites, and Notification Management. Below this is the Search section, with fields for Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.
Below this is the Show only recoverable faults checkbox and Fault Type drop-down list, in which All Faults is selected. Below this are the Select and View drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, Component Instance ID, and Logs.


14 Managing BPEL Process Service Components and Engines

This chapter describes how to manage BPEL process service components and service engines, including recovering from service component and service engine faults, managing service component policies, performing BPEL process message recovery, and storing instance and callback message data in Oracle Coherence cache.

This chapter includes the following topics:

	
Section 14.1, "Recovering from BPEL Process Service Component Faults"


	
Section 14.2, "Managing BPEL Process Service Component Policies"


	
Section 14.3, "Recovering from BPEL Process Service Engine Faults"


	
Section 14.4, "Performing BPEL Process Service Engine Message Recovery"


	
Section 14.5, "Storing Instance and Callback Message Data in Oracle Coherence Distributed Cache on Oracle Exalogic Platforms"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






14.1 Recovering from BPEL Process Service Component Faults

You can monitor and perform individual and bulk fault recoveries for BPEL process service components that are identified as recoverable. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service component faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Select the BPEL process service component in the Component Metrics section.


	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service component, including the fault ID, error message, whether you can recover from the fault, time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




[image: Description of bpel_comp_faults.gif follows]

Description of the illustration bpel_comp_faults.gif



BPEL process service component faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following methods. Fault recovery selection at the BPEL process service component level equals the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery:

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 6.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery:

	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 6.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 6.

Note: Only the actions applicable to all selected faults are available.














	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to display only faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or Oracle Web Services Manager (OWSM) faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.


	
In the Logs column, click a link to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









14.2 Managing BPEL Process Service Component Policies

You can attach and detach policies to and from BPEL process service components in currently deployed SOA composite applications. Policies apply security to the delivery of messages. Oracle Fusion Middleware uses a policy-based model to manage web services.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.









To manage BPEL process service component policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Select the BPEL process service component in the Component Metrics section.


	
Click Policies.

The Policies page enables you to attach and detach policies to and from BPEL process service components. The Policies section displays the attached policy name, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

[image: Description of bpel_comp_policy.gif follows]
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Click Attach/Detach.

If multiple components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the service or component to which to attach or detach a policy.

This invokes a dialog for attaching or detaching policies.

Policies currently attached appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.


	
Select to attach policies appropriate to your environment.


	
Click Attach.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 7.6, "Managing SOA Composite Application Policies" for the dialogs that are displayed during policy attachment


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment









14.3 Recovering from BPEL Process Service Engine Faults

You can monitor and perform individual and bulk recoveries of faults occurring in BPEL process service engines that are identified as recoverable. All BPEL process service component faults, regardless of the SOA composite application instance of which they are a part, can be viewed in the BPEL process service engine. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service engine faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPEL.




	
	
Right-click soa-infra.


	
Select Service Engines > BPEL.











	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service engine, including the fault ID, the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application and service component in which the fault occurred, and the service component instance ID.




[image: Description of bpel_se_faults.gif follows]
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BPEL process service engine faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. As with fault recovery at the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 5 of Section 14.1, "Recovering from BPEL Process Service Component Faults" for instructions on selecting faults to perform these types of recovery.




	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to only display faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or OWSM faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Component column, click a specific service component to access its home page.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.







For more information, see the following sections:

	
Section 1.4.3.1, "Introduction to Fault Recovery" for conceptual details about faults


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"









14.4 Performing BPEL Process Service Engine Message Recovery

You can perform a manual recovery of undelivered invoke or callback messages due to a transaction rollback in the process instance. Recovery of invoke messages applies to asynchronous BPEL processes only. Synchronous BPEL processes return an error to the calling client and are not recoverable from the Recovery page. Recoverable activities are activities that failed and can be recovered. For example, if you are using the file adapter to initiate an asynchronous BPEL process and your system fails while the instance is processing, you can manually perform recovery when the server restarts to ensure that all message records are recovered. 

You can also manage messages that have failed automatic recovery attempts by the BPEL process service engine. To ensure that automatic recovery of these messages is not attempted multiple times, these messages are placed in the exhausted state. You can then perform one of the following actions on these messages:

	
Return them to the automatic recovery queue


	
Never attempt a recovery on them again


	
Attempt to recover them immediately




For example, assume you have a BPEL process that writes to a database adapter. If the database is down, these messages are sent to a recovery queue. Automatic recovery of these messages fails while the database is down. Such messages are marked with the exhausted state so that automatic recovery is not attempted on them again. When the database begins running again, you can reset these messages (return them to the automatic recovery queue) so that an automatic recovery is attempted on them again.

To perform BPEL process service engine message recovery:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPEL.




	
	
Right-click soa-infra.


	
Select Service Engines > BPEL.











	
Click Recovery.

The Recovery page displays the following details:

	
A Refresh Alarm Table button for resynchronizing lost, in-memory, Quartz-scheduled jobs in the database. For example, assume a timer on a wait activity or on an onAlarm branch of a pick activity was initiated, but the transaction was rolled back. You can resynchronize these jobs with the BPEL instances residing in the wait activity/onAlarm branch in the database. 


	
A utility for searching for a specific message failure by specifying criteria and clicking Search. Click the Help icon for details.

You can enter the execution context ID (ECID) value in the ECID field. The ECID value enables you to track a message flow that crosses instances of different composite applications. If there are BPEL process messages requiring recovery and the AuditConfig property in the System MBean Browser is set to All (the default value), the following message is displayed in the Trace table of the Flow Trace page:


BPEL Message Recovery Required


Clicking Show Details or the recovery icon that appears next to this message displays a Warning dialog with information about the number of invoke, callback, and activity recoverable message types and the ECID value. You can copy the ECID value from the Warning dialog, paste it into the ECID field, and select the recoverable message type from the Type list as part of creating your search criteria on the Recovery page.

For more information, see Section 13.1, "Monitoring the Audit Trail and Process Flow of a BPEL Process Service Component."




	
Note:

Oracle recommends that you add an index on the DLV_MESSAGE.ECID column of the DLV_MESSAGE table to improve SQL query performance when searching messages for a specific ECID value. This is because if there are too many entries in the DLV_MESSAGE table, the search query may be slow and may also overload the database. For information on adding an index, see Chapter "Creating Indexes" of the Oracle Database Administrator's Guide.










	
Message failures in the service engine, including the conversation ID, whether you can recover from the message failure, the service component and composite application in which the failure occurred, and the time at which the fault occurred. Depending on the state, you can recover these messages immediately, cancel these messages, or reset these messages for automatic recovery.




[image: Description of bpel_se_recov.gif follows]
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Notes:

	
You can recover callback messages in resolved and undelivered states. These messages can be displayed for recovery when you execute search criteria in which you select Callback from the Type list and either Resolved or Undelivered from the Message State list. When a callback message first enters the BPEL process service engine, its state is undelivered. When this message is resolved to the target BPEL process instance either through matching a conversation ID or a correlation, the state is switched to resolved. In both of these states, the messages have not yet been consumed. Messages in these two states can be recovered (redelivered into the BPEL process service engine for consumption). In other situations, the callback messages can become stranded in both of these states. Messages in these states can also be recovered. However, there is no guarantee that stranded callback messages always remain in an undelivered state.


	
If you select Invoke from the Type list and Undelivered from the Message State list, and then click Recover, a recovery is performed. However, the Last Modified Date column remains empty for this instance on the Dashboard page of the Oracle BPEL Process Manager service component or service engine. This is the expected behavior. The last modified date is not displayed because the initial Oracle BPEL Process Manager instance (for example, bpel:70004) is created by the first invocation (that is, it is created, but has not yet been modified). The recovery of the undelivered invocation message always creates a new instance (for example, bpel:70005). The previously created instance (bpel:70004) is not used and remains permanently in the same status (the Last Modified Date column is empty). This information is provided for auditing purposes only.


	
The Message States list is applicable only to callback and invoke message type recovery, and not for activity message type recovery.













	
Select a fault in the table.


	
Select one of the following options:


	Action	Description
	
Recover

	
Retries the message in which the fault occurred.

If you select messages in the exhausted state and click this button, an attempt is made to recover them immediately. Should this recovery attempt also fail, the message is returned to the exhausted state. You must then select the message and click Reset to return the message to the automatic recovery queue.

If an asynchronous BPEL process encounters a transaction rollback scenario because of any underlying exception error, it rolls back to the last dehydration activity. If this is a new instance, and a receive activity was the first dehydration activity, the BPEL process service engine creates a recoverable invoke. When you click Recover to recover the invoke, the service engine creates a new instance. This instance may run to completion with no exception error. However, you continue to see the older instance identified as faulted.


	
Mark Cancelled

	
Marks the message so it is never delivered. If you select messages in the exhausted state and click this button, recovery is never attempted on them.

Note: The Recover and Mark Cancelled buttons are enabled in the following situations:

	
For users with the administrator or operator role. These buttons are disabled for users with the monitor role.


	
In the context of a recoverable message. You must select a recoverable message for these buttons to be enabled.




For more information about roles, see Appendix C, "Roles and Privileges."


	
Reset

	
Select to reset exhausted messages to the undelivered state. This returns the message to the automatic recovery queue. The messages that are displayed in the exhausted state disappear from the messages table. If you select Undelivered from the Message State list and click Search, these messages are displayed. Callback messages in the exhausted state can also be reset to the resolved state and still remain recoverable.








Once a message is submitted for recovery, the BPEL process service engine may take time to complete the action. This typically takes less than several seconds. During this time, the message remains visible in the Recovery page. Duplicate attempts to recover the same message in that period are ignored. Refresh the page every few seconds to receive the latest recovery status.




	
Note:

If you define a fault policy in a BPEL process with an ora-retry action and a fault occurs, the BPEL process attempts to recover from the fault the number of times you specified with the retryCount parameter. After this period, the process continues to be in a running state. The status of an activity in the process that has not completed (such as an invoke or receive) shows as pending a manual recovery. This is the expected behavior.









For information about configuring the maximum number of times to attempt an invoke and callback message recovery, see Section 12.4, "Configuring Automatic Recovery Attempts for Invoke and Callback Messages."









14.5 Storing Instance and Callback Message Data in Oracle Coherence Distributed Cache on Oracle Exalogic Platforms

With BPEL processes, a potential performance issue is the number of database interactions required per instance. This factor is the main reason for synchronous transient flows outperforming asynchronous durable flows. You can design around this issue by utilizing synchronous transient flows in situations where low response times are required. However, you may be unable to design this type of flow for business reasons.

If you are running Oracle SOA Suite 11g Release 1 11.1.1.6 on an Oracle Exalogic platform, you can use the distributed cache feature of Oracle Coherence to store instance and callback message data from BPEL processes. This eliminates database reads, thereby reducing the number of database interactions.

Oracle Coherence is a component of Oracle Fusion Middleware that enables organizations to scale mission-critical applications by providing access to frequently used data. Oracle Coherence includes a distributed cache feature that provides scalability for both read and write access. Data is automatically, dynamically, and transparently partitioned across nodes. The distribution algorithm minimizes network traffic and avoids service pauses by incrementally shifting data.

Oracle Exalogic is an integrated hardware and software system designed to provide a platform for a range of application types and varied workloads. Oracle Exalogic is intended for large-scale, performance-sensitive, mission-critical application deployments.




	
Note:

If your environment is not using Oracle Exalogic, Oracle Coherence distributed cache is not available. 









The potential performance gains of using a distributed cache for BPEL processes are as follows:

	
Eliminates the read required for messages (invoke and callback) from the database after initial delivery


	
Eliminates the read required for cube instances after a dehydration point




For more information about Oracle Coherence, see the Oracle Coherence Getting Started Guide and Oracle Coherence Developer's Guide.

For more information about Oracle Exalogic, see the Oracle Exalogic Machine Owner's Guide.


14.5.1 Introduction to the Oracle Coherence Caching Architecture

During dehydration, instance objects are stored in the database using the Java Persistence API (JPA) in a container-managed Enterprise JavaBeans (EJB) transaction. The BPEL process service engine registers the transaction afterCompletion listener for post-transaction processing. Instance objects modified during a transaction are tracked and made available to the afterCompletion listener, which updates the cache. Figure 14-1 provides details about the dehydration process.


Figure 14-1 Dehydration Process

[image: Description of Figure 14-1 follows]
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During rehydration, instance objects are read from cache. JTA implementations do not provide XA guarantees for transaction completion notification, and cache eviction may delete the object from cache. JTA implementations account for these two scenarios and address the issues of cache not returning an object or returning an older version of the object. Figure 14-2 provides details about the rehydration process.


Figure 14-2 Rehydration Process

[image: Description of Figure 14-2 follows]
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If the instance object is not found in cache, it is loaded from the database. In this scenario, cache does not provide any benefits. However, if you configure the correct amount of cache for your environment, this is not common. The correct cache size varies based on your environment. Therefore, Oracle Coherence configuration must be available and you should be able to configure it.

To identify object staleness, the CACHE_VERSION column in the database table is queried and compared to the corresponding cacheVersion object attribute. If the comparison fails, instance objects are loaded from the database. In this scenario, cache provides no benefit. However, this is a rare occurrence.

Cache lookup usually provides a valid object. In this scenario, performance gain for dehydration and rehydration using cache over direct writes (the default) equals the following:


(database read time + relational to object mapping) minus (Object serialization +
reading from serialized form + Coherence network overhead + query to
database for reading CACHE_VERSION)


It also reduces activity on the database server.

If Oracle Coherence cache is not available due to a network issue, the BPEL process service engine continues to work. If there are no errors, business process instances continue to progress. The BPEL process service engine checks for the availability of cache, resuming its usage when it is back online. While cache is unavailable, warning messages are logged and you may notice a decrease in performance.





14.5.2 Running with Default SOA Cluster Nodes and Coherence Cache Grid Nodes

BPEL process caches are not created on an Oracle SOA Suite cluster node. You must start the BPEL cache servers, which host the BPEL caches, by following the instructions in Section 14.5.5, "Starting the BPEL Process Cache Servers." Start at least four servers to observe an increase in performance.There is no requirement for ordering of an Oracle SOA Suite cluster and BPEL cache servers. The BPEL process service engine continues to function without BPEL cache servers, even when the qualityOfService property is set to CacheEnabled in Oracle Enterprise Manager Fusion Middleware Control.

For more information about Oracle Coherence, see the Oracle Coherence Getting Started Guide and Oracle Coherence Developer's Guide.






14.5.3 Configuring Oracle Coherence Caching

The System MBean Browser property QualityOfService enables you to configure Oracle Coherence for dehydration. You must configure this property on all nodes in the SOA cluster.

To configure Oracle Coherence for dehydration:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > BPEL Properties.




	
	
Right-click soa-infra.


	
Select SOA Administration > BPEL Properties.











The BPEL Service Engine Properties page is displayed.


	
Click More BPEL Configuration Properties.


	
In the Attributes tab, click QualityOfService.


	
In the Value field, enter a value appropriate to your environment. This change does not require a SOA Infrastructure restart.


Table 14-1 qualityOfService Values

	Value	Description
	
DirectWrite

	
No cache is used for dehydration and rehydration. Read and write operations are done to the database. This is the default setting.


	
CacheEnabled

	
During dehydration, the instance data is stored in the database using an XA data source connection; the placement of objects into cache is part of post-transaction processing.

During rehydration, data is fetched from the cache. If the data is not found (for example, the BPEL process cache servers are not available) or the version is stale, data is read from the database.








	
Click Apply.









14.5.4 Configuring the Storage of Multiple Audit Trail Messages in One Transaction

For asynchronous flows, performance gains can be achieved by storing multiple audit messages in one transaction. To improve performance, you can store multiple audit trail messages (across instances) in a single transaction by setting the System MBean browser property AsynchAuditBatchSize in Oracle Enterprise Manager Fusion Middleware Control. 

Setting this property to an appropriate value reduces audit trail transaction commits. Instead, a commit is only performed when a specified limit is reached.

To configure the storage of multiple audit messages in one transaction:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > BPEL Properties.




	
	
Right-click soa-infra.


	
Select SOA Administration > BPEL Properties.











The BPEL Service Engine Properties page is displayed.


	
Click More BPEL Configuration Properties.


	
In the Attributes tab, click AsynchAuditBatchSize.


	
In the Value field, enter a value appropriate to your environment. The default value of -1 indicates that there is no audit trail message batching. Each audit message is persisted in its own transaction.

The recommended value range is 5 to 25. For example, if you set this property to 8, this indicates that when eight audit trail messages have accumulated, a transaction is created with these messages and committed to the dehydration store.

This parameter only impacts Oracle Exalogic environments. For other environments, it is not operational.

This change does not require a SOA Infrastructure restart.


	
Click Apply.









14.5.5 Starting the BPEL Process Cache Servers

You must run the start-bpel-cache.sh. script to start the BPEL process cache servers. This script must be run on UNIX platforms. This script is independent of the SOA cluster. It can be on the same node as the SOA cluster nodes or on a completely different host. The only requirement is network connectivity. The Oracle SOA Suite nodes must be reachable from the host on which the BPEL process cache servers are installed.

This script joins an Oracle SOA Suite cluster with a multicast, default address and port. These values match with the corresponding values in the $FMW_HOME/user_projects/domains/domain_name/bin/setDomainEnv.sh or setDomainEnv.bat file.

If you choose multicast for a cluster, but use a different address and port, you can override it in the bpelCacheEnv.sh file by using an environment variable or setting a shell variable. Use the same values for SOA managed servers (setDomainEnv.sh or setDomainEnv.bat).

The default cache configuration for the Oracle SOA Suite cluster must be unicast, and not multicast. For more information about this recommended cache configuration for Oracle SOA Suite clusters for Oracle Coherence, see the Oracle Fusion Middleware High Availability Guide or Oracle Fusion Middleware Enterprise Deployment Guide for Oracle SOA Suite for details.

To start the BPEL process cache servers:

	
Go to the $FMW_HOME/SOA_ORACLE_HOME/bin directory.


	
Open the start-bpel-cache.sh file.


	
Follow the instructions inside this file to create the bpelCacheEnv.sh file and configure various environment variables.

Environment/shell variable names and value formats are described in the initial notes section of the start-bpel-cache.sh file.


	
Ensure that you first set the QualityOfService property to CacheEnabled in Oracle Enterprise Manager Fusion Middleware Control, as described in Section 14.5.3, "Configuring Oracle Coherence Caching."


	
Go to the $FMW_HOME/SOA_ORACLE_HOME/bin directory.


	
Run the following script:


start-bpel-cache.sh














29 Configuring Oracle JCA Adapters

This chapter describes how to configure inbound and outbound end point properties during runtime for Oracle JCA adapters.

This chapter includes the following topics:

	
Section 29.1, "Configuring the End Point Properties for an Inbound Adapter"


	
Section 29.2, "Configuring the End Point Properties for an Outbound Adapter"






29.1 Configuring the End Point Properties for an Inbound Adapter

This section describes how to configure the end point properties for an inbound adapter. It includes the following topics:

	
Section 29.1.1, "Editing a Predefined Property for an Inbound Adapter"


	
Section 29.1.2, "Adding Predefined Properties for an Inbound Adapter"


	
Section 29.1.3, "Creating a New Property for an Inbound Adapter"


	
Section 29.1.4, "Deleting a Property for an Inbound Adapter"


	
Section 29.1.5, "Reverting a Property Value for an Inbound Adapter"






29.1.1 Editing a Predefined Property for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible edit the predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To edit a predefined property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Edit a predefined property:

	
Click Properties to see a list of the currently defined binding properties.


	
Select the property you want to edit.


	
Edit the value in the Value text box, and then click Save.

You have edited a predefined property for an inbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.1.2 Adding Predefined Properties for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.




	
Note:

Though the Properties page list both endpoint and the binding properties, you can only add endpoint properties.









To add a predefined property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Add a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Click the Select Values icon in the Name field of the new row.

The Properties dialog is displayed.


	
Select a property that is valid for the particular adapter from the list of properties, and then click OK.


	
Click Save.

You have added a predefined property for an inbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.1.3 Creating a New Property for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add new properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To create a new property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Create a new property:

	
Click the Properties tab to see the list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Specify the property name and value in the Name and the Value fields of the new row.


	
Click Save.

You have created a new property for an inbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.1.4 Deleting a Property for an Inbound Adapter

You can delete only properties that you added from the predefined list of properties or the ones that you newly created.

To delete a property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Delete a property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to delete, and then click Delete.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have deleted a property for an inbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.1.5 Reverting a Property Value for an Inbound Adapter

You can only revert the properties that you have changed. Also note that you can perform the revert operation only on the existing property values and not on those that you added from the predefined list of properties or the ones that you created.

To revert a property value for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Revert a property value for an inbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to revert, and then click Revert.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have reverted a property value for an inbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.








29.2 Configuring the End Point Properties for an Outbound Adapter

This section describes how to configure the end point properties for an outbound adapter. It includes the following topics:

	
Section 29.2.1, "Editing a Predefined Property for an Outbound Adapter"


	
Section 29.2.2, "Adding a Predefined Property for an Outbound Adapter"


	
Section 29.2.3, "Creating a New Property for an Outbound Adapter"


	
Section 29.2.4, "Deleting a Property for an Outbound Adapter"


	
Section 29.2.5, "Reverting a Property Value for an Outbound Adapter"






29.2.1 Editing a Predefined Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to edit the predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To edit a predefined property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Edit a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to edit.


	
Edit the value in the Value text box, and then click Save.

You have edited a predefined property for an outbound adapter.










	
Note:

For Oracle MQ Series Adapter in an asynchronous outbound request/reply scenario, properties are differentiated by an (Enqueue) or (Dequeue) label. For example, QueueName(Enqueue) is used for putting a message and QueueName(Dequeue) is used for dequeuing the reply.

When editing Oracle MQ Series Adapter properties in this scenario, note the following:

	
If you change the ReplyToQueueName(Enqueue) property, you must also change the QueueName(Dequeue) property to the same value.


	
If you change the MessageId(Dequeue) property, you must also change the MessageId(Enqueue) property to the same value.


	
If you change the CorrelationId(Dequeue) property, you must also change the CorrelationId(Enqueue) property to the same value.












For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.2.2 Adding a Predefined Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To add a predefined property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Add a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Click the Select Value icon in the Name field of the new row.

The Properties dialog is displayed.


	
Select a property that is valid for the particular adapter from the list of properties, and then click OK.


	
Click Save.

You have added a predefined property for an outbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.2.3 Creating a New Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add new properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To create a new property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Create a new property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Specify the property name and value in the Name and the Value fields of the new row.


	
Click Save.

You have created a new property for an outbound adapter.







For more information about configuring adapters, seeSection 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.2.4 Deleting a Property for an Outbound Adapter

You can delete only properties that you added from the predefined list of properties or the ones that you newly created.

To delete a property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Delete a property for an outbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to delete, and then click Delete.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have deleted a property for an outbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






29.2.5 Reverting a Property Value for an Outbound Adapter

You can revert changes made, if any, only for the already existing property values and not those that you added from the predefined list of properties or the ones that you newly created.

To revert a property value for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Click Home.

The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	
Under soa-infra, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Revert a property value for an outbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to revert, and then click Revert.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have reverted a property value for an outbound adapter.







For more information about configuring adapters, see Section 34.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.










35 Monitoring Service and Reference Binding Components

This chapter describes how to monitor service and reference binding components in SOA composite applications, including monitoring instances, faults, and rejected messages.

This chapter includes the following topics:

	
Section 35.1, "Monitoring Binding Component Instances and Faults"


	
Section 35.2, "Monitoring Binding Component Rejected Messages"




For more information, see the following documentation:

	
Section 1.2.5, "Introduction to Binding Components" for conceptual details about binding components


	
Part XII, "Administering Oracle B2B" for details about Oracle B2B


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






35.1 Monitoring Binding Component Instances and Faults

You can monitor instances and faults for all binding components included in SOA composite applications.

To monitor binding component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click Dashboard (if it is not selected).


	
Select a specific service or reference in the Services and References section.


	
If you select a service that is a JCA adapter or web service, the Dashboard page displays the following details:

	
A graphic representation of the total incoming messages and faults since server startup.


	
Recently rejected messages, including the message name, time of the fault, and type of fault (business or system).




[image: Description of bc_dashboard.gif follows]

Description of the illustration bc_dashboard.gif



	
If you select a service that invokes a SOA composite application through a remote RMI call (known as direct binding), the Dashboard page displays similar details as described in Step 5. Direct binding enables SOA composite applications to be invoked through an API that supports transaction and security propagation across JVMs.

The word Direct is displayed in the header to indicate that this is a direct binding component. However, no Polices and Properties tabs are available for direct binding components.

[image: Description of bc_direct.gif follows]

Description of the illustration bc_direct.gif



	
If you select a reference, the Dashboard page displays the following details:

	
A graphic representation of the total outgoing messages and faults since server startup.


	
Recent faults, including the time of the fault and the type of fault (business or system).




Reference binding components are only available for JCA adapters and web services.

[image: Description of bc_dashboard3.gif follows]
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35.2 Monitoring Binding Component Rejected Messages

You can monitor rejected messages for all binding components included in a SOA composite application.

To monitor binding component rejected messages:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Select a service or reference in the Services and References section.


	
Click Faults and Rejected Messages.

The Faults and Rejected Messages page shows the list of faults and rejected messages, including details such as the error message, time of the fault, and the associated composite instance ID. Depending upon the type of the binding component selected, the faults can be on the incoming messages processed by a service binding component or outgoing messages processed by a reference binding component.

You can perform fault recovery from this page.

[image: Description of bc_rejectedmess.gif follows]

Description of the illustration bc_rejectedmess.gif



	
Click a specific message in the Error Messages column to display complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to perform fault recovery.


	
If you want to delete rejected messages., click Delete Rejected Messages.


	
This displays a dialog for specifying criteria for deleting rejected messages.

[image: Description of bc_delrejectmess.gif follows]

Description of the illustration bc_delrejectmess.gif



	
Specify criteria, and click Delete.









28 Managing Oracle User Messaging Service

This chapter describes how to deploy Oracle User Messaging Service (UMS) drivers by using Oracle WebLogic Scripting Tool (WLST), Oracle Enterprise Manager Fusion Middleware Control, Oracle Fusion Middleware Configuration Wizard, and the wsadmin utility of IBM WebSphere Application Server. It also describes how to undeploy and register Oracle UMS drivers.

This chapter includes the following topics:

	
Section 28.1, "Deploying Drivers"


	
Section 28.2, "Undeploying and Unregistering Drivers"






28.1 Deploying Drivers

When you install Oracle UMS, preinstalled drivers are included (Email, XMPP, SMPP, and VoiceXML). Among these drivers, only the Email driver is deployed to the WebLogic Server. To deploy other drivers, target that driver to the WebLogic Server (using Oracle WebLogic Server Administration Console, or you can target the drivers when creating or extending the domain using the Oracle Fusion Middleware Configuration Wizard).

The Worklist driver must be deployed to a SOA Server to make use of the UMS integration with Worklist. Because this integration involves multiple JEE applications and a SOA composite, there is a special extension template you must use to enable this feature in one step. See Install the Worklist Driver on the Oracle WebLogic Server Platform and Install the Worklist Driver on IBM WebSphere Platform for more information.

You can deploy additional drivers in a variety of ways using: WLST commands (recommended), wsadmin tool, Oracle Enterprise Manager Fusion Middleware Control, and through the Oracle Fusion Middleware Configuration Wizard.

The section includes the following topics:

	
Section 28.1.1, "Deploying Drivers Using WLST Commands"


	
Section 28.1.2, "Deploying Drivers Using Oracle Enterprise Manager Fusion Middleware Control"


	
Section 28.1.3, "Deploying Drivers Using the Oracle Fusion Middleware Configuration Wizard"


	
Section 28.1.4, "Deploying Drivers Using the wsadmin Tool"







	
Note:

To deploy two or more driver instances of a particular driver EAR, you must use the custom deployment plan templates available at $ORACLE_HOME/communications/plans. Deploying drivers using WLST commands is recommended because these commands automatically modify your deployment plans for you; using other methods requires you to manually modify your deployment plans.











28.1.1 Deploying Drivers Using WLST Commands

You can deploy drivers using the WLST command deployUserMessagingDriver.



28.1.1.1 deployUserMessagingDriver

Command Category: UMS

Use with WLST: Online



28.1.1.1.1 Description

deployUserMessagingDriver is used to deploy additional instances of user messaging drivers.Specify a base driver type (for example: email, xmpp, voicexml, and others) and a short name for the new driver deployment. The string usermessagingdriver- is prepended to the specified application name. Any valid parameters for the deploy command can be specified, and is passed through when the driver is deployed.






28.1.1.1.2 Syntax


deployUserMessagingDriver(baseDriver, appName, [targets],
[stageMode], [options])



	Argument	Definition
	
baseDriver

	
Specifies the base messaging driver type.

Must be a known driver type, such as email, proxy, smpp, voicexml, or xmpp.


	
appName

	
A short descriptive name for the new deployment. The specified value is prepended with the string usermessagingdriver-.


	
targets

stageMode

options

	
Optional. Additional arguments that are valid for the deploy command can be specified and passed through when the new driver is deployed.












28.1.1.1.3 Examples

To deploy a second instance of an email driver with name myEmail.


wls:/base_domain/serverConfig> deployUserMessagingDriver(baseDriver='email',
appName='myEmail')


To deploy a second instance of an email driver, specifying deployment targets.


wls:/base_domain/serverConfig> deployUserMessagingDriver(baseDriver='email',
appName='email2', targets='server1,server2')










28.1.2 Deploying Drivers Using Oracle Enterprise Manager Fusion Middleware Control

To deploy drivers using Oracle Enterprise Manager Fusion Middleware Control:

	
Retrieve a deployment template (for example: ORACLE_HOME/communications/plans)


	
Copy the plan to a location of your choice (to the same directory or any other directory).


	
Edit the plan:

Replace DriverDeploymentName with whichever name you want to use (ensure you replace all instances of the name).

Replace DriverShortName with any name you like.

Replace the @RunAsPrincipalName@ token with a valid principal for use by UMS. In a default deployment, the system principal OracleSystemUser is available for this purpose.


	
Start Oracle Enterprise Manager Fusion Middleware Control.


	
Enter the location of the .ear file.

[image: Deploying UMS Drivers using EM]
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Click Next.

The Select Target page appears.


	
Enter the location of the deployment plan.

[image: Select Target screen]

Description of the illustration ns_dep2.gif



	
Select the SOA target.


	
Enter an application name in the Application Attributes page. The application name must exactly match the string used for DriverDeploymentName (in Step 3 above) which is provided in the deployment plan. If it does not, the deployment and activation fails. The Deployment Setting page appears.

[image: Description of ns_dep3.gif follows]

Description of the illustration ns_dep3.gif



	
Click Deploy. The Deployment Completed page appears.

[image: Deployment Complete screen]

Description of the illustration ns_dep4.gif



	
To see the result (driver deployed), start the SOA Server.









28.1.3 Deploying Drivers Using the Oracle Fusion Middleware Configuration Wizard

To install the SMPP, XMPP, and VoiceXML drivers, extend the domain using the extension template available at $ORACLE_HOME/common/templates/applications/oracle.ums.drivers_template_11.1.1.jar.To extend a domain using Oracle Fusion Middleware Configuration Wizard:

	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/config.sh or %ORACLE_HOME%\common\bin\config.cmd).


	
Select the Extend an existing WebLogic domain option.


	
Select the desired domain directory containing UMS.


	
Select the Extend my domain using an existing extension template option.


	
Click Browse, and navigate to $ORACLE_HOME/common/templates/applications


	
Select oracle.ums.drivers_template_11.1.1.jar.


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard, and remember to target the required drivers to the desired Oracle WebLogic Servers, clusters, or both.


	
Restart the appropriate Oracle WebLogic Servers.









28.1.4 Deploying Drivers Using the wsadmin Tool

You can deploy additional instances of UMS drivers by using the Oracle Fusion Middleware-specific wsadmin command OracleUMS.deployUserMessagingDriver.


28.1.4.1 About the wsadmin OracleUMS.deployUserMessagingDriver Command

This section describes the syntax and arguments for the wsadmin OracleUMS.deployUserMessagingDriver command.


28.1.4.1.1 Description

OracleUMS.deployUserMessagingDriver is used to deploy additional instances of user messaging drivers.

Specify a base driver type (email, xmpp, smpp, voicexml, proxy, or worklist) and a short name for the new driver deployment. The string "usermessagingdriver-" is prepended to the specified application name.





28.1.4.1.2 Syntax


OracleUMS.deployUserMessagingDriver(baseDriver, appName, required_options)



	Argument	Definition
	
baseDriver

	
Specifies the base messaging driver type.

Must be a known driver type, such as email, proxy, smpp, voicexml, 'proxy', or 'worklist'.


	
appName

	
A short descriptive name for the new deployment. The specified value is prepended with the string usermessagingdriver-.


	
required_options

	
Additional arguments that are valid for the "AdminApp.install" command.

These options are mandatory for this command:

-node, -cell, -server, -usedefaultbindings, and -defaultbinding.virtual.host








Example:


OracleUMS.deployUserMessagingDriver('email', 'myEmail', '-node myNode -cell myCell
 -server myServer -usedefaultbindings -defaultbinding.virtual.host default_host')


where:

email and myEmail represent values for the baseDriver and appName arguments respectively.

-node, -cell, -server, -usedefaultbindings, -defaultbinding.virtual.host are the required options. myNode, myCell, myServer and default_host represent the values of respective options.





28.1.4.1.3 Examples

To deploy a second instance of an email driver with name "smpp2" on a SOA Server named "soa_server1":


wsadmin> OracleUMS.deployUserMessagingDriver('smpp','smpp2','-node DefaultNode01
 -cell DefaultCell01 -server soa_server1 -usedefaultbindings
 -defaultbinding.virtual.host default_host')


To deploy a second instance of an email driver with name "email2" on a BAM Server named "bam_server1":


wsadmin> OracleUMS.deployUserMessagingDriver('email','email2','-node DefaultNode01
 -cell DefaultCell01 -server bam_server1 -usedefaultbindings
 -defaultbinding.virtual.host default_host')







28.1.4.2 Deploying an Additional Driver

To deploy the UMS drivers by using the wsadmin tool, do the following:

	
Open a browser and enter the following URL to access the IBM WebSphere Administrative Console (also known as IBM WebSphere Integrated Solutions Console):


https://hostname:SSL Port/ibm/console


	
Log in to the administration console by using the administrator name and password.


	
Navigate to System administration > Deployment manager > Configuration > Ports > BOOTSTRAP_ADDRESS and identify the corresponding port number.

[image: Description of ns_wsadmin.gif follows]
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On the system where Oracle SOA server is running, set the ORACLE_HOME environment variable to the location where Oracle Fusion Middleware SOA component is installed. You should set this variable before running the wsadmin command.

For example,

On UNIX platform, run the following command in the UNIX shell:


$ export ORACLE_HOME=/fmwwas-nd/middleware/Oracle_SOA1


On Windows platform, run the following command in the DOS shell:


C:\> set ORACLE_HOME=C:\fmwwas-nd\middleware\Oracle_SOA1


	
From the ORACLE_HOME\common\bin folder, run the wsadmin command. Specify the RMI port number (see Step 2) as the value for the -port option.



On UNIX:


ORACLE_HOME/common/bin/wsadmin.sh 
      -profileName profilename
      -connType RMI
      -host hostname
      -port RMI_port
      -user admin_user
      -password admin_password


On Windows:


ORACLE_HOME\common\bin\wsadmin.cmd 
      -profileName profilename
      -connType RMI
      -host hostname
      -port RMI_port
      -user admin_user
      -password admin_password


	
To view the list of enterprise applications and drivers that are already deployed, run the wsadmin command as follows:



wsadmin>print AdminApp.list()
    DMS Application_11.1.1.1.0
    DefaultToDoTaskFlow
    Dmgr DMS Application_11.1.1.1.0
    FMW Welcome Page Application_11.1.0.0.0
    User Messaging Parlay X Sample App
    composer
    em
    oracle-bam
    soa-infra
    usermessagingdriver-email
    usermessagingdriver-smpp
    usermessagingdriver-voicexml
    usermessagingdriver-xmpp
    usermessagingserver
    worklistapp
    wsil-nonwls
    wsm-pm 


	
Run the OracleUMS.deployUserMessagingDriver command to deploy the UMS driver(s) as follows:


wsadmin> OracleUMS.deployUserMessagingDriver('email','email01','-node
DefaultNode01 -cell DefaultCell01 -server soa_server1 -usedefaultbindings
-defaultbinding.virtual.host default_host')
 


	
To verify that the newly deployed UMS driver(s) is listed along with the rest of enterprise applications and drivers, run the following command:


wsadmin>print AdminApp.list()
DMS Application_11.1.1.1.0
    DefaultToDoTaskFlow
    Dmgr DMS Application_11.1.1.1.0
    FMW Welcome Page Application_11.1.0.0.0
    User Messaging Parlay X Sample App
    composer
    em
    oracle-bam
    soa-infra
    usermessagingdriver-email
    usermessagingdriver-email-email01
    usermessagingdriver-smp
    usermessagingdriver-voicexml
    usermessagingdriver-xmpp
    usermessagingserver
    worklistapp
    wsil-nonwls
    wsm-pm 


Make sure that the newly deployed UMS drivers(s) is listed. In the above example, usermessagingdriver-email-email01 is the new driver.




For more information about using the wsadmin utility to configure Oracle Fusion Middleware products, see Oracle Fusion Middleware Configuration Guide for IBM WebSphere Application Server. For more information about managing Oracle SOA Suite on IBM WebSphere, see Oracle Fusion Middleware Third-Party Application Server Guide.










28.2 Undeploying and Unregistering Drivers

Since Messaging Drivers are standard JEE applications, they can be undeployed from the Oracle WebLogic Server using standard Oracle WebLogic tools such as the Administration Console or WLST.

However, since the UMS server keeps track of the messaging drivers that have been registered with it in a persistent store (database), this registration must be cleaned in a separate step using a runtime MBean exposed by the UMS server. The procedure to do this from Oracle Enterprise Manager Fusion Middleware Control is as follows.

To undeploy and unregister drivers:

	
Ensure the UMS server is available.


	
In Oracle Enterprise Manager Fusion Middleware Control, select any usermessagingserver target in the domain.


	
From the target's menu, select System MBean Browser.


	
In System MBean Browser, locate the ComponentAdministration MBean of usermessagingserver:

Expand the folder com.oracle.sdp.messaging > Server (such as Server: soa_server1) > SDPMessagingrun time > ComponentAdministration.


	
Invoke the operation listDriverInstances.

	
Click the Operations tab.


	
Click the operation listDriverInstances.


	
Click Invoke.


	
Identify and copy the name of the driver you want to unregister. (for example: /Farm_soa_bam_domain/soa_bam_domain/soa_server1/usermessagingdriver-email:oracle_sdpmessagingdriver_email#Email-Driver)




[image: list driver in EM]
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Click Return.


	
Invoke the operation unregisterDriverInstance with the desired driver name.

	
Click the operation unregisterDriverInstance.


	
Paste the driver name in the Value field (for example: /Farm_soa_bam_domain/soa_bam_domain/soa_server1/usermessagingdriver-email:oracle_sdpmessagingdriver_email#Email-Driver).


	
Click Invoke.
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Check the confirmation dialog for success.




This completes the unregistration of the specified driver from the UMS server and it is no longer used in future message delivery.








Part III


Administering the SOA Infrastructure

This part describes how to administer the SOA Infrastructure.

This part includes the following chapters:

	
Chapter 3, "Configuring the SOA Infrastructure"


	
Chapter 4, "Monitoring the SOA Infrastructure"






Part I



Introduction to Oracle SOA Suite and Oracle Business Process Management Suite

This part describes Oracle SOA Suite and Oracle Business Process Management Suite.


This part includes the following chapter:

	
Chapter 1, "Introduction and Concepts"







2 Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite

This chapter describes how to log in to and navigate the menus of Oracle Enterprise Manager Fusion Middleware Control to perform Oracle SOA Suite and Oracle BPM Suite configuration, monitoring, and management tasks. It also describes how to access Oracle WebLogic Server Administration Console from Oracle Enterprise Manager Fusion Middleware Control.

This chapter includes the following topics:

	
Section 2.1, "Logging In to Oracle Enterprise Manager Fusion Middleware Control"


	
Section 2.2, "Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks"


	
Section 2.3, "Logging Out of Oracle Enterprise Manager Fusion Middleware Control"




For more information about service engines, service components, binding components, and the SOA Infrastructure, see Chapter 1, "Introduction and Concepts."



2.1 Logging In to Oracle Enterprise Manager Fusion Middleware Control

This section describes how to log in to Oracle Enterprise Manager Fusion Middleware Control.

To log in to Oracle Enterprise Manager Fusion Middleware Control:

	
Use Microsoft Internet Explorer 7, Mozilla Firefox 2.0.0.2, Apple Safari 4.0, or Mozilla Firefox 3.0.x to access the following URL:


http://host_name:port/em


Where host_name is the name of the host on which Oracle Enterprise Manager Fusion Middleware Control is installed and port is a number that is dynamically set during installation. This port is typically 7001, but is the HTTP port associated with Oracle HTTP Server. For environments in which the SSL port was enabled during configuration, the default port is 7002.


	
Enter weblogic/password and click Login.

where:

	
weblogic is the default administrator user name for Oracle Enterprise Manager Fusion Middleware Control (you can change this during installation).


	
password is the password you entered during Oracle SOA Suite installation.




The Accessibility Preference dialog appears the first time you log in. If you want, you can select to not display this dialog again.


	
Select an appropriate action and click Continue.

The farm home page is displayed. From there, you can navigate to Oracle SOA Suite and Oracle BPM Suite in several different ways, as described in the following sections.




For more information about installation, see Oracle Fusion Middleware Installation Guide for Oracle SOA Suite and Oracle Business Process Management Suite.






2.2 Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks

This section describes methods for navigating to Oracle SOA Suite and Oracle BPM Suite administration tasks in Oracle Enterprise Manager Fusion Middleware Control:

	
Section 2.2.1, "Navigating Through the SOA Infrastructure Home Page and Menu"


	
Section 2.2.2, "Navigating Through the SOA Composite Application Home Page and Menu"


	
Section 2.2.3, "Navigating Through the Partition Home Page and Menu"


	
Section 2.2.4, "Navigating to Deployed Java EE Applications"


	
Section 2.2.5, "Navigating to the Oracle WebLogic Server Administration Console and Other Pages"


	
Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page"







	
Note:

The Farm menu is always displayed at the top of the navigator. As you expand the SOA folder in the navigator and click the links displayed beneath it, the SOA Infrastructure menu becomes available at the top of the page.











2.2.1 Navigating Through the SOA Infrastructure Home Page and Menu

You can navigate to Oracle SOA Suite and Oracle BPM Suite administration tasks through the SOA Infrastructure home page and menu. The SOA Infrastructure provides you with access to all deployed SOA composite applications, service engines, service components, business events, and other elements.

To navigate through the SOA Infrastructure home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Expand the specific partition (for example, default).

This displays all SOA composite applications running in the selected partition of the SOA Infrastructure for that managed server. Composites are grouped into the partition in which they are deployed.

[image: Description of sca_soamenu2.gif follows]
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Click soa-infra.

This displays the Dashboard page of the SOA Infrastructure. Click the help icon at the top of this page to access the Resource Center for the entire Oracle SOA Suite. The upper part of the page displays details about recently deployed SOA composite application instances, deployed composites, recent faults, and rejected messages. You can click a specific SOA composite application name or instance ID to access additional details. You can also click Show All at the bottom of each section to see more information about all items.

[image: Description of gs_soahomepage.gif follows]
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The lower part of the page displays details about the service engines provided by the SOA Infrastructure and a graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure. You must expand these sections to see this information. Click a service engine name to access more specific details.


	
Note that the SOA Infrastructure menu appears below the soa-infra name at the top of the page.




	
Note:

Depending upon your current location, the context of this menu changes to provide you with the administrative options most relevant to your current location. For example, when you are within the pages of a SOA composite application, the SOA Composite menu is displayed, or on the home page of a specific partition, the SOA Partition menu is displayed.










	
Select the SOA Infrastructure menu.
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These administrative options enable you to perform the following tasks:


	Option	Description
	
Home

	
This option displays the following details for the SOA Infrastructure Dashboard page:

	
Recent SOA composite application instances.


	
Deployed SOA composite details (status, instance, and fault counts).


	
Recent faults and rejected messages in all SOA composite application instances, including whether the instance is recoverable.


	
Number of components hosted by service engines and the faults in those components.


	
Graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure.




For more information, see Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites."


	
Monitoring

	
This option displays the following details:

	
A summary of performance statistics in the SOA infrastructure.


	
Request processing details that show the breakup of time spent in handshaking requests between the binding components, service infrastructure, and service engines.




For more information, see Section 4.2, "Monitoring Message Delivery Processing Requests."


	
Logs

	
This option enables you to view and configure the logging levels for runtime loggers.

For more information, see Section 3.4, "Configuring Log Files" and Section B.1, "Setting Logging Levels for Troubleshooting."


	
SOA Deployment

	
This option enables you to deploy, undeploy, or redeploy SOA composite applications.

For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Manage Partitions

	
This option enables you to logically group your SOA Infrastructure into separate sections known as partitions in which you deploy your SOA composite applications. This helps you to logically group composites so that you can perform bulk lifecycle management tasks on large numbers of composites.

For more information, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Service Engines

	
This option provides access to monitoring and management tasks for the BPEL process, Oracle BPMN, Oracle Mediator, human workflow, and business rules service engines.


	
Bindings

	
This option displays details about recently active document types and trading partners, and inbound and outbound end points for Oracle B2B.

For more information, see Section 32.1, "Monitoring the Oracle B2B Infrastructure."


	
Services and References

	
This option displays message processing metrics for service and reference binding components in all SOA composite applications.

For more information, see Section 4.3, "Monitoring Service and Reference Binding Components in the SOA Infrastructure."


	
Business Events

	
This option displays available business events, current event subscribers, and fault details.

For more information, see Chapter 33, "Managing Business Events."


	
SOA Administration

	
This option provides access to the following configuration tasks for the SOA Infrastructure and each service engine:

	
Common Properties: For setting properties that impact the entire SOA Infrastructure, such as viewing and setting the SOA Infrastructure audit level, capturing the state of the SOA composite application instance, enabling the payload validation of incoming messages, specifying the callback server and server URLs, setting Universal Description, Discovery and Integration (UDDI) registry properties, viewing the data source JNDI locations, setting the nonfatal connection retry count, setting web service binding properties, and optimizing the loading performance of pages.

For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."


	
BPEL Properties: For setting the audit trail size, maximum document size for a variable, payload validation for incoming and outgoing messages, audit trail level, BPEL monitor and sensor disabling status, and dispatcher thread level for invoke message threads, system threads, and service engine threads.

For more information, see Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
BPMN Properties: For setting the audit trail size, maximum document size for a variable, payload validation for incoming and outgoing messages, audit trail level, and dispatcher thread level for invoke message threads, system threads, and service engine threads.

For more information, see Section 37.1, "Configuring BPMN Process Service Engine Properties"


	
Mediator Properties: For setting the audit level, metrics level, number of parallel worker threads, number of maximum rows retrieved for parallel processing, parallel thread sleep values, error thread sleep values, container ID refresh time, and container ID lease timeout values.

For more information, see Section 15.1, "Configuring Oracle Mediator Service Engine Properties."


	
Workflow Config: Displays the following tabs:

Mailer tab: For setting the workflow service notification mode and actionable email address value. For more information, see Section 20.1, "Configuring Human Workflow Notification Properties."

Task tab: For setting the actionable email account, adding the worklist application URL, selecting the pushback assignee, adding portal realm mapping, and adding the task auto release configuration priority. For more information, see Section 20.2, "Configuring Human Workflow Task Service Properties."


	
B2B Server Properties: For enabling Dynamic Monitoring Service (DMS) metrics.


	
Cross References: For selecting cross-reference values. For more information, see Section 18, "Managing Cross-References."





	
Security

	
This option displays the following selections:

	
Application Policies: For creating application policies that an application relies upon for controlling access to resources.


	
Application Roles: For creating application roles for applications.

For more information about application roles, see Oracle Fusion Middleware Application Security Guide.




This option is available for all deployed Java EE applications, including the SOA Infrastructure (soa-infra) application. These options do not configure security policies for SOA composites.

For more information about attaching policies to composite applications, see Section 7.6, "Managing SOA Composite Application Policies."


	
Administration

	
This option displays the following selections:

	
MDS Connections: For managing metadata service (MDS) connections.


	
TopLink Sessions: For managing cache for the Oracle TopLink persistence framework.


	
System MBean Browser: For advanced configuration of properties across applications and components.

For more information, see Oracle Fusion Middleware Administrator's Guide for instructions on using the System Mean Browser.

In addition to configuring the System MBean Browser from Oracle Enterprise Manager Fusion Middleware Control, you also can invoke SOA configuration MBean operations with the WebLogic Scripting Tool (WLST). For information, see Oracle Fusion Middleware Oracle WebLogic Scripting Tool. 

Note: The System MBean Browser includes an MBean for Oracle BPMN, even if Oracle BPM Suite is not installed. If Oracle BPM Suite is not installed, this MBean cannot be used, and should be ignored. The presence of this MBean does not impact the runtime behavior of other Oracle SOA Suite components.





	
General Information

	
This option displays general details about the SOA Infrastructure, such as the Oracle Enterprise Manager Fusion Middleware Control version, Oracle home, and Oracle instance.











	
Note:

Starting with 11g Release 1 (11.1.1.4.0), you can no longer stop and start the SOA Infrastructure from the SOA Infrastructure menu.










	
Select a specific SOA composite application from the soa-infra list shown in Step 2.

The SOA Infrastructure menu is now displayed above the navigator, providing you with access to the same high-level administrative options, even when you are within the pages of a SOA composite application. This menu changes positions when you select a composite application.

[image: Description of soainfra_menu2.gif follows]
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Right-click soa-infra in the navigator. The menu that is displayed provides you with access to the same administrative options that appear in the SOA Infrastructure menu.









2.2.2 Navigating Through the SOA Composite Application Home Page and Menu

You can navigate directly to Oracle SOA Suite and Oracle BPM Suite administration tasks for a specific SOA composite application.

To navigate through the SOA composite application home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Expand the partitions.

This displays all SOA composite applications running in the partitions of the SOA Infrastructure.
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Select a specific SOA composite application.

This displays the home page for the selected SOA composite application. The upper part of the page displays details about recent instances and faults and rejected messages. This part of the page also provides you with access to important administrative and configuration tasks at the composite level.

[image: Description of soaapp_upper_helloworld.gif follows]
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Click Show All at the bottom of each section to see more of these items. You can also click links to access more details about a specific composite instance or fault.

The lower part of the page displays details about the service components (in this example, Oracle Mediator, BPEL process, and human workflow) and binding components (services and references) included in the SOA composite application. You can click a specific service component or service or reference binding component in the Name column to access more specific details.

[image: Description of soaapp_lower_helloworld.gif follows]
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When you are within the pages of a SOA composite application, the SOA Composite menu appears below the application name at the top of the page. This menu provides you with administrative tasks specific to the current composite application.


	
Select the SOA Composite menu.
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These administrative options enable you to perform the following tasks.


	Option	Description
	
Home

	
This option displays the following details for the SOA composite application home page.

	
Recent instances.


	
Recent faults and rejected messages, including whether the instance is recoverable.


	
Service components included in the SOA composite application.


	
Services and references included in the SOA composite application.




For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Monitoring

	
This option displays the performance summary statistics for the selected SOA composite application.


	
SOA Deployment

	
This option enables you to undeploy or redeploy this SOA composite application, or deploy another SOA composite application.

For more information, see Section 7.1, "Deploying SOA Composite Applications."


	
Export

	
This option enables you to export a deployed SOA composite application to a JAR file.

For more information, see Section 7.7, "Exporting a Deployed SOA Composite Application."


	
Test Service

	
This option enables you to manually initiate an instance of this deployed SOA composite application through the Test Web Service page.

For more information, see Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
Unit Tests

	
This option enables you to run test cases that simulate the interaction between the current SOA composite application and its web service partners before deployment to a production environment. This generates test instances of the composite.

For more information, see Section 1.4.3.4, "Introduction to SOA Composite Application Automated Testing" and Section 7.5, "Automating the Testing of SOA Composite Applications."


	
Policies

	
This option enables you to view and attach or detach policies to or from the SOA composite application.

For more information, see Section 1.4.3.2, "Introduction to Policies" and Section 7.6, "Managing SOA Composite Application Policies."


	
SOA Infrastructure

	
This option takes you to the SOA Infrastructure home page.


	
SOA Infrastructure Common Properties

	
This option enables you to view and set the audit level, capture the state of the SOA composite application instance, enable the payload validation of incoming messages, set UDDI registry properties, specify the callback server and server URLs, view the data source JNDI locations, set the nonfatal connection retry counts, set web service binding properties, and optimize the loading performance of pages. The SOA composite application typically inherits the settings defined at the SOA Infrastructure level.

For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."


	
Service/ Reference Properties

	
This option enables you to configure WSDL file properties for the service and reference binding components included in the SOA composite application.

For more information, see Section 34.1, "Configuring Service and Reference Binding Component Properties."


	
General Information

	
This option displays general details about this SOA composite application, such as Oracle Enterprise Manager Fusion Middleware Control version, Oracle home, Oracle instance, and partition in which the composite is deployed.








	
Right-click the name of a SOA composite application in the navigator. A menu is displayed that provides you with access to the same administrative options that appear in the SOA Composite menu.









2.2.3 Navigating Through the Partition Home Page and Menu

You can navigate to administrative tasks for a specific partition in the SOA Infrastructure.

To navigate through the partition home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Click a specific partition.
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At the top of the page, select the SOA Partition menu.
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These administrative options enable you to perform the following tasks:


	Option	Description
	
Home

	
This option displays the following details for the partition home page:

	
SOA composite applications in this partition.


	
Status of the SOA composite applications in this partition (either Up (on) or Down (off)).


	
Mode of the SOA composite applications in this partition (active or retired).


	
Total number of instances and faulted instances of the SOA composite applications in this partition.


	
Time at which the SOA composite applications in this partition were last deployed, redeployed, or reconfigured.





	
Composites Control

	
This option displays the following bulk lifecycle management tasks:

	
Start Up All: Invokes a dialog for starting all composites in this partition.


	
Shut Down All: Invokes a dialog for shutting down all composites in this partition.


	
Activate All: Invokes a dialog for activating all composites in this partition.


	
Retire All: Invokes a dialog for retiring all composites in this partition.




For information about these composite states, see Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level."


	
SOA Deployment

	
This option displays the following management tasks.

	
Deploy To This Partition: Invokes the Deploy SOA Composite wizard for selecting a composite to deploy in this partition.


	
Undeploy All From This Partition: Invokes a dialog for undeploying all composites in this partition.


	
Redeploy: Invokes the Redeploy SOA Composite wizard to select composites to redeploy in this partition.




For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Delete This Partition

	
This option invokes a dialog to delete this partition. All composites in the partition are automatically undeployed before the partition is deleted.


	
General Information

	
This option displays general details about the partition, such as the partition (target) name, Oracle Fusion Middleware version, Oracle Fusion Middleware home directory, domain home directory, hostname, and deployed server.








	
Right-click the name of a partition in the navigator. A menu is displayed that provides you with access to the same administrative options that appear in the SOA Partition menu.







	
Note:

You can also access the partition home page from the Related Topics menu on the home page of a SOA composite application.









For information about partitions, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure" and Section 7.8, "Grouping SOA Composite Applications into Partitions."






2.2.4 Navigating to Deployed Java EE Applications

You can navigate to deployed Java EE applications related to Oracle SOA Suite and (if installed) Oracle BPM Suite components. These applications are Java EE applications that represent the SOA system components, such as the technology adapters, Oracle B2B, Oracle BPM Worklist, and so on. You can deploy a web service and see it listed here. You can also click individual applications (for example, the deployed web service), and manage and test that you can deploy WAR and EAR files from here. If you have deployed your own Java EE applications, they also display here.

To navigate to deployed Java EE applications:

	
Expand Application Deployments in the navigator.


	
Expand Internal Applications.


	
Expand Resource Adapters.

A list of deployed Java EE applications related to Oracle SOA Suite and Oracle BPM Suite components appears.
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Oracle B2B (b2bui) appears in the Internal Applications folder, while Oracle BPM Worklist (worklistapp) appears in the top level Application Deployments folder.


	
Click a specific application (for this example, worklistapp is selected).

The page displays details about application performance.
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While Oracle Enterprise Manager Fusion Middleware Control displays the URLs for all deployed modules, you cannot directly invoke them from this page.









2.2.5 Navigating to the Oracle WebLogic Server Administration Console and Other Pages

Most pages in Oracle Enterprise Manager Fusion Middleware Control include a Related Links menu in the upper right-hand corner. Depending upon your current location, the context of the menu changes to provide links to relevant pages. For example, when you are on the BPEL process service engine page, the Related Links menu provides links to the SOA Infrastructure home page, the BPEL process configuration properties page, the Oracle WebLogic Server Administration Console, and a page for service engine log files. Figure 2-1 provides details. You can also click soa-infra at the top of the BPEL service engine page to go directly to the SOA Infrastructure home page.


Figure 2-1 Related Links Menu for a SOA Composite Application

[image: Description of Figure 2-1 follows]
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When you are on the page of a service component of a SOA composite application, several navigational menus and links are available:

	
The Related Links menu provides links to the SOA Infrastructure home page and the applicable service engine home page. Figure 2-2 provides details.


	
Breadcrumbs are displayed in the upper left-hand corner as you traverse further into a SOA composite application.


	
Within any SOA composite application page (including the service component pages), links to the SOA Infrastructure pages also remain available through the SOA Infrastructure menu that is displayed next to the Farm menu above the navigator. For example, this enables you to go from the home page of a specific BPEL service component directly to the BPEL service engine configuration properties page.


	
Names at the top of the page can be clicked to navigate to parent pages. For example, clicking the name of a composite at the very top of a service component page enables you to go to the composite that includes that component.





Figure 2-2 Related Links Menu for a Service Component of a SOA Composite Application

[image: Description of Figure 2-2 follows]

Description of "Figure 2-2 Related Links Menu for a Service Component of a SOA Composite Application"





The service engines, SOA administration (such as the SOA Infrastructure Common Properties page), and business event pages all provide access to Oracle WebLogic Server Administration Console from the Related Topics list. Selecting WebLogic Server Console opens a new browser page and takes you to the login prompt for the Oracle WebLogic Server Administration Console. Your current page in Oracle Enterprise Manager Fusion Middleware Control is not lost. After logging in, the home page is displayed. Figure 2-3 provides details.


Figure 2-3 Oracle WebLogic Server Administration Console

[image: Description of Figure 2-3 follows]

Description of "Figure 2-3 Oracle WebLogic Server Administration Console"





You can perform the following Oracle SOA Suite tasks from Oracle WebLogic Server Administration Console:

	
Configure adapter connections for composite references.


	
Create and manage data sources utilized by adapters.


	
Create and manage JMS resources utilized by adapters.


	
Manage SOA Infrastructure data sources (for example, modifying connection pool settings).


	
Administer security of human workflow users.


	
Manage Oracle WebLogic Server transaction (JTA) settings (for example, the transaction timeout value).


	
Deploy human task user interfaces.









2.2.6 Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page

You can access the home page of the SOA Infrastructure, a specific SOA partition, or a specific SOA composite application from the Farm home page.

To navigate to the SOA Infrastructure or SOA composite application home page:

	
In the Deployments section of the Farm home page, click soa-infra or a specific SOA composite application (for example, SimpleApproval).

[image: Description of sca_menu3.gif follows]

Description of the illustration sca_menu3.gif



The home page for your selection is displayed.











2.3 Logging Out of Oracle Enterprise Manager Fusion Middleware Control

This section describes how to log out of Oracle Enterprise Manager Fusion Middleware Control.

To log out of Oracle Enterprise Manager Fusion Middleware Control:

	
Note the following details about logging out.

	
If multiple pages are open (for example, the help dialog, topology viewer, and flow trace), logging out of any page logs you out of the entire application in all open pages.


	
If you log out with any unsaved configuration changes, you receive no warning message and your changes are lost.





	
In the upper right-hand corner of any page, click the Log Out link.












A Demo User Community

This appendix describes how to install and use the organizational hierarchy of users and groups known as the demo user community in the database.

	
Section A.1, "Using the Demo User Community"


	
Section A.2, "Users"


	
Section A.3, "Groups"


	
Section A.4, "soa-infra Application Roles"


	
Section A.5, "SOATestDemoApp Application Roles"


	
Section A.6, "Roles Granted to and Owned by Users"


	
Section A.7, "WorkflowPermission Class"






A.1 Using the Demo User Community

After installing Oracle SOA Suite, you must seed the user demo community in the database. The demo user community is an organizational hierarchy of users and groups.

To seed the demo user community:

	
Download the workflow-001-DemoCommunitySeedApp sample from the Oracle SOA Suite samples.


	
Follow the instructions in the README.txt file included with this sample. This file describes how to seed the user demo community described in this appendix.




	
Note:

You must run the script for seeding the user demo community locally from within a domain, and not remotely.

















A.2 Users

Table A-1 lists the users in the demo community.


Table A-1 Users in the Demo Community

	User	User Name	First Name	Last Name	Title	Manager	Email
	
1

	
achrist

	
Agatha

	
Christie

	
Loan Consultant

	
wfaulk

	
achrist@emailExample.com


	
5

	
cdickens

	
Charles

	
Dickens

	
CEO

	
--

	
cdickens@emailExample.com


	
6

	
cdoyle

	
Conan

	
Doyle

	
Loan Agent 2

	
rsteven

	
cdoyle@emailExample.com


	
3

	
EHEMING

	
Ernest

	
Hemingway

	
CFO

	
JVerne

	
EHEMING@emailExample.com


	
7

	
fkafka

	
Franz

	
Kafka

	
Manager 1

	
ltolstoy

	
fkafka@emailExample.com


	
8

	
istone

	
Irving

	
Stone

	
Loan Agent 2

	
sfitzger

	
istone@emailExample.com


	
9

	
jausten

	
Jane

	
Austen

	
Loan Consultant

	
fkafka

	
jausten@emailExample.com


	
10

	
jcooper

	
James

	
Cooper

	
Loan Agent 1

	
jstein

	
jcooper@emailExample.com


	
11

	
jlondon

	
Jack

	
London

	
Loan Agent 1

	
sfitzger

	
jlondon@emailExample.com


	
12

	
jstein

	
John

	
Steinbeck

	
Manager 2

	
wfaulk

	
jstein@emailExample.com


	
2

	
JVerne

	
Jules

	
Verne

	
CIO

	
cdickens

	
JVerne@emailExample.com


	
13

	
ltolstoy

	
Leo

	
Tolstoy

	
Director

	
wfaulk

	
ltolsoy@emailExample.com


	
14

	
mmitch

	
Margaret

	
Mitchell

	
Loan Analyst

	
fkafka

	
mmitch@emailExample.com


	
15

	
mtwain

	
Mark

	
Twain

	
Loan Agent 2

	
jstein

	
mtwain@emailExample.com


	
16

	
rsteven

	
Robert

	
Stevenson

	
Manager 3

	
jstein

	
rsteven@emailExample.com


	
17

	
sfitzger

	
Scott

	
Fitzgerald

	
Manager 1

	
wfaulk

	
sfitzger@emailExample.com


	
18

	
szweig

	
Stefan

	
Zweig

	
Loan Analyst

	
fkafka

	
szweig@emailExample.com


	
4

	
VHUGO

	
Victor

	
Hugo

	
HR Manager

	
EHEMING

	
VHUGO@emailExample.com


	
19

	
wfaulk

	
William

	
Faulkner

	
Vice President

	
cdickens

	
wfaulk@emailExample.com


	
20

	
wshake

	
William

	
Shakespeare

	
Manager 3

	
rsteven

	
wshake@emailExample.com








Figure A-1 shows the organizational hierarchy of the demo community.


Figure A-1 Demo Community Organizational Hierarchy

[image: Description of Figure A-1 follows]

Description of "Figure A-1 Demo Community Organizational Hierarchy"









A.3 Groups

Table A-2 lists the following:

	
Groups in the demo community


	
Users and groups that are granted each group role (direct grantees and all grantees)


	
Group roles and application roles granted to each group (direct-granted roles and all granted roles)




See Table A-6 for the roles granted to users sorted by user.


Table A-2 Groups in the Demo Community: Grant Relationships

	Group	Direct Grantees	All Grantees	Direct-Granted Roles	All Granted Roles
	
RegionalOffices

	
CentralRegion, WesternRegion, EasternRegion

	
szweig, wshake, jcooper, WesternRegion, mmitch, EasternRegion, jlondon, CentralRegion, istone, cdoyle, mtwain, California, fkafka

	
-

	
-


	
EasternRegion

	
szweig, wshake, mmitch, fkafka

	
szweig, wshake, mmitch, fkafka

	
RegionalOffices

	
RegionalOffices


	
CentralRegion

	
jlondon, mtwain

	
jlondon, mtwain

	
RegionalOffices

	
RegionalOffices


	
WesternRegion

	
cdoyle, California

	
jcooper, istone, cdoyle, California

	
RegionalOffices

	
RegionalOffices


	
California

	
jcooper, istone

	
jcooper, istone

	
WesternRegion

	
RegionalOffices, WesternRegion


	
LoanAgentGroup

	
jlondon, wshake, LoanAnalyticGroup, jcooper, istone, cdoyle, mtwain

	
szweig, jlondon, wshake, LoanAnalyticGroup, jcooper, istone, cdoyle, mtwain, mmitch, fkafka

	
-

	
-


	
LoanAnalyticGroup

	
szweig, mmitch, fkafka

	
szweig, mmitch, fkafka

	
BPMWorkflowCustomize, LoanAgentGroup

	
BPMWorkflowCustomize, LoanAgentGroup


	
Supervisor

	
jcooper, mtwain, rsteven

	
jcooper, mtwain, rsteven

	
-

	
-


	
Executives

	
cdickens, JVerne, EHEMING, VHUGO

	
cdickens, JVerne, EHEMING, VHUGO

	
-

	
-








Table A-3 continues information for several groups listed in Table A-2. It lists the following:

	
Users and groups (direct owners and all owners) that own each group


	
Group roles (direct-owned roles and all owned roles) that each group owns




See Table A-6 for the roles owned by users sorted by user.


Table A-3 Groups in the Demo Community: Ownership Relationships

	Group	Direct Owners	All Owners	Direct Owned Roles	All Owned Roles
	
EasternRegion

	
jstein

	
jstein

	
-

	
-


	
WesternRegion

	
jstein

	
jstein

	
-

	
-


	
California

	
fkafka

	
fkafka

	
-

	
-


	
LoanAgentGroup

	
jcooper, fkafka

	
jcooper, fkafka

	
-

	
-


	
LoanAnalyticGroup

	
jstein

	
jstein

	
-

	
-


	
Supervisor

	
jstein

	
jstein

	
-

	
-












A.4 soa-infra Application Roles

Table A-4 lists the following:

	
soa-infra application roles


	
Users, groups, and roles that are granted each application role (direct grantees and all grantees)


	
Roles granted to each application role (direct-granted roles and all granted roles)




See Table A-6 for the application roles granted to users sorted by user.


Table A-4 Application Roles in soa-infra

	Application Role	Direct Grantees	All Grantees	Direct-Granted Roles	All Granted Roles
	
SOAAdmin

	
Administrators

	
Administrators

	
BPMWorkflowAdmin

	
BPMWorkflowCustomize BPMWorkflowAdmin


	
BPMWorkflowAdmin

	
SOAAdmin, demoadmin

	
SOAAdmin, demoadmin, Administrators

	
BPMWorkflowCustomize

	
BPMWorkflowCustomize


	
BPMWorkflowCustomize

	
LoanAnalyticGroup, BPMWorkflowAdmin

	
szweig, LoanAnalyticGroup, SOAAdmin, BPMWorkflowAdmin, mmitch, fkafka, Administrators, demoadmin

	
-

	
-








For more information about application roles, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






A.5 SOATestDemoApp Application Roles

Table A-5 lists the roles in the SOATestDemoApp application.


Table A-5 SOATestDemoApp Roles

	Application Role	Direct Grantees	All Grantees	Direct-Granted Roles	All Granted Roles
	
DevTeam

	

rsteven	
rsteven, mmitch, fkafka, jcooper, istone

	
	

	
QATeam

	
jlondon, Supervisor

	
jlondon, jcooper, mtwain, rsteven, mmitch, fkafka, istone

	
	

	
ProductionTeam

	
mmitch, fkafka, California

	
mmitch, fkafka, jcooper, istone

	
DevTeam, QATeam

	
DevTeam, QATeam












A.6 Roles Granted to and Owned by Users

Table A-6 lists the following:

	
Roles granted to each user (direct-granted roles and all granted roles)


	
Roles owned by each user (direct-owned roles and all owned roles)





Table A-6 Roles for Each User

	User Name	Direct-Granted Roles	All Granted Roles	Direct-Owned Roles	All Owned Roles
	
achrist

	
Executives

	
-

	
-

	
-


	
cdickens

	
-

	
-

	
Executives

	
-


	
cdoyle

	
WesternRegion, LoanAgentGroup

	
RegionalOffices, WesternRegion, LoanAgentGroup

	
-

	
-


	
EHEMING

	
	
Executives

	
	

	
fkafka

	
LoanAnalyticGroup, EasternRegion, ProductionTeam

	
BPMWorkflowCustomize, RegionalOffices, LoanAnalyticGroup, LoanAgentGroup, EasternRegion, ProductionTeam, DevTeam, QATeam

	
LoanAgentGroup, California

	
LoanAgentGroup, California


	
istone

	
LoanAgentGroup, California

	
RegionalOffices, WesternRegion, LoanAgentGroup, California, DevTeam, QATeam, ProductionTeam

	
-

	
-


	
jausten

	
-

	
-

	
-

	
-


	
jcooper

	
Supervisor, LoanAgentGroup, California

	
RegionalOffices, WesternRegion, Supervisor, LoanAgentGroup, California, DevTeam, QATeam, ProductionTeam

	
LoanAgentGroup

	
LoanAgentGroup


	
jlondon

	
CentralRegion, LoanAgentGroup, QATeam

	
CentralRegion, RegionalOffices, LoanAgentGroup, QATeam

	
-

	
-


	
jstein

	
-

	
-

	
LoanAnalyticGroup WesternRegion, Supervisor, EasternRegion

	
LoanAnalyticGroup WesternRegion, Supervisor, EasternRegion


	
JVerne

	
	
Executives

	
	

	
ltolstoy

	
-

	
-

	
-

	
-


	
mmitch

	
LoanAnalyticGroup, EasternRegion, ProductionTeam

	
BPMWorkflowCustomize RegionalOffices, LoanAnalyticGroup, LoanAgentGroup, EasternRegion, DevTeam, QATeam, ProductionTeam

	
-

	
-


	
mtwain

	
CentralRegion, Supervisor, LoanAgentGroup

	
CentralRegion, RegionalOffices, Supervisor, LoanAgentGroup, QATeam

	
-

	
-


	
rsteven

	
Supervisor, DevTeam

	
Supervisor, DevTeam

	
-

	
-


	
sfitzger

	
-

	
-

	
-

	
-


	
szweig

	
LoanAnalyticGroup, EasternRegion

	
BPMWorkflowCustomizeDemoApp/FlexFieldRole, RegionalOffices, LoanAnalyticGroup, LoanAgentGroup, EasternRegion

	
	

	
vhugo

	
	
Executives

	
	

	
wfaulk

	
-

	
-

	
-

	
-


	
wshake

	
LoanAgentGroup, EasternRegion

	
RegionalOffices, LoanAgentGroup, EasternRegion

	
-

	
-












A.7 WorkflowPermission Class

Table A-7 lists the permissions defined in the WorkflowPermission class and the application roles associated with each permission.


Table A-7 WorkflowPermission Class

	Permission	Application Role with Permission
	
workflow.mapping.publicFlexField

	
BPMWorkflowAdmin, BPMWorkflowCustomize


	
workflow.mapping.protectedFlexField

	
BPMWorkflowAdmin


	
workflow.admin

	
BPMWorkflowAdmin


	
workflow.admin.evidenceStore

	
BPMWorkflowAdmin















B Troubleshooting Oracle SOA Suite and Oracle BPM Suite

This appendix describes how to troubleshoot issues you can encounter when using Oracle SOA Suite and Oracle BPM Suite, including server startup best practices, page loading optimizations, message failures, tablespace issues, connection timeouts, event delivery network issues, and human workflow issues. It also describes how to set logging levels for troubleshooting.

This appendix includes the following topics:

	
Section B.1, "Setting Logging Levels for Troubleshooting"


	
Section B.2, "Connection and Transaction Timeout Troubleshooting"


	
Section B.3, "Runtime Diagnostics Troubleshooting"


	
Section B.4, "Human Workflow Troubleshooting"


	
Section B.5, "Event Delivery Network Troubleshooting"


	
Section B.6, "Performance Troubleshooting"


	
Section B.7, "Server Troubleshooting"


	
Section B.8, "Browser Troubleshooting"


	
Section B.9, "Additional Troubleshooting Documentation"






B.1 Setting Logging Levels for Troubleshooting

To simplify troubleshooting, it is recommended that you set logging levels to the TRACE:32 FINEST level in Oracle Enterprise Manager Fusion Middleware Control. This section describes loggers to which to set to this level.

To set logging levels for troubleshooting:

	
See Section 3.4, "Configuring Log Files" for instructions on accessing the Log Configuration page.


	
From the Oracle Diagnostic Logging Level (Java Level) list, set the following parent loggers to the TRACE:32 FINEST level:

	
oracle.soa


	
oracle.fabric


	
oracle.integration


	
oracle.wsm (Setting this logger to the ERROR level may also be sufficient because this setting logs the required error messages.)





	
If you want finer-grained control over logging, expand the parent loggers and set any of the following loggers:


	Component	Logger
	
Human workflow/approval management extensions (AMX)/rules

	
	
oracle.soa.services.common


	
oracle.soa.services.identity


	
oracle.soa.services.notification


	
oracle.soa.services.rules


	
oracle.soa.services.rules.obrtrace


	
oracle.soa.services.workflow


	
oracle.soa.services.workflow.common


	
oracle.soa.services.workflow.evidence


	
oracle.soa.services.workflow.metadata


	
oracle.soa.services.workflow.persistency


	
oracle.soa.services.workflow.query


	
oracle.soa.services.workflow.report


	
oracle.soa.services.workflow.runtimeconfig


	
oracle.soa.services.workflow.soa


	
oracle.soa.services.workflow.task


	
oracle.soa.services.workflow.task.dispatch


	
oracle.soa.services.workflow.task.routing


	
oracle.soa.services.workflow.user


	
oracle.soa.services.workflow.verification


	
oracle.soa.services.workflow.performance - Workflow Performance API


	
oracle.soa.services.workflow.worklist - Oracle BPM Worklist





	
SOA Infrastructure

	
	
oracle.fabric.common.wsdl - WSDL/schema management


	
oracle.integration.platform.blocks.deploy - Deployment


	
oracle.integration.platform.blocks.soap - WS binding - Calling web services


	
oracle.integration.platform.blocks.local - Local binding


	
oracle.integration.platform.kernel - Startup issues


	
oracle.integration.plaform.blocks.mesh - Message routing


	
oracle.integration.platform.common - Metadata/MDS


	
oracle.integration.platform.instance - Instance


	
oracle.integration.platform.instance.activity - Instance


	
oracle.integration.platform.instance.store - Instance





	
Event Delivery Network (EDN)

	
	
oracle.integration.platform.blocks.event


	
oracle.integration.platform.blocks.event.saq


	
oracle.integration.platform.blocks.event.jms





	
Deployment 

	
oracle.integration


	
Oracle Mediator 

	
	
oracle.soa.mediator.common - Logs the processing events related to Oracle Mediator audit message persistence.


	
oracle.soa.mediator.common.cache - Metadata cache (RuntimeMetadataCache) and runtime related cache (RuntimeCache).


	
oracle.soa.mediator.common.error - Logs related to error enqueuing and handling.


	
oracle.soa.mediator.common.error.recovery - Logs only the error recovery processing. All fault policy handlers are part of this logger.


	
oracle.soa.mediator.common.listener - Processing related to common infrastructure for Oracle Mediator parallel routing rules and resequencer.


	
oracle.soa.mediator.common.message - Logs related to creation and modification of the Oracle Mediator message. (Oracle Mediator wraps a normalized message into the Oracle Mediator message.)


	
oracle.soa.mediator.common.persistence - Logs related to the persistence of Oracle Mediator deferred messages to the database.


	
oracle.soa.mediator.dispatch - Logs everything related to message routing inside Oracle Mediator. This includes sequential, parallel, and dynamic routing.


	
oracle.soa.mediator.dispatch.db - Logs related to the deferred message and container ID infrastructure.


	
oracle.soa.mediator.dispatch.resequencer.toplink - Logs related to database interactions of the resequencer. This includes execution of all three resequencer strategies.


	
oracle.soa.mediator.monitor - Logs all events related to instance tracking in Oracle Mediator.


	
oracle.soa.mediator.resequencer - Everything related to Oracle Mediator resequencer processing such as locker-worker infrastructure, group, and sequencer ID expression evaluation.


	
oracle.soa.mediator.resequencer.besteffort - For best effort strategy of the resequencer; in particular, the locking stage processing.


	
oracle.soa.mediator.resequencer.fifo - For the FIFO strategy of the resequencer.


	
oracle.soa.mediator.resequencer.standard - For standard strategy of the resequencer.


	
oracle.soa.mediator.service - Logs events related to the processing of various message exchange patterns (one way, two way (synchronous, asynchronous), and so on) in Oracle Mediator.


	
oracle.soa.mediator.service.common.functions - Oracle Mediator XPath extension function-related logs.


	
oracle.soa.mediator.service.filter - Evaluation of filter criteria for routing rules.


	
oracle.soa.mediator.service.transformation - Logs transformation-related events such as the payload before and after the transformation.


	
oracle.soa.mediator.serviceEngine - Logs lifecycle events of the Oracle Mediator service engine. Also logs the entry and exit of messages for Oracle Mediator.





	
Oracle BPEL Process Manager

	
	
oracle.soa.bpel


	
oracle.soa.bpel.console


	
oracle.soa.bpel.engine


	
oracle.soa.bpel.engine.activation


	
oracle.soa.bpel.engine.agents


	
oracle.soa.bpel.engine.bpel


	
oracle.soa.bpel.engine.compiler


	
oracle.soa.bpel.engine.data


	
oracle.soa.bpel.engine.delivery


	
oracle.soa.bpel.engine.deployment


	
oracle.soa.bpel.engine.dispatch


	
oracle.soa.bpel.engine.sensor


	
oracle.soa.bpel.engine.translation


	
oracle.soa.bpel.engine.ws


	
oracle.soa.bpel.engine.xml


	
oracle.soa.bpel.entity


	
oracle.soa.bpel.jpa


	
oracle.soa.bpel.system





	
Oracle BPM Suite

	
oracle.bpm.bpmn.engine


	
Oracle B2B

	
	
oracle.soa.b2b.apptransport - Runtime logger


	
oracle.soa.b2b.engine - Runtime logger


	
oracle.soa.b2b.transport - Runtime logger


	
oracle.soa.b2b.ui - User interface logger


	
oracle.soa.b2b.repository - Repository access detailed logger





	
Oracle adapters

	
oracle.soa.adapter


	
Oracle Web Services Manager (OWSM)

	
oracle.wsm - Defaulted to the ERROR level; logs all WSM-0xxxx errors. TRACE:32 results in significant details.








	
From the Oracle Diagnostic Logging Level (Java Level) list, change the logger level to one of the following settings:

	
TRACE:1 (FINE)


	
TRACE:16 (FINER)


	
TRACE:32 (FINEST) - Most verbose level (recommended for troubleshooting)




The change takes effect within several minutes.




For information about monitoring Oracle Business Activity Monitoring (BAM) logs, see Section 24.6, "Monitoring Oracle BAM Logs." For information about monitoring Oracle User Messaging Service (UMS) logs, see Section 27.2, "Viewing Log Files."



B.1.1 Log Files and Thread Dumps from All Managed Servers

Table B-1 describes the log files to view and thread dumps to obtain.


Table B-1 Log Files and Thread Dumps

	Output	Description
	
Server diagnostic log

	
View the following file:


$DOMAIN_HOME/servers/server_name/logs/server_name-diagnostic.log


For example, soa_server1-diagnostic.log, if server_name is soa_server1.

This is where the log output is available. By default, only the last 100 MB of the diagnostic logs are retained.


	
Server log

	
server_name.log (for example, soa_server1.log, if server_name is soa_server1)


	
Server console output

	
<stdout> is also useful, especially for deployment and patching issues.


	
Server thread dump

	
Enter the following at the operating system command prompt:


kill -3 managed_server_process_ID


You can also use Oracle WebLogic Server Administration Console.

	
In the navigation tree of Oracle WebLogic Server Administration Console, select Environment > Servers.


	
In the table, select the server.


	
Select the Monitoring tab.


	
Select the Threads tab.


	
Click Dump Thread Stacks.




The output is in the console logs.


	
OWSM message log

	
The following log captures all SOAP messages on the wire.


$DOMAIN_HOME/servers/server_name/logs/owsm/msglogging/diagnostic.log


This log is not enabled by default. To enable this log:

	
Go to Fusion Middleware Control > Weblogic Domain > Web Services > Policies.


	
Select the security level for which to enable logging.


	
Edit the policy to enable the log assertion.

















B.2 Connection and Transaction Timeout Troubleshooting

This section describes how to troubleshoot connection and transaction timeout issues.



B.2.1 Resolving Connection Timeouts

You can receive a connection timeout error under circumstances such as the following:

	
You run a SOA composite application with a large payload that takes more than 30 seconds to process.


	
You are invoking a stress test using a large payload from the Test Web Service page of Oracle Enterprise Manager Fusion Middleware Control.


	
You are passing a large number of message files (one million) into a composite with a file adapter service.


	
You are retrieving instance and fault count metrics in Oracle Enterprise Manager Fusion Middleware Control.




To avoid receiving timeout errors, increase the transaction timeout property as follows:

	
Log into Oracle WebLogic Administration Console.


	
Click JTA.


	
Change the value of Timeout Seconds (the default is 30).


	
Click Save.


	
Restart Oracle WebLogic Server.









B.2.2 Increasing Database Connection Values

You can receive the following error message because of slow connections to the database.


Exception [TOPLINK-4002] (Oracle TopLink - 11g Release 1 (11.1.1.1.0) (Build 
090304)): oracle.toplink.exceptions.DatabaseException 
Internal Exception: java.sql.SQLException: Internal error: Cannot obtain 
XAConnection weblogic.common.resourcepool.ResourceDeadException: Pool 
SOADataSource has been disabled because of hanging connection tests, cannot 
allocate resources to applications.


If this occurs, perform the following steps:

	
Open the DOMAIN_HOME\bin\setSOADomainEnv.cmd file.


	
Uncomment the lines shown in bold.


# 8331492: Value of weblogic.resourcepool.max_test_wait_secs is 10 
# seconds. It can be increased by uncommenting line below if your database 
# connections are slow. See SOA documentation for more details. 
 EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES}
-Dweblogic.resourcepool.max_test_wait_secs=30" 
export EXTRA_JAVA_PROPERTIES 


	
Save your changes and restart the managed Oracle WebLogic Server.









B.2.3 Updating the EJB Transaction Timeout Value in the Deployment Archive After SOA Infrastructure Failure

Updating the transaction time out value for the FacadeFinderBean property in Oracle WebLogic Server Administration Console under Deployments > expanded SOA Infrastructure Application > FacadeFinderBean > Configuration tab can result in the following error after restarting the SOA Infrastructure:


java.lang.IllegalArgumentException: Cannot convert value of type [$Proxy223
implementing
 oracle.bpel.services.workflow.verification.IVerificationService,org.springframe
work.aop.SpringProxy,org.springframework.aop.framework.Advised]
to required type
[oracle.bpel.services.workflow.verification.IVerificationService] for
property 'verificationService': no matching editors or conversion strategy found
Message icon - Warning Errors were encountered while performing this operation.


The SOA Infrastructure status is also displayed as failed.

This error is not specific to FacadeFinderBean; it also applies to any EJB that is part of the SOA Infrastructure application.

To resolve this error, you must manually modify the transaction timeout setting in your deployment archive.

To update the transaction timeout setting:

	
Open the fabric-ejb.jar file in your deployment archive.


	
Increase the transaction timeout value in the META-INF/weblogic-ejb-jar.xml file to a larger value.


	
Rejar the file.


	
Restart the managed server that includes the SOA Infrastructure by following the instructions in Section 3.2, "Stopping and Starting the Managed Server and SOA Infrastructure."




	
Note:

This issue may also occur while updating any EJBs deployed as part of the SOA Infrastructure application. If this issue occurs, you must update the corresponding contained JAR file for those EJBs in a similar fashion.
















B.2.4 Long Running, Synchronous Calls To Remote Web Services Error Out or Asynchronous Transactions Return with an Error after a Long Time

You may have long running, synchronous calls to remote web services that end with JTA transaction rolled-back errors. When executing a transaction making an asynchronous call (for example, to the SOA server), the application may return with an error. The server logs show JTA transaction timeouts, which can cause this behavior.

To check the JTA transaction timeout in the Oracle WebLogic Server Administration Console.

	
Log in to Oracle WebLogic Server Administration Console.


	
In the Domain Structure, select Services > JTA to check the timeout value.

If the transaction is always timing out beyond 30 seconds and is a custom composite synchronous client invocation, then you may need to revisit the design approach. It may be best for the external web service to be invoked as an asynchronous transaction.

Increasing the JTA for supporting long running, synchronous transactions is simply an interim mechanism. For information on changing the JTA transaction timeout setting, see Section B.2.1, "Resolving Connection Timeouts."


	
If synchronous client invocations take a long time, check for any performance issues with the system and try to resolve them.


	
Check for appropriate values for the syncMaxWaitTime property and BPEL's EJB transaction timeout settings in relation to the JTA timeout settings and only then increase the value of the JTA timeout, if needed.

For information on viewing and changing the syncMaxWaitTime property, see Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
To view and change the BPEL EJB transaction timeout settings, perform the following steps:

	
Log in to Oracle WebLogic Server Administration Console.


	
In the Domain Structure, click Deployments.


	
Expand soa-infra > EJBs.


	
Update the following EJBs:

- BPELActivityManagerBean

- BPELDeliveryBean

- BPELDispatcherBean

- BPELEngineBean

- BPELFinderBean

- BPELInstanceManagerBean

- BPELProcessManagerBean

- BPELSensorValuesBean

- BPELServerManagerBean


	
Click Save.


	
Restart Oracle WebLogic Server.





	
For asynchronous transactions, check the values for both the BPEL EJB transaction timeout and the JTA transaction timeout and adjust as needed.











B.3 Runtime Diagnostics Troubleshooting

This section describes how to troubleshoot runtime issues.


B.3.1 Oracle SOA Suite Runtime Failure with a "Cannot read WSDL" Error

The following error is displayed if either the endpoint is not available for a reference or a composite is deployed with an incorrect deployment plan file.


oracle.fabric.common.FabricException: Cannot read WSDL


To diagnose this issue:

	
Ensure that the endpoint for the reference is up and running.

The WSDL or endpoint is stated in the error. The service can then be looked up from Oracle Enterprise Manager Fusion Middleware Control to check if it is active. Once the service is active and the endpoint is reachable, search for the SOA instance and retry it through the Recovery tab for the BPEL process service engine in Oracle Enterprise Manager Fusion Middleware Control.


	
For extensions/customizations, ensure that the correct URL is updated in the deployment configuration plan.

For information about deployment plans, including examples of using sca_extractPlan to extract plans, see the "Customizing Your Application for the Target Environment Prior to Deployment" section of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.








B.3.2 Automatic Recovery of BPEL Instances is Not Recovering A Specific Instance

BPEL processes have an automatic recovery feature that attempts to automatically recover activities that are recoverable such as unresolved invoke/callback messages, activities not completed over a provided threshold time, and so on. However, the automatic recovery feature only tries to recover a few instances and only retries a fixed number of times. If some instances are not being automatically recovered, they are likely not being picked up because of the configuration of the automatic recovery parameters.

To resolve this issue:

	
Set the maximum number of messages to automatically recover.

By default, the automatic recovery feature of Oracle BPEL Process Manager processes 50 messages to submit for each recovery attempt. This is controlled by the maxMessageRaiseSize property.

	
In the navigation pane, right-click soa-infra (SOA_cluster_name).


	
Select SOA Administration > BPEL Properties > More BPEL Configuration Properties > RecoveryConfig.


	
Expand both RecurringScheduleConfig > maxMessageRaiseSize and StartupScheduleConfig > maxMessageRaiseSize.

The default value is 50 for each. A negative value causes all messages selected from the database to be submitted for recovery. A value of 0 causes no messages to be selected from the database (effectively disabling recovery). To recover more than 50 messages, set the property value to that value. Use this property to limit the impact of recovery on the server.





	
Set the maximum number of automatic recovery attempts on a given message.

You can also configure the number of automatic recovery attempts to submit in the same recoverable instance. The value you provide specifies the maximum number of times that invoke and callback messages are recovered. If the value is 0 (the default value), it recovers all messages. Once the number of recovery attempts on a message exceeds the specified value, a message is marked as nonrecoverable.

To configure automatic recovery attempts for invoke and callback messages in Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigation pane, right-click soa-infra (SOA_cluster_name).


	
Select SOA Administration > BPEL Properties > More BPEL Configuration Properties.


	
Select MaxRecoverAttempt, and enter a value in the Value field.


	
Click Apply.

It may not be desirable in all cases to use automatic recovery. If services are not idempotent, then corruption can occur. Moreover, the automatic recovery restores the composite to the last save point that can be immediately after an asynchronous invoke, wait, and so on. Therefore, it is important to understand the process behavior and what it does next before performing mass recoveries. Attempt mass automatic recovery only after the root cause of the composite failures has been fixed (for example, a service that was unavailable is now available, a database running out of space was fixed, and so on). Automatic recovery can also trigger an unexpected load during failure scenarios. This causes more threads to block on a remote server that can induce hangs in the SOA server in a cascading fashion.

For more information, see Section 12.2, "Configuring Automatic Recovery for Oracle BPEL Process Manager."











B.3.3 Some Composites Are Retried Multiple Times on Failure

When a BPEL process flow errors out, it is retried with all its invocations. This is undesirable in some cases.

The property GlobalTxMaxRetry (default value is 3) specifies how many retries are performed if an error is identified as a retriable one. For example, after several web service invocations, if dehydration fails due to a data source error, then this is identified as a retriable error and all activities from the prior dehydration state are retried. If the activities being retried are not idempotent (that is, their state can change with each retry and is not guaranteed to give the same behavior), then multiple retries can be problematic.

To rectify this situation, customize the composite by specifically marking the nonidempotent activities with idempotentset set to false in the partner link settings section of the composite.xml file to prevent retries.


<property name="bpel.partnerLink.partner_link_name.idempotent">false</property>


You cannot set the idempotentset property in Oracle Enterprise Manager Fusion Middleware Control.

You can also set GlobalTxMaxRetry to 0 in the Systems MBean Browser.

To set GlobalTxMaxRetry:

	
Right-click soa-infra (SOA_cluster_name).


	
Select SOA Administration > Common Properties.


	
Click More SOA Infra Advanced Configuration Properties.


	
Click GlobalTxMaxRetry.


	
In the Value field, enter an appropriate value.


	
Click Apply.




For information about the idempotent property, see the "BPEL Properties Set Inside a Composite" section of Oracle Fusion Middleware Performance and Tuning Guide.





B.3.4 Application Transaction Does Not Complete and the Underlying Composite Is Stuck in a Running State

An application transaction is not completing. For example, a purchase order status may remain processing. Checking the composite instance shows that the composite is stuck in the running state. In this case, the component is probably not running. Instead, it has likely faulted and may need recovery.

Faults may occur for various reasons:

	
A BPEL activity faulted with an error (for example, a business error, security authorization error, or some other error).


	
A BPEL activity invoked an external web service that was unavailable.


	
A BPEL activity has already been terminated by the administrator using Oracle Enterprise Manager Fusion Middleware Control.


	
A BPEL activity invoked an asynchronous ADF service and the message is stuck in the AQ/JMS queue.


	
A BPEL activity invoked an asynchronous ADF service, but because Oracle SOA Suite was unavailable, the callback message did not arrive.


	
A BPEL activity invoked a synchronous ADF service, which is taking a long time (or is hanging).


	
A network error occurred.




To diagnose this issue:

	
Log in to Oracle Enterprise Manager Fusion Middleware Control.


	
In the navigator pane, go to domain_name > SOA.


	
Click soa-infra (SOA_cluster_name).


	
Click the Instances tab.


	
Search for the composite instance, and click the instance ID.

The Flow Trace page appears.

If the instance is not visible (and the Audit Level is not set to Off in the SOA Infrastructure Common Properties page), this implies that the message is stuck outside of Oracle SOA Suite.

If the message has reached Oracle Mediator, but not instantiated the BPEL flow, the BPEL instance may have been rolled back from the start due to an error.

If the BPEL flow exists, the Faults section of the Flow Trace page typically shows the faulted service that can trace the root cause.


	
In the Trace section, click the BPEL process.


	
Expand the BPEL audit trail to see the exact point at which the service faulted.

This information is also available in the Faults tab of the BPEL flow trace. It also indicates whether the fault can be recovered.


	
Click the View Raw XML link.

The same information is also available through this link, where you can see the error. For example:


...
<message>Faulted while invoking operation "modifyUserRoles" on provider
 "UserService". </message><details>
...
<tns:message>JBO-27023: Failed to validate all rows in a
 transaction.</tns:message>
<tns:severity>SEVERITY_ERROR</tns:severity>
...
<message>The transaction was rolled back. The work performed for bpel instance
 "451042" was rolled back to the previous dehydration point, but the audit
 trail has been saved.
You can recover the instance from the recovery console by resubmitting the
 callback message or activity for execution.</message


Since the instance was rolled back to its previous dehydration point, the status remains as Running.


	
In the Audit Trail and Faults tabs, make a note of the following:

	
Composite name (for example, POComposite)


	
Component (for example, UpdateGuid BPEL process)


	
BPEL instance ID (for example, bpel:451042)




This is all used in the recovery of the instance, if it is recoverable. The Audit Trail window may mark the error as a nonrecoverable business fault, but the recoverability of the message can be found in the Recovery tab of the BPEL process service engine.


	
To attempt to recover the instance, right-click soa-infra (SOA_cluster_name), and select Service Engines > BPEL.


	
Click the Recovery tab.


	
From the Type list, select Activity.


	
Specify the composite and component names captured in step 9, and click Search.


	
Find the specific BPEL instance ID. You can recover faults marked as Recoverable.


	
Check the other recovery options in the Type list (for example, Invoke and Callback), if they exist.




	
Note:

You can also search for recoverable messages from the Faults and Rejected Messages tab of the SOA Infrastructure by clicking the message and selecting the appropriate action from the Recovery Actions list.










	
If the instance is not marked as recoverable, then reinvoking the service is not allowed (most probably because it is not idempotent). In some cases, you may need to provide diagnostic information to Oracle Support Services to resolve issues with nonrecoverable, nonidempotent transactions.


	
If the BPEL activity has invoked an asynchronous ADF service and the message is stuck in the AQ JMS queue, you can view the server.log and server-diagnostic.log files to see the logging of the message metadata logged by the JRF web services infrastructure.

In addition, the ADF diagnostic logs are also available to debug, if needed.

	
Use the ECID field to correlate and track ADF service logging corresponding with the SOA composite application that invoked it.


	
When viewing the log in Oracle Enterprise Manager Fusion Middleware Control, click the Broaden Target Scope dropdown list and select the farm_name/domain_name (Oracle WebLogic Domain) to view messages across the domain.


	
In the Selected Targets section of the Log Messages page for the Oracle WebLogic Server domain, ensure that the search includes the ECID field with the value noted in step a.


	
Search and view log records for the ECID and note any issues.

For a specific ECID, you find several root instances (top level clients). You must drill down to the appropriate instance to find a specific fault.


	
Observe if the components completed successfully or completed with an error. See the "Viewing and Searching Log Files" section in the Oracle Fusion Middleware Administrator's Guide.







See the following chapters for the various ways to recover transactions and messages:

	
Chapter 8, " Managing SOA Composite Application Instances" to recover from the SOA composite application page in Oracle Enterprise Manager Fusion Middleware Control.


	
Chapter 14, "Managing BPEL Process Service Components and Engines" to recover from the BPEL process service component and BPEL process service engine message recovery pages.











B.4 Human Workflow Troubleshooting

This section describes how to troubleshoot human workflow issues.



B.4.1 Task Assignment/Routing/Escalation Issues

Table B-2 describes symptoms, possible causes, and possible solutions for task assignment/routing/escalation issues.


Table B-2 Troubleshooting Task Assignment/Routing/Escalation Issues

	Symptom	Possible Cause	Possible Solution
	
The task completes without any assignment occurring.

	
The most common problem is that task assignees are specified using XPath expressions, and the expression does not evaluate to any nodes. Other problems can include incorrect skip conditions for participants.

	
	
Correct any issues with the XPath expressions.


	
Ensure that you get some results for the XPath expression for the given data.


	
Check the skip conditions specified with the Specify skip rule checkbox for task participants in the Human Task Editor.





	
The business rules do not return any list builders.

	
When participants of a task are specified using business rules, it is expected that business rules return at least one list builder. If business rules determine that no participants are needed, the function IgnoreParticipant(...) must be used. If modeled correctly and you still see this error, it is likely that none of the rules fired. See the symptom entitled '"A human workflow task chooses the incorrect user if many rules are defined or it errors with the following message:" in this table.

	
	
Use the ignoreParticipant(..) function to model your rules.


	
Ensure the rules are modeled correctly so that at least one rule is fired.





	
The business rules return list builders of different types.

	
When participants in a task are specified using business rules, it is expected that business rules return list builders of the same type.

	
Correct your rules.


	
A human workflow task chooses the incorrect user if many rules are defined or it errors with the following message:


Ruleset returned lists with
different list builder

	
At runtime, when a human workflow task tries to fetch the list of users, it may error out with the following error:


Ruleset returned lists with different list builder


This error is displayed in the Task Detail comments field. Alternately, the task may select a user or approver, which may not appear to be the correct or expected one. This is primarily caused by having overlapping rules. When the participants of a task are specified using business rules, it is expected that business rules return list builders of the same type.

Moreover, only one rule from a ruleset must be applicable for a transaction. In case many rules are true, the actions associated with the applicable rule with the highest priority get executed. In case multiple applicable rules have the same priority, then the first rule in the list is picked and its actions executed.

	
Avoid writing overlapping rules. Constraints from different list builders are different and cannot be mixed. If multiple rules get triggered with a different list builder, this error occurs. In addition, only one set of constraints is honored.

Check that all rules in the ruleset have priorities defined so that multiple rules with the same priority are not applicable for the same transaction.

For more details., see Oracle Fusion Middleware Modeling and Implementation Guide for Oracle Business Process Management.


	
Parallel assignees have to approve or reject the task even though the parallel completion criteria is met.

	
In the Add Participant Type dialog for a parallel participant, there is a selection that enables you to configure the human task during runtime to wait for all parallel participants to complete or to complete when criteria is met.

	
Make the correct selection for completion in the Add Participant Type dialog.


	
The task is assigned to the group/role when the expectation is that it goes to every user in the group/role individually.

	
When a group or a role is used as a task assignee, the task is assigned to the group or role directly. Task runtime does not assign it separately. One of the users in the group/role has to claim the task and work on it. When used with a parallel or serial participant, often times it is expected that this resolution to users is automatic, which it is not.

	
To assign separately to the members of the group or role, use the XPath functions ids:getUsersInGroup and ids:getUsersInAppRole.


	
A task errors out when invoking the decision service for evaluation of routing rules or rule-based participants.

	
Payload validation is enabled on the SOA infrastructure instance.

	
Deselect the Payload Validation checkbox for the instance. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."












B.4.2 Task Action Issues

Table B-3 describes symptoms, possible causes, and possible solutions for task action issues.


Table B-3 Troubleshooting Task Action Issues

	Symptom	Possible Cause	Possible Solution
	
A user is not allowed to perform an action on a task.

	
The most common problem is that the user does not have permissions to perform that action on that task at that point in time.

	
Find out if the user can be an assignee, owner, or creator of the task, or if they are an administrator. If the user should have been allowed to perform the action, check the server log file for a detailed log message, which includes information such as the task state, task assignees, user who acquired it, permitted actions, roles played by this user for the given task, and so on.


	
A task is locked and cannot be updated in Oracle BPM Worklist. An ORA-30279 error is displayed (with an underlying ORA SQL exception of ORA-20001 also displayed).

	
Two users are trying to update the same task concurrently.

	
Wait for the other user to finish.












B.4.3 Notification Issues

Table B-4 describes symptoms, possible causes, and possible solutions for notification issues.


Table B-4 Troubleshooting Notifications Issues

	Symptom	Possible Cause	Possible Solution
	
The task email notification is not being sent out.

	
Notification Mode is set to NONE on the Workflow Notification Properties page in Oracle Enterprise Manager Fusion Middleware Control.

	
Change this setting to Email or All. For information, see Section 20.1, "Configuring Human Workflow Notification Properties."


	
The email notification is not being sent out.

	
Incorrect outgoing server settings are used in the email driver configuration.

	
Check the SMTP port/SMTP host/user name/password/email values.

Tip: Validate the values by using them in any email client for connecting to the SMTP server.

Perform the following steps to verify the settings in Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigator, right-click User Messaging Service.


	
Select usermessagingdriver-email > Email Driver Properties.


	
Check the settings.





	
The notifications are sent, but are not actionable.

	
The Actionable Address field is not configured.

	
In Oracle Enterprise Manager Fusion Middleware Control, configure the Actionable Address field with a valid email address. For information, see Section 20.1, "Configuring Human Workflow Notification Properties."

Ensure that the same email address is used when configuring the incoming server setting in the Oracle User Messaging Server email driver. For information, see Section 20.1, "Configuring Human Workflow Notification Properties."


	
Notifications are sent, but are not actionable.

	
The human workflow task is not set to send actionable notifications.

	
In the Human Task Editor (you can double click the .task file in Oracle JDeveloper to start the editor), expand the Notification section, click the Advanced tab, and select the Make notification actionable checkbox.


	
Actionable notifications are sent, but no action is taken after responding.

	
The Actionable Address field is incorrect.

	
Check the IMAP/POP3 server/port values. Ensure the Actionable Address field is used in the email driver configuration.

Tip: Validate the values by using them in any email client for connecting to the IMAP/POP3 server.


	
Actionable notifications are sent, but no action is taken after responding.

	
The nondefault email client is configured for receiving notifications.

	
When the user clicks the approval link, the default mail client page opens, which may send emails to a different email server. Configure the default email client to receive actionable notifications.

Enter the correct value in the Actionable Email Account field of the Workflow Task Service Properties page as the incoming, actionable email account to use. The default account name is Default.

For information, see Section 20.2, "Configuring Human Workflow Task Service Properties."


	
Actionable notifications are sent but no action is taken after responding.

	
An email client is configured with the same account used in the email driver.

	
The mail may be downloaded and marked as read or deleted by the email client before the human workflow notification service can download and process the mail. Remove that account from the email client.


	
The Oracle BPM Worklist link appears in email notifications.

	
This is the default behavior. By default, email notifications point to Oracle BPM Worklist.

	
Perform the following steps:

	
In the Notification section of the Human Task Editor, click the Advanced tab.


	
Deselect the Show worklist URL in notifications checkbox.





	
Performance is slow for group notifications.

	
The group notification performance depends on the number of members in the group (size of group).

	
	
Provide an email ID for the group in LDAP. In this case, human workflow sends one email to the group email ID, instead of individual emails to each group member.


	
In the Notification section of the Human Task Editor, click the Advanced tab.


	
If you want to send one email to all group members, select Send one email containing all user addresses from the Group notification configuration list. This action enables all members to see the to list and common content is sent to all members (without considering locale, and so on).


	
If you want to send individual emails but reuse content between members, select Send individual emails (the default selection) from the Group notification configuration list and unselect Use separate task forms based on locale. This action enables group members to receive individual mails in their locale. Task forms generated for creating notification content are reused between members in the same locale.















B.4.4 Task View Issues

Table B-5 describes symptoms, possible causes, and possible solutions for task view issues.


Table B-5 Troubleshooting Task View Issues

	Symptom	Possible Cause	Possible Solution
	
Showing custom (mapped attribute) columns in a view.

	
Attribute mappings are created for specific task types. The view must be associated with one or more task types to use mapped attributes.

	
In Oracle BPM Worklist (view/create/edit UI), specify a task type for the view in the Definition tab. The attribute labels used in the mappings for that task type are now available as columns that can be used in the view in the Display tab.

It is possible to associate a view with multiple task types. Multiple task types can be selected from the Task Type browser. If multiple task types are selected, then the attribute labels for all those task types are available for use in the view.


	
View grantees can view and edit tasks belonging to the view owner.

	
The view is shared as data. This type of sharing allows grantees to use the view as if they are the view owner, and can see and act on the view owner's task.

	
In the Definition tab of Oracle BPM Worklist (view/edit UI), ensure that Share View is set to Definition only, which enables grantees to use the view against their own tasks. Setting Share View to Data enables grantees to use the view against the view owner's data.


	
Creating a new standard view.

	
Only users with administration privileges can create standard views.

	
	
Ensure the logged-in user has administration privileges.


	
Define the view as usual, using Oracle BPM Worklist (create/edit UI).


	
Check the add to standard views checkbox.

The view is created as a standard view.





	
Internationalizing a standard view name.

	
The value specified in the name field for standard views can be used as a resource key to look up a display name from the WorkflowLabels resource bundle.

	
Add a new resource key to the WorkflowLabels resource bundle. The key is the name you used for the view, prefixed by STD_VIEW. (note the required trailing period).

For more information about resource bundles, see workflow sample workflow-110-workflowCustomizations, available with the Oracle SOA Suite Samples.


	
Migrating views and standard views you have created on one instance to another SOA server.

	
You must use the test-to-production utility.

	
The test-to-production utility enables you to export user views and standard views as an XML file, and to import the views from the XML file into another instance. For information about this utility, see Section 22.6, "Moving Human Workflow Data from a Test to a Production Environment."












B.4.5 Task Attribute Mapping Issues

Table B-6 describes symptoms, possible causes, and possible solutions for task attribute mapping issues.


Table B-6 Troubleshooting Task Attribute Mapping Issues

	Symptom	Possible Cause	Possible Solution
	
No payload attributes are available for mapping to a public attribute in Oracle BPM Worklist.

	
Oracle BPM Worklist only supports creation of mappings to simple payload attributes. Only simple attributes from the task payload are displayed for creating mappings in Oracle BPM Worklist.

	
	
Add simple attributes to the payload.


	
Create protected mappings at design time. Mappings can be made to be complex payload attributes using XPath expressions for protected attribute mappings at design time in Oracle JDeveloper.


	
Use the RuntimeConfigService API to create public mappings using XPath expressions.





	
You cannot create mappings for the protected attribute label in Oracle BPM Worklist.

	
Protected mappings can only be created as part of the task definition at design time. Protected mappings cannot be created or updated at runtime using Oracle BPM Worklist, or the RuntimeConfigService API.

	
	
Use a public attribute label for the mapping.


	
Create the mapping to the protected attribute label in the task definition at design time.





	
You cannot see any attribute labels for which to create mappings in Oracle JDeveloper.

	
Design-time mappings can only be created for protected attribute labels. Ensure that protected attribute labels have been created in the SOA instance to which you are connected.

	
	
Log in to Oracle BPM Worklist as an administrator.


	
Go to Administration > Protected Flexfields.


	
Check that protected attribute labels exist.


	
Create any protected attribute labels as required.





	
Internationalizing the name of an attribute label.

	
The attribute label name can be used as a resource key to look up a display name from the WorkflowLabels resource bundle.

	
Add a new resource key to the WorkflowLabels resource bundle. The key is the name you used for the label, prefixed by FLEX_LABEL. (note the trailing period).

For more information on the resource bundle, see the workflow sample workflow-110-workflowCustomizations, available with the Oracle SOA Suite Samples.


	
Migrating attribute labels and mappings from one server to another.

	
Use the test-to-production utility.

	
The test-to-production utility enables you to export public attribute labels, public attribute mappings, and protected attribute labels as an XML file, and to import the labels and mappings from the XML file into another instance.

For more information, see Section 22.6, "Moving Human Workflow Data from a Test to a Production Environment."












B.4.6 Task Report Issues

Table B-7 describes symptoms, possible causes, and possible solutions for task report issues.


Table B-7 Troubleshooting Task Report Issues

	Symptom	Possible Cause	Possible Solution
	
You receive the following error:


Null Pointer Exception when
running Task Productivity
Report

	
This is caused by an issue with handling of dates when the worklist client locale and server default locale are different.

	
The workaround is to change the locale for the worklist client to be the same as the server, or to run a report without specifying dates.












B.4.7 Task History Issues

Table B-8 describes symptoms, possible causes, and possible solutions for task history issues.


Table B-8 Troubleshooting Task History Issues

	Symptom	Possible Cause	Possible Solution
	
The Add Participant button is disabled.

	
A current or past participant is selected in the history table,

	
This is designed behavior. Adding adhoc participants is not allowed with the current or past participant. The current participant means the task is with that participant at that point in time.


	
All the added adhoc participants disappeared after a page refresh.

	
You may not have saved your modifications to the history table.

	
Ensure that you save your changes. Otherwise, all changes disappear. If you think you have saved your changes and the changes still disappear, file a bug.


	
Do not see future approvers in the history table.

	
The Future Approvers checkbox may not be selected.

	
Select the Future Approvers checkbox in Oracle BPM Worklist (configuration in the task sequence table).


	
You see the message in the history table about the correlation ID not being passed or any exception related to the correlation ID.

	
If the task is uninitiated, the correlation ID may not have been passed.

	
Ensure that you pass the correlation ID to the uninitiated task.


	
The edit toolbar is disabled or is not displayed.

	
The user may not have privileges to edit the participants.

	
	
In the Assignment tab of the Human Task Editor, click the Task will go from starting to final participant icon in the upper right corner.

The Configure Assignment dialog is displayed.


	
Select the Allow participants to edit new participants and Allow initiator to add participants checkboxes.





	
You receive the following error:


<Warning>
<oracle.adf.controller.intern
al.metadata.MetadataService>
 <BEA-000000><ADFc:
 /META-INF/adfc-config.xml: > 
  <Warning>
<oracle.adf.controller.intern
al.metadata.MetadataService><
ADFC-52024> <ADFc: Duplicate
 managed bean definition for
 'aleCompBindings' detected.> 

	
Shared library oracle.soa.worklist.webapp is referenced in weblogic.xml and the JAR files adflibWorklistComponents.jar and adflibTasklistTaskflow.jar are packaged in the web application.

	
These JARs ideally should not be packaged inside the web application. They should only be referenced as a shared library. Do not package these JARs in the web application.


	
You receive the following error:


<Error> <Deployer>
 <BEA-149265> <Failure
 occurred in the execution of
 deployment request with ID
 '1297964056778' for task
 '3'. Error is:
 'weblogic.management.Deployme
ntException:
[J2EE:160149]Error while
processing library
references. Unresolved
application library
references, defined in
weblogic-application.xml:
[Extension-Name:
oracle.soa.workflow.wc,
exact-match: false].'
weblogic.management.Deploymen
tException:
[J2EE:160149]Error while
processing library
references. Unresolved
application library
references, defined in
weblogic-application.xml:
[Extension-Name:
oracle.soa.workflow.wc,
exact-match: false].

	
Shared library oracle.soa.workflow.wc is referenced in weblogic.xml, but not available on the server.

	
Ensure that this shared library is deployed on the server to which you are deploying your application. It may happen that the shared library is deployed, but not targeted, for that server.


	
You receive the following error:


java.lang.IllegalStateExcepti
on: Attempt to validate an
already invalid RegionSite: 

	
This is a generic exception that sometimes is displayed in the server logs (for example, AdminServer.log).

	
See the real exception in the diagnostic logs (for example, AdminServer-diagnostic.log) and provide that exception with the bug you file.


	
You receive the following error:


[AdminServer] [NOTIFICATION]
 [J2EE JSP-00008]
 [oracle.j2ee.jsp] [tid:
 [ACTIVE].ExecuteThread: '15'
 for queue:
 'weblogic.kernel.Default
 (self-tuning)'] [userId:
 weblogic] [ecid:
17011f2a001d6b0e:7e22d6ce:12e
3444eb1b:-8000-0000000000002f
0a,0] [APP: FederatedApp_
application1] unable to
 dispatch JSP page: The
 following exception
 occurred:.[[
java.lang.RuntimeException:
 Cannot find FacesContext
        at
javax.faces.webapp.UIComponen
tClassicTagBase.getFacesConte
xt(UIComponentClassicTagBase.
java:2122) 

	
This is a common mistake and is not related to any components you are using. You forget to put faces in the URL. For example:


http://server:port/FederatedApp
/test.jspx

	
Put faces in the URL as follows:


http://server:port/FederatedApp/fac
es/test.jspx\\












B.4.8 Task Form/Action Issues

Table B-9 describes symptoms, possible causes, and possible solutions for task form/ action issues.


Table B-9 Troubleshooting Task Form/ Action Issues

	Symptom	Possible Cause	Possible Solution
	
The task form application does not have an empty JSPX page.

	
N/A

	
The task forms are now invoked using an ADF task flow and control is returned to the module that initiated the task form task flow when the task flow completes. Therefore, no empty JSPX is needed.


	
The task form does not load in Microsoft Internet Explorer.

	
Microsoft Internet Explorer has a URL length limit.

	
Your task form URL length is too long.


	
Deployment fails with a class not found exception.

	
The shared library entry is missing from weblogic.xml.

	
If you see the following error:


Caused By:
 java.lang.ClassNotFoundException:
oracle.bpel.services.datacontrol.ty
pes.Number 


during deployment of a task form, then it is likely due to the missing shared library in weblogic.xml. Add the following element in weblogic.xml:


<library-ref>
 <library-name>oracle.soa.worklist.w
 ebapp</library-name>
 <specification-version>11.1.1</spec
 ification-version>
</library-ref> 


	
Deployment/access of task form fails when the hostname is used.

	
The DNS entry is missing.

	
If you are using a server with DHCP, the DNS entry may be missing for the host. Therefore, deployment/access using the IP address may succeed, but deployment/access using a hostname may fail. Update your client computer by manually adding the host/IP address:

	
On Windows operating systems, this is typically is in %windir%\drivers\etc\lmhosts.


	
On Linux/UNIX, this is typically in /etc/hosts.





	
Task form URL protocol (HTTP or HTTPS).

	
You are unable to access the task form through HTTPS or HTTP.

	
	
DefaultToDoTaskForm: The worklist accesses the default to-do task form using the port/protocol returned by the getServerInfo API from the runtime config service. This API uses the frontend host setup for the cluster or managed server. It gives preference to the HTTPS protocol if it is enabled. It is dynamic and can be changed using Oracle Enterprise Manager Fusion Middleware Control for default to-do tasks as the other custom task form.


	
CustomTaskForm: The custom task form gets the HTTP and HTTPS information from the setup. It uses the JRF API to get the information. This gets the frontend host information from the cluster and then the managed server if the cluster frontend host is not set up. In case the managed server frontend host is not set up, it uses a regular port. If the user enables the HTTPS port during deployment, the task form stores this information in the database. After this occurs, if the user disables the HTTPS port using Oracle WebLogic Server Administration Console, then the user must remove the HTTPS port for the task form using Oracle Enterprise Manager Fusion Middleware Control.















B.4.9 Task Comments/Attachment Issues

Table B-10 describes symptoms, possible causes, and possible solutions for task comments/attachment issues.


Table B-10 Troubleshooting Task Comments/Attachment Issues

	Symptom	Possible Cause	Possible Solution
	
The file is not getting uploaded.

	
The file is too big

	
By default, ADF has a size limit of 2000 KB for each request. Add the following parameters in web.xml to adjust file size and temporary storage for uploaded files:


<context-param>
  <!-- Maximum memory per request
(in bytes) -->
<param-name>oracle.adf.view.faces.U
PLOAD_MAX_MEMORY</param-name>
  <!-- Use 500K -->
  <param-value>512000</param-value>
</context-param>
<context-param>
  <!-- Maximum disk space per
 request (in bytes) -->
<param-name>oracle.adf.view.faces.U
PLOAD_MAX_DISK_SPACE</param-name>
  <!-- Use 5,000K -->
 <param-value>5120000</param-value>
</context-param>
<context-param>
  <!-- directory to store temporary
 files -->
<param-name>oracle.adf.view.faces.U
PLOAD_TEMP_DIR</param-name>
  <!-- Use an ADFUploads
 subdirectory of /tmp -->
<param-value>/tmp/ADFUploads/</para
m-value>
</context-param>


	
The file uploaded in the task details application is not visible in the same task flow.

	
After uploading a file, the attachment link generated in task form is invalid. Clicking this link returns an empty stream.

	
When you upload a file, you see the attachment link in the table. However, this link does not work. You must reload the task details to view the file.


	
Adding file attachments creates a new task version, but adding a URL attachment does not create a new version.

	
Inconsistent behavior of URL attachment and file attachment

	
When a file is uploaded, the task is saved because the file is uploaded to persistency storage. This creates a new task version. The URL attachments only update the local task object in the user interface application. Therefore, no task version is created.












B.4.10 Design Time at Runtime Issues

Table B-11 describes symptoms, possible causes, and possible solutions for design time at runtime issues. Two design time at runtime tools are available for use:

	
Oracle SOA Composer


	
Task Configuration tab of Oracle BPM Worklist





Table B-11 Troubleshooting Design Time at Runtime UI Issues

	Symptom	Possible Cause	Possible Solution
	
Modifications made to a task in a design time at runtime tool do not appear for the task.

	
The task was instantiated before you actually edited it using a design time at runtime tool.

	
Design time at runtime updates go into effect only for instances created after the changes, and not for those that were created before the change.

Therefore, if you edit a task using a design time at runtime tool, and then instantiate a new task, the new instance of the task has the changes you made.


	
Modifications made to a task in a design time at runtime tool do not appear for the task.

	
The changes made were probably not committed to the MDS repository.

	
The Save button just saves the changes made in a design time at runtime tool to the sandbox. To see these changes in action, click Commit to send them to the MDS repository.












B.4.11 Human Workflow API (Including SOAP/EJB) Usage Issues

Table B-12 describes symptoms, possible causes, and possible solutions for human workflow API (including SOAP/EJB) usage issues.


Table B-12 Troubleshooting Human Workflow API Usage Issues

	Symptom	Possible Cause	Possible Solution
	
Location of the JavaDoc for human workflow APIs.

	
N/A

	
See Oracle Fusion Middleware Workflow Services Java API Reference for Oracle BPEL Process Manager, which is available in the documentation library.


	
Understanding the API usage.

	
N/A

	
	
Refer to the API documentation.


	
See sample workflow-118-JavaSamples, available with the Oracle SOA Suite Samples.





	
Using .net to access the APIs.

	
N/A

	
It is possible to write a .net client that accesses the SOAP web service APIs. See sample workflow-119-DotNetSample, available with the Oracle SOA Suite Samples.


	
You receive Class not found errors when attempting to use the Java API clients.

	
Not all required JAR files are in the client class path.

	
See the workflow-118-JavaSamples definition of client.classpath in the build.xml ant file, available with the Oracle SOA Suite Samples.The sample includes all required JAR files.


	
Creating a routing slip for simple patterns to use with a simple approval task or to dynamically route a task during task initiation.

	
N/A

	
See oracle.bpel.services.workflow.task.impl.SimpleApprovalTaskUtil.












B.4.12 Oracle JDeveloper Data Control / Form Generation Issues

Table B-13 describes symptoms, possible causes, and possible solutions for Oracle JDeveloper data control/form generation issues.


Table B-13 Troubleshooting Oracle JDeveloper Data Control / Form Generation Issues

	Symptom	Possible Cause	Possible Solution
	
Empty1.jspx is not generated when creating the task form.

	
Created an initiator task based on an XSD element and tried to autogenerate the task form.

	
This file is not required except for the BPM initiator task. If you encounter it, create an Empty1.jspx file in the same directory as referenced by adfc-config.xml and put the following content in it:


<?xml version='1.0'
 encoding='UTF-8'?><jsp:root
xmlns:jsp="http://java.sun.com/JSP/
Page" version="2.1"xmlns:f="http://java.sun.com/jsf/core"
xmlns:h="http://java.sun.com/jsf/html"
xmlns:af="http://xmlns.oracle.com/a
df/faces/rich">  <jsp:directive.page
contentType="text/html;charset=UTF-8"/>
  <f:view>
    <af:document id="d1">
      <af:form id="f1"></af:form>
    </af:document>
  </f:view>
</jsp:root>












B.4.13 Human Workflow Service/ System MBean Browser Issues

Table B-14 describes symptoms, possible causes, and possible solutions for human workflow service/System MBean Browser issues.


Table B-14 Troubleshooting Human Workflow Service/ System MBean Browser Issues

	Symptom	Possible Cause	Possible Solution
	
Setting commonly used human workflow configuration parameters.

	
N/A

	
Use the Workflow Task Service and Workflow Notification pages of Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigator, right-click soa-infra.


	
Select SOA Administration > Workflow Config > Mailer tab to access notification properties.


	
Select SOA Administration > Workflow Config > Task tab to access task service properties.





	
Setting human workflow configuration parameters not available in the Oracle Enterprise Manager Fusion Middleware Control properties pages.

	
N/A

	
Use the System MBean Browser in Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigator, right-click soa-infra.


	
Select SOA Infrastructure >Administration > System MBean Browser.


	
Select Application Defined MBeans > oracle.as.soainfra.config > server > WorkflowConfig > human-workflow.


	
Set simple parameters by editing the appropriate field in the Attributes tab, and clicking Apply.


	
Make more complex parameter changes (for example, adding a new locale) by switching to the Operations tab, selecting the appropriate operation, entering required fields, and clicking Invoke.





	
The System MBean Browser does not reflect my changes after editing the human workflow configuration MBeans.

	
The System MBean Browser is showing a previously cached version of beans.

	
Click the refresh cached tree data button in the System MBean Browser.


	
Human workflow services are not locating resource bundles or classes located at the workflow customizations class path URL.

	
The protocol is not specified in the URL, or the URL is missing a trailing forward slash (/).

	
Ensure that the configured URL is formatted correctly, and specifies a protocol. If the class path points to a directory (rather than a JAR file), it is important that the URL has a trailing forward slash character. For example:


file:///home/wstallar/wfcustomizati
ons/


	
Manually setting the URL used for displaying task details for a particular task component.

	
N/A

	
Use the Administration page in Oracle Enterprise Manager Fusion Middleware Control for the human task service component.

See Section 22.3, "Managing the URI of the Human Task Service Component Task Details Application" for instructions.

You can edit or delete existing task display URL entries, and add new entries. For task display URLs used from Oracle BPM Worklist, the application name must be set to worklist.












B.4.14 AMX Extension Issues

Table B-15 describes symptoms, possible causes, and possible solutions for AMX extension issues.


Table B-15 Troubleshooting AMX Extension Issues

	Symptom	Possible Cause	Possible Solution
	
The dynamic approval group class is not found.

	
The class file is not accessible in the Oracle SOA Suite class path

	
To make the dynamic approval group class accessible, the class file must be placed in the following directory:


$FMW_HOME/SOA_HOME/soa/modules/ora
cle.soa.ext_11.1.1/classes


This directory is part of the SOA class path.

The Oracle WebLogic Server must be restarted.


	
During design time at runtime, while defining a rule based on the Approval Group list builder, a message keeps appearing indicating that the group does not exist.

	
The Approval Group name is not enclosed in quotes (" ")

	
Enclose the name in quotes (for example, "Sample Approval Group Name").


	
In a ruleset, many rules defined are applicable for a transaction. It appears that the correct constraints are not getting applied; therefore, the generated approver list is not correct.

	
Only one rule from a ruleset must be applicable for a transaction.

In case many rules are true, the actions associated with the applicable rule with the highest priority are executed.

In case multiple applicable rules have the same priority, the first rule in the list is picked and its actions are executed.

	
Check that all rules in the ruleset have priorities defined so that multiple rules with the same priority are not applicable for the same transaction.












B.4.15 Oracle BPM Worklist/Task Region Issues

Table B-16 describes symptoms, possible causes, and possible solutions for Oracle BPM Worklist/task region issues.


Table B-16 Troubleshooting Oracle BPM Worklist/Task Region Issues

	Symptom	Possible Cause	Possible Solution
	
You receive the following exception message in the logs:


<Warning>
<oracle.adf.controller.internal.
metadata.MetadataService>
<BEA-000000><ADFc:
/META-INF/adfc-config.xml: >
<Warning>
<oracle.adf.controller.internal.
metadata.MetadataService><ADFC-5
2024> <ADFc: Duplicate managed
bean definition for
'aleCompBindings' detected.> 

	
The shared library oracle.soa.worklist.webapp is referenced in the weblogic.xml file and also the JAR files adflibWorklistComponents.jar and adflibTasklistTaskflow.jar are packaged in the web application.

	
These JARs ideally should not be packaged inside the web application. They should only be referenced as a shared library. Do not package these JARs in the web application.


	
You receive the following exception message in the logs:


Duplicate default server in
client configuration.
Configuration needs to have only
one default server in client
configuration.
Specify one default server in
client configuration. 

	
Two default servers are specified in the client configuration file or in the JAXB object passed to the task flow.

	
Mark only one server as the default in the client configuration file or in the JAXB object passed.


	
You receive the following exception message in the logs:


The default server is not
specified 

	
The default server is not specified in the client configuration file or in the JAXB object passed to the task flow.

	
Ensure that the default server is marked in the client configuration file or the JAXB object.


	
You receive the following exception message in the logs:


Invalid display column.
The display column COLUMN NAME
is not a valid Task column.
Specify a valid column name.

	
The column name passed to the task flow parameter displayColumnsList is not correct.

	
Ensure that you pass the correct column name to the task flow parameter.


	
You receive the following exception message in the logs:


java.lang.IllegalStateException:
Attempt to validate an already
invalid RegionSite: 

	
This is a generic exception that sometimes appears in server logs (for example, AdminServer.log).

	
See the real exception in the diagnostic logs (for example, AdminServer-diagnostic.log) and provide that exception with the bug you can file.


	
You receive the following exception message in the logs:


Caused by:
oracle.adf.controller.Controller
Exception: ADFC-02001: The ADF
Controller cannot find
'/WEB-INF/taskList-task-flow-def
inition.xml'

	
The Oracle BPM Worklist JARs are not provided in the class path, either by referring to the shared library oracle.soa.worklist.webapp or by packaging those in the web application.

	
Ensure either the JARs are referred through the shared library or packaged inside the application.


	
Filters for the task list are removed when the task list is refreshed.

	
Because an inbox is not a persisted view, filters set on it are removed when rendering the page again or refreshing the task list.

	
Instead of setting filters on the task list, create a user view with the required set of filters and pass the viewId of that view as the value of parameter ViewFilter. This makes that view the default view of the task list.


	
You have set the taskTypesFilterList parameter, but instead of seeing assigned tasks, you are seeing all tasks.

	
If you specified the taskTypesFilterList parameter, then you forgot to specify the attributesFilterList parameter.

	
You have to use both parameters with the AND operator. For example:


<parameter
id="taskTypesFilterList"
value="http://xmlns.oracle.com/H
elpDeskRequestSOAApp/HelpDeskReq
uestComposite/HelpDeskRequestHum
anTask,[
http://xmlns.oracle.com/Vacation
RequestApp/VacationRequest/Vacat
ionRequestTask]"/>

<parameter id=
"attributesFilterOperator"
value="and"/>
 <parameter id= "attributesFilterList"
 value="state=ASSIGNED"/>


	
You receive the following exception message in the logs:


[AdminServer] [NOTIFICATION]
 [J2EE JSP-00008]
 [oracle.j2ee.jsp] [tid:
 [ACTIVE].ExecuteThread: '15'
 for queue:
 'weblogic.kernel.Default
 (self-tuning)'] [userId:
 weblogic] [ecid:
17011f2a001d6b0e:7e22d6ce:12e344
4eb1b:-8000-0000000000002f0a,0]
 [APP: FederatedApp_
application1] unable to dispatch
 JSP page: The following
 exception occurred:.[[
java.lang.RuntimeException:
 Cannot find FacesContext 
at
javax.faces.webapp.UIComponentCl
assicTagBase.getFacesContext(UIC
omponentClassicTagBase.java:2122)

	
This is a common mistake that is generic in nature and is not related to any components you are using. You forgot to put faces in the URL. For example:


http://server:port/FederatedApp/test.jspx

	
Put faces in the URL as follows:


http://server:port/FederatedApp/
faces/test.jspx


	
You receive the following exception message in the logs:


[AdminServer] [TRACE] [] []
[tid: [ACTIVE].ExecuteThread:
'5' for queue:
'weblogic.kernel.Default
(self-tuning)'] [userId:
weblogic] [ecid:
17011f2a001d6b0e:7e22d6ce:12e344
4eb1b:-8000-0000000000001d39,0]
[SRC_CLASS:
oracle.bpel.services.workflow.cl
ient.config.ClientConfigurationU
til] [APP: FederatedApp_
application1] [SRC_METHOD:
getClientConfiguration]
WorkflowServiceClientContext:
Cannot find client
configuration file: wf_client_
config.xml 

	
There are three possible causes for this issues:

	
The client configuration file is not provided in the class path.


	
The JAXB object is not passed to the task flow.


	
If one of the above is provided, the port number for the remote/SOAP client is incorrect.




	
Ensure either the client configuration file wf_client_config.xml is provided in the class path or the JAXB object is passed to the task flow. If it is already done, ensure that the port number refers to the SOA server.


	
You receive the following exception message in the logs:


<Error> <Deployer> <BEA-149265>
<Failure occurred in the
execution of deployment request
with ID '1297964056778' for
task '3'. Error is:
'weblogic.management.DeploymentE
xception: [J2EE:160149]Error
while processing library
references. Unresolved
application library references,
defined in
weblogic-application.xml:
[Extension-Name:
oracle.soa.workflow.wc,
exact-match: false].'
weblogic.management.DeploymentEx
ception: [J2EE:160149]Error
while processing library
references. Unresolved
application library references,
defined in
weblogic-application.xml:
[Extension-Name:
oracle.soa.workflow.wc,
exact-match: false]. 

	
Shared library oracle.soa.workflow.wc is referenced in weblogic.xml, but is not available on the server.

	
Ensure that this shared library is deployed on the server on which you are deploying your application. The shared library may be deployed, but not targeted, for that server.


	
You cannot see the mapped attributes mapped columns.

Note: Oracle BPM Worklist flex fields are now known as mapped attributes.

	
The right set of parameters is not being passed to the task list task flow.

	
The correct set of parameters to be passed is as follows:


<parameter id= "displayColumnsList"
value="assignees,creator,
assignedDate,state,
textAttribute1,textAttribute2"/>


textAttribute1,textAttribute2 is the correct way to provide a value for the column name. Providing 'label name'(Name of the mapping) associated with these values does not work.

You must specifically pass the fully qualified value to parameter taskTypesFilterList. Otherwise, the column creation does not work.

For example:


<parameter
 id="taskTypesFilterList"
value="http://xmlns.oracle.com/Hel
pDeskRequestSOAApp/HelpDeskRequest
Composite/HelpDeskRequestHumanTask
"/>












B.4.16 Test-to-Production Issues

Table B-17 through Table B-20 describe symptoms, possible causes, and possible solutions for test-to-production issues.


Table B-17 Troubleshooting Test-to-Production Issues

	Symptom	Possible Cause	Possible Solution
	
Finding the default realm name for a SOA server

	
N/A

	
The defaultRealmName can be obtained from the identity configuration service. You can get this from the SOAP service test page.

	
From a browser, go to the following URL:


http:HOST:PORT/integration/servic
es/IdentityService/configuration


	
Select getDefaultRealmName from the Operation drop-down menu.


	
Click the Invoke button.




This retrieves the default realm name. Here is a sample answer from an invocation:


<env:Envelope
xmlns:env="http://schemas.xmlsoap.org/soap
/envelope/">
 <env:Header/>
 <env:Body>
  <realmName
xmlns="http://xmlns.oracle.com/bpel/servi
ces/IdentityService">jazn.com</realmName>
 </env:Body>
</env:Envelope>









Table B-18 Troubleshooting Test-to-Production Issues

	Symptom	Possible Cause	Possible Solution
	
User authentication error (in the following example, the user is FMW_USERID and the identity context is jazn.com): Assume you encounter the following error:


[java] Error in workflow service Web
service operation invocation. The
error is ORA-30501:Error in
authenticating user.
[java] Error in authenticating and
creating a workflow context for
user jazn.com/FMW_USERID. [java]
Verify that the user credentials
and identity service configurations
are correct.

	
This occurs if the given user is not seeded and available in the LDAP provider.

To find out if the user is seeded properly, try to log in to Oracle BPM Worklist from a browser as this user. If the user can log in to Oracle BPM Worklist, that means the user is seeded.

	
If Oracle Internet Directory or another other LDAP provider is used, ensure the configuration of the LDAP provider is completed correctly. Otherwise, you cannot get past this error.


	
Import of task payload mapped attributes (previously known as flex field) mappings:

While importing task payload mapped attribute mappings into the target SOA server, you may encounter the following error in the console logs:


[java] Caused by:
java.sql.SQLIntegrityConstrain
tViolationException: ORA-02291:
integrity constraint (UAT_
SOAINFRA.SYS_C0018364) violated -
parent key not found* * 

	
The importing of task payload mapped attribute mappings into the target SOA server is a two-step process.

Even before the import of task payload mapped attribute mappings into the target SOA server operation is attempted, there is a prerequisite step that must be performed. This is the import of attribute labels into the target SOA server operation.

	
To be successful, perform the following operations (in the correct order) with the human workflow test-to-production migration tool:

	
Import attribute labels into the target SOA server.


	
Import payload mappings into the target SOA server.




See Section 22.6, "Moving Human Workflow Data from a Test to a Production Environment" for more details.









Table B-19 Troubleshooting Test-to-Production Issues

	Symptom	Possible Cause	Possible Solution
	
Assume you encounter the following error during rule migration:


[java]  Error encountered during
migration. [java] Exception in thread "main"[java] 
UserConfigDataMigrationException:[java]
faultString:Invalid parameters for RULE.
[java] Invalid user and group: both
parameters can not have null values.[java] To migrate User Rules,
provide the 'user' parameter only.
[java]  To migrate Group Rules, provide
the 'group' parameter only.[java]
oracle.bpel.services.workflow.util.
tools.wfUserConfigDataMigrator.
UserConfigDataMigrationE xception [java]
at oracle.bpel.services.workflow.
util.tools.wfUserConfigDataMigrator. implhwfMigrator.parseParametersNode

	
There are two properties in the migration.properties file that are of interest for this error.

	
user


	
group




During any rule migration (whether export or import) operation, at most one of them (user or group) should have a value. That is, both user and group cannot have null or empty values.

	
Set values for at most one of them. To perform user rule migration, set the user parameter alone. To perform group rule migration, set the group parameter alone.


	
Assume you encounter the following error during rule migration:


[java]  Error encountered during
migration.[java] Exception in
thread "main"[java] 
UserConfigDataMigrationExcepti
on: [java]  faultString:
Invalid parameters for RULE.
[java]  Invalid user and group: both
 parameters can not have values.
[java]  To migrate User Rules,
 provide the 'user'parameter only. 
[java]  To migrate Group Rules,
 provide the 'group' parameter only.
[java]  oracle.bpel.services. workflow.util.tools.wfUserConfigData
Migrator.UserConfigDataMigrationE
xception 

	
This is similar to the previous explanation.

During any rule migration (whether export or import) operation, both user and group parameters cannot have a value.

	
Provide values for at most one of them.









Table B-20 Troubleshooting Test-to-Production Issues

	Symptom	Possible Cause	Possible Solution
	
Testing the health of the installed server

	
N/A

	
Before performing a test-to-production migration, it is useful to test the health of the server.

From a browser, you can test some SOAP services. The following list provides a subset of human workflow services and Oracle BPM Worklist:


http://host:port/integration/worklistapp/

http://host:port/integration/services
/TaskQueryService/TaskQueryService

http://host:port/integration/services/IdentityService/configuration

http://host:port/integration/services/IdentityService/identity

http://host:port/integration/services/RuntimeConfigService/RuntimeConfigService


You can randomly test some operations in these services, and verify that the operation yields results. Similarly, you can log in as a user to Oracle BPM Worklist and see if everything is fine.












B.4.17 Identity Service Issues

Table B-21 and Table B-22 describe symptoms, possible causes, and possible solutions for identity service issues.


Table B-21 Troubleshooting Identity Service Issues

	Symptoms	Possible Cause	Possible Solution
	
Only a subset of users in LDAP can log in to Oracle BPM Worklist.

	
The user base DN is not configured properly.

	
Mention the user base under which all the groups are seeded. This can be performed in two ways:

Add the base DN under which all the required groups are seeded. For instance, if users are seeded under:


UserDN 1 : cn=users1,dc=us,dc=oracle,dc=com
UserDN 2 : cn=users2,dc=us,dc=oracle,dc=com
UserDN 3 : cn=users3,dc=us,dc=oracle,dc=com


Then mention the group base DN as follows:


dc=us,dc=oracle,dc=com


This is the common DN. If only some user DNs are required (for example, UserDN1 and UserDN2), then the following property must be added to serviceInstance with the name idstore.ldap in the $DOMAIN_HOME/config/fmwconfig/jps-config.xml file:


<serviceInstance name="idstore.ldap"
 provider="idstore.ldap.provider">
 <property name="idstore.config.provider" 
value="oracle.security.jps.wls.internal.idstore.WlsLd
apIdStoreConfigProvider"/>
 <property name="CONNECTION_POOL_CLASS"
value="oracle.security.idm.providers.stdldap.JNDIPool"/>
 <extendedProperty>
   <name>user.search.bases</name>
   <values>
      <value>cn=users1,dc=us,dc=oracle,dc=com</value>
      <value>cn=users2,dc=us,dc=oracle,dc=com</value>
   </values>
 </extendedProperty>
</serviceInstance>


	
Users and groups seeded only in the first authenticator are visible, but not from the other authenticators.

	
By default, users and groups from the first authenticator are authorized.

	
Starting with 11.1.1.4, you can authorize users and groups from multiple authenticators. Add the following property to the idstore instance in the $DOMAIN_HOME/config/fmwconfig/jps-config.xml file.


<serviceInstance name="idstore.ldap"
  provider="idstore.ldap.provider">
   ............................
   <property name="virtualize" value="true"/>
   ..............................
</serviceInstance> 









Table B-22 Troubleshooting Identity Service Issues

	Symptom	Possible Cause	Possible Solution
	
The following exception appears when myrealm (the default realm in the Oracle WebLogic Server Administration Console configuration) is passed as a parameter to the identity context to the Identity Service APIs.


Exception seen :
 Service"
Unknown macro: {0}
"in configuration" 
Unknown macro: {1}
" could not be
initialized. Error
in initializing
service
"Authentication"
in configuration
"myrealm".

	
The human workflow identity service uses the identity context that is set in the WorkflowIdentityConfig file (by default, it is jazn.com) and not from the Oracle WebLogic Server configuration. Therefore, in the customer code, if jazn.com is passed as the identity context, the authenticate API should work fine.

	
To change the realm name, the WorkflowIdentityConfig file can be edited in the System MBean Browser of Oracle Enterprise Manager Fusion Middleware Control.

	
In the navigator, right-click soa-infra.


	
Select SOA Infrastructure > Administration > System Mbean Browser.


	
Select Application Defined Mbeans > oracle.as.soainfra.config > Server > WorkflowIdentityConfig > human-workflow > WorkflowIdentityConfig.ConfigurationType.


	
Select the configuration and rename it by invoking the operation setRealmName. This change requires a server restart.





	
After configuring LDAP with Oracle WebLogic Server, the users are visible in the Oracle WebLogic Server Administration Console, but the following error is thrown:


No Role found
matching the
criteria

	
The group's base DN is not configured properly. Either the group that is being looked up is not present in LDAP or it may be seeded outside the group base DN that is mentioned while configuring LDAP.

	
Mention the group base under which all the groups are seeded. This can be performed in two ways.

Add the base DN under which all the required groups are seeded. For instance, if groups are seeded under:


GroupDN 1 : cn=groups1,dc=us,dc=oracle,dc=com
GroupDN 2 : cn=groups2,dc=us,dc=oracle,dc=com
GroupDN 3 : cn=groups3,dc=us,dc=oracle,dc=com


Then mention the group base DN as follows:


dc=us,dc=oracle,dc=com


This is the common DN. If only some group DNs are required (for example, GroupDN1 and GroupDN2), then the following property must be added to serviceInstance with the name idstore.ldap in the $DOMAIN_HOME/config/fmwconfig/jps-config.xml file.


<serviceInstance name="idstore.ldap"
 provider="idstore.ldap.provider">
   <property name="idstore.config.provider"
value="oracle.security.jps.wls.internal.idstore.WlsL
dapIdStoreConfigProvider"/>
 <property name="CONNECTION_POOL_CLASS"
value="oracle.security.idm.providers.stdldap.JNDIPool"/>
  extendedProperty>
  <name>group.search.bases</name>
  <values>
    <value>cn=groups1,dc=us,dc=oracle,dc=com</value>
    <value>cn=groups2,dc=us,dc=oracle,dc=com</value>
  </values>
 </extendedProperty>
</serviceInstance>














B.5 Event Delivery Network Troubleshooting

This section describes how to troubleshoot Event Delivery Network (EDN) issues.


B.5.1 Tuning EDN Event Bus and Delivery

You can customize the following EDN properties in the System MBean Browser:

	
Right-click soa-infra.


	
Select SOA Infrastructure > Administration > System MBean Browser.


	
Expand Application Defined MBeans > oracle.as.soainfra.config > Server: soa_server-x > EDNConfig > edn.


	
Double-click an attribute.


	Properties	Type	Details
	
NumberOfThreads

	
int

	
Defaults to 3 for the EDN-DB implementation or 2 for the EDN-JMS implementation. Setting this property to 0 is effectively the same as 2 for EDN-DB or 1 for EDN-JMS.


	
Paused

	
boolean

	
Values are true or false. If true, the EDN listener threads are decreased to 0, which effectively stops the delivery of events. This works for EDN-DB and EDN-JMS.


	
NumberOfRetrys

	
int

	
The maximum number of EDN delivery and redeliveries before moving the event to the error hospital. This parameter works only for one and only one delivery, and not for guaranteed delivery. The maximum allowed value is 5. If set to less than 5, then it is effectively the same as 5.

If NumberOfRetrys is set to the following values:

	
>= 2, then EDN delivers the event once, and may try redeliveries up to (NumberOfRetrys -1) times in case of XA failures.


	
= 1, then EDN delivers the event only once. There is no retry with XA failures.


	
= 0, then this is the same as = 1 (that is, EDN delivers an event only once). There is no retry with XA failures.


	
> 5, then it is effectively the same as NumberOfRetrys = 5.











	
Enter a value, and click Apply.








B.5.2 Rolled Back OAOO Event Delivery Messages are Displayed in the Log Files

If the Java debug level is set to TRACE:16 (FINER) or a lower value, you may see log messages such as the following:


Began XA for OAOO
Rolled back XA for OAOO


These are normal messages of OAOO event delivery when there are no events waiting to be delivered. These are not error conditions. You can turn off these messages by setting the Java logging level to TRACE:1 (FINE) or a higher value.





B.5.3 Events Are Consumed by Multiple Revisions of the Same Composites

By design, different composites can subscribe to the same event. However, it is an error if multiple revisions of the same composite subscribe to the same event. This occurs when you have multiple active versions of the composite that may be a result of a patch failure.

Perform the following steps to determine whether there are multiple, active revisions of the same composite and to retire the composite revision that should not be active:

	
Go to Oracle Enterprise Manager Fusion Middleware Control.


	
Click SOA > soa-infra.

In the Deployed Composites section of the Dashboard tab, you see a list of deployed composite names, revisions, and modes (for example, active).


	
Identify composites with the same name and with an active mode, but with different revisions.


	
Click the composite revision that should not be active.


	
Click the Retire button.








B.5.4 Business Event Is Picked Up Twice (Or More) By SOA Server

Business events may be raised from J2EE applications and picked up more than once. Expected behavior is that they must be picked up only once.


Solution

If a patch fails, it may be possible for two versions of a given composite to be active (that is, the older version has not been retired). When multiple versions of a composite are active, they all become subscribers and the event is picked up more than once. This should not happen under normal scenarios. Reapply the patch and ensure that the deployed composite only has one active version.





B.5.5 Some Messages Are Lost Between EDN and Composites or Composites Across Clusters

Messages primarily may get lost for the following reasons:

	
The EDN message was not delivered.


	
The target asynchronous service did not respond.


	
The message was roll backed (though it was not lost; you still see it in Oracle Enterprise Manager Fusion Middleware Control).




This issue typically requires you to identify where the messages are supposed to be and to diagnose the path.

	
Check if the Oracle WSM Policy Manager security configurations allow the client to invoke the SOA composite.


	
Verify that the transaction is not transient (nonpersistent).

Oracle BPEL Process Manager uses the dehydration store database to maintain long-running, asynchronous processes and their current state information in a database while they wait for asynchronous callbacks. Storing the process in a database preserves the process and prevents any loss of state or reliability if a system shuts down or a network problem occurs. There are two types of processes in Oracle BPEL Process Manager. These processes impact the dehydration store database in different ways.

	
Transient processes: This process type does not incur any intermediate dehydration points during process execution. If there are unhandled faults or there is system downtime during process execution, the instances of a transient process do not leave a trace in the system. Instances of transient processes cannot be saved in-flight (whether they complete normally or abnormally). Transient processes are typically short-lived, request-response style processes. The synchronous process you design in JDeveloper is an example of a transient process.


	
Durable processes: This process type incurs one or more dehydration points in the database during execution because of the following activities:

	
Receive activity


	
OnMessage branch of a pick activity


	
OnAlarm branch of a pick activity


	
Wait activity




Instances of durable processes can be saved in-flight (whether they complete normally or abnormally). These processes are typically long-living and initiated through a one-way invocation. Because of out-of-memory and system downtime issues, durable processes cannot be memory-optimized.





	
If a composite instance is not visible in Oracle Enterprise Manager Fusion Middleware Control and the SOA Infrastructure is running, check that the Audit Level is not set to Off in the SOA Infrastructure Common Properties page. This can be checked in Oracle Enterprise Manager Fusion Middleware Control:

	
Right-click soa-infra (SOA_cluster_name).


	
Select SOA Administration > Common Properties.





	
If the composite instance is available, check the bpel.config.oneWayDeliveryPolicy BPEL property value. You can check the value in Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigation pane, expand soa-infra (SOA_cluster_name).


	
Expand the partition, and select the composite.

The Dashboard page for the composite is displayed.


	
In the upper right corner, click the Show XML Definition icon.

The contents of composite.xml for that composite are displayed.




If this is set to async.cache, you may lose messages. Set it to async.persist for reliable messages. This is typically specified in the BPEL process service component section of the composite.xml file, so this can be set for custom composites. If the value is not set in composite.xml, the value for oneWayDeliveryPolicy in the System MBean Browser in Oracle Enterprise Manager Fusion Middleware Control is used. The following values are possible:

	
async.persist: Messages are persisted in the database hash map.


	
async.cache: Messages are stored in memory.


	
sync: Direct invocation occurs on the same thread.




For more information about these settings, see the "Deployment Descriptor Properties" appendix and the "Transaction and Fault Propagation Semantics in BPEL Processes" chapter of the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For information about setting the oneWayDeliveryPolicy property in the System MBean Browser, see the "Configuring BPEL Process Service Engine Properties" section of Oracle Fusion Middleware Administrator's Guide for Oracle SOA Suite and Oracle Business Process Management Suite.

It is also possible that the transaction has invoked a target asynchronous service that has not responded back. In this case, the composite instance flow shows the call to the target asynchronous service.


	
Check if the instance has rolled back and the message is in recovery.

	
Log in to Oracle Enterprise Manager Fusion Middleware Control.


	
Right-click soa-infra (SOA_cluster_name), and select Service Engines > BPEL.


	
Click the Recovery tab.




This may occur if any external references receiving the message are not reachable (for example, an external web service, enterprise applications such as Siebel, and so on).











B.6 Performance Troubleshooting

This section describes how to troubleshoot performance issues.



B.6.1 Optimizing the Loading of Pages with Instance and Fault Metrics

Since production systems can include numerous composite instances and faults, there is a possibility of time-outs in the Oracle Enterprise Manager Fusion Middleware Control pages as information retrieval becomes relatively slow. To optimize the loading performance of Dashboard pages for the SOA Infrastructure, SOA composite applications, service components, and service engines; Deployed Composites page of the SOA Infrastructure and service engines; and partition home page, you can enable two property settings in the SOA Infrastructure Common Properties page that perform the following:

	
Disable the loading of all metrics information upon page load. The instances and faults metrics can be obtained on demand from the server.




	
Note:

This setting disables fault, instance, and count metrics, and not DMS metrics.










	
Restrict the retrieval of instances, faults, and counts to a specified time period (default selection).




To optimize the loading of pages with instance and fault metrics:

	
In the navigator, click soa-infra.


	
Note that values appear in the Running and Total fields in the Recent Composite Instances section and the Instances and Fault Instances columns of the Deployed Composites section. When these values are large, it can take time to load this page and other pages with similar information.

[image: Description of soaadmin_fetch1.gif follows]
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From the SOA Infrastructure menu, select SOA Administration > Common Properties.


	
In the Display Data Counts section, select the Disable fetching of instance and fault count metrics checkbox.


	
Click Apply.


	
Return to the Dashboard page of the SOA Infrastructure.


	
Note that the values that previously displayed have been replaced with links.


	
In the Deployed Composites section, click a link for a specific SOA composite application to display details about the number of instances. The values are calculated for the link you select.

[image: Description of soaadmin_fetch7.gif follows]
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Click OK.


	
Click Number of Instances.

[image: Description of soaadmin_fetch6.gif follows]
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A message displays the number of running and total instances in the SOA Infrastructure.


	
Click OK.


	
Return to the SOA Infrastructure Common Properties page.


	
In the Display Data Counts section, select the Restrict display of instances and faults to the last time_period checkbox if it is not already selected. By default, this checkbox is selected and the time period duration is set to 24 hours (one day).


	
Specify a time period during which to retrieve recent instances, faults, and count metrics for display (for example, 10 minutes).


	
Click Apply.


	
Return to the Dashboard page of the SOA Infrastructure.


	
Note that the following message is displayed in the upper right section of the page:


Recent Instances and Faults for the last 10 minutes


	
Click Number of Instances.

The value that you specified for the time period is displayed in the message title. The number of running and total messages for that time period is also displayed.

[image: Description of soaadmin_fetch8.gif follows]
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Click OK.


	
In the Deployed Composites section, click a link.

[image: Description of soaadmin_fetch2.gif follows]
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The value that you specified for the time period is displayed in the message title. The number of running and total messages for the selected SOA composite application for that time period is also displayed.

[image: Description of soaadmin_fetch3.gif follows]
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For more information about setting these properties, see Section 3.1, "Configuring SOA Infrastructure Properties."




	
Notes:

	
If you click a link to retrieve instance and fault count metrics, and Oracle Enterprise Manager Fusion Middleware Control times out, increase the transaction timeout property. For more information, see Section B.2.1, "Resolving Connection Timeouts."


	
If you click Recalculate, and the recalculation occurs quickly, the progress indicator does not have a chance to render. However, any updates to the data are reflected on-screen.

















B.6.2 Resolving Message Failure Caused by Too Many Open Files

You can receive the following error at runtime or compilation time, depending on the number of JAR files being used, the use of file descriptors by JDK 6/JRE, or both.


Message send failed: Too many open files 


To resolve this error, increase the number of file descriptors to at least 4096.

	
Use the limit command (for the C shell) or the ulimit command (for the Bash shell) to identify the value for descriptors. A value of 1024 is typically too low, especially for JDK 6.


% limit

cputime      unlimited
filesize     unlimited
datasize     unlimited
stacksize    10240 kbytes
coredumpsize unlimited
memoryuse    unlimited
vmemoryuse   unlimited
descriptors  1024
memorylocked 500000 kbytes
maxproc      46720


	
Log in as the root user on your operating system.


	
Edit the /etc/security/limits.conf file to increase the value for descriptors.

For this example, the limits.conf file appears as follows after increasing the limit for all users to 4096:


#<domain>      <type>  <item>         <value>
#

#*               soft    core            0
#*               hard    rss             10000
#@student        hard    nproc           20
#@faculty        soft    nproc           20
#@faculty        hard    nproc           50
#ftp             hard    nproc           0
#@student        -       maxlogins       4

# End of file
@svrgroup    soft    memlock         500000
@svrgroup    hard    memlock         500000
*           soft    nofile          4096
*           hard    nofile          4096


	
Close your terminal and reopen for the change to take effect. A system restart is not required.









B.6.3 Resolving MaxMessageSizeExceededException Errors Caused By Large Payloads

If you provide a large payload (for example, 12 MB) to your deployed SOA composite application, then click View XML Document in the audit trail to view the payload, you can encounter MaxMessageSizeExceededException errors. This error can be resolved by setting the following JVM parameter.

	
Open the following file:

	
On UNIX operating systems, open $MIDDLEWARE_HOME/user_projects/domains/domain_name/bin/setDomainEnv.sh.


	
On Window operating systems, open MIDDLEWARE_HOME\user_projects\domains\domain_name\bin\setDomainEnv.bat.





	
Add the weblogic.MaxMessageSize property with the following value:


EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES}
-Dweblogic.MaxMessageSize=20000000"
export EXTRA_JAVA_PROPERTIES 


	
Restart the server.









B.6.4 Extending Tablespaces to Avoid Problems at Runtime

If the database tablespace is not extended, runtime processing can be impacted. Messages are not processed or persisted, and exception errors similar to the following can appear in the log files. This is because Oracle BPEL Process Manager relies on the database to store instance data. If the database is not available, runtime processing is impacted.


INFO: MediatorServiceEngine returning after processing the request for 
operation = processResponse 

[EL Warning]: 2009.01.14 11:46:16.783--UnitOfWork(32372128)--Exception 
[EclipseLink-4002] (Eclipse Persistence Services - 1.1 (Build 
SNAPSHOT-20081007)): org.eclipse.persistence.exceptions.DatabaseException 
Internal Exception: java.sql.BatchUpdateException: ORA-01691: unable to 
extend lob segment SH_SOAINFRA.SYS_LOB0000145067C00007$$ by 1024 in 
tablespace SH_SOAINFRA 

Error Code: 1691 
Query: InsertObjectQuery(com.collaxa.cube.persistence.dto.AuditTrail@199b33d) 
[EL Warning]: 2009.01.14 11:46:16.782--UnitOfWork(32372128)--Exception 
[EclipseLink-4002] (Eclipse Persistence Services - 1.1 (Build 
SNAPSHOT-20081007)): org.eclipse.persistence.exceptions.DatabaseException 
Internal Exception: java.sql.BatchUpdateException: ORA-01691: unable to 
extend lob segment SH_SOAINFRA.SYS_LOB0000145067C00007$$ by 1024 in 
tablespace SH_SOAINFRA 
. . .
. . .


Ensure that you set a tablespace to automatically extend itself by a specified amount when it reaches its size limit. If you do not enable autoextend, ensure that you respond when alerted that the tablespace is reaching its critical or warning threshold size. You can respond to size alerts by manually increasing the tablespace size.






B.6.5 Resolving Database Growth Issues Caused by a High Volume of Transactions

If Oracle SOA Suite transactions fail and logs indicate that the database is running out of space, the dehydration store or MDS store may be running out of space due to a high volume of transactions. In the latter example, you see errors such as the following:


java.sql.SQLException: ORA-01653: unable to extend table SH_MDS.CUBE_INSTANCE by
16 in tablespace FUSION_TS_TOOLS 


This indicates that the tablespace is full and the database cannot extend it.

Perform the following tasks.

	
Purge the dehydration store tables periodically, taking into account the appropriate record retention policies and ensuring that the applications have no dependencies on runtime data.

The purge should be followed by commands to coalesce the space. For the purging strategy to work, it is important to understand how long to retain the data in the database. Factors that drive the retention policy include the following:

	
Legal requirements


	
Line of business requirements


	
Overall company policy on retention of data




The longer the retention policy, the greater the volume of data that must be stored and, correspondingly, the higher the disk capacity requirements.

For details on creating a purging strategy, see Chapter 9, "Managing Database Growth."


	
Ensure that the database hardware has sufficient resources to handle the demands of Oracle Database partitioning before configuring your tables for partitioning.

For the dehydration store, database partitioning using range partitioning and hash partitioning is an optimal solution. Partitioning by definition means storing data in multiple tables to reduce bigger data sets into smaller, more manageable data sets. Partitioning strategies play a large role in easing maintenance overheads (dropping and pruning the partition) and improving performance. Partitioning should at least be done for tables having high activity. This plays a large role in balancing disk I/O and preventing hot disks. One important requirement that you must meet before configuring your tables for partitioning is to ensure that the database hardware has sufficient resources to handle the demands of Oracle Database partitioning. If preproduction testing has indicated that the installation is large, Oracle expects that you have sized your environment (CPU, memory, and disk space) correctly to take advantage of the partitioning features.


	
Tune database parameters for memory, tablespace, and partitions to get maximum performance. For more information, see Section "Tune Database Parameters" of the Oracle Fusion Middleware Performance and Tuning Guide.


	
For other tablespaces running out of space, use the following query to check for free tablespace:


SELECT Total.tablespace_name "Tablespace Name", Free_space, (total_space-Free_
space) Used_space, total_space, round((Free_space*100/total_space),2) "Free %"
FROM (select tablespace_name, sum(bytes/1024/1024) Free_Space from sys.dba_
free_space group by tablespace_name) Free,
(select tablespace_name, sum(bytes/1024/1024) TOTAL_SPACE from sys.dba_data_
files group by tablespace_name) Total
WHERE Free.Tablespace_name = Total.tablespace_name AND Total.tablespace_name =
 '<tablespacename>'
ORDER BY 5;


	
To increase tablespace settings, use the administrator account. For example:


alter tablespace tablespace_name add datafile 'datafile_name' size 500m
autoextend on;




For more details, see Section B.6.2, "Resolving Message Failure Caused by Too Many Open Files."





B.6.6 Observing Slow Application Performance Such as Longer Time to Serve Pages or Finish Transactions

You can observe slow application performance and/or memory trashing. For example, it may take longer to load and serve pages or to complete composite transactions. Response time may seem slower compared to normal behavior.

There are various reasons for slow performance. It may be due to a large number of servers running on the same host, or there may be a large number of records/sessions/locking in the database. Thread contention can also be a reason for poor performance.




	
Note:

All configuration changes in Oracle Enterprise Manager Fusion Middleware Control may be unavailable due to this problem.









To diagnosis this issue:

	
Check the CPU utilization to see if it is saturated due to a heavy load or too many processes in relation to CPU capacity.

If CPU utilization is at 100% during normal load hours (the target should be 70-80%), you have no capacity to handle a peak load and the hardware resources are insufficient. Add scale-out servers to handle the additional load.


	
Check applications using Oracle Enterprise Manager Fusion Middleware Control to report on performance. Check the performance of services and the invoke/response times in the BPEL process audit trail.


	
To maximize performance, it is recommended that you not set the logging level higher than the default INFO level.

For debugging purposes, you must set the logging level to the FINEST level. However, once issues are resolved, reset the logging level to the default level for best performance. It is also recommended that you set Audit Level to Production in the SOA Infrastructure Common Properties page. This can be set in Oracle Enterprise Manager Fusion Middleware Control as follows:

	
Right-click soa-infra (SOA_cluster_name).


	
Select SOA Administration > Common Properties.


	
Set Audit Level to Production.





	
Purge periodically based on retention requirements to maintain any service level agreements (SLAs).

To identify the tables where data growth may lead to performance issues, see the "Tables Impacted By Instance Data Growth" section in the Oracle Fusion Middleware Performance and Tuning Guide.

For information about using the purge scripts, see Chapter 9, "Managing Database Growth."


	
Check the memory/IO/paging/swapping/CPU usage load statistics using Top or Glance or another monitoring tool.


	
Optimize the JVM to avoid full garbage collection or out-of-memory errors.

Frequent garbage collection can be either due to higher memory usage or memory leaks.

	
Ensure that the sum of the maximum heap size of all the JVMs running on your system does not exceed the amount of available physical RAM to avoid operating system level paging activity.


	
Use the JRockit mission control memory profiling tools to get thread dumps and memory snapshots, which helps Oracle Support Services debug any code issues. For more information about thread dumps, see Chapter 11, "Diagnosing Problems with SOA Composite Applications."





	
Optimize threads to avoid contention. Get a thread dump to investigate and submit it to Oracle Support Services.


	
Check the JVM and thread dumps for methods invoking the database to identify if database performance is a bottleneck.


	
Run database Automatic Workload Repository (AWR) snapshots to identify causes of database performance issues.


	
Ensure that database statistics are updated at regular intervals and other tunable parameters for memory, tablespace, and partitions are used effectively to obtain maximum performance.

Here are some common tuning recommendations. For more information, see the "Tune Database Parameters" section in the Oracle Fusion Middleware Performance and Tuning Guide.

	
Put indexes and tables in as physically separate disk areas if possible.


	
Never put rollback segments with data or index segments.


	
Separate highly active tables and indexes into their own tablespaces.


	
Partition high activity tables and indexes to help balance disk I/O and prevent hot disks.


	
Have processes in place to generate database table statistics at regular intervals.





	
Tune database tables to control the high watermark (HWM) contention of large objects. Tune database advanced queues (AQ) to control high watermark (HWM) contention and ensure consistent performance of producing and consuming messages from AQ.

The EDN AQ names to be aware of are EDN_EVENT_QUEUE_TABLE and EDN_OAOO_DELIVERY_TABLE.


	
Tune the BPEL and EDN thread counts to ensure optimal settings (for example, the Dispatcher Invoke Threads and Dispatcher Engine Threads properties on the BPEL Service Engine Properties page in Oracle Enterprise Manager Fusion Middleware Control). If the thread configuration is too high, the servers run out of memory. If they are too low, the messages start backing up.


	
Tune the BPEL properties to reduce overhead (for example, disable the ValidateXML and StatsLastN (statistics gathering batch size) properties on the BPEL Service Engine Properties page in Oracle Enterprise Manager Fusion Middleware Control) if they are not needed.


	
In case of integration with packaged applications (for example, Siebel), check if the issue lies with the legacy applications.




For more information about performance tuning the various components, see the "Top Performance Areas" chapter and the "SOA Suite Components" part in the Oracle Fusion Middleware Performance and Tuning Guide.

For information about setting properties on the BPEL Service Engine Properties page, see Chapter 12, "Configuring BPEL Process Service Components and Engines."








B.7 Server Troubleshooting

This section describes how to troubleshoot server issues.



B.7.1 Best Practices for Starting and Stopping a Managed Server

As a best practice, it is always recommended that you start and stop a managed server through one, but not both, of the following methods. Do not mix these methods, such as starting the managed server from the command line and stopping it from Oracle Enterprise Manager Fusion Middleware Control, or vice versa.

	
Oracle Enterprise Manager Fusion Middleware Control

With this method, the node manager must be up and running. The node manager tracks all managed server startups and shutdowns performed from Oracle Enterprise Manager Fusion Middleware Control. With this method, the server state is not an issue.


	
Command line

With this method, the node manager does not track the server state. Therefore, if you start the server from the command line and shut it down from Oracle Enterprise Manager Fusion Middleware Control, the Oracle WebLogic Administration Server accesses the node manager to determine its status, which returns a state of Unknown.




Perform the following steps to stop and start the server from Oracle Enterprise Manager Fusion Middleware Control.

	
Expand the WebLogic domain.


	
Select the managed server (for example, named soa_server1).


	
Select Control > Shut Down.


	
Select Control > Start Up.




For information on starting and stopping managed servers from the command line, see Oracle Fusion Middleware Installation Guide for Oracle SOA Suite and Oracle Business Process Management Suite.





B.7.2 Diagnosing SOA Server Startup Problems

If the SOA server (soa_infra) does not start, there can be various reasons for server startup issues. A discovery-based approach to finding the root cause is required. Check the server and diagnostic logs as a first attempt to diagnose the issue. In addition, check the following.

To diagnose server startup issues:

	
Check if the database is not available or there are not enough connections available. Some failures with Oracle SOA Suite runtime can result from database outage/connectivity issues. Perform the following steps:

	
Log in to Oracle WebLogic Server Administration Console.


	
In the Domain Structure, view the status by selecting Services > Data Sources > SOADatasource > Monitoring > Testing to test the data source. You can also check this from a SQL prompt.





	
Check the list of ports used for port conflicts.


	
Check if the MDS repository cannot load shared documents (incorrect MDS configuration or the database that holds the MDS schema is not reachable).


	
Check the Coherence configuration if using an Oracle SOA Suite cluster (use of unicast versus multicast).

This issue only applies after provisioning is complete. Clustering of SOA servers may fail if there are port conflicts (used by Coherence). For example, one SOA server may be picking up the deployment, but the other server is not. In some cases, this may only present the following error:


[soa_server1] [ERROR] [] [Coherence] [tid: Logger@352821903 3.6.0.4] 
[ecid: 46f620208907e045:63f295ec:12dd091ec2e:-8000-0000000000000003,1:27187] 
[APP: soa-infra] 2011-01-28 23:06:19.463/414.816 Oracle Coherence GE 3.6.0.4 
<Error> (thread=[ACTIVE] ExecuteThread: '0' for queue: 'weblogic.kernel.Default
 (self-tuning)', member=n/a): 
Error while starting cluster: com.tangosol.net.RequestTimeoutException: Timeout
 during service start: ServiceInfo(Id=0, Name=Cluster, Type=Cluster[[...


In this example, Coherence timeouts are prominently available. However, sometimes it presents itself with an unrelated error, such as the following:


Error creating bean with name 'SensorManager' defined in ServletContext
resource


The root cause of this is still primarily related to Coherence configuration.


	
Check if both the Administration Server and Managed Server ports are open and accessible.


	
Check if Managed Server startup failed because the Administration Server is not reachable.


	
Check network issues (for example, IP routing filtering/rules that may be causing issues).


	
Check Oracle WebLogic Server LDAP security corruption.

The Managed Server may report that policies for the application System MBeans Browser already exist or do not exist.




For more information, see the "Setting the Frontend URL for the Administration Console and Setting Redirection Preferences" section and the "Setting the Frontend HTTP Host and Port" section in the Oracle Fusion Middleware Enterprise Deployment Guide for Oracle SOA Suite.






B.7.3 Specifying the Proxy Server

To use system properties to specify the proxy server, write your client application in the standard way, and then specify Java system properties when you execute the client application.


setenv PROXY_SETTINGS "-DproxySet=true
-Dhttp.proxyHost=www-myproxy.us.mycompany.com -Dhttp.proxyPort=80
 -Dhttp.nonProxyHosts=localhost|*.us.mycompany.com
  |0:0:0:0:0:0:0:1|fe80:0:0:0:250:56ff:fe31"





	
Note:

When you specify values for proxy properties such as http.proxyHost and http.proxyPort, also specify the http.nonProxyHosts property.














B.7.4 Flow Diagram Does Not Display The First Time on Some Lower End Hosts

The flow diagram for an instance ID of a deployed SOA composite application in Oracle Enterprise Manager Fusion Middleware Control may not display the first time on some lower end hosts. Instead, you receive a failed to load resource message.

As a workaround, close the flow trace page and click the instance ID to return to the flow trace page.






B.7.5 Accessing Oracle Enterprise Manager Fusion Middleware Control on Dual Stack Hosts that Support IPv4 and IPv6

If you run Oracle SOA Suite on a dual stack host that supports both IPv4 and IPv6, you must update the etc/hosts file as shown in Table B-23 for IPv4 clients to access IPv6 URLs in Oracle Enterprise Manager Fusion Middleware Control.


Table B-23 IPv4 and IPv6 Settings in etc/hosts File

	On The...	Edit the etc/hosts File as Follows....
	
On the IPv4 client:

	

xx.xxx.xxx.xxx myhost10-ipv6 


where xx.xxx.xxx.xxx is the IP address of IPv6.


	
On the IPv6 client

	

fdf5:74cc:db0a::0:1  myhost10-ipv6 myhost10-ipv6.us.oracle.com


Note: Replace fdf5:74cc:db0a::0:1 with a value appropriate to your host environment.














B.8 Browser Troubleshooting

This section describes how to troubleshoot browser issues.



B.8.1 Limitation on Using the Safari Browser to View WSDL File Content

If you are using the Safari browser, note the following limitation and workaround for viewing WSDL file contents in Oracle Enterprise Manager Fusion Middleware Control. Note also that Mozilla Firefox works correctly and does not require this workaround.

	
Go to the home page for a SOA composite application.


	
Click the Show WSDL and endpoint URI link at the top of the page.


	
Click the WSDL link that is displayed.

This opens a blank page that does not display the contents of the selected WSDL.

As a workaround, perform the following additional steps.


	
In the upper right corner of this page, click the Display a menu for the current page icon.


	
Select View Source from the menu that is displayed.

This displays the contents of the selected WSDL in another page.











B.9 Additional Troubleshooting Documentation

Table B-24 describes documentation to see for additional troubleshooting issues.


Table B-24 Additional Troubleshooting Documentation

	For Information About...	See...
	
SOA Infrastructure startup and shutdown issues

	
Section 3.2, "Stopping and Starting the Managed Server and SOA Infrastructure."



	
Using WebLogic Diagnostic Framework (WLDF) and Diagnostics Framework (DFW) to diagnosis Oracle SOA Suite problems

	
Chapter 11, "Diagnosing Problems with SOA Composite Applications."



	
Managing large documents and metadata and for managing environments with large numbers of instances

	
Chapter "Managing Large Documents and Large Numbers of Instances" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Troubleshooting deployment and compilation errors

	
Section "Testing and Troubleshooting" in Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Troubleshooting Oracle WSM Policy Manager errors

	
Section "Diagnosing Problems" chapter in the Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	
Troubleshooting Oracle Business Activity Monitoring (BAM)

	
Appendix "Troubleshooting" of Oracle Fusion Middleware User's Guide for Oracle Business Activity Monitoring.


	
Troubleshooting Oracle Business Rules

	
Appendix "Oracle Business Rules Troubleshooting" of Oracle Fusion Middleware User's Guide for Oracle Business Rules.


	
Oracle User Messaging Service

	
Section 26.7, "Troubleshooting Oracle User Messaging Service."















Part XVI



Appendixes

This part includes the following appendixes:

	
Appendix A, "Demo User Community"


	
Appendix B, "Troubleshooting Oracle SOA Suite and Oracle BPM Suite"


	
Appendix C, "Oracle Enterprise Manager Roles"







5 Securing SOA Composite Applications

This chapter describes security configuration procedures unique to SOA composite applications. Most SOA composite application security procedures do not require SOA-unique configuration steps. References are provided to additional documentation for performing those tasks.

This chapter includes the following topics:

	
Section 5.1, "Introduction to Securing SOA Composite Applications"


	
Section 5.2, "Configuring Oracle HTTP Server with Oracle BPM Worklist"


	
Section 5.3, "Setting up SAML Message-Protected Policy Configuration for the SOA Infrastructure"


	
Section 5.4, "Automatically Authenticating Oracle BPM Worklist and Oracle Business Process Management Users"


	
Section 5.5, "Listing the Authentication Provider"


	
Section 5.6, "Configuring SSL"


	
Section 5.7, "Configuring Security for Human Workflow WSDL Files"







	
Note:

See the following sections for information on attaching and detaching policies:

	
Section 7.6, "Managing SOA Composite Application Policies"


	
Section 14.2, "Managing BPEL Process Service Component Policies"


	
Section 17.2, "Managing Oracle Mediator Policies"


	
Section 22.1, "Managing Human Task Service Component Policies"


	
Section 36.1, "Managing Binding Component Policies"














5.1 Introduction to Securing SOA Composite Applications

This chapter describes security procedures unique to SOA composite applications. Most SOA composite application security procedures do not require SOA-unique steps and can be performed by following the documentation listed in Table 5-1.


Table 5-1 Security Documentation

	For Information On...	See The Following Guide...
	
Securing Oracle Fusion Middleware, including Oracle Single Sign-On (OSSO) configuration

	
Oracle Fusion Middleware Application Security Guide



	
Securing and administering web services

	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services



	
Understanding Oracle WebLogic Server security

	
Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server



	
Securing an Oracle WebLogic Server production environment

	
Oracle Fusion Middleware Securing a Production Environment for Oracle WebLogic Server



	
Securing Oracle WebLogic Server

	
Oracle Fusion Middleware Securing Oracle WebLogic Server



	
Developing new security providers for use with Oracle WebLogic Server

	
Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server



	
Securing web services for Oracle WebLogic Server

	
Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server



	
Programming security for Oracle WebLogic Server

	
Oracle Fusion Middleware Programming Security for Oracle WebLogic Server



	
Oracle Business Activity Monitoring

	
Section 23.9, "Configuring Security"



	
Securing Oracle User Messaging Service

	
Section 26.6, "Securing the Oracle User Messaging Service"













5.2 Configuring Oracle HTTP Server with Oracle BPM Worklist

You must add the /integration location in the mod_wl_ohs.conf file of Oracle HTTP Server for Oracle BPM Worklist to work through Oracle HTTP Server.


  <Location /integration>
       SetHandler weblogic-handler
   #   PathTrim /weblogic
       ErrorPage  http:/WEBLOGIC_HOME:WEBLOGIC_PORT/
  </Location>






5.3 Setting up SAML Message-Protected Policy Configuration for the SOA Infrastructure

This section describes how to set up and validate Security Assertion Markup Language (SAML) message-protected policy configuration for the SOA Infrastructure with the Oracle WebLogic Scripting Tool (WLST). The example in this section describes task query service configuration. However, these instructions are relevant to all human workflow services that support SAML-token ports:

	
Activity guide query service


	
Activity guide metadata service


	
Activity guide admin service


	
Task query service


	
Task service


	
Task metadata service


	
Runtime config service


	
Task evidence service


	
User metadata service




If you want to change the policy for another service, you must apply the same WLST commands to that service's SAML-token port.

To set up an SAML message-protected policy configuration:

	
Log in to the SOA domain (for example, named base_domain) using WLST.


	
Detach the existing out-of-the-box service policy named wss10_saml_token_service_policy.


wls:/base_domain/domainRuntime> detachWebServicePolicy('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService','web',
'WorkflowProvider','TaskQueryServicePortSAML','oracle/
wss10_saml_token_service_policy')


	
Restart the application to activate any policy or configuration change.


	
Attach the new policy. In this case, the policy is named oracle/wss10_saml_token_with_message_protection_service_policy.


wls:/base_domain/domainRuntime> attachWebServicePolicy('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService',
'web','WorkflowProvider','TaskQueryServicePortSAML','ora
cle/wss10_saml_token_with_message_protection_service_policy')


	
Restart the application to activate any policy or configuration change.


	
List the policy to validate.


wls:/base_domain/domainRuntime> listWebServicePolicies('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService',
'web','WorkflowProvider','TaskQueryServicePortSAML')
    TaskQueryServicePortSAML :
    security :
oracle/wss10_saml_token_with_message_protection_service_policy,
    enabled=true 
Attached policy or policies are valid; endpoint is secure.


	
Create a keystore, add the orakey alias, and run the Oracle Web Service Manager (OWSM) configuration to activate the SAML message-protected policy. For example:


keytool -genkeypair
        -keystore  domain_home/config/fmwconfig/default-keystore.jks
        -keyalg RSA
        -dname "cn=consumer,dc=example,dc=com"
        -alias clientalias
        -keypass  password 
        -storepass password
        -validity 3600

keytool -exportcert 
        -keystore domain_home/config/fmwconfig/default-keystore.jks
        -v 
        -alias clientalias
        -storepass password 
        -rfc 
        -file domain_home/config/fmwconfig/certificate.cer

keytool -importcert 
        -keystore domain_home/config/fmwconfig/default-keystore.jks
        -alias orakey
        -file domain_home/config/fmwconfig/certificate.cer
        -storepass password
         createCred(map="oracle.wsm.security", key="keystore-csf-key",
         user="owsm", password="welcome1", desc="Keystore key")
         createCred(map="oracle.wsm.security", key="enc-csf-key",
         user="clientalias", password="welcome1", desc="Encryption key")
         createCred(map="oracle.wsm.security", key="sign-csf-key",
         user="clientalias", password="welcome1", desc="Signing key") 


	
Restart the servers.









5.4 Automatically Authenticating Oracle BPM Worklist and Oracle Business Process Management Users

This section describes how to authenticate Oracle BPM Worklist and Oracle Business Process Management users in different environments.



5.4.1 Automatically Authenticating Oracle BPM Worklist Users in SAML SSO Environments

To be automatically authenticated when accessing a second Oracle BPM Worklist from a first Oracle BPM Worklist in SAML SSO environments, you must perform the following steps. Otherwise, you are prompted to log in again when you access the second Oracle BPM Worklist. In these environments, the first Oracle BPM Worklist is configured as the SAML identity provider and the second Oracle BPM Worklist that you access is configured as the SAML service provider.

To automatically authenticate Oracle BPM Worklist users in SAML SSO environments:

	
Add /integration/worklistapp/* as the redirect URL for worklistapp to the SAML service provider site's SAML2IdentityAsserter configuration as follows.

	
In the Oracle WebLogic Server Administration Console, select Security Realms.


	
Click the realms for the service providers.


	
Select the Providers tab, and then the Authentication subtab.


	
From the provider list, select the provider with the description SAML 2.0 Identity Assertion Provider.

If you do not see the SAML identity assertion provider configuration, follow the instructions in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
Select the Management tab.

Under the Management tab, you see a list of identity provider partners. These are hosts that have been configured as the SAML identity provider partners for this SAML identity service provider site. Remember that this configuration step is performed on the identity service provider site on which Oracle BPM Worklist is hosted.


	
Select the identity provider site where you want the user to perform the initial login.


	
Scroll down the page until you see the field Redirect URIs.


	
Add /integration/worklistapp/* to the list.




After performing this step, you can log in to Oracle BPM Worklist at the SAML identity provider site though the regular URL of/integration/worklistapp. If necessary, you can then navigate to the URL /integration/worklistapp/ssologin at the SAML service provider site, where you gain access to Oracle BPM Worklist and are automatically authenticated.

For more information about SAML2IdentityAsserter and configuring SSO with web browsers and HTTP clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.









5.4.2 Automatically Authenticating Oracle BPM Worklist Users in Windows Native Authentication Environments

For Windows native authentication through Kerberos to work with Oracle BPM Worklist, you must use the /integration/worklistapp/ssologin protected URL. For example, after configuring Windows native authentication, you access Oracle BPM Worklist as follows:


http://host_name.domain_name:8001/integration/worklistapp/ssologin 


For information on configuring SSO with Microsoft clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.






5.4.3 Automatically Authenticating Oracle Business Process Management Process Composer Users in Windows Native Authentication Environments

For Windows native authentication through Kerberos to work with Oracle Business Process Management Process Composer, you must use the bpm/composer/ssologin protected URL. For example, after configuring Windows native authentication, you access Process Composer as follows:


http://host_name.domain_name:8001/bpm/composer/ssologin 


For information on configuring SSO with Microsoft clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.








5.5 Listing the Authentication Provider

This section describes how to set the first authentication provider.



5.5.1 Listing Oracle Internet Directory as the First Authentication Provider

The Oracle BPM Worklist and workflow services use Java Platform Security (JPS) and the User and Role API. For this reason, the Oracle Internet Directory authenticator must be the first provider listed when workflow is used with Oracle Internet Directory. If Oracle Internet Directory is not listed first (for example, it is listed below DefaultAuthenticator), login authentication fails.

For information about changing the order of authentication providers, see Oracle Fusion Middleware Securing Oracle WebLogic Server.






5.5.2 Accessing Web-based Applications with the Default Authentication Provider

Logging in to web-based applications may fail when using Oracle Internet Directory authentication. This is caused when the Oracle WebLogic Server configuration is set to use the Oracle Internet Directory authentication before default authentication.

This may produce the following error:


"@ User "weblogic" is not found in configuration "jazn.com" Check if the user
 exists in the repository specified by the configurations. Check the error stack
 and fix the cause of the error. Contact oracle support if error is not fixable."


The order of the security providers should be:

	
Default authentication


	
Oracle Internet Directory/LDAP authentication











5.6 Configuring SSL

This section describes configuring secure socket layer (SSL) in Oracle SOA Suite and Oracle Business Process Management environments.



5.6.1 Recommendation to Configure Either All or No Managed Servers with SSL

As a best practice, Oracle recommends that you configure either all managed servers or no managed servers with SSL (SOA, BAM, and so on). Configuring some managed servers with SSL, while not configuring others, may lead to undesirable results in Oracle BPM Worklist and Oracle Web Services Manager (OWSM). For example, if there is an SSL-configured, managed server (bam_server), servers not configured with SSL are not used by OWSM. In cases in which an SSL-configured server is down, it causes OWSM to be in a down state, which in turn causes Oracle BPM Worklist to be in a down state.






5.6.2 Switching from Non-SSL to SSL Configurations with Oracle BPM Worklist

Switching from non-SSL to SSL configurations with Oracle BPM Worklist requires the Frontend Host and Frontend HTTPS Port fields to be set in Oracle WebLogic Server Administration Console. Not doing so results in exception errors when you attempt to create to-do tasks.

To switch from non-SSL to SSL configurations with Oracle BPM Worklist:

	
Log in to Oracle WebLogic Server Administration Console.


	
In the Environment section, select Servers.


	
Select the name of the managed server (for example, soa_server1).


	
Select Protocols, then select HTTP.


	
In the Frontend Host field, enter the hostname on which Oracle BPM Worklist is located.


	
In the Frontend HTTPS Port field, enter the SSL listener port.


	
Click Save.









5.6.3 Configuring SOA Composite Applications for Two-Way SSL Communication

Oracle SOA Suite uses both Oracle WebLogic Server and Sun Secure Socket Layer (SSL) stacks for two-way SSL configurations.

	
For the inbound web service bindings, Oracle SOA Suite uses the Oracle WebLogic Server infrastructure and, therefore, the Oracle WebLogic Server libraries for SSL.


	
For the outbound web service bindings, Oracle SOA Suite uses JRF HttpClient and, therefore, the Sun JDK libraries for SSL.




Due to this difference, start Oracle WebLogic Server with the following JVM option.

To configure SOA composite applications for two-way SSL communication:

	
Open the following file:

	
On UNIX operating systems, open $MIDDLEWARE_HOME/user_projects/domains/domain_name/bin/setDomainEnv.sh.


	
On Window operating systems, open MIDDLEWARE_HOME\user_projects\domains\domain_name\bin\setDomainEnv.bat.





	
Add the following lines in the JAVA_OPTIONS section, if the server is enabled for one-way SSL (server authorization only):


-Djavax.net.ssl.trustStore=your_truststore_location


For two-way SSL, the keystore information (location and password) is not required.




In addition, perform the following steps to enable two-way SSL for a SOA composite application to invoke another SOA composite application or another non-SOA application.




	
Note:

Both the server and client are assumed to have been configured for SSL with mutual authentication.









To enable two-way SSL for a SOA composite application to invoke another application:

	
On the client side, provide the keystore location.

	
From the SOA Infrastructure menu, select SOA Administration > Common Properties.


	
At the bottom of the page, click More SOA Infra Advanced Configuration Properties.


	
Click KeystoreLocation.


	
In the Value column, enter the keystore location.


	
Click Apply.


	
Click Return.





	
During design time in Oracle JDeveloper, update the reference section in the composite.xml file with the oracle.soa.two.way.ssl.enabled property.


<reference name="Service1" 
   ui:wsdlLocation=". . ."> 
   <interface.wsdl interface=". . ."/> 
     <binding.ws port=". . ."> 
      <property name="oracle.soa.two.way.ssl.enabled">true</property> 
  </binding.ws> 
 </reference> 


	
In Oracle Enterprise Manager Fusion Middleware Control, select WebLogic Domain > domain_name.


	
Right-click domain_name and select Security > Credentials.


	
Click Create Map.


	
In the Map Name field, enter a name (for example, SOA), and click OK.


	
Click Create Key.


	
Enter the following details.


	Field	Description
	
Select Map

	
Select the map created in Step 6 (for this example, SOA).


	
Key

	
Enter the key name (KeystorePassword is the default).


	
Type

	
Select Password.


	
User Name

	
Enter the keystore user name (KeystorePassword is the default).


	
Password

	
Enter the password that you created for the keystore.











	
Note:

When you set up SSL in Oracle WebLogic Server, a key alias is required. You must enter mykey as the alias value. This value is required.










	
Set the keystore location in Oracle Enterprise Manager Fusion Middleware Control. See Step 1 for instructions.


	
Modify composite.xml to use https and sslport to invoke a SOA composite application. For example, change the syntax shown in bold:


<?xml version="1.0" encoding="UTF-8" ?> 
<!-- Generated by Oracle SOA Modeler version 1.0 at [4/1/09 11:01 PM]. --> 
<composite name="InvokeEchoBPELSync" 
revision="1.0" 
label="2009-04-01_23-01-53_994" 
mode="active" 
state="on" 
xmlns="http://xmlns.oracle.com/sca/1.0" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:wsp="http://schemas.xmlsoap.org/ws/2004/09/policy" 
xmlns:orawsp="http://schemas.oracle.com/ws/2006/01/policy" 
xmlns:ui="http://xmlns.oracle.com/soa/designer/"> 
<import 
namespace="http://xmlns.oracle.com/CustomApps/InvokeEchoBPELSync/BPELProcess1"
  location="BPELProcess1.wsdl" importType="wsdl"/>
<import namespace="http://xmlns.oracle.com/CustomApps/EchoBPELSync/
BPELProcess1"location="http://hostname:port/soa-infra/services/default/EchoBPEL
Sync/BPELProcess1.wsdl"
importType="wsdl"/>


to use https and sslport:


location="https://hostname:sslport/soa-infra/services/default/EchoBPELSync
/BPELProcess1.wsdl"









5.6.4 Invoking References in One-Way SSL Environments in Oracle JDeveloper

When invoking a web service as an external reference from a SOA composite application in one-way SSL environments, ensure that the certificate name (CN) and the hostname of the server exactly match. This ensures a correct SSL handshake.

For example, if a web service is named adfbc and the certificate has a server name of myhost05, the following syntax results in an SSL handshake exception.


  <import namespace="/adfbc1/common/" 
           
 location="https://myhost05.us.oracle.com:8002/CustomApps-adfbc1-context-root/Ap 
pModuleService?WSDL" 
          importType="wsdl"/> 
 <import namespace="/adfbc1/common/" location="Service1.wsdl" 
          importType="wsdl"/> 


If you switch the order of import, the SSL handshake passes.


<import namespace="/adfbc1/common/" location="Service1.wsdl" 
          importType="wsdl"/> 
<import namespace="/adfbc1/common/" 
           location="https://myhost05.us.oracle.com:8002/CustomApps-adfbc1-context-root/Ap 
pModuleService?WSDL" 
          importType="wsdl"/> 


Note the following restrictions around this issue:

	
There are no options for ignoring hostname verification in Oracle JDeveloper as exist with the Oracle WebLogic Server Administration Console. This is because the SSL kit used by Oracle JDeveloper is different. Only the trust store can be configured from the command line. All other certificate arguments are not passed.


	
In the WSDL file, https://hostname must match with that in the certificate, as described above. You cannot perform the same procedures as you can with a browser. For example, if the hostname is myhost05.us.oracle.com in the certificate's CN, then you can use myhost05, myhost05.us.oracle.com, or the IP address from a browser. In Oracle JDeveloper, always use the same name as in the certificate (that is, myhost05.us.oracle.com).









5.6.5 Configuring Oracle SOA Suite and Oracle HTTP Server for SSL Communication

Follow these steps to configure SSL communication between Oracle SOA Suite and Oracle HTTP Server.



5.6.5.1 Configuring Oracle HTTP Server for SSL Communication

To configure Oracle HTTP server for SSL communication:

	
Update mod_ssl.conf with the <Location /integration/services> location directive.


LoadModule weblogic_module   ${ORACLE_HOME}/ohs/modules/mod_wl_ohs.so

<IfModule mod_weblogic.c>
      WebLogicHost host.domain.com
      WLLogFile <logdir>/ohs_ssl.log
      Debug ALL
      DebugConfigInfo ON
      SecureProxy ON
      MatchExpression *.jsp
      WlSSLWallet <OHS_
HOME>/instances/instance1/config/OHS/ohs1/keystores/default
</IfModule>

<Location /soa-infra>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /b2bconsole>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /b2b> 
      WebLogicPort 8002 
      SetHandler weblogic-handler 
       ErrorPage http://host.domain.com:port/error.html 
</Location> 

<Location /integration/worklistapp>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /integration/services>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /DefaultToDoTaskFlow>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /OracleBAM>
      WebLogicPort 9002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /OracleBAMWS>
      WebLogicPort 9002
      SetHandler weblogic-handler
      ErrorPage  http://host.domain.com:port/error.html
</Location>

<Location /sdpmessaging/userprefs-ui/>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>


	
Start the Oracle WebLogic Servers as described in Section 5.6.3, "Configuring SOA Composite Applications for Two-Way SSL Communication."









5.6.5.2 Configuring Certificates for Oracle Client, Oracle HTTP Server, and Oracle WebLogic Server

To configure certificates for Oracle Client, Oracle HTTP Server, and Oracle WebLogic Server:

	
Export the user certificate from the Oracle HTTP Server wallet.


orapki wallet export -wallet . -cert cert.txt  -dn 'CN=\"Self-Signed
 Certificate for ohs1 \",OU=OAS,O=ORACLE,L=REDWOODSHORES,ST=CA,C=US'


	
Import the above certificate into the Oracle WebLogic Server trust store as a trusted certificate.


keytool -file cert.txt -importcert -trustcacerts -keystore DemoTrust.jks


	
Export the certificate from the Oracle WebLogic Server trust store.


keytool -keystore DemoTrust.jks -exportcert -alias wlscertgencab -rfc -file
certgencab.crt


	
Import the above certificate to the Oracle HTTP Server wallet as a trusted certificate.


orapki wallet add -wallet . -trusted_cert -cert certgencab.crt -auto_login_only


	
Restart Oracle HTTP Server.


	
Restart the Oracle WebLogic Servers as described in Section 5.6.3, "Configuring SOA Composite Applications for Two-Way SSL Communication."











5.6.6 Configuring SSL Between SOA Composite Application Instances and Oracle WebCache

The Test Web Service page in an Oracle WebCache and Oracle HTTP Server environment may require communication back through Oracle WebCache. Therefore, SSL must be configured between the SOA composite application instance and Oracle WebCache (that is, export the user certificate from the Oracle WebCache wallet and import it as a trusted certificate in the Oracle WebLogic Server trust store).






5.6.7 Using a Custom Trust Store for One-Way SSL During Design Time

To invoke a SOA composite application from another composite over HTTPS when using a custom trust store created with a tool such as keytool or orapki, perform the following actions in Oracle JDeveloper.

To use a custom trust store for one-way SSL during design time:

	
To fetch a WSDL file in the reference section, set the trust store information in Tools > Preferences > Http Analyzer > HTTPS Setup > Client Trusted Certificate Keystore.


	
During deployment to an SSL-enabled server, use the JSSE property at the command line:


jdev -J-Djavax.net.ssl.trustStore=your_trusted_location









5.6.8 Enabling an Asynchronous Process Deployed to an SSL-Enabled, Managed Server to Invoke Another Asynchronous Process Over HTTP

Assume you create the following environment:

	
Asynchronous BPEL process A invokes asynchronous BPEL process B


	
Asynchronous BPEL process A is deployed to a one-way SSL enabled, managed server


	
All WSDL reference and bindings use plain HTTP




At runtime, the WSDL is looked for over HTTPS, and the callback message from asynchronous BPEL process B fails.

To resolve this issue, the callbackServerURL property must be passed at the reference binding level in the composite.xml file. This explicitly indicates the value of the callback URL for the given reference invocation. If the client composite is running in an SSL-managed server, then the callback defaults to SSL.


<reference name="Service1" 
ui:wsdlLocation="http://localhost:8000/soa-infra/services/default/AsyncSecondB 
PELMTOM/BPELProcess1.wsdl"> 
    <interface.wsdl
 interface="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl 
.interface(BPELProcess1)" 
callbackInterface="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProce
ss1#wsdl.interface(BPELProcess1Callback)"/> 
    <binding.ws 
port="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl.endp 
oint(bpelprocess1_client_ep/BPELProcess1_pt)" 
                
location="http://localhost:8000/soa-infra/services/default/AsyncSecondBPELMTOM 
/bpelprocess1_client_ep?WSDL"> 
         <wsp:PolicyReference URI="oracle/wss_username_token_client_policy" 
                           orawsp:category="security" 
orawsp:status="enabled"/> 
      <wsp:PolicyReference URI="oracle/wsaddr_policy" 
                           orawsp:category="addressing" 
orawsp:status="enabled"/> 
. 
 <property name="callbackServerURL">http://localhost:8000/</property> 
. 
    </binding.ws> 
. 
  <callback> 
      <binding.ws 
port="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl.endp 
oint(bpelprocess1_client_ep/BPELProcess1Callback_pt)"> 
            <wsp:PolicyReference 
URI="oracle/wss_username_token_service_policy" 
                           orawsp:category="security" 
orawsp:status="enabled"/> 
 </binding.ws> 
    </callback> 
    
. 
  </reference> 








5.7 Configuring Security for Human Workflow WSDL Files

If the WSDL files for human workflow services are not exposed to external consumers, then set the flag that exposes the WSDL to false for each of the services:


<expose-wsdl>false</expose-wsdl>


For more information, see Oracle Fusion Middleware Developer's Guide for Oracle Web Services.








Part XI



Administering Oracle JCA Adapters

This part describes how to administer Oracle JCA Adapters.

This part includes the following chapters:

	
Chapter 29, "Configuring Oracle JCA Adapters"


	
Chapter 30, "Monitoring Oracle JCA Adapters"







38 Monitoring BPMN Process Service Components and Engines

This chapter describes how to monitor BPMN process service components and service engines.

This chapter includes the following topics:

	
Section 38.1, "Viewing the Audit Trail and Process Flow of a BPMN Process Service Component"


	
Section 38.2, "Monitoring BPMN Process Service Component Instances and Faults"


	
Section 38.3, "Monitoring BPMN Process Service Component Instances"


	
Section 38.4, "Monitoring BPMN Process Service Engine Instances and Faults"


	
Section 38.5, "Monitoring BPMN Process Service Engine Request and Thread Statistics"


	
Section 38.6, "Monitoring BPMN Process Service Engine Instances"


	
Section 38.7, "Monitoring Deployed BPMN Processes in the Service Engine"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






38.1 Viewing the Audit Trail and Process Flow of a BPMN Process Service Component

This section describes how to view the audit trail and process flow of a BPMN process service component in a SOA composite application instance.




	
Note:

	
This section assumes a SOA composite application instance has been initiated. If not, see Section 8.1, "Initiating a SOA Composite Application Test Instance" for instructions.


	
When several messages are thrown in a short interval, they are not processed in the same order as they were sent. This can be apparent when you are examining the audit trail of a process instance.












To view the audit trail and process flow of a BPMN process service component:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











The Dashboard page for the selected composite application appears.


	
Use one of the following methods to select an instance of the application:

	
For recent instances of this application, click the instance number of an instance in the Instance ID column of the Recent Instances section.


	
For all instances of this application, click the Instances tab, then click a specific instance in the Instance ID list.




The Flow Trace page displays the following details:

	
The Faults section shows the faults occurring in the services, service components, and references that comprise the SOA composite application. Sensors enable you to monitor BPMN process activities, variables, and faults during runtime. Selecting a fault highlights the row in the Trace section in which the fault occurred. Closing the fault clears the selection in the Trace section.


	
The Sensors section displays details about composite sensors included in the service and reference binding components of the SOA composite application. The total number of sensors is shown in the section header. Composite sensors can be added to service and reference binding components during design time in Oracle JDeveloper. You cannot add composite sensors to service components. Selecting a composite sensor in this section highlights the service or reference in the Trace section in which composite sensor data was collected. Closing the sensor clears the selection in the Trace section.




	
Note:

Expand the Faults or Sensors sections one at a time. The fault or sensor information is displayed only for viewing in this way.










	
The Trace section shows the sequence of the message flow through the services, service components, and references that comprise the SOA composite application.




The flow trace is a runtime trail of a message flow identified by an execution context ID (ECID) that is displayed in the upper right corner of the page. An ECID enables you to track a message flow that crosses instances of different composites. The flow trace lists all services, references, components across composites participating in the flow. 

[image: Description of bpmn_compsensor3.png follows]
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For the flow example in the Trace section, the service binding component and reference binding component involved in the flow have successfully received and processed messages.

Note the following restrictions with ECIDs:

	
A separate ECID is displayed for each instance of a composite application and not for the composite level ECID that can track the complete flow of any instances for the composite application.


	
To get complete flow information, you must find the composite level ECID in the log files. Use that value to get all information for a particular composite and therefore all its executed instances.


	
ECIDs are not propagated through business events. This can limit the amount of logging information that is collected. For example, if you publish an event that is subscribed to in the same composite application, limited logging information is available.





	
Select a fault in the Faults section.

This highlights the row in the Trace section in which the fault occurred.


	
Close the fault to clear the selection in the Trace section.


	
Expand the Sensors section to display composite sensors.


	
Select a sensor in the Sensors section.

This highlights the row in the Trace section in which the composite sensor data was collected.


	
In the Instance column of the Trace section, click a specific BPMN process service component instance. Service component instances can be accessed from this section; services and references cannot be accessed.

The Instance page appears, as shown in Figure 38-1.


Figure 38-1 Instance Page

[image: Description of Figure 38-1 follows]
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Use these pages to view the audit trail, flow and faults of a BPMN process service component instance. The following links provide additional details about the instance:

	
Flow Trace link: Click the breadcrumbs in the upper left corner of the page to access the flow trace for the ECID (composite instance) that contains this BPMN component instance.


	
Information icon: Click the information icon to the right of the name of the BPMN component (in the page title) to see biographical information about this BPMN instance. This information includes a summary of the instance, including instance ID, ECID, instance startup time or last modification time, instance state (for example, running), and number of faults.

This icon is displayed only on the Audit Trail pages of BPMN processes and Oracle Mediators, and not on the pages of human tasks and business rules.


	
Current Audit Level: Click to display information details, such as the audit level used by this instance.




When you first open the Instance page, the Audit Trail page is displayed by default. It provides execution details about the activities in the BPMN process.


	Column	Description
	
Activity

	
Lists all the BPM constructs available in a process in the order they are executed. These include:

	
Events: start, end, signal, throw, catch message.


	
Activities: user task, business rules task, service task, call activity, subprocess.


	
Gateways: inclusive, exclusive, parallel, event based, and complex.





	
Loop Count Event

	
If the activity referred to in a row of the audit trail table is a subprocess with the loop characteristic set to either Loop or Multi-instance, this column shows the value of the loopCounter variable.


	
Event

	
When any BPMN construct executes, audit is logged twice: once when it enters that activity, and once when it leaves that activity to move to next activity. If the node is collapsed, it shows you whether the activity is completed, processing, or canceled.


	
Date

	
Time stamp showing when the item was posted.


	
Copy

	
If some activities are executed simultaneously—for example, on different paths in a parallel gateway—the copy keeps the number of threads used for this purpose.








	
Scroll through the audit trail to check for errors and expand the payload links to view their contents at a given point in the flow.

When you click a payload link, the Payload XML page appears. This page shows the value of data objects which had out data association at that particular point in the process.
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Click the Flow tab.

A flow diagram of the BPMN process activities appears. This flow diagram shows a fault highlighted in a BPMN process activity.


	
Click an activity to view the flow of the payload through the process.




	
Note:

If using Microsoft Internet Explorer, you can click Copy details to clipboard to copy the activity details to the clipboard. If using Mozilla Firefox, this link does not appear. Instead, you must manually select the text and copy and paste it to a file.










	
Scroll through the flow diagram to check for errors and click the highlighted activity to view error messages.


	
Close the window.


	
Click the Faults tab.

This page shows the error message, whether you can recover from the fault, the time at which the fault occurred, and the activity in which the fault occurred. This page displays the faults in the BPMN component instance (but not the faults that occurred in a service or reference binding component).

You can recover from instance faults identified as recoverable. This page lists all instance faults, recoverable or not. The component instance faults that occurred in a service or reference are not listed here.

This page enables you to target individual faults from which to recover, and provides a degree of fault recovery granularity not available on other pages.

However, you cannot perform bulk fault recoveries on this page. To perform bulk fault recovery, use one of the following pages:

	
Faults and Rejected Messages page of a specific SOA composite application or of the SOA Infrastructure.


	
Faults page of the BPMN process service engine or of a specific BPMN process service component.





	
Select a fault for recovery that has been identified as recoverable through one of the following methods. The page refreshes to display a fault recovery section at the bottom of the page.

	
If you click a fault in the Error Message column, a popup message displays details about the fault, including the fault ID, fault time, fault location, fault type, and complete error message text. If the fault is identified as recoverable, a Recover Now button is displayed that you can click.


	
You click a fault identified as recoverable in the Recovery column.





	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPMN fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulting activity as a success).








Your selection causes additional fields to appear. For example, the following fields display if you select Rethrow.


	
Use the After Successful Retry list to select defined actions to invoke after a successful retry. If you select a variable in the Variable list, you can edit the value in the Value text box.


	
Click the Back button of your browser to exit the flow diagram.









38.2 Monitoring BPMN Process Service Component Instances and Faults

You can monitor BPMN process service component recent instances and faults. Each service component in a SOA composite application has its own instance ID. These IDs are different from the overall instance ID of the SOA composite application of which each service component is a part.

To monitor BPMN process service component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
In the Component Metrics section, select the BPMN process service component.


	
Click Dashboard.
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The upper part of the Dashboard page displays the following details:

	
Recent instances of the BPMN process service component, including the instance ID, the state of the instance (for example, completed successfully or faulted), the start time, the last modification time, and logs describing the instance.


	
Recent faults in the BPMN process service component, including the error message, whether you can recover from the fault, the time at which the fault occurred, the instance ID of the BPMN service component, the BPMN activity in which the fault occurred, and logs describing the fault.


	
The average processing time for each activity in the BPMN process service component.





	
In the Recent Instances section, you can perform the following tasks:

	
View the audit trail, process flow and faults of a service component. To do this task, in the Instance ID column, click the instance ID of that service component.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.


	
Access the Instances page of the service component. To do this: Click Show All below the section.





	
In the Recent Instances and Faults section, you can perform the following tasks:

	
Display complete information about a fault. To do this task, in the Error Message column, click an error message. If the fault is identified as recoverable, you can perform fault recovery by clicking the Recover Now link.


	
Perform fault recovery at the component instance level. To do this task, in the Recovery column, click a fault identified as Recoverable.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.


	
Access the Faults page of the service component. To do this task, click Show All below the section.




The lower part of the Dashboard page displays the following details:

	
A graphical representation of the number of successful, faulted, and incoming (pending) instances of the BPMN process service component over a specific time range.


	
The number of faults and message processed by any reference binding component with which this BPMN process service component communicated.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






38.3 Monitoring BPMN Process Service Component Instances

You can monitor BPMN process service component instances. Each service component has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this service component is a part.

To monitor BPMN process service component instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
In the Component Metrics section, select the BPMN process service component.


	
Click the Instances tab.
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The Instances page displays the following details:

	
A utility for searching for a specific BPMN service component instance by specifying criteria and clicking Search.


	
BPMN process service component instances, including the instance ID, instance state (for example, completed or faulted), instance start time, last instance modification time, and log files describing the instance.




In this page, you can perform the following tasks:

	
View the audit trail, process flow, and faults of a service component. To do this task, in the Instance ID column, click the instance ID for a service component.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






38.4 Monitoring BPMN Process Service Engine Instances and Faults

You can monitor instances and faults of all BPMN process service components running in the BPMN process service engine. These BPMN process service components can be part of separate SOA composite applications.

To monitor BPMN process service engine instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Dashboard.
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The upper part of the Dashboard page displays recent instances of all BPMN process service components running in the BPMN process service engine, including the instance ID of the service component, the service component name, the SOA composite application of which the service component is a part, the state of the instance (for example, completed successfully or faulted), the instance start time, the last modification time, and logs describing the instance.

[image: Description of bpmn_dashboard_low.gif follows]
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The lower part of the Dashboard page displays the following details:

	
The service components running in the service engine, the SOA composite applications of the service components, the state of the applications (for example, running), and the total, running, and faulted instances in the service engine.


	
The recent faults in the service engine, including the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application in which the fault occurred, the service component, the instance ID of the service component, the activity in which the fault occurred, and log files describing the fault.





	
In the Recent Instances section, you can perform the following monitoring tasks:

	
View the audit trail, process flow and faults of a service component. To do this task, in the Instance ID column, click an instance ID for the service component.


	
Access the home page of a service component. To do this task, in the Component column, click a specific service component.


	
Access its home page of a SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Log Messages page with filtered messages specific to an instance. To do this task, in the Logs column, click the specific log.


	
Access the Instances page of the service engine. To do this task, click Show All below the section.





	
In the Components section, you can perform the following tasks:

	
Access the home page of a specific service component. To do this task, in the Name column, click the specific service component.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Deployed Components page of the service engine. To do this task, click Show All below the section.





	
In the Recent Faults section, you can perform the following tasks:

	
Display complete information about a fault. To do this task, in the Error Message column, click an error message. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
Perform fault recovery at the component instance level. To do this task, in the Recovery column, click a fault identified as Recoverable.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the home page of a specific service component. To do this task, in the Component column, click a specific service component.


	
View the audit trail, process flow and faults of a service component. To do this task, in the Component Instance ID column, click an instance ID for a service component.


	
Access the Log Messages page with filtered messages specific to a fault. To do this task, in the Logs column, click the specific log.







For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






38.5 Monitoring BPMN Process Service Engine Request and Thread Statistics

You can monitor request and thread statistics for all BPMN process service components running in the service engine.

To monitor BPMN process service engine request and thread statistics:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Statistics.

The upper part of the Statistics page displays the following details. Click the Help icon for additional details.

	
Pending requests in the service engine


	
Active requests in the service engine


	
Thread statistics for the service engine




The lower part of the Statistics page displays details about the count and minimum, maximum, and average request processing times.









38.6 Monitoring BPMN Process Service Engine Instances

You can monitor all BPMN process service component instances running in the service engine. These BPMN process service components can be part of separate SOA composite applications.

To monitor BPMN process service engine instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Instances.
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The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the service component name, the SOA composite application name, the state of the instance (for example, completed successfully, running, or faulted), the instance start time, the last modification time, and log files describing the instance.





	
In the Instances section, you can perform the following monitoring tasks:

	
View the audit trail, process flow, sensor values, and faults of a service component. To do this task, in the Instance ID column, click an instance ID for a service component.


	
Access the home page of a specific service component. To do this task, in the Component column, click the specific service component.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Log Messages page with filtered messages specific to an instance. To do this task, in the Logs column, click the specific log.







For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






38.7 Monitoring Deployed BPMN Processes in the Service Engine

You can monitor all deployed SOA composite applications with BPMN process service components running in the service engine.

To monitor deployed BPMN processes in service engines:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Deployed Components.
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The Deployed Components page displays the following details:

	
A utility for searching for a specific deployed SOA composite application by specifying criteria and clicking Search.


	
Details about deployed SOA composite applications with BPMN process service components running in this service engine, including the service component name, the SOA composite application, the current status, and the total, running, and faulted instances in the service engine.




To access the home page of a specific service component, in the Name column, click the specific service component.

To access the home page of a specific SOA composite application, in the Composite column, click the specific SOA composite application.











Part II



Getting Started with Administration

This part describes how to navigate to Oracle SOA Suite and Oracle BPM Suite administration tasks in Oracle Enterprise Manager Fusion Middleware Control.

This part includes the following chapter:

	
Chapter 2, "Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite"
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33 Managing Business Events

This chapter describes how to manage business events, including subscribing to business events, managing subscribers, and recovering from business event faults. Business events consist of message data sent as the result of an occurrence in a business environment. When a business event is published, other service components or database agents can subscribe to it.

This chapter includes the following topics:

	
Section 33.1, "Introduction to the Event Delivery Network"


	
Section 33.2, "Subscribing to Business Events"


	
Section 33.3, "Managing Business Event Subscribers"


	
Section 33.4, "Recovering from Business Event Faults"




For information about troubleshooting business event issues, see Section B.5, "Event Delivery Network Troubleshooting."

For more information about business events, see Chapter "Using Business Events and the Event Delivery Network" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



33.1 Introduction to the Event Delivery Network

The subsystem of Oracle SOA Suite that accepts published business events and delivers them to the subscribers is called the Event Delivery Network (EDN). EDN has two different implementations:

	
EDN-DB

EDN-DB uses an Oracle database as a back-end store and depends on Oracle-specific features.


	
EDN-JMS

EDN-JMS uses a JMS queue as a back-end store.




The correct implementation is configured during installation by Oracle Universal Installer. You can also make postinstallation changes. From an application development point of view, the two implementations are identical and the behavior is the same.






33.2 Subscribing to Business Events

You can subscribe to business events in Oracle Enterprise Manager Fusion Middleware Control. Business events consist of message data sent as the result of an occurrence in a business environment. You create business events in Oracle JDeveloper and include them in SOA composite applications that you deploy to Oracle Enterprise Manager Fusion Middleware Control. Service components and database agents can subscribe to business events. Only database agents can be subscribed to from Oracle Enterprise Manager Fusion Middleware Control. Service components are only subscribed to from Oracle JDeveloper. When a business event is published, the entity subscribed to that event receives it.

To subscribe to business events:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Business Events.

	
Right-click soa-infra and select Business Events.








The Events page displays the following details:

	
A utility for searching for a specific business event by specifying a full or partial name and clicking the Search icon. Click the Help icon for details.


	
Business events, including the namespace used, event name, number of subscriptions to each event, and number of failed event deliveries. Business events are contained within their namespace.




[image: Description of busevent_events1.gif follows]
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Select a specific event in the Namespaces and Events section.


	
Click Show Event Definition.

The event definition language (EDL) file for the selected event appears. The business event is defined using EDL. EDL is a schema used to build business event definitions.

In this example, two business events named OrderReceivedEvent and ProductSoldAlert appear in the event definition. The namespace (orders) and associated schema file (ProductOrder.xsd) are referenced.

[image: Description of busevent_def.gif follows]
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Click OK to close the dialog.


	
Click Subscribe to subscribe a database agent to the event selected in the Namespaces and Events table.




	
Note:

The Events page for EDN-JMS implementations does not display the Subscribe button for subscribing a database agent to the selected event.









The Create Database Subscription to an Event dialog appears. You create an agent to listen for and subscribe to appropriate events when they are published.
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Enter the following values. An asterisk indicates a required field.


	Field	Description
	
Event Namespace

	
Displays the event namespace.


	
Event Name

	
Displays the event name.


	
Database Agent

	
Specify a database agent name or click Create Agent to create an agent. The agent listens for and subscribes to appropriate events when they are published.


	
Consistency Level

	
Select one of the following options:

	
Guaranteed: Delivers events to the subscriber asynchronously without a global transaction. The subscriber can choose to create its own local transaction for processing, but it is committed independently of the rest of the event processing. By default, guaranteed delivery attempts to deliver the event to the subscriber for three times. If it cannot deliver the event in these three attempts, then the delivery fails. Also, there is a possibility that a system failure can cause an event to be delivered multiple times because there is no global transaction. If the subscriber throws an exception (or fails in any way), the exception is logged, but the event is not resent.


	
Immediate: Delivers events to the subscriber on the same transaction and same thread as the publisher. The publish call does not return until all immediate subscribers have completed processing. If any subscribers throw an exception, no additional subscribers are invoked and an exception is thrown to the publisher.





	
XPath Filter

	
If you want to filter the event, specify an XPath expression. When the subscription is delivered and the expression logic is satisfied, the event is accepted for delivery. If the logic is not satisfied, the event is not delivered.








	
Click Subscribe.


	
Click Test to test a selected event. This action enables you to publish a test event that subscribers can act upon.

The Test Event dialog appears.


	
Specify the XML payload to use in the test.


	
Click Publish.







	
Note:

Enforcement of policies for event subscriptions is not supported in this release. You can attach or detach a policy to or from a service component that subscribes to a business event (such as Oracle Mediator) without being warned. This action does not result in any errors; policy enforcement simply does not occur.









For more information, see the following documentation:

	
Section 1.2.8, "Introduction to the Contents of SOA Composite Applications"


	
Chapter "Using Business Events and the Event Delivery Network" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for details about business events









33.3 Managing Business Event Subscribers

You can also create, edit, and delete existing database subscriptions. When a business event is published, service components and database agents can subscribe to it. Use this page to view all subscriptions to business events. This page also enables you to manage event subscriptions by database agents. Service component subscriptions are created in Oracle JDeveloper during design time and cannot be modified in Oracle Enterprise Manager Fusion Middleware Control.




	
Notes:

	
If your SOA composite application includes a business event subscription, and you deploy different revisions of the composite, all event subscriptions from all revisions of the composite are active and receive messages. To receive the event with the latest revision of the composite only, it is recommended that you retire all previous revisions of the composite.


	
A BPEL component in a retired SOA composite application cannot receive a business event, even if the event is associated with a noninitiating receive activity of the BPEL process.












To manage business event subscribers:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Business Events.




	
	
Right-click soa-infra.


	
Select Business Events.











	
Click Subscriptions.

The Subscriptions page displays the following details:

	
A utility for searching for a specific subscription by specifying criteria and clicking Search. Click the Help icon for details.


	
The database subscriptions, including the event name, namespace used, subscription agent name, optionally defined XPath filters, consistency level, and number of failed deliveries. You create database subscriptions to business events on this page during runtime.


	
The component subscriptions, including the event name, namespace used, the service component subscribing to the event, the SOA composite application, any optionally defined XPath filters, and the consistency level.
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Note:

For business events implementing EDN - JMS, the Create Database Agent icon, Edit Database Agent icon, Delete Database Agent icon, and Manage Database Agents button are not displayed.










	
Click the appropriate icon below the Database Subscriptions title to create, edit, or delete a database subscription.
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Click Manage Database Agents to edit the PL/SQL procedure or delete agents not currently subscribing to events.


	
In the Subscription Component column, click a service component to access its home page.


	
In the Composite column, click a SOA composite application to access its home page.




For more information about business events, see Chapter "Using Business Events and the Event Delivery Network" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






33.4 Recovering from Business Event Faults

You can recover from business event faults that are identified as recoverable.

To recover from business event faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Business Events.




	
	
Right-click soa-infra.


	
Select Business Events.











	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific business event fault by specifying criteria and clicking Search.


	
Faults occurring in a business event, including the error message, whether you can recover from the fault, the time at which the fault occurred, the event namespace, event name, the subscriber, and the subscription type (database or component). The Recoverable? column identifies faults for which recovery actions can be performed.
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From the View list, select Columns > Fault ID to display the fault IDs for each error message.


	
Click a specific fault that has been identified as recoverable and select one of the following options:


	Action	Description
	
Retry

	
Retries the instance in which the fault occurred


	
Abort

	
Terminates the entire instance in which the fault occurred








	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.




For more information about business events, see Chapter "Using Business Events and the Event Delivery Network" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.









36 Managing Service and Reference Binding Components

This chapter describes how to manage policies for web service and JCA adapter service and reference binding components in SOA composite applications and publish service binding components to the Universal Description, Discovery, and Integration (UDDI) registry from a registered UDDI source.

This chapter includes the following topics:

	
Section 36.1, "Managing Binding Component Policies"


	
Section 36.2, "Publishing Web Services to the UDDI Registry"







	
Notes:

	
Oracle SOA Suite does not support multiple bindings for service or reference binding components (for example, specifying both SOAP 1.1 and SOAP 1.2 in the composite.xml file). Support is only provided for a single web service binding per service or reference. If you specify multiple bindings, remove all but one and redeploy your SOA composite application.


	
The only type of binding component to which you can attach a policy is a web service. If you click the Policies tab for another type of binding component, such as a JCA adapter, ADF-BC service, or EJB service, the following message is displayed:


Policies can be attached to web service bindings and SOA
components.












For more information, see the following documentation:

	
Section 1.2.5, "Introduction to Binding Components" for conceptual details about binding components


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






36.1 Managing Binding Component Policies

You can attach and detach security policies to and from binding components included in a currently deployed SOA composite application. Policies apply security to the delivery of messages. Oracle Fusion Middleware uses a policy-based model to manage web services.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.









To manage binding component policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











The list of currently deployed SOA composite applications appears.


	
In the Composite list, select an application.

The Dashboard page for the selected SOA composite application appears. The Services and References section of this page displays the binding components being used in the application.


	
In the Services and References section, select a service or reference.


	
Click Policies.

The Policies page enables you to view the globally-attached and directly-attached policies, and to attach or detach security policies to and from a service or reference binding component:

	
The Globally Attached Policies table displays the globally-attached policy name, the policy set, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS Addressing), the violations since the SOA Infrastructure was last restarted, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

Policy sets provide a means to attach policies globally to a range of endpoints of the same type. Attaching policies globally using policy sets enables an administrator to ensure that all subjects are secured in situations in which the developer, assembler, or deployer did not explicitly specify the policies to attach. Policies that are attached using a policy set are considered externally attached. For information about creating and managing policy sets, see Chapter "Creating and Managing Policy Sets" of Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	
The Directly Attached Policies table displays the directly-attached policy name, the policy reference status (enabled or disabled), the category, the violations since the SOA Infrastructure was last restarted, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.
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In the Directly Attached Policies section, click Attach/Detach.

If multiple components are available, you are prompted to select the service or component for which to perform the attachment or detachment.




	
Note:

If you attach a policy to a service binding component (client) and initiate an instance of the SOA composite application in the Test Web Service page, and the policy attachment fails, an Oracle Web Services Manager (OSWM) policy error is not generated and viewable in Oracle Enterprise Manager Fusion Middleware Control.

If the same SOA composite application instance is initiated externally, a policy error is generated and viewable in Oracle Enterprise Manager Fusion Middleware Control.

For service components (such as a BPEL process) or reference binding components, the policy error is always generated and viewable, regardless of whether the application instance was initiated externally or internally through the Test Web Service page.










	
Select the service or component to which to attach or detach a policy.

This invokes a dialog for attaching or detaching policies.

Policies currently attached appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.


	
Select policies to attach that are appropriate to your environment.


	
Click Attach.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.

The attached policy is displayed in the policies table.


	
Click OK.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 7.6, "Managing SOA Composite Application Policies" for the dialogs that are displayed during policy attachment


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment






36.1.1 Override Policy Configuration Property Values

Your environment may include multiple servers with the same policies. However, each server may have their own specific policy requirements. To satisfy your runtime requirements, you can override the property values for some management and security policies attached to service and reference binding components.

	
Follow the instructions in Section 36.1, "Managing Binding Component Policies" to attach a policy to a service or reference binding component.


	
Select the attached policy in the table.

The Security Configuration Details table is displayed at the bottom of the page.
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In the Value field, enter a value to override the default value in the Original Value column.


	
Click Apply.




For more information on overriding policy values, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.








36.2 Publishing Web Services to the UDDI Registry

You can publish service binding components to the UDDI registry from a registered UDDI source.




	
Notes:

	
You cannot publish a reference binding component to the UDDI registry.


	
You can only publish web services to the UDDI registry. For example, you cannot publish a JCA adapter.












For information about the Oracle Service Registry:

	
Visit the following URL:


http://www.oracle.com/technetwork/topics/soa/whatsnew/index.html


	
Click the Products tab.


	
Click Governance.




For information about Oracle Enterprise Repository, see Oracle Fusion Middleware Configuration Guide for Oracle Enterprise Repository and Oracle Fusion Middleware Integration Guide for Oracle Enterprise Repository.

For more information about publishing web services to the UDDI registry, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.



36.2.1 Configuring the Environment for Publishing Web Services to UDDI

Before you can publish a web service to the UDDI registry, you must configure your environment.

If your SOA Infrastructure installation is behind a firewall, the Oracle Enterprise Manager Fusion Middleware Control managed server must have a proxy server configured for outbound URL connections.

To configure the environment for publishing web services to UDDI:

	
Configure the proxy server setting in either of the following ways:

In the following file:

	
Open the FMW_Home/user_projects/domains/soainfra/bin/setDomainEnv.sh file for Linux (or setDomainEnv.bat for Windows operating systems).


	
Enter the following syntax and provide host, port, and proxy host details appropriate to your environment:


EXTRA_JAVA_PROPERTIES="${EXTRA_JAVA_PROPERTIES} -DproxySet=true
-Dhttp.proxyHost=www-myproxy.us.mycompany.com -Dhttp.proxyPort=80
-Dhttp.nonProxyHosts=localhost|$HOST_IP_ADDRESS|$HOSTNAME|*.us.mycompany.com"
export EXTRA_JAVA_PROPERTIES


	
Run setDomainEnv.sh or setDomainEnv.bat.




With an environment variable:

	
Set the PROXY_SETTINGS environment variable before starting Oracle WebLogic Server.


setenv PROXY_SETTINGS "-DproxySet=true
-Dhttp.proxyHost=www-myproxy.us.mycompany.com -Dhttp.proxyPort=80
 -Dhttp.nonProxyHosts=localhost|*.us.mycompany.com
  |0:0:0:0:0:0:0:1|fe80:0:0:0:250:56ff:fe31"







You must set up a UDDI source to use for publication.

	
In the navigator, expand Weblogic Domain.


	
Right-click soainfra and select Web Services> Registered Services.

The Registered Sources and Services page appears.


	
In the Sources section, click Register Web Services.

The Register New Source dialog appears.
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Enter the following information:


	Field	Description
	
Name

	
Enter a descriptive name for the service.


	
Description

	
Enter a descriptive name for the UDDI source to which to publish the WSDL.


	
Type

	
Select UDDI v3 registry import.


	
Source Location

	
Enter the source location. For example:


http://myhost.us.mycompany.com:7001/registry/uddi/inquiry


	
Publication

	
Select the Enable checkbox.


	
Publication URL

	
Enter the publication URL. For example:


http://myhost.us.mycompany.com:7001/registry/uddi/publishing


	
Security URL

	
Enter the security URL. For example:


http://myhost.us.mycompany.com:7001/registry/uddi/security


	
User ID

	
Enter admin.


	
Password

	
Enter the user ID password.








	
Click OK.









36.2.2 Publishing a Web Service to the UDDI Registry




	
Note:

You can publish web services to default Oracle Service Registry businesses from Oracle Enterprise Manager Fusion Middleware Control. To publish to nondefault businesses, use the publish option in Oracle Service Registry.

For more information about Oracle Service Registry, including documentation, visit the following URL:


http://www.oracle.com/technetwork/middleware/registry/overview/index.html









To publish a web service to the UDDI registry:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Services and References.




	
	
Right-click soa-infra.


	
Select Services and References.











The Services page displays details about the names and types of the services, the SOA composite applications in which the services are used, the partition in which the composite is deployed, the total number of messages processed, the average processing time, and the number of faults occurring in the services. 


	
In the Service table, select a service to publish to the UDDI registry.


	
From the Actions list, select Publish To UDDI.
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The Publish Service to UDDI dialog appears.


	
Enter the following information:


	Field	Description
	
Service Name

	
Displays the name of the selected service.


	
Service Description

	
Enter an optional description of the selected service.


	
System Definition Location

	
Displays the WSDL URL to publish to the UDDI registry. For example:


http://myhost.mycompany.com:7001/soa-infra/services/default/HelloWorld/client?WSDL


	
UDDI Source

	
Select the UDDI publishing source from which to register the service.


	
Business Name

	
Select a business to publish the service. This is the name of the data structure in the UDDI registry. It is assumed that the business has already been registered in the UDDI registry.








When complete, the Publish Service to UDDI dialog looks similar to the following:
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Click OK.














19 Monitoring Decision Service Components and Engines

This chapter describes how to monitor decision service components, including service engine instances, faults, statistics, and deployed composites; deployed decision service component instances; business rule tracing; and log files. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.

This chapter includes the following topics:

	
Section 19.1, "Monitoring Business Rules Service Engine Recent Instances and Faults"


	
Section 19.2, "Monitoring Business Rules Service Engine Statistics"


	
Section 19.3, "Monitoring Business Rules Service Engine Instances"


	
Section 19.4, "Monitoring Business Rules Service Engine Faults"


	
Section 19.5, "Monitoring Business Rules Service Engine Deployed Components"


	
Section 19.6, "Monitoring Decision Service Component Instances of a Composite Application"


	
Section 19.7, "Monitoring Business Rule Tracing"


	
Section 19.8, "Monitoring Decision Service Component Logs"







	
Note:

The business rules service engine does not support any user level configuration.











19.1 Monitoring Business Rules Service Engine Recent Instances and Faults

Using the business rules service engine home page Dashboard page, you can monitor recent instances and faults of decision service components running in the SOA Infrastructure. These decision service components can be part of separate SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine instances and faults:

	
Access the business rules service engine home page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Business Rules.




	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Dashboard.

The Recent Instances section of the Dashboard page displays recent instances of all decision service components, including the instance ID of the decision service component, the decision service component name, the SOA composite application of which the decision service component is a part, the state of the instance (for example, completed successfully or faulted, the instance start time, the last modification time, and a Logs icon (clicking the Logs icon shows the Log Messages page with filtered messages specific to that instance)).




	
Note:

To see the state with the correct information, you must set the Capture Composite Instance State property. You can change this setting on the SOA Administration Common Properties page. Turning this feature on allows for separate tracking for running instances. However, this may impact performance. For information on setting this property, see Section 3.1, "Configuring SOA Infrastructure Properties."
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In the Instance ID column, click an instance ID for a decision service component to view its audit trail.




	
Note:

The contents of the audit trail page depends on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. In other modes, for example Off, the audit trail does not show decision service details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Component column, click a specific decision service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All to access the Instances page of the service engine.




The lower section of the Dashboard page displays the following:

	
The Components section shows the decision service components deployed on the business rules service engine across SOA composites. It also shows the status of the SOA composites and the instance count information in the respective instance state columns.


	
The Recent Faults section lists the recent faults in the service engine, including the error message, the time at which the fault occurred, the SOA composite application in which the fault occurred, the decision service component, the instance ID of the decision service component, and a Logs icon (clicking the Logs icon shows the Log Messages page with filtered messages specific to that instance).




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.2 Monitoring Business Rules Service Engine Statistics

Using the business rules service engine Statistics page, you can monitor business rules service engine performance and metrics. This page shows service engine-level, not component-level, details. Business rules service components are also called decision service components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine statistics:

	
Access the business rules service engine statistics page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Statistics.

The Statistics page displays the following:

	
Average Request Processing Time: This chart displays the average request processing time of the business rules service engine since server startup. That is, how many requests were processed by the service engine per unit of time.


	
Business Rules Cache Statistics: This section provides details about the service engine cache. This section lists the types of caches used by the service engine and the object count in each of the caches. All these metrics are based on the object count since server startup.


	
Business Rules Operation Statistics: This section shows the operation statistics. Using the operation statistics, you can determine the number of calls to Oracle Business Rules decision functions since server startup, and determine the total time spent in Decision Functions since server startup.




	
Note:

When you view business rules operation statistics for composite applications created with Oracle Fusion Middleware 11g Release 1 (11.1.1), the only operation shown is the callFunction operation. In this release, the decision service only calls Oracle Business Rules using decision functions, and this operation is indicated with values for the operation named callFunction (with Count and Average(ms) fields). With composite applications that were migrated from older releases, the decision service performs callFunction operations and the other operations listed in the Business Rules Operation Statistics section. For these migrated projects, you can debug the flow of the request through various important operations within the service engine. Also, you can find any long-running operations and take the necessary actions. These metrics also are since server startup.
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19.3 Monitoring Business Rules Service Engine Instances

Using the business rules service engine Instances page, you can monitor all decision service component instances. These decision service components can be part of separate SOA composite applications. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.

To monitor business rule service engine instances:

	
Access the business rules service engine Instances page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Instances.

The Instances page displays the following:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
A list of instances, including the instance ID of the decision service component, the decision service component name, the SOA composite application name, the state of the instance (for example, completed successfully, running, or faulted), the instance start time, the last modification time, and a Logs icon (clicking the Logs icon shows the instance log messages).
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In the Instance ID column, click an instance ID for a decision service component to view its audit trail details.




	
Note:

The contents of the audit trail page depends on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Component column, click a specific decision service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.4 Monitoring Business Rules Service Engine Faults

Using the business rules service engine Faults page, you can monitor all decision service component faults. The Faults page shows this information for decision service components that can be part of separate SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine faults:




	
Note:

Decision service component faults are always nonrecoverable.









	
Access the business rules service engine Faults page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Right-click soa-infra.


	
Select Service Engines > Business Rules.











	
Click Faults.

The Faults page displays the following:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
A list of faults that occurred in the decision service component, including the error message, the time at which the fault occurred, the SOA composite application and decision service component in which the fault occurred, the decision service component instance ID, and a Logs icon (clicking the Logs icon shows the instance log messages).




Decision service component instance faults cannot be recovered.
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You can perform the following monitoring tasks from within the Faults page:

	
From the Fault Type list, select to display all Faults, system faults, business faults, or Oracle Web Services Manager faults in the Faults page.


	
From the View list, select Columns > Fault ID to display the fault IDs for each fault. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component column, click a specific decision service component to access its home page.


	
In the Component Instance ID column, click a specific decision service component instance ID to view the audit trail.




	
Note:

The contents of the audit trail page depend on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to the instance. Clicking the Log link shows the faults and error messages related to that faulted instance.





	
In the Error Message column, click to view the fault details.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.5 Monitoring Business Rules Service Engine Deployed Components

Using the business rules service engine home page Deployed Components page, you can monitor all decision service components deployed across SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rule service engine deployed components:

	
Access the business rules service engine Deployed Components page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Right-click soa-infra.


	
Select Service Engines > Business Rules.











	
Click Deployed Components.

The Deployed Components page displays the following:

	
A utility for searching for a specific component by specifying criteria and clicking Search.


	
A list of components, including the name, the SOA composite application name, the status (up or down), and the instances count (total, running, and faulted).
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In the Name column, click a name to navigate to the Component home page and view component details.


	
In the Composite column, click a specific SOA composite application to access its home page.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.6 Monitoring Decision Service Component Instances of a Composite Application

You can monitor decision service component instances of a composite application. Each decision service component instance has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this decision service component is a part. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.




	
Note:

To see the state with the correct information, you must set the Capture Composite Instance State option. You can change this setting on the SOA Infrastructure Common Properties page. Turning this feature on allows for separate tracking for running instances. However, this may impact performance. For information on setting the option, see Section 3.1, "Configuring SOA Infrastructure Properties."









To monitor decision service component instances from a composite application:

	
Access a decision service component from a composite application through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
In the navigator, select soa-infra.


	
From the SOA Infrastructure menu, Select Home.


	
Click Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application that includes a decision service component.




	
	
Expand soa-infra.


	
Select a specific SOA composite application that includes a decision service component.
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The Component Metrics section on the composite dashboard provides a high-level overview of each decision service component. This table includes columns showing the Component Type, the Total Instances, the Running Instances, and the Faulted Instances (recoverable and nonrecoverable).


	
Select a decision service component in the Component Metrics section to display the corresponding decision service component page.
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For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






19.7 Monitoring Business Rule Tracing

You can use Oracle Enterprise Manager Fusion Middleware Control to perform rule execution tracing. For more information about accessing and using Fusion Middleware Control, see Chapter 2, "Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite."

A rule execution trace is a mechanism of tracing business rules service engine events that occur during the evaluation of rules. The types of events traced are:

	
Fact operations (assert, retract, and modify)


	
Rules execution


	
Rule activation


	
Ruleset stack changes


	
Rule compilation


	
Reset (required for maintaining state during analysis)




Each trace contains information about the event that it traces. For example, a rule trace entry for an executed rule consists of:

	
Rule name (RL name)


	
Execution sequence number


	
List of fact IDs for the facts that matched this rule


	
Timestamp in milliseconds




Rule execution trace audit levels are the same as the audit levels supported in the SOA Infrastructure:

	
Off: Rule execution tracing is disabled. The decision component instance is not created at all.


	
Development: Full rule execution tracing that contains all the details about facts (listing, operations such as modify and assert), rule activation, pop or push rulesets, and so on. It also provides a list of fact IDs on which the executed rules are matched. See Section 19.7.1, "Tracing Rule Execution at the Development Audit Level" for an example.


	
Production: The executed rules are traced. All the details about facts, rule activation, pop or push ruleset are not available. The trace do not contain a list of the matching facts IDs. See Section 19.7.2, "Tracing Rule Execution at the Production Audit Level" for an example.




You can set audit levels either at the SOA Infrastructure level or at the composite level. See Section 3.1, "Configuring SOA Infrastructure Properties" for SOA Infrastructure audit level configuration information. See Section 1.4.1.1, "Introduction to the Order of Precedence for Audit Level Settings" for a discussion about audit level precedence when set at the SOA Infrastructure level and the composite level. The following sections discuss setting audit levels at the composite level for the purposes of rule execution tracing.



19.7.1 Tracing Rule Execution at the Development Audit Level

Setting the audit level to Development enables you to view all the details pertaining to a rule that has been executed.

To perform a development-level rule execution trace:

	
Open the composite application in Oracle Enterprise Manager Fusion Middleware Control.

A list of the recent composite instances is shown on the composite Dashboard page.


	
Click the Settings list, select Composite Audit Level, > Development to set the trace level as Development at the composite level.
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Click Yes in the Confirmation dialog.
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Click Test and then client to invoke a test instance of the composite to view the decision traces corresponding to different input parameters, such as the Order ID.
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Enter an Order ID, for example 1001, in the Value field in the Input Arguments section on the Test Web Service page and click the Test Web Service button.
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Based on the input Order ID, the service invokes a BPEL process instance containing the details of the Order ID, and the rule that is relevant to the order details is executed.


	
Click Launch Message Flow Trace under the Response tab to open the Flow Trace page.

[image: Description of em_test_msg_flow_trace.gif follows]

Description of the illustration em_test_msg_flow_trace.gif



	
Click the decision service component instance called DiscountDictionary in the Trace section to view the actual rule execution trace.

[image: Description of em_test_trace_dec_comp.gif follows]

Description of the illustration em_test_trace_dec_comp.gif






	
Note:

You can also view the values of composite variables before and after invocation of business rule component. You must click the BPEL process component instance in the Flow Trace page, and then click the relevant payload. In this case, the BPEL component name is FODOrderProcessingProcess.









The following graphic shows the execution trace for the decision service component called DiscountDictionary.

[image: Description of em_test_trace_dev.gif follows]

Description of the illustration em_test_trace_dev.gif



	
Click the Show rule set stack states in audit trail checkbox to view further details of the rule execution.

[image: Description of em_test_trace_dev_show_rule.gif follows]

Description of the illustration em_test_trace_dev_show_rule.gif



The development-level trace report displays the fact name, activated rule, and the pushed and popped ruleset names.

The following table lists the entries of the trace report:


	Element	Description
	
Invoked Decision Service Name

	
Displays the name of the decision service component that is invoked.


	
Asserted Fact

	
Displays the name of the fact that is passed by the BPEL service to the decision service component. This is based on the input parameter provided by the user, which according to the example is the Order ID 1001.


	
Activated Rule

	
Displays the name of the rule that is activated, along with the name of the fact that activated the rule.


	
Pushed ruleset

	
Displays the name of the ruleset that has been invoked when the fact is asserted.


	
Fired rules in Ruleset

	
Displays the name of the ruleset whose rule is executed.


	
Fired rule

	
Displays the name of the rule that is executed.


	
Modified fact

	
Displays the name of the fact that has been modified because of the rule execution. This modified fact is then passed by the decision service component to the BPEL service.


	
Popped ruleset

	
Displays the name of the ruleset for which execution is complete and so, the ruleset is taken out of the execution queue.











	
Notes:

The entry Invoked Decision Service Name appears differently in different scenarios:

	
For AS10.1.3.x to AS11 upgraded rules dictionaries with AssertExecuteWatch patterns, the entry appears in the trace report as Invoked Decision Service.


	
For AS10.1.3.x to AS11 upgraded rules dictionaries with CallFunction patterns, the entry appears in the trace report as Invoked Decision Function.


	
For AS11 created dictionaries, the entry is displayed as Invoked Decision Function.




















19.7.2 Tracing Rule Execution at the Production Audit Level

Setting the audit level to Production provides a truncated report on the rule execution trace. It only displays the ruleset and the rules that have been fired and does not display details about facts, rule activation, and so on.

The process of production-level tracing is similar to the development-level tracing. However, for Production-level tracing, you must do the following:

In Fusion Middleware Control, after opening the composite, select Production from the Composite Audit Level of the Settings menu.

The following graphic shows the Flow Trace page that displays the trace report.

[image: Description of em_test_trace_prod.gif follows]

Description of the illustration em_test_trace_prod.gif



The Production-level trace report contains only the name of the ruleset and the rules that were fired. In addition, the Show rule set stack states in audit trail checkbox that provides a drill-down detailed trace report is unavailable in the Production-level trace report.








19.8 Monitoring Decision Service Component Logs

You can monitor decision service component logs. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.



19.8.1 Viewing Decision Service Component Logs

To view decision service component logs:

	
In the navigation tree, select and right-click soa-infra.


	
Select Logs > View Log Messages. This displays the Log Messages page.

[image: Description of rules1_logs1.gif follows]

Description of the illustration rules1_logs1.gif



The Log Messages page opens. Use this page to select target log files.

[image: Description of rules1_logs2.gif follows]

Description of the illustration rules1_logs2.gif



	
To access a prefiltered list of log files for each instance or fault, click in the Logs column from any specific page (for example, in the decision service engine or component's faults or instances tables).

For example, from the Faults table, click the Logs column.

[image: Description of rules1_engine_faults.gif follows]

Description of the illustration rules1_engine_faults.gif










19.8.2 Setting the Diagnostic Logging Level with a Log Configuration

Use the Log Configuration page to configure the logging level.

To set the diagnostic logging level with a log configuration:

	
Right-click soa-infra, and select Logs > Log Configuration.

[image: Description of rules1_logs3.gif follows]
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To configure the decision service component logging level, expand the oracle.soa.service.rules and the oracle.soa.services.rules.obrtrace loggers and set the notification level.

[image: Description of rules1_logs4.gif follows]
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7 Deploying and Managing SOA Composite Applications

This chapter describes how to deploy and manage SOA composite applications, including managing the states of deployed composites; deploying, redeploying, and undeploying a SOA composite application from Oracle Enterprise Manager Fusion Middleware Control; automating testing of SOA composite applications; managing policies; exporting deployed composites; grouping composites into partitions; and managing BPEL and BPMN monitors.

This chapter includes the following topics:

	
Section 7.1, "Deploying SOA Composite Applications"


	
Section 7.2, "Redeploying SOA Composite Applications"


	
Section 7.3, "Undeploying SOA Composite Applications"


	
Section 7.4, "Managing the State of Deployed SOA Composite Applications"


	
Section 7.5, "Automating the Testing of SOA Composite Applications"


	
Section 7.6, "Managing SOA Composite Application Policies"


	
Section 7.7, "Exporting a Deployed SOA Composite Application"


	
Section 7.8, "Grouping SOA Composite Applications into Partitions"


	
Section 7.9, "Disabling and Enabling BPEL and BPMN Business Monitors"




For information on the following:

	
Creating SOA composite application archives and configuration plans in which you define the URLs and property values to use for test, development, and production environments, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Deploying with ant scripts, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Deploying with Oracle WebLogic Scripting Tool (WLST), see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference







	
Note:

If Oracle Enterprise Manager Fusion Middleware Control is run in a single sign-on (SSO)-enabled environment, you are again prompted to enter the user name and password credentials as part of the last step of the Deploy SOA Composite, Undeploy SOA Composite, and Redeploy SOA Composite wizards. This information is only requested once per Oracle Enterprise Manager Fusion Middleware Control session.











7.1 Deploying SOA Composite Applications

You can deploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Deploy SOA Composite wizard. You must first create a deployable archive in Oracle JDeveloper or with the ant or WLST command line tool. Use the Deploy SOA Composite wizard to deploy any of the following:

	
A new SOA composite application for the first time.


	
A new revision (for example, 2.0) alongside an older revision (for example, 1.0) without having an impact on the latter. The revision deployed last becomes the new default revision of that composite (unless you specify otherwise at a later step during deployment).


	
A SOA bundle (ZIP file) containing multiple revisions (for example, revisions 2.0, 3.0, and 4.0) of a SOA composite application that has different revisions currently deployed (for example, 1.0). This option enables you to deploy revisions 1.0, 2.0, 3.0, and 4.0 at the same time. The bundle can also contain revisions of different composites. There is no restriction that all revisions must be of the same composite application. There should not be any cross references between the composites in the same bundle. For example, composite A revision 1.0 should not reference composite B revision 1.0.




Deployment extracts and activates the composite application in the SOA Infrastructure. After an application is deployed, you can perform administration tasks, such as creating instances, configuring properties, monitoring performance, managing instances, and managing policies and faults.




	
Note:

If you want to redeploy an existing revision of an application, do not use this wizard. Instead, use the Redeploy SOA Composite wizard. 









To deploy SOA composite applications:

	
Access the Deploy SOA Composite wizard through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment > Deploy.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Deploy.




	
	
Click the Deployed Composites tab.


	
Above the Composite table, click Deploy.




	
	
Select SOA Deployment > Deploy Another Composite.














	
Note:

You can also access the Deploy SOA Composite wizard by selecting Deploy To This Partition from the Deployment dropdown list on the Manage Partitions page or home page of a specific partition, from the SOA Partition menu at the top of the home page of a specific partition, or by right-clicking a specific partition in the navigator.









The Select Archive page appears.

[image: Description of sca_deploy.gif follows]
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In the Archive or Exploded Directory section, specify the archive of the SOA composite application to deploy. The archive contains the project files of the composite to be deployed (for example, HelloWorld_rev1.0.jar for a single archive or OrderBooking_rev1.0.zip for multiple archives). This information is required.


	
In the Configuration Plan section, optionally specify the configuration plan to include with the archive. The configuration plan enables you to define the URL and property values to use in different environments. During process deployment, the configuration plan is used to search the SOA project for values that must be replaced to adapt the project to the next target environment.


	
Click Next.

The Select Target page appears.

This page lists the Oracle SOA Suite managed server or cluster to which to deploy the SOA composite application archive.


	
Select the partition into which to deploy this SOA composite application. Partitions enable you to logically group SOA composite applications into separate sections. Even if there is only one partition available, you must explicitly select it. Once deployed, a composite cannot be transferred to a different partition.

If you want to deploy a SOA composite application to a partition that does not exist, exit the wizard and create the partition before deploying the composite. You create partitions in the Manage Partitions page, accessible from the SOA Infrastructure menu.

If the server contains no partitions, you cannot deploy composite applications to that server. Also, if the server is not in a running state, you cannot deploy this archive. By default, a partition named default is automatically included with Oracle SOA Suite. You can delete the default partition.




	
Note:

Human workflow artifacts such as task mapped attributes (previously known as flex field mappings) and rules (such as vacation rules) are defined based on the namespace of the task definition. Therefore, the following issues are true when the same SOA composite application with a human workflow task is deployed into multiple partitions:

	
For the same task definition type, mapped attributes defined in one partition are visible in another partition.


	
Rules defined on a task definition in one partition can apply to the same definition in another partition.












If you invoke the Deploy SOA Composite wizard by selecting Deploy To This Partition from the Deployment dropdown list on the Manage Partitions page or home page of a specific partition, the partition to which to deploy is selected. Therefore, the Select Target page is skipped.


	
Click Next.

The Confirmation page appears.


	
Review your selections.


	
Select whether to deploy the SOA composite application as the default revision. The default revision is instantiated when a new request comes in.


	
Click Deploy.

Processing messages are displayed.

At this point, the deployment operation cannot be canceled. Deployment continues even if the browser page is closed.


	
When deployment has completed, the home page of the newly deployed composite revision is displayed automatically. A confirmation message at the top of the page tells you that the composite has been successfully deployed. In the case of a bundle deployment, the Deployed Composites page of the SOA Infrastructure is displayed.




For information about creating configuration plans and deploying applications from Oracle JDeveloper, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



7.1.1 Deploying SOA Composite Applications with Task Flows

When you deploy a SOA composite application with a task flow Enterprise Resource Archive (EAR) file from Oracle Enterprise Manager Fusion Middleware Control or Oracle WebLogic Server Administration Console to a multiple partition environment, you cannot specify partition details. To specify a partition, modify the hwtaskflow.xml file to include the partition name in the generated EAR file (the project version of the file remains unchanged). This file is located under the TaskForm project adfmsrc directory (for example, HelpDeskRequestTaskFlow\adfmsrc\hwtaskflow.xml).


<hwTaskFlows
 xmlns="http://xmlns.oracle.com/bpel/workflow/hwTaskFlowProperties">
   <ApplicationName>worklist</ApplicationName>
   <LookupType>LOCAL</LookupType>
   <TaskFlowDeploy>false</TaskFlowDeploy>
   <PartitionName>partition2</PartitionName> 





7.1.2 Deploying SOA Composite Applications with ant Scripts and the WLST Command Line Tool

You can also deploy SOA composite applications with ant scripts and the WLST command line tool.

	
For information on deploying with ant scripts, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
For information on deploying with WLST, see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference











7.2 Redeploying SOA Composite Applications

You can redeploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Redeploy SOA Composite wizard. Using the Redeploy SOA Composite wizard has the following consequences:

	
A new version of a revision of a currently deployed SOA composite application is redeployed on the same deployment target (for example, old version 1.0 is redeployed as new version 1.0).


	
If the older, currently deployed version of this revision has running instances, you can select whether to change the state of those instances to stale. See Step 6 for a description of the Running Instances section of the Redeploy SOA Composite wizard and limitations on this option.

The instance state is available in the instance listing, and you can access audit and flow trace details.







	
Notes:

	
If you want to maintain multiple revisions of a deployed application (for example, revisions 1.0 and 2.0), do not use this wizard. Instead, use the Deploy SOA Composite wizard.


	
Redeploying multiple SOA composite applications at once is not supported.












To redeploy applications:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment >Redeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select the SOA composite application revision you want to redeploy, and click Next.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Redeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select the SOA composite application revision you want to redeploy, and click Next.




	
	
Click the Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application. Only one application can be redeployed at a time.


	
Above the Composite table, click Redeploy.




	
	
Select SOA Deployment > Redeploy.














	
Note:

You can also access the Redeploy SOA Composite wizard by right-clicking a partition and selecting SOA Deployment > Redeploy.









The Select Archive page appears.


	
In the Archive or Exploded Directory section, select the location of the SOA composite application revision you want to redeploy.


	
In the Configuration Plan section, optionally specify the configuration plan to include with the archive.


	
Click Next.

The Confirmation page appears.


	
In the Default Revision section, select whether to redeploy the SOA composite application as the default revision.


	
In the Running Instances section, select whether to continue running the current instances of a redeployed SOA composite application.

	
Change states of running instances to stale:

	
Select to change the states of currently running instances to stale after redeployment of the SOA composite application.




	
Note:

Even if the state of a SOA composite application instance becomes stale, the instance states of BPEL process service components included in this composite remain as completed and not as stale. This is done for performance reasons, and is the expected behavior. 













	
Continue instances on redeploy (current instance states will not be changed):




	
Note:

This option is displayed if Oracle BPM Suite is installed in the SOA Infrastructure, and only supported for the deployment of BPM composites. Do not select this option if you are deploying:

	
A SOA composite application from a SOA Infrastructure environment in which Oracle BPM Suite is also installed.


	
A BPM composite that includes a durable BPEL process, regardless of whether that process has been modified. Durable BPEL processes are those that take time to complete execution. Examples of durable BPEL processes are asynchronous processes (which are always durable) and synchronous processes that include a durable activity such as a wait activity.

If you select this option and attempt to redeploy a durable BPEL process, then deployment fails. 












	
Select to continue running instances after redeployment of the BPM composite application. This prevents these instance states from being changed to stale. 

Instances of different service components behave differently after redeployment. Ensure that you understand the following details:








	For...	Description
	
Oracle Business Process Management Notation (BPMN) instances

	
You must manually migrate instances.

BPMN service component instances are displayed as running in Oracle Enterprise Manager Fusion Middleware Control after redeployment. However, to ensure that your redeployed application is running correctly, search for instances with the pending migration state in Oracle BPM WorkSpace and manually migrate these instances to the new component definition. 


	
Oracle BPEL process, decision service (business rule), Oracle Mediator, and human workflow instances

	
Instances are automatically migrated.

Oracle Enterprise Manager Fusion Middleware Control attempts to automatically migrate the instances of these components. If the migration is successful, your SOA composite application is redeployed. However, if some of the following component instances cannot be migrated, redeployment of the entire composite fails. 

	
BPEL instances: This capability is not supported if the composite includes a BPEL process service component that has changed from the previous revision.


	
Oracle Mediator: Checks the new component definition for compatibility. If it is incompatible with the existing component definition, the redeployment of the composite revision fails. However, if at the time of redeployment all Oracle Mediator processes within the running instances of this composite have completed, the definition change has no impact and redeployment is successful. Because Oracle Mediator instances take a short time to complete, their migration does not pose a high risk of redeployment failure.


	
Decision service: If the component definition has changed and is incompatible with the existing component definition, this may cause the redeployment of the composite revision to fail. However, if at the time of redeployment all decision service processes within the running instances of this composite have completed, the definition change has no impact and redeployment is successful. Because decision service instances take a short time to complete, their migration does not pose a high risk of redeployment failure.


	
Human workflow: Changes in human workflow do not impact any existing user task that has been created. Newly created human tasks after redeployment can use a new routing slip.











	
Click Redeploy.

Processing messages are displayed.

At this point, the deployment operation cannot be canceled. Deployment continues even if the browser page is closed.


	
When redeployment has completed, click Close.

When redeployment has completed, the home page of the newly redeployed composite revision is displayed. A confirmation message at the top of the page tells you that the composite has been successfully redeployed.









7.3 Undeploying SOA Composite Applications

You can undeploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Undeploy SOA Composite wizard. Using the Undeploy SOA Composite wizard has the following consequences:

	
You can no longer configure and monitor this revision of the application.


	
You can no longer process instances of this revision of the application.


	
The state of currently running instances is changed to stale and no new messages sent to this composite are processed.


	
The instance state of the undeployed composite application is set to stale. The instance state is available in the instance listing, and you can access audit trail and flow trace details.


	
If you undeploy the default revision of the SOA composite application (for example, 2.0), the next active, available revision of the application is automatically designated as the new default (for example, 1.0).


	
A warning message is displayed at the end of this wizard when you undeploy the default composite revision.

If no active revision is available and the default revision is undeployed, your composite may be unable to process new incoming requests. It is recommended that you have at least one active revision of this composite deployed before you undeploy the default revision. 

If you undeploy this revision and no active revisions of this composite are found, a retired revision is automatically designated as the new default revision. A warning message is displayed after this wizard closes. Although all currently executing instances complete normally in retired composites, they cannot process any incoming requests. To process new incoming requests for this composite after the current default revision is undeployed, you must deploy a new revision or reactivate a previously retired revision.







	
Note:

If you want to undeploy and then redeploy an existing revision of this application, do not use this wizard. Instead, use the Redeploy SOA Composite wizard. The Redeploy SOA Composite wizard enables you to redeploy an existing revision of a SOA composite application and remove (overwrite) the older, currently deployed version of the revision.









To undeploy applications:




	
Note:

You can undeploy multiple SOA composite applications together if they are located in the same partition. For information, see Section 7.8, "Grouping SOA Composite Applications into Partitions."









	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment >Undeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select a specific SOA composite application to undeploy, and click Next.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Undeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select a specific SOA composite application to undeploy, and click Next.




	
	
Click the Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application. Only one application can be undeployed at a time.


	
Above the Composite table, click Undeploy.




	
	
Select SOA Deployment > Undeploy.














	
Note:

You can also access the Undeploy SOA Composite wizard through these additional partition options:

	
Right-clicking a partition and selecting SOA Deployment > Undeploy All From This Partition


	
Selecting Deployment > Undeploy All From This Partition on the partition home page


	
Selecting Deployment > Undeploy All From This Partition for the selected partition from the Manage Partitions page












The Confirmation page appears.


	
If you are satisfied, click Undeploy. You are warned if you are about to undeploy the last remaining revision of a deployed composite application.

Processing messages are displayed.

At this point, the undeploy operation cannot be canceled. Undeployment continues even if the browser page is closed.


	
When undeployment has completed, the SOA Infrastructure Deployed Composites page is displayed automatically. A confirmation message at the top of the page tells you that the composite has been successfully undeployed.







	
Note:

When a partition is deleted, all SOA composite applications in it are automatically undeployed. A message is displayed indicating that all the applications in that partition are to be undeployed.














7.4 Managing the State of Deployed SOA Composite Applications

You can manage the lifecycle state of deployed SOA composite applications from either of two pages:

	
From the Deployed Composites page of the SOA Infrastructure, which lists all SOA composite applications deployed to the SOA Infrastructure


	
From the application home page of a specific SOA composite application (all tabs)




The management tasks that you can perform are based on the page you are on. Table 7-1 provides details.


Table 7-1 Application State Actions

	Action	Perform on the Deployed Composites Page of the SOA Infrastructure?	Perform on the Application Home Page (All Tabs)?
	
Shut Down and Start Up

	
Yes

	
Yes


	
Retire and Activate

	
Yes

	
Yes


	
Set as Default

	
Yes

	
	
No: If only one version of the composite application is set as the default.


	
Yes: If there are multiple versions of the same composite application, this option is visible for all other versions of the same composite expect the one that is the default.





	
Deploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Deploy Another Composite)


	
Undeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Undeploy)


	
Redeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Redeploy)


	
Test

	
No

	
Yes


	
Composite Audit Level

	
No

	
Yes


	
Payload Validation

	
No

	
Yes


	
Enable/Disable Business Monitoring

	
No

	
Yes


	
Show WSDL and Endpoint URI (icon)

	
No

	
Yes


	
Show XML Definition (icon)

	
No

	
Yes








See the following section based on the action you want to perform:

	
Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level"


	
Section 7.4.2, "Managing the State of an Application from the SOA Composite Application Home Page"




For more information, see Section 1.2.2, "Introduction to SOA Composite Applications."



7.4.1 Managing the State of All Applications at the SOA Infrastructure Level

You can manage the state of all SOA composite applications from the Deployed Composites page at the SOA Infrastructure level.

To manage the state of all applications at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Deployed Composites tab.

The Deployed Composites page displays the following details:

	
A utility for searching for a specific SOA composite application by specifying a full or partial composite name and clicking Search. You can also search for SOA composite applications by partition.


	
A list of all SOA composite applications deployed in the SOA Infrastructure, including the partition in which they are deployed, current mode (active or retired), number of instances, number of faulted instances, and last modification date (deployment time, redeployment time, or any composite configuration change). The green dot to the left of the composite name indicates that this is the default revision of the application.




[image: Description of sca_deployedcomps.gif follows]
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Note:

To always see the latest details about deployed SOA composite applications, click the Refresh icon in the upper right corner or navigate away from this page and return to it. 










	
Click Deploy to deploy a new application. For all other options listed above the Composite section, first select the composite application by clicking the column to the left of the name, then select a specific option to perform.

[image: Description of sca_selectinstance.gif follows]
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The following table describes the available options:


	Action	Description
	
Shut Down

	
Shuts down a running SOA composite application revision. Any request (initiating or a callback) to the composite is rejected if the composite is shut down. New incoming requests cannot be processed. All existing instances are allowed to complete as usual (the same as when a composite is retired).

Note: The behavior differs based on which binding component is used. For example, if it is a web service request, it is rejected back to the caller. A JCA adapter binding component may do something else in this case (for example, put the request in a rejected table).

This option is displayed when the composite application has been started.


	
Start Up

	
Restarts a composite application revision that was shut down. This action enables new requests to be processed (and not be rejected). No recovery of messages occurs.

This option is displayed when the composite application has been stopped.


	
Retire

	
Retires the selected composite revision. If the process lifecycle is retired, you cannot create a new instance. Existing instances are allowed to complete normally.

An initiating request to the composite application is rejected back to the client. The behavior of different binding components during rejection is as described for the shut down option.

A callback to an initiated composite application instance is delivered properly.

This option is displayed when the composite application is active.

Note the following details when you attempt to retire the default composite revision, or have already retired a default composite revision. A warning page is also displayed with these details.

	
When you attempt to retire the default composite revision, if another active revision of the composite is found, it is designated as the new default revision. If there are multiple active revisions, the active composite that was most recently the default revision (based on the time stamp) is designated as the default revision. If you then re-activate the retired revision, it does not automatically become the default revision again. You must explicitly make it the default revision again.


	
If you retire the default composite revision and no active revision of this composite is found, a new default revision is not designated and a warning message is displayed. The retired revision remains the default revision. However, this composite can no longer process any incoming requests. To process new incoming requests for this composite, you must deploy a new revision or re-activate one of the previously retired revisions.





	
Activate

	
Activates the retired composite application revision. Note the following behavior with this option:

	
All composite applications are automatically active when deployed.


	
Other revisions of a newly deployed composite application remain active (that is, they are not automatically retired). If you want, you must explicitly retire them.




This option is displayed when the application is retired.


	
Set As Default

	
Sets the selected composite application revision to be the default. Default revisions are indicated by a green dot in the Composite table. If a new request comes in for a specific composite application revision, that composite application revision is invoked. If a new request comes in without specifying a revision, the default revision is invoked.

The default revision can change when a composite application is retired. The change is based on whether there is another active revision of the composite. For details, see the description for the Retire action in this table. 

The default revision is changed automatically when a default composite application revision is undeployed. 

The default composite revision also changes automatically when you redeploy a composite application. The newly redeployed revision automatically becomes the default revision, unless at the time of redeployment, you specify to keep the previous default revision unchanged. For details, see the description of the Undeploy action in this table. 

Inbound adapters are activated only on the default revision.


	
Deploy

	
Deploys a revision. Deployment activates the composite application in the SOA Infrastructure. Use this selection when you want to deploy:

	
A new SOA composite application for the first time.


	
A new revision (for example, 2.0) of a SOA composite application that has a different revision that is currently deployed (for example, 1.0). This option enables both revisions 1.0 and 2.0 to be deployed at the same time.




If you specify a revision that exists, you receive an error. You must change this revision outside of the Deploy SOA Composite wizard.

For more information, see Section 7.1, "Deploying SOA Composite Applications" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Undeploy

	
Undeploys the selected composite application revision. The consequences of this action are as follows:

	
You can no longer configure and monitor this revision of the composite application.


	
You can no longer process instances of this revision of the composite application.


	
You cannot view previously completed processes.


	
The state of currently running instances is changed to stale and no new messages sent to this composite application are processed.


	
If you undeploy the default revision of the composite application (for example, 2.0), the next available, active revision of the composite application becomes the default (for example, 1.0).

If no active revision is available and the old default revision is undeployed, your composite may be unable to process new incoming requests. It is recommended that you have at least one active revision of this composite deployed before you undeploy the default revision.

If you undeploy the default revision and no active revisions of this composite are found, a retired revision is automatically designated as the new default revision. A warning message is displayed after this wizard closes. Although all currently executing instances complete normally in retired composites, they cannot process any incoming requests. To process new incoming requests for this composite after the current default revision is undeployed, you must deploy a new revision or reactivate a previously retired revision.




Note: Undeploying multiple SOA composite applications at the same time is supported if they are in the same partition.

For more information, see Section 7.3, "Undeploying SOA Composite Applications" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Redeploy

	
Redeploys an existing revision of a SOA composite application. The consequences of this action are as follows:

	
A new version of a revision of a currently deployed SOA composite application is redeployed (for example, old version 1.0 is redeployed as new version 1.0).


	
The older, currently deployed version of this revision is removed (overwritten).


	
If the older, currently deployed version of this revision has running instances, you can select whether to change the state of those instances to stale.




For more information, see Section 7.2, "Redeploying SOA Composite Applications."








For more information, see Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications."









7.4.2 Managing the State of an Application from the SOA Composite Application Home Page

You can manage the state of an individual SOA composite application from the application's home page.

To manage the state of an application from the SOA composite application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











The Dashboard page of the selected SOA composite application is displayed.

[image: Description of sca_helloworld.gif follows]
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Notes:

	
The Total field of the Recent Instances section sometimes does not display the correct number of total instances despite instances having completed successfully. In these cases, click the Refresh icon in the upper right corner to view the actual number of total instances.


	
When the Capture Composite Instance State checkbox is enabled on the SOA Infrastructure Common Properties page, created instances are displayed immediately even if you have defined a constraint that appears to prevent an instance from being displayed immediately (for example, you have defined a flush delay of 10 minutes or specified a batch size of 100 records to write to a database). This is because instance tracking is moved to the immediate mode since the state of the composites must be captured. 


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the SOA composite application home page. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."













	
From the list of options at the top of the page, select a specific action to perform. These options are also displayed at the top of the Instances, Faults and Rejected Messages, Unit Tests, and Policies pages of the SOA composite application.





	Action	Description
	
Shut Down

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Start Up

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Retire

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Activate

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Test

	
Enables you to initiate a test instance from the Test Web Service page.

Note: This button is disabled when the SOA composite application is stopped or retired. This is because you cannot create an instance for a stopped or retired application. This button is also disabled when there are no web services available for the application. Only composite applications having services with web service bindings can be tested from this page.

For more information, see Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
Settings: Composite Audit Level

	
Sets the level of audit tracking to perform at the SOA composite application level. This setting can override the audit level defined at the SOA Infrastructure level. By default, the value is Inherit, which does not override the SOA Infrastructure level setting.

If you select to set the audit tracking level, the following options are available:

	
Inherit: Logging matches the SOA Infrastructure audit level that you set on the SOA Infrastructure Common Properties page. This is the default setting.


	
Production: Minimal information for SOA composite application instances is collected. For example, the BPEL process and Oracle Mediator service engines do not capture the payload. Therefore, the payload details are not available in the flow audit trails. The BPEL process service engine collects payload details for all activities except assign activities. This level is optimal for most standard operations and testing.


	
Development: Complete information for SOA composite application instances is collected. This option allows both composite instance tracking and payload tracking. This setting may have an impact on performance because the payload is stored at each step in the message flow. This setting is useful for debugging purposes.


	
Off: No logging is performed. Composite instance tracking information and payload tracking information are not collected.




Setting audit level tracking at the SOA composite application level overrides the same tracking set at the SOA Infrastructure level. By default, the settings are the same at the SOA composite application and SOA Infrastructure levels. SOA composite application settings are automatically changed when the global SOA Infrastructure settings are changed. By choosing any other setting at the SOA composite application level, you are overriding the inherited settings.

One form of overriding is when you explicitly select the same local composite value that happens to be the current global value. If the SOA Infrastructure setting is then changed, this specific composite application does not inherit the new value. For example, assume the SOA Infrastructure setting is Off. Therefore, all composite applications have their audit tracking set to Off. Then, you explicitly set composite application XYZ to Off. Then, go to the SOA Infrastructure and change the setting to Production. The tracking levels for all composite applications are now Production; except for XYZ, which is still set to Off.

Note the following impact of instance tracking changes on message flows that span several SOA composite applications (for example, a composite application invoking another composite application through a reference binding component or an event published in one composite application and subscribed to in another composite application).

	
If an intermediate composite application has disabled instance tracking, then a single message flow across multiple composite application instances appears as separate, unconnected flows. For example, assume a message flows through composite applications C1, C2, and C3. C1 and C3 have enabled instance tracking, while C2 has disabled it. Two separate flows for C1 and C3 are displayed in Oracle Enterprise Manager Fusion Middleware Control.


	
Sources or targets of events or messages may not be displayed. For example, assume you have two composite applications: C1 and C2. If C1 has disabled instance tracking, the flow trace does not show the origin of the message flow and makes it appear as if C2 were directly invoked.





	
Settings: Payload Validation

	
Validates the XML schema-based payload at the inbound and outbound points of the composite application revision. If you enable payload validation and there is an invalid payload (that does not follow the schema), a fault is generated for that message.

The exception to this is the response message of a synchronous service. That message is not validated, even with payload validation enabled. The inbound message is still validated; only the outbound message is not.


	
Settings: Enable/Disable Business Monitoring

	
Select an option to invoke a confirmation dialog that displays the current status of the sensors.

	
Disable: Select to disable BPEL sensors for all BPEL components in this SOA composite application.


	
Enable: Select to enable BPEL sensors for all BPEL components in this SOA composite application.




The Enable/Disable Business Monitoring selection is only displayed for composites that have a BPEL service component, regardless of whether that component includes sensors.

When BPEL sensors are disabled at the service engine level, you cannot enable or disable BPEL sensors at the SOA composite application level. You can enable or disable BPEL monitors and sensors at the service engine level in the BPEL Service Engine Properties page.

For more information, see Section 7.9, "Disabling and Enabling BPEL and BPMN Business Monitors" and Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
Show WSDL and endpoint URI (icon)

	
Click to display the end point addresses and WSDLs of all external services for this SOA composite application.

Note: If you are using the Safari Browser to view this information, see Section B.8.1, "Limitation on Using the Safari Browser to View WSDL File Content."


	
Show Composite XML Definition (... icon)

	
Click to show the XML definition of the SOA composite application.








For more information, see the following sections:

	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 3.1, "Configuring SOA Infrastructure Properties"









7.4.3 Starting and Stopping a Managed Oracle WebLogic Server on Which the SOA Infrastructure is Deployed in the Middle of BPEL Processing

If you start and stop a managed Oracle WebLogic Server on which the SOA Infrastructure is deployed in the middle of BPEL processing in a SOA composite application, note the following issues: 

	
For synchronous BPEL processes

The whole scenario is synchronous and the instances that are in a running state (after server restart) are pending in the BPEL wait activity. Therefore, the flow thread ends with the server (while sleeping in the wait activity). When the server is restarted, the same instance is not restarted because the flow is synchronous. Therefore, these instances always remain in a running state because no processing can happen on them after server restart.


	
For asynchronous BPEL processes

If server shutdown occurred in the middle of a BPEL invoke activity, the messages received by BPEL are not handled. BPEL does not automatically recover these messages during restart; they must be recovered manually using Facade API calls. For more information about the Facade API, see Chapter 10, "Programmatically Managing SOA Composite Applications."








7.4.4 Setting the Composite Instance Name

You can set the instance name of a SOA composite application during design time for Oracle Mediator and Oracle BPEL Process Manager. For more information, see Section "Setting the Composite Instance Name at Design Time" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.








7.5 Automating the Testing of SOA Composite Applications

You can create, deploy, and run test cases that automate the testing of SOA composite applications. Test cases enable you to simulate the interaction between a SOA composite application and its web service partners before deployment in a production environment. This helps to ensure that a process interacts with web service partners as expected by the time it is ready for deployment to a production environment. You create test cases in Oracle JDeveloper and include them in a SOA composite application that is then deployed and administered from Oracle Enterprise Manager Fusion Middleware Control. You can also create BPEL process service component test cases in the SOA composite application test case.

To automate the testing of SOA composite applications:




	
Note:

Before testing SOA composite applications or BPEL process service components from Oracle Enterprise Manager Fusion Middleware Control, see Chapter "Automating Testing of SOA Composite Applications" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases.









	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Unit Tests tab.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
Click the Unit Tests tab.




	
	
Select Unit Test.











The test cases that are displayed were designed in Oracle JDeveloper and included in a deployed SOA composite application.


	
Select the entire test suite or individual tests of a suite to run, and click Execute.

[image: Description of sca_unittest.gif follows]
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You are prompted to create a test.


	
Enter the following values, and click OK.


	Field	Description
	
Test Run Name

	
Enter a name for the test instance. When testing is complete, report details are captured under this name.


	
Timeout

	
Enter a value in seconds in which to complete this test. If the test does not complete within this time limit, then testing is terminated.


	
Number of Concurrent Test Instances

	
Enter the number of test instances to create.








The Test Runs page is automatically displayed for tracking the running tests.

The Test Runs page enables you to track running test cases and view test results. Test suites consist of a logical collection of one or more test cases. Each test case contains a set of commands to perform as the test instance is executed. The execution of a test suite is known as a test run.

[image: Description of sca_unittest2.gif follows]
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In the Test Run Name column, click a specific test run to display details in the Results of Test Run section. If you want to create more test runs, you can switch back to the Test Cases page at any time.

The Results of Test Run section displays details about the executed test run, such as a test summary and the success rate. Click the Help icon for additional details.


	
View assertion details at the bottom of the page. Assertions enable you to verify variable data or process flow.

[image: Description of sca_unittest3.gif follows]
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Click a composite instance number to view specific test details.

The composite instances created by executing unit test runs are displayed with a yellow square next to the instance ID in the Instances page of a SOA composite application and in the Recent Instances tables of the SOA Infrastructure and SOA composite application. This yellow box distinguishes these instances from test instances created on the Test Web Service page or automatically created by external consumers of the application.




For more information, see the following documentation:

	
Section 1.4.3.4, "Introduction to SOA Composite Application Automated Testing"


	
Chapter "Automating Testing of SOA Composite Applications" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases for SOA composite applications and BPEL process service components in Oracle JDeveloper









7.6 Managing SOA Composite Application Policies

You can attach or detach security policies to and from currently deployed SOA composite applications. Policies apply security to the delivery of messages.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment. 









To manage SOA composite application policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Policies tab.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
Click the Policies tab.




	
	
Select Policies.











The Policies page enables you to attach and detach policies to and from SOA composite applications. The policies table displays the attached policy name, the component to which the policy is attached, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

[image: Description of sca_policy.gif follows]
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Click Attach/Detach To.

If multiple services or components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the component to or from which to attach or detach a policy.

[image: Description of soaapp_policy1.gif follows]
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This invokes a dialog for attaching or detaching policies.

Currently attached policies appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.

[image: Description of soaapp_policy2.gif follows]
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Select policies to attach that are appropriate to your environment.


	
Click Attach.

The attached policy appears in the Attached Policies section.

[image: Description of soaapp_policy3.gif follows]
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Attach additional policies as needed.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.

[image: Description of soaapp_policy4.gif follows]
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For more information about policies, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment






7.6.1 WS-RM Sessions

Multiple requests from Oracle SOA Suite in a single WS-RM session are not currently supported. Each request is in an individual WS-RM session.






7.6.2 Policy Attachments and Local Optimization in Composite-to-Composite Invocations

OWSM supports an Oracle SOA Suite local optimization feature for composite-to-composite invocations in which the reference of one composite specifies a web service binding to a second composite. Local optimization enables you to bypass the HTTP stack and SOAP/normalized message conversions during runtime. Local optimization is not used if the composites are in different containers. If a policy is attached to the web service binding, the policy may not be invoked if local optimization is used.

By default, an OWSM security policy includes a local-optimization property that identifies if the policy supports local optimization. You can view the setting for a policy in Oracle Enterprise Manager Fusion Middleware Control.

To view the local optimization setting for policies:

	
In the navigator, expand the WebLogic Domain folder.


	
Right-click WLS_SOAWC, and select Web Services > Policies.


	
Select a policy and click Export to File.


	
Open the file with a text editor and search for local-optimization to identify the value. This property supports the following values:

	
on: Local optimization is used in the attached policy, and the policy is not applied at runtime.


	
off: Local optimization is not used in the attached policy, and the policy is applied at runtime.


	
check-identity: If a JAAS subject exists in the current thread, local optimization is used. Otherwise, local optimization is not used.







For information on the default local optimization settings for security policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

You can override the local optimization setting for a policy by adding the oracle.webservices.local.optimization property in the binding section of the composite.xml file. The following values are supported:

	
true (default value): Local optimization is used, and the policy is applied if it is applicable to optimized calls (details are defined in the individual policy file).


	
false: Local optimization is not used, regardless of the default setting for the local-optimization property at the OWSM policy level. This setting forces the policy to be applied.




For example, the following setting of false causes oracle/wss_username_token_client_policy to be applied.


 <binding.ws
port="http://xmlns.oracle.com/CalledBPELProcessApp_
jws/CalledBPELProcess/CalledBPELProcess#wsdl.endpoint(calledbpelprocess_client_
ep/CalledBPELProcess_pt)"

location="http://sta00634.us.oracle.com:8001/soa-infra/services/default/CalledBPEL
Process!1.0/calledbpelprocess_client_ep?WSDL">
      <wsp:PolicyReference URI="oracle/wss_username_token_client_policy"
                           orawsp:category="security"
orawsp:status="enabled"/>
      <wsp:PolicyReference URI="oracle/log_policy"
orawsp:category="management"
                           orawsp:status="enabled"/>
                            <property
name="oracle.webservices.local.optimization">false</property>
    </binding.ws> 


For more information about local optimization, see Section 3.7, "Configuring Local Optimization."








7.7 Exporting a Deployed SOA Composite Application

You can export the contents of a deployed SOA composite application to an archive JAR file. The file can include some or all of the following data:

	
The original design-time composite


	
Postdeployment changes in the rules dictionary and domain value maps (DVMs)


	
Postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments







	
Notes:

	
SOA composite application exporting is currently only allowed at the individual SOA composite level.


	
Shared metadata is not exported as part of the composite export SOA archive (SAR).












To export a running SOA composite application:

	
Go to the home page of the SOA composite application to export.


	
From the SOA Composite menu, select Export.

The Export Composite page appears.
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Select an option.

	
Option 1: Generates an archive file containing the original design-time composite and the postdeployment details described in Option 2 and Option 3.


	
Option 2: Includes the original design-time composite and postdeployment changes in the rules dictionary and DVMs.


	
Option 3: Includes the original design-time composite and postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments.


	
Option 4: Generates an archive file containing only the original design-time composite. Options 2 and 3 are not included.





	
If you want to append an additional name to the existing file, select Specify Custom Extension Text. For example, entering MyText to a file named sca_OrderBookingComposite_rev1.0.jar names the exported file as sca_OrderBookingComposite_rev1.0-MyText.jar.


	
Click Export.

The Processing: Export Composite dialog displays the progress of archive file generation. When generation completes, you are prompted to save the file.


	
Click Save File.

A dialog appears for either opening or saving the file to a directory on your local host.




	
Note:

It is important that you click the Save File button. Do not simply close this dialog. Although the composite is exported, you cannot retrieve the actual exported file.










	
Specify the local directory in which to save the JAR file.


	
In the upper right of the Processing: Export Composite dialog, click the x icon to close the dialog.


	
On the Export Composite page, note that the Cancel button has changed to Done.


	
Click Done.

The Export Composite is closed and you are returned to the SOA composite application home page.









7.8 Grouping SOA Composite Applications into Partitions

You can deploy SOA composite applications into separate sections of the SOA Infrastructure known as partitions. Deploying to partitions enables you to logically group SOA composites and perform bulk lifecycle management tasks on all SOA composite applications within a specific partition. Partitions are similar to the domain feature that was part of 10.1.x releases of Oracle BPEL Process Manager. However, you cannot perform specific configuration tasks on partitions, such as restricting login access to a specific partition or configuring partitions (such as configuring threading).

At least one partition is required for deploying SOA composite applications. A default partition named default is automatically included with Oracle SOA Suite.

You can manage partitioning from either of two pages:

	
From the Manage Partitions page of the SOA Infrastructure, which lets you create partitions, delete partitions, and perform bulk lifecycle management tasks on all SOA composite applications in a specific partition


	
From the partition home page, which also enables you to perform bulk lifecycle management tasks on all SOA composite applications in a specific partition







	
Note:

If SOA composite applications using the same inbound resource are deployed to different partitions, it cannot be guaranteed which partition picks up the message for processing. 

For example, assume you are using the file adapter and /home/Directory1 is the inbound directory for the composite SOAComposite1. If this composite is deployed to both Partition1 and Partition2, when a file is placed in /home/Directory1, either the composite in Partition1 or Partition2 may pick up the file.

With the socket adapter, however, there is a limitation that does not permit you to deploy any composite that uses the same inbound port. In that case, an exception is thrown indicating that the inbound port is in use.









Table 7-2 provides more specific details on the tasks you can perform from both pages.


Table 7-2 Partition Management Actions

	Action	Perform on the Manage Partitions Page?	Perform on the Partition Home Page?
	
Create a partition

	
Yes

	
No


	
Delete a partition

	
Yes

	
Yes. Select the SOA Partition menu, then select Delete This Partition.

Note: You can also delete a partition by right-clicking it in the navigator and selecting Delete This Partition.


	
Perform bulk lifecycle management tasks on all composites deployed to a specific partition:

	
Start all


	
Shut down all


	
Retire all


	
Activate all


	
Undeploy all




	
Yes

	
Yes











	
Notes:

	
Partitions are not associated with a particular state such as started, stopped, activated, or retired. Only the composites within the partition are associated with a particular state. Therefore, you cannot start, stop, activate, or retire a partition.


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the Manage Partitions and Partitions home pages. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."












See the following section based on the tasks you want to perform:

	
Section 7.8.1, "Creating and Deleting Partitions"


	
Section 7.8.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions"




For more information about partitions, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure."



7.8.1 Creating and Deleting Partitions

You can create and delete partitions on the Manage Partitions page. A default partition named default is automatically included with Oracle SOA Suite. You can delete the default partition. You cannot rename existing partitions; only creation and deletion of partitions is supported.

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the Home Page of a Specific Partition...
	
	
Select Manage Partitions.




	
	
From the Related Links list of a specific partition, select Manage Partitions.











The Manage Partitions page displays the following details:

	
The name of each partition, the number of active and retired SOA composite application revisions in each partition, the name of the composites contained in each partition (under the View link), and the total number of running and faulted instances in each partition.


	
A utility for searching for a specific partition. Enter a full or partial partition name and click the Search icon or press the Return key. The search is not case-sensitive.
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To add a partition, click Create.

The Create New SOA Partition dialog is displayed.

[image: Description of soaadmin_createpartition.gif follows]
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In the Name field, enter a partition name, and click Create.




	
Note:

The name must conform to the following conventions:

	
ASCII letters and numbers are permitted.


	
Underscores (_) are permitted.


	
Hyphens (-) are permitted (except as the first character).


	
Non-ASCII letters are permitted.


	
Spaces are not permitted.




Examples of valid names are mypartition, partition2, dept-a, customer_services, and 22. Examples of invalid names are -part2, /partition, and null or empty names.









You cannot rename an existing partition or later transfer the composite applications you deployed to it to a different partition.

The new partition is displayed in both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page. You can now deploy composites to this partition by selecting Deploy to This Partition from the Deployment dropdown list or right-clicking a specific partition in the navigator and clicking Deploy to This Partition.

When a composite is deployed to a partition, it is displayed beneath the partition in the navigator. Once deployed, a composite cannot be transferred to a different partition.
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To delete a partition, select a specific partition and click Delete. You can also right-click a specific partition in the navigator and click Delete This Partition.

The Delete SOA Partition dialog is displayed. Note the following:

	
If you want to re-create some of your composite deployments in another partition, you can export those composites to a JAR file before you delete this partition. 


	
Before deleting the selected partition, all SOA composite application revisions in the partition are undeployed. The states of all undeployed instances of these revisions become stale.







	
Note:

You must have at least one partition. If you delete all partitions, you cannot deploy a SOA composite application.
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Click Delete (Undeploy All Composites).

All composites that were deployed in the partition are undeployed and no longer appear in the navigator. The partition is then deleted from both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page.







For information about performing bulk lifecycle management tasks from the Composites Control and Deployment lists, see Section 7.8.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions."

You can also create partitions with the Oracle WebLogic Scripting Tool (WLST) and ant commands. For information, see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference and Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






7.8.2 Performing Bulk Lifecycle Management Tasks on Composites in Partitions

You can perform bulk lifecycle management tasks on all SOA composite applications in a specific partition on the Manage Partitions page, on the home page of a specific partition, and from the menu that is displayed when you right-click a partition in the navigator.

Bulk lifecycle management tasks impact not one, but many, composites at once. If a composite has running instances and a lifecycle changing operation is performed on the composite, the instances may not complete. For information about how different lifecycle operations impact the composite instances, see Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level."

To perform bulk lifecycle management tasks on all SOA composite applications in a specific partition:

	
Access either page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Manage Partitions.




	
	
Under soa-infra, select a specific partition.














	
Note:

As a shortcut, you can also right-click a specific partition in the navigator to display a menu for selecting the bulk lifecycle management actions described in this section. For more information about this menu, see Step 3 of Section 2.2.3, "Navigating Through the Partition Home Page and Menu."









Two dropdown lists that are displayed on either page enable you to perform bulk lifecycle management actions:

	
Composites Control list


	
Deployment list




On the home page of a specific partition, these lists are displayed at the top of the page.

[image: Description of soaadmin_partition3.gif follows]
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On the Manage Partitions page, these lists are displayed above the SOA Partition table:

[image: Description of soaadmin_partition4.gif follows]
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Note:

You can also select to deploy composites to a partition and perform bulk lifecycle management tasks by selecting the SOA Partition menu at the top of the partition home page.










	
To perform one of the following bulk lifecycle management tasks for all SOA composite applications contained in the selected partition, select the Composites Control list:

	
Start all composites.


	
Shut down all composites.


	
Activate all composites.


	
Retire all composites.




[image: Description of soaadmin_comp_control.gif follows]
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Select an operation to perform.

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.





	
To perform one of the following management tasks, select the Deployment list:

	
Specify a composite to deploy to this partition. This selection invokes the Deploy SOA Composite wizard where you specify a composite revision to deploy.


	
Undeploy all composites in this partition. 

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.




[image: Description of soaadmin_deployment.gif follows]
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7.9 Disabling and Enabling BPEL and BPMN Business Monitors

The term business monitoring comprises different types of sensors that can be defined for some types of SOA components, such as the following:

	
BPEL sensors: Enable you to create sensors in BPEL faults, activities, and variables.


	
BPEL Monitors: Enable you to capture BPEL process metrics that are sent to Oracle BAM Server, and then used for analysis and graphic display.


	
BPMN measurements: Enable you to measure a business indicator at a certain point in the process or in a section of the process.




At the SOA composite application level, you set the same status for all sensors defined for all types of service components comprising the selected composite. You cannot selectively enable or disable sensors defined for a specific type of service component for just one composite. However, you can globally disable service component-type specific sensors for all composites in the respective BPEL Service Engine Properties page or BPMN Service Engine Properties page.

By default, BPEL and BPMN sensors defined in SOA composite applications are enabled. Disabling sensors means that sensor values are not captured during runtime. For example, this results in the values not being displayed in the Sensor Values section of the BPEL audit trail.

To disable sensors at the service engine level:

	
Access the BPEL Service Engine Properties page by following the steps in Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
Select the Disable BPEL Monitors and Sensors checkbox.


	
Click Apply.


	
Access the BPMN Service Engine Properties page by following the steps in Section 37.1, "Configuring BPMN Process Service Engine Properties."




	
Note:

The BPMN Service Engine Properties page is only displayed if Oracle BPM Suite is installed.










	
Select the Disable BPMN Measurements checkbox.


	
Click Apply.




To disable or enable sensors at the SOA composite application level:

	
Go to the home page of the SOA composite application in which you want to disable or enable sensors.


	
From the Settings menu, select Enable/Disable BPEL Business Monitoring. This selection is only displayed for composites that have at least one BPEL or BPMN service component, regardless of whether those components include sensors.

[image: Description of sca_sensordis.gif follows]
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A dialog is invoked that displays the current status of sensors and enables you to change that status. The dialog only displays the options applicable to the component types present in the selected composite. For example, if the composite contains only BPEL components and not BPMN components, you see only the option to set the status of BPEL sensors.

The following steps describe the types of dialogs that can be displayed and the available actions.

	
If sensors are disabled at both service engine levels, the message Disabled Globally is displayed for each. You cannot select Enable All or Disable All in this dialog. Both buttons are disabled.

[image: Description of sca_sensordis3.gif follows]
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In addition, if sensors are disabled at the BPEL service engine level and the BPMN service engine does not appear because Oracle BPM Suite is not installed, you cannot select Enable All or Disable All in this dialog. Both buttons are disabled.

[image: Description of sca_sensordis8.gif follows]
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If sensors are not disabled at the composite level, checkmarks are displayed. If sensors are also not disabled at both the BPEL and BPMN service engine levels, the message Disabled Globally does not display.

Click Disable All to disable all types of sensors defined for service components that comprise the selected composite. (If sensors are disabled at the service engine level, they remain disabled.)

[image: Description of sca_sensordis4.gif follows]
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If sensors are disabled at a specific service engine level, the sensor status you set for those types of sensors at the composite application level only takes effect when the corresponding Disable BPEL Monitors and Sensors or Disable BPMN Measurements checkbox in the service engine Properties page is deselected.

For example, if sensors are disabled at the BPMN service engine level (as shown below), and you select Enable All for all sensors at the selected composite level, that status is only applied to other types of sensors, such as BPEL. BPMN sensors and monitors remain disabled. However, if you later change the BPMN service engine setting, BPMN sensors are automatically enabled in this composite.

[image: Description of sca_sensordis5.gif follows]
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If sensors are disabled at the composite level, no checkmark is displayed. Click Enable All to enable all types of sensors defined for service components that comprise the selected composite. (Sensors disabled at the service engine level remain disabled until you change the service engine level setting.) Because the composite does not include BPMN service components, BPMN is not displayed.

[image: Description of sca_sensordis7.gif follows]
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After you select an action, an inline message is displayed in the page confirming that sensors were enabled or disabled.

For more information about BPEL sensors and monitors, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For more information about BPMN measurements, see Oracle Fusion Middleware Modeling and Implementation Guide for Oracle Business Process Management.









4 Monitoring the SOA Infrastructure

This chapter describes how to monitor recent instances and faults, deployed SOA composite applications, message delivery processing requests, and service and reference binding components in the SOA Infrastructure. All SOA composite applications are deployed to the SOA Infrastructure. It also describes how to display details about BPEL process messages that require recovery and how to access the Recovery page of the BPEL process service engine to perform message recovery.

This chapter includes the following topics:

	
Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites"


	
Section 4.2, "Monitoring Message Delivery Processing Requests"


	
Section 4.3, "Monitoring Service and Reference Binding Components in the SOA Infrastructure"




For more information, see Section 1.2.1, "Introduction to the SOA Infrastructure Application."



4.1 Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites

You can monitor the SOA composite applications deployed to the SOA Infrastructure.

To monitor SOA Infrastructure recent instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Select soa-infra.




	
	
Select SOA Infrastructure.











The upper part of the SOA Infrastructure Dashboard page displays the following details:

	
A message indicating that the retrieval of recent instances and faults that are displayed on this page is restricted to the specified time period. This message is displayed if the Restrict display of instances and faults to the last time_period checkbox is selected on the SOA Infrastructure Common Properties page (it is selected by default). The default time period value is 24 hours, but you can change this value. If this checkbox is not selected, all instances and faults (including count metrics) in the SOA Infrastructure since the last purging are displayed.


	
Recent SOA composite application instances, instance IDs, and starting times. By default, only running instances are shown.


	
The status of deployed SOA composite applications and their revision numbers, the number of instances created for each application, and the number of faulted instances in each application. The total number of deployed composites also is displayed in parentheses next to the Show All link.


	
Recent faults and rejected messages, including the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application in which the fault occurred, the location of the fault (service binding component, service component, or reference binding component), the instance ID of the SOA composite application, and a link to log messages describing the fault or rejected message. You can recover from faults identified as recoverable at the SOA Infrastructure, SOA composite application, service engine, and service component levels.

If messages are awaiting recovery from the Recovery page of the BPEL process service engine, a message is displayed at the top of each SOA Infrastructure home page.




[image: Description of gs_soahomepage.gif follows]
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Note:

After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the SOA Infrastructure home page. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."










	
If BPEL process messages require recovery from the Recovery page of the BPEL process service engine, the BPEL Message Recovery Required message is displayed at the top of each SOA Infrastructure home page.

[image: Description of bp_bpel_message_recov.gif follows]
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The display of this message recovery information is controlled by the bpelRecoveryStatus and excludeBpelMaxCreationTime keys of the AuditConfig property in the System MBean Browser. This property is accessible from the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. By default, the bpelRecoveryStatus key is set to All and the excludeBpelMaxCreationTime key is set to exclude the display of messages requiring recovery in the last five minutes.

	
Perform the following tasks:


	Click This Link...	To...
	
Show Details

	
View a message showing the number of invoke, callback, and activity messages that require recovery from the Recovery page of the BPEL process service engine. Manual recovery is not required if automatic recovery of BPEL messages is enabled. In that case, only exhausted messages must be manually recovered. Click Refresh to recalculate the number of invoke, callback, and activity messages requiring recovery.


	
Go to BPEL Recovery Console

	
Access the Recovery page of the BPEL process service engine to perform message recovery.

You can also access the Recovery page later by selecting Service Engines > BPEL from the SOA Infrastructure menu and clicking the Recovery tab in the resulting page.


	
Set Time Threshold

	
View a message showing the time period for excluding messages that require recovery. By default, this setting excludes the last five minutes of messages. This value is controlled by the excludeBpelMaxCreationTime key of the AuditConfig property on the SOA Infrastructure Common Properties page. To change this value, click Yes to access this property in the System MBean Browser.


	
Disable Alert

	
View a message enabling you to prevent the display of this message recovery information on the Dashboard page. If you click Yes, this message recovery information is not displayed.

To display this information again on the Dashboard page, set the bpelRecoveryStatus key to All for the AuditConfig property in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."











	
In the Recent Composite Instances section, perform the following tasks:

	
Click the Number of Instances link to display a message showing the numbers of running and total instances in the SOA Infrastructure. The link is not displayed by default. To enable this link to be displayed, select the Disable fetching of instance and fault count metrics. Each metric can still be retrieved on demand checkbox in the SOA Infrastructure Common Properties page.

If you selected the Restrict display of instances and faults to the last time_period checkbox on the SOA Infrastructure Common Properties page and specified a time period or accepted the default value of 24 hours, the numbers of running and total instances in the SOA Infrastructure for that time period are displayed. If you did not select this checkbox, all instances and faults in the SOA Infrastructure since the last purging are displayed. Click Recalculate to recalculate the numbers.


	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Instances page of the SOA Infrastructure.





	
In the Deployed Composites section, perform the following tasks:

	
In the Composite column, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Deployed Composites page of the SOA Infrastructure.





	
In the Recent Faults and Rejected Messages section, perform the following tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
In the Recovery column, if a fault is identified as recoverable, click Recover to perform fault recovery.


	
In the Composite column, click a SOA composite application to access its home page.


	
In the Fault Location column, click a specific location to access the home page of the service, component, or reference in which the fault occurred.


	
In the Composite Instance ID column, click a composite instance ID to access the flow trace of the message that contains that fault.


	
In the Logs column, click a specific log to access the Log Messages page, with the search criteria prefiltered to display any log messages related to the fault.


	
Click Show All below the section to access the Recent Faults and Rejected Messages page of the SOA Infrastructure.




The lower part of the SOA Infrastructure Dashboard page displays the following details:

	
The number of service components running in the service engines (BPEL process, BPMN process (if Oracle BPM Suite is installed), Oracle Mediator, human workflow, business rules, and spring) and the number of faulted instances for each service engine.

[image: Description of gs_soahomepage3.gif follows]
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A graphical representation of the total number of instances and faults for all SOA composite applications since the SOA Infrastructure was last restarted.




[image: Description of gs_soahomepage2.gif follows]
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In the Name column of the Service Engines section, click a specific service engine to access its home page. If you click Spring Engine, a message is displayed indicating that it cannot be managed.




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"


	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Section 14.4, "Performing BPEL Process Service Engine Message Recovery"


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









4.2 Monitoring Message Delivery Processing Requests

You can monitor SOA Infrastructure message delivery processing requests. These are metrics for the message delivery between the service engines, service infrastructure, and binding components. Once a message is handed over to a service engine, the amount of time it takes to process that message (instance processing time) is not captured in these metrics.

To monitor processing requests:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Monitoring > Request Processing.




	
	
Right-click soa-infra.


	
Select Monitoring > Request Processing.











The Request Processing page enables you to monitor the following details:

	
The average request processing time for both synchronous and asynchronous messages, active requests, requests processed, and faulted requests in the service engines and service infrastructure.


	
The average request processing time, requests processed, and errors occurring in service (inbound) and reference (outbound) binding components.




[image: Description of soainfra_requestproc.gif follows]
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In the Service Engines section, click a specific service engine (for example, BPEL Engine) to access details such as recent instances using this service engine, components using this service engine, and recent fault occurrences.




For more information, see the following sections:

	
Section 1.2.5, "Introduction to Binding Components"


	
Section 1.2.6, "Introduction to Service Engines"


	
Section 1.2.7, "Introduction to the Service Infrastructure"









4.3 Monitoring Service and Reference Binding Components in the SOA Infrastructure

You can monitor all service and reference binding components used in all SOA composite applications deployed to the SOA Infrastructure. Services provide the outside world with an entry point to the SOA composite application. The WSDL file of the service advertises its capabilities to external applications. References enable messages to be sent from the SOA composite application to external services in the outside world.

To monitor service and reference binding components in the SOA Infrastructure:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Services and References.




	
	
Right-click soa-infra.


	
Select Services and References.











The Services page displays details about the names and types of the services, the SOA composite applications in which the services are used, the partitions in which the SOA composite applications are deployed, the total number of messages processed, the average processing time, and the number of faults occurring in the services. 

[image: Description of sca_services.gif follows]
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In the Service column, click a specific service to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Partitions column, click a specific partition to access its home page.


	
Click the References tab.

The References page displays details about the names and types of the references, the SOA composite applications in which the references are used, the partitions in which the SOA composite applications are deployed, the total number of messages processed, the average processing time, and the number of faults occurring in the references.

[image: Description of sca_references.gif follows]
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In the Reference column, click a specific reference to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Partitions column, click a specific partition to access its home page.




For more information about services and references, Section 1.2.5, "Introduction to Binding Components."









11 Diagnosing Problems with SOA Composite Applications

This chapter describes how to identify Oracle SOA Suite problems early and take the proper corrective actions with the assistance of the WebLogic Diagnostic Framework (WLDF) and the Oracle Fusion Middleware Diagnostic Framework.

This chapter includes the following topics:

	
Section 11.1, "Introduction to the Diagnostic Frameworks"


	
Section 11.2, "Creating Watches and Notifications"


	
Section 11.3, "Manually Triggering and Executing Dumps"


	
Section 11.4, "Viewing Incident Packages with ADR Tools"


	
Section 11.5, "Querying Problems and Incidents"




For information about troubleshooting, see Appendix B, "Troubleshooting Oracle SOA Suite and Oracle BPM Suite."



11.1 Introduction to the Diagnostic Frameworks 

When you monitor and diagnose problems in Oracle SOA Suite, you face the following challenges:

	
Capturing diagnostic data at the moment of occurrence (also known as just-in-time diagnostics), especially for intermittent issues such as obtaining multiple thread dumps when the system hangs or obtaining heap dumps before a system runs out of memory.


	
Obtaining advanced information such as data shape (counts by state and growth patterns for the SOA schema and MDS schema).


	
Communicating back and forth with Oracle Support Services to provide basic information such as versions, logs, configuration files, patches applied, and so on.


	
Detecting problems and taking corrective actions early before they escalate.




To address these challenges, Oracle SOA Suite is integrated with the following diagnostic frameworks that assist you in identifying problems early and taking the proper corrective actions:

	
WLDF: For monitoring diagnostic scenarios using watches and notifications.


	
Diagnostic Framework: For gathering SOA-specific diagnostic scenarios into data dumps that are formatted for viewing and analyzing. These data dumps can be made accessible through the Support Work Bench and uploadable as part of a service request (SR).





11.1.1 Introduction to WLDF

WLDF is a monitoring and diagnostics framework included with Oracle WebLogic Server that defines and implements a set of services that run within server processes and participate in the standard server life cycle.

Using WLDF, you can capture diagnostic data from Oracle SOA Suite. You configure WLDF watches and notifications from Oracle WebLogic Server Administration Console to collect diagnostic data to identify problems. This data enables you to isolate and diagnose faults when they occur.

For more information about WLDF, see Oracle Fusion Middleware Configuring and Using the Diagnostics Framework for Oracle WebLogic Server.


11.1.1.1 Introduction to Watches and Notifications

Watches monitor server and application states and send notifications based on criteria that you set. Watches and notifications are configured as part of a diagnostic module targeted to one or more server instances in a domain. When you create a watch, you build rule expressions for monitoring using the attributes of Oracle SOA Suite and Oracle WebLogic Server MBeans in Oracle WebLogic Server Administration Console.

For example, assume you want to be notified when the percentage of free heap memory falls below 100%. You create a watch that uses the Oracle WebLogic Server MBean weblogic.management.runtime.JRockitRuntimeMBean and its attribute HeapFreePercent. You then define logic indicating that when HeapFreePercent is less than 100%, you want to receive a notification. You can also use the MBean JVMRuntimeMBean when running with a non-JRockit virtual machine (VM).

For information about creating watches and notifications in Oracle WebLogic Server Administration Console, see Section 11.2, "Creating Watches and Notifications" and Section "Configuring the Diagnostic Framework" of Oracle Fusion Middleware Administrator's Guide.





11.1.1.2 Introduction to Diagnostic Scenarios and MBeans

The watch rule expressions that you create use the attributes of Oracle SOA Suite and Oracle WebLogic Server MBeans to collect data and perform monitoring. You diagnose scenarios with available MBeans to provide statistics about that scenario or to log messages. Managed beans (MBeans) are Java objects that represent JMX manageable resources in a distributed environment. The attributes of the following MBeans are available for defining in watches to monitor scenarios:

	
Oracle WebLogic Server MBeans


	
Diagnostic Oracle SOA Suite MBeans


	
DMS metrics exposed as MBeans




Oracle SOA Suite provides several diagnostic scenarios that you can monitor with watches and notifications. Table 11-1 provides details about the supported diagnostic scenarios and the MBeans to use for monitoring.


Table 11-1 Supported Diagnostic Scenarios and MBeans

	Scenario	Description	Diagnostic Data Source
	
Memory issues (startup, deployment, and runtime)

	
Monitor the free heap available. If the free heap percentage is below a threshold, a notification is triggered to generate a thread stack dump and heap dump.

	
Oracle WebLogic Server MBean


	
Deployment hanging

	
Monitor the elapsed time of a deployment. If it exceeds a threshold, a notification is triggered.

	
Oracle SOA Suite deployment MBean


	
Data source issues

	
Monitor the suspension and connection pool/transaction time outs

	
JDBC MBeans


	
Server overload

	
Monitor the server's self-health.

	
Oracle WebLogic Server MBean


	
Stuck threads

	
Monitor stuck threads. If any are found, a notification is triggered.

	
A stuck thread watch/Diagnostic Framework notification is automatically included. Diagnostic Framework incident packages can be created with a tool such as the ADR Command Interpreter (ADRCI). Incidents are created automatically.








Table 11-2 lists some of the available MBeans and DMS Metrics to select when creating watches for monitoring and collecting diagnostic data.


Table 11-2 MBeans and DMS Metrics

	Diagnostic Data Source (MBean) and Usage	Description	Oracle WebLogic Server MBean	SOA MBean or DMS Metric
	
weblogic.management.runtime.JVMRuntimeMBean/ weblogic.management.runtime.JRockitRuntimeMBean

	
For memory statistics

	
Yes

	
- -


	
oracle.fabric.management.wldf.mbean.DeploymentWatchMXBeanImpl

	
For deployment elapsed time

	
- -

	
SOA MBean


	
weblogic.management.runtime.ServerRuntimeMBean

	
For health state information

	
Yes

	
- -


	
weblogic.management.runtime.JDBCDataSourceRuntimeMBean

weblogic.management.runtime.JTARuntimeMBean

	
For JDBC data sources and for accessing transaction runtime characteristics

	
Yes

	
- -








For more information about Oracle WebLogic Server MBeans, see Oracle Fusion Middleware Oracle WebLogic Server MBean Reference.







11.1.2 Introduction to the Diagnostic Framework

The Diagnostic Framework is an Oracle Fusion Middleware feature that aids in detecting, diagnosing, and resolving problems. The problems that are targeted are critical errors such as those caused by code bugs, metadata corruption, customer data corruption, deadlocked threads, and inconsistent state. The Diagnostic Framework detects critical failures and captures dumps of relevant diagnostics information (logs, metrics, server images, and so on). WLDF watches and notifications trigger events for which the Diagnostic Framework listens and generates appropriate data dumps. The dumps are formatted into incident packages for viewing and analysis.

The problems captured as incidents include critical errors such as those described in Table 11-1. Each incident package is identified by a unique ID. When a critical error occurs, it is assigned this unique ID known as an incident number. Diagnostic data for the error (such as log files) is immediately captured and tagged with this number.

The data is then stored in the Automatic Diagnostic Repository (ADR). ADR is a file-system repository for cataloging occurrences of failures and storage of associated diagnostic data. The data is retrieved by incident package number, formatted, viewed with Oracle database tools such as ADRCI, and analyzed.

ADRCI enables you to view the names of the dump files and the alert log with XML tags stripped. This viewing enables you to investigate problems, and package and upload first-failure diagnostic data to Oracle Support Services.

You can also use the Diagnostic Framework WLST commands to perform the following tasks:

	
Query problems


	
View incident dump files


	
Create manual incidents


	
Manually execute dumps




The Diagnostic Framework is supported on all JRF-supported platforms.

The Diagnostic Framework automatically includes several dumps. For information about these dumps, see Section "Investigating, Reporting, and Solving a Problem" of Oracle Fusion Middleware Administrator's Guide.

In addition to these dumps, several Oracle SOA Suite dumps are also supported. For information about Oracle SOA Suite dumps, see Section 11.1.4, "Supported Oracle SOA Suite Diagnostic Dumps."

For more information about solving problems, incidents, and WLDF and Diagnostic Framework integration, see Chapter "Diagnosing Problems" of Oracle Fusion Middleware Administrator's Guide.

For more information about ADR, see Section 11.4, "Viewing Incident Packages with ADR Tools."


11.1.2.1 Controlling the Number of Incident Packages

If you have a recurring problem in Oracle SOA Suite, this can cause for the creation of multiple incident packages. To prevent the server from being overloaded when many failures are occurring, the Diagnostic Framework automatically flood controls some incidents. To avoid this problem, you can configure the Diagnostic Framework to control the number of incident packages. For more information, see Section "Configuring the Diagnostic Framework" of Oracle Fusion Middleware Administrator's Guide.








11.1.3 Predefined Incident Processing Rules

When you create a watch in the Oracle WebLogic Server Administrator's Console, you also define a notification. A notification named FMWDFW notification is automatically available for selection. While you can create your own notifications, Oracle recommends that you select FMWDFW notification because it creates the Oracle SOA Suite dumps described in Section 11.1.4, "Supported Oracle SOA Suite Diagnostic Dumps."

When an error is detected, the FMWDFW notification handler creates an incident and the Diagnostic Framework takes over incident processing semantics. These semantics are controlled by incident processing rules. The incident processing rules are defined in an XML file and loaded and registered with the Diagnostic Framework during SOA Infrastructure startup.

If you encounter scenarios different from those listed in Table 11-1, you must work with Oracle Support Services to obtain a copy of customized incident processing rules and follow the directions related to registration and server restart.

Oracle Support Services can place a customized rules file (named custom-rules.xml) under the SOA Server instance home directory (for example, FMW_HOME/user_projects/domains/domain_name/servers/server_name). Example 11-1 shows a sample custom rules file in which when an ERROR level message is detected in the *-diagnostic.log from the oracle.soa.bpel.engine.ws module, the soa.composite.trail dump is executed.


Example 11-1 Sample Custom Rules File


<?xml version="1.0" encoding="UTF-8"?> 
<diagnosticRules xmlns="http://www.oracle.com/DFW/DiagnosticsFrameworkRules"
 xmlns:xs="http://www.w3.org/2001/XMLSchema-instance"> 
<logDetectionConditions> 
<condition module="oracle.soa.bpel.engine.ws"/> 
</logDetectionConditions> 

<defaultActions> 
<dumpAction name="soa.composite.trail"> 
<argument name="ecid" value="ECID" valueType="Fact" mandatory="true"/> 
</dumpAction> 
</defaultActions> 

</diagnosticRules>








11.1.4 Supported Oracle SOA Suite Diagnostic Dumps

In addition to the diagnostic dumps available with Oracle WebLogic Server, Oracle SOA Suite supports the creation of the diagnostic dumps shown in Table 11-3.


Table 11-3 Supported Oracle SOA Suite Diagnostic Dumps

	Dump	Description
	
soa.env

	
Runtime environment dumps


	
soa.config

	
Runtime platform configuration dumps


	
soa.db

	
Database dumps


	
soa.composite

	
Deployed composite metadata dumps


	
soa.composite.trail

	
Instance audit trail dumps


	
soa.edn

	
Event dumps


	
soa.wsdl

	
Deployed composite WSDL/schema cache dumps








The Diagnostic Framework outputs and records the diagnostic dumps. You can list details about all the supported diagnostic dumps with the WLST listDumps and describeDump commands.




	
Note:

You must start WLST from MW_HOME/oracle_common/common/bin. Otherwise, the ODF functions are missing.









To list the supported dumps:

	
Connect to the server on which the SOA Infrastructure is installed.


wls:/offline> connect('user_name', 'password',
't3://myhost:8001')
Connecting to t3://myhost:8001 with userid user_name ...
Successfully connected to managed Server 'soa_server1' that belongs to
domain 'soainfra'.


	
List the supported Diagnostic Framework dumps.


wls:/soainfra/serverConfig> listDumps()
odl.activeLogConfig
jvm.classhistogram
dms.ecidctx
wls.image
odl.logs
dms.metrics
odl.quicktrace
http.requests
jvm.threads

Use the command describeDump(name=<dumpName>) for help on a specific dump.


	
List the supported Oracle SOA Suite dumps.


wls:/soainfra/serverConfig> listDumps(appName='soa-infra')
adf.ADFConfigDiagnosticDump
soa.composite
soa.composite.trail
soa.config
soa.db
soa.edn
soa.env
soa.wsdl

Use the command describeDump(name=<dumpName>) for help on a specific dump.


The supported Oracle SOA Suite dumps are described in the following subsections.

For more information about listDumps and describeDump, see Chapter "Diagnostic Framework Custom WLST Commands" of Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.

For more information about Diagnostic Framework dumps, see Chapter "Diagnosing Problems" of Oracle Fusion Middleware Administrator's Guide.





11.1.4.1 Supported Runtime Environment Diagnostic Dumps (soa.env)

Table 11-4 provides details about supported runtime environment diagnostic dumps.


Table 11-4 Runtime Environment Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.env

	
	
Dump parameters:

None


	
Dump Mode:

ASYNC_SYNC




	
	
SOA runtime version, label (can be obtained from the Discovery MBean), and topology (information about the cluster of which the runtime version is a member).


	
Topology: Cluster and Oracle Coherence information such as cluster name, member name, whether the cluster is the leader, local members, machine ID, rack ID, and so on.

The leader is generally the oldest node in the cluster. This may change over time as members leave and join the cluster. This senior member is responsible for maintaining cluster membership and making other decisions for the cluster. It also acts as the final arbiter in various protocols, such as the panic protocol.


	
Oracle Coherence messaging mode: Either unicast or multicast.












11.1.4.1.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.env.


wls:/soainfra/serverConfig> describeDump(name='soa.env',appName='soa-infra')
Name: soa.env
Description: SOA Dump for runtime environment info: SOA runtime version, label,
topology. ...
Mandatory Arguments:
Optional Arguments:

wls:/soainfra/serverConfig> executeDump(name='soa.env',appName='soa-infra')
Begin dumping EMInstanceProperties
key=soaClusterName
value=NULL
key=label
value=PCBPEL_11.1.1.6.0_GENERIC_111018.1315.1477
key=CompositeLabel
value=NULL
key=version
value=11.1.1.6.0
key-HttpUrl
value=http://myhost.us.oracle.com:8001
End dumping EMInstanceProperties
Cluster Info:
-----------------------------------------------
cluster name:null
cluster is leader:true
cluster is standalone:true










11.1.4.2 Supported Runtime Platform Configuration Diagnostic Dumps (soa.config)

Table 11-5 provides details about supported runtime platform configuration diagnostic dumps.


Table 11-5 Runtime Platform Configuration Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.config

	
	
Dump parameters:

zip: (Optional) Supports the following values:

- true: (Default value) Zips the output file and artifacts into one ZIP file.

- false: Writes the dump text file and artifacts to the dump path location without compressing them into one ZIP file.

output: (Optional) Specifies the alternate directory location to which to write dump files. If not specified, the diagnostic dump uses the Diagnostic Framework dump path.


	
Dump Mode:

ASYNC_SYNC




	
deployed-composites.xml - A catalog of deployed composites, including their revisions.

Service engine configurations: The following configurations are persisted in MDS (soa/configuration/default/*.xml):

	
adapter-config.xml


	
b2b-config.xml


	
bpel-config.xml


	
bpmn-config.xml


	
businessrules-config.xml


	
cep-config.xml


	
edn-config.xml


	
mediator-config.xml


	
soa-infra-config.xml


	
workflow-config.xml


	
workflow-identity-config.xml


	
workflow-notification-config.xml












11.1.4.2.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.config:


wls:/soainfra/serverConfig> describeDump(name='soa.config',appName='soa-infra')
Name: soa.config
Description: Description: SOA dump that captures SOA runtime configuration
                          info, such as deployed-composites.xml, service engine
                          configurations, etc.
Mandatory Arguments:
Optional Arguments:
   Name    Type     Description
   zip     BOOLEAN  Boolean flag (default to 'true') indicating if the dump
                    files need to be compressed into one single zip file,
                    true - dump into a single zip, false, otherwise.
   output  STRING   Path to output destination, a directory where the dump
                    content will be written to, default to DFW dump path if 
                    not specified ...

wls:/soainfra/serverConfig> executeDump(name='soa.config',appName='soa-infra')

Start dumping artifacts from MDS
URI:deployed-composites/deployed-composites.xml to /tmp/soa_
dumps139780820495.tmp/soa_config734535543.d

Finished dumping specified MDS metadata to /tmp/soa_dumps139780820495.tmp/soa_
config734535543.d

Start dumping artifacts from MDS URI:soa/configuration/default/ to /tmp/soa_
dumps139780820495.tmp/soa_config734535543.d/se-configurations

Finished dumping specified MDS metadata to: /tmp/soa_dumps139780820495.tmp/soa_
config734535543.d/se-configurations
MDS artifacts dumped, next, compressing all dump files into:
/tmp/oracle-dfw--1770056289547048694.tmp/soa_config364634563344231671.zip


The executeDump command dumps deployed-composites.xml from the MDS repository and service engine configurations for all installed service engines into a single, compressed ZIP file (soa_config364634563344231671.zip).


	
Enter the following WSLT command line syntax to execute a dump of soa.config with the zip parameter set to false. This setting writes the dump text file and artifacts to the dump path location without compressing them into one ZIP file.


wls:/soainfra/serverConfig> executeDump(name='soa.config',appName='soa-infra',
args={'zip':'false'})Start dumping artifacts from MDS
 URI:deployed-composites/deployed-composites.xml to:
 /tmp/oracle-dfw-7178460573556479044.tmp/soa_config199325881615155981.d
Finished dumping specified MDS metadata to:
/tmp/oracle-dfw-7178460573556479044.tmp/soa_config199325881615155981.d
Start dumping artifacts from MDS URI:soa/configuration/default/ to:
/tmp/oracle-dfw-7178460573556479044.tmp/soa_
config199325881615155981.d/se-configurations
Finished dumping specified MDS metadata to:
/tmp/oracle-dfw-7178460573556479044.tmp/soa_
config199325881615155981.d/se-configurations


	
Examine the contents under the default dump path:


[jdoe@myhost /tmp]$ ls -alR oracle-dfw-7178460573556479044.tmp
oracle-dfw-7178460573556479044.tmp:
total 52
drwxr-----   3 jdoe dba   4096 Oct 24 15:43 .
drwxrwxrwt 104 root root 36864 Oct 24 15:37 ..
drwxr-----   4 jdoe dba   4096 Oct 24 15:43 soa_config199325881615155981.d
-rw-r-----   1 jdoe dba    561 Oct 24 15:43 soa_config199325881615155981.txt

oracle-dfw-7178460573556479044.tmp/soa_config199325881615155981.d:
total 16
drwxr----- 4 jdoe dba 4096 Oct 24 15:43 .
drwxr----- 3 jdoe dba 4096 Oct 24 15:43 ..
drwxr----- 2 jdoe dba 4096 Oct 24 15:43 deployed-composites
drwxr----- 2 jdoe dba 4096 Oct 24 15:43 se-configurations

oracle-dfw-7178460573556479044.tmp/soa_
config199325881615155981.d/deployed-composites:
total 12
drwxr----- 2 jdoe dba 4096 Oct 24 15:43 .
drwxr----- 4 jdoe dba 4096 Oct 24 15:43 ..
-rw-r----- 1 jdoe dba 1437 Oct 24 15:43 deployed-composites.xml

oracle-dfw-7178460573556479044.tmp/soa_
config199325881615155981.d/se-configurations:
total 56
drwxr----- 2 jdoe dba 4096 Oct 24 15:43 .
drwxr----- 4 jdoe dba 4096 Oct 24 15:43 ..
-rw-r----- 1 jdoe dba  267 Oct 24 15:43 adapter-config.xml
-rw-r----- 1 jdoe dba  425 Oct 24 15:43 b2b-config.xml
-rw-r----- 1 jdoe dba 2040 Oct 24 15:43 bpel-config.xml
-rw-r----- 1 jdoe dba 1525 Oct 24 15:43 bpmn-config.xml
-rw-r----- 1 jdoe dba  895 Oct 24 15:43 businessrules-config.xml
-rw-r----- 1 jdoe dba  119 Oct 24 15:43 cep-config.xml
-rw-r----- 1 jdoe dba  215 Oct 24 15:43 edn-config.xml
-rw-r----- 1 jdoe dba  836 Oct 24 15:43 mediator-config.xml
-rw-r----- 1 jdoe dba 1148 Oct 24 15:43 soa-infra-config.xml
-rw-r----- 1 jdoe dba 2693 Oct 24 15:43 workflow-config.xml
-rw-r----- 1 jdoe dba 2146 Oct 24 15:43 workflow-identity-config.xml
-rw-r----- 1 jdoe dba  605 Oct 24 15:43 workflow-notification










11.1.4.3 Supported Database Diagnostic Dumps (soa.db)

Table 11-6 provides details about supported database diagnostic dumps. The types of database information captured include data shape information such as counts by state and growth patterns for Oracle SOA Suite schemas and the MDS schema.


Table 11-6 Database Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.db

	
	
Dump parameters:

None


	
Dump Mode:

ASYNC_SYNC




	
BPEL database table growth data using JDBC-based access to execute the query and dump the result:


SELECT dt.table_name table_name,ds.bytes/1024/1024
segment_size_mb, ds.extents extents_used, dt.num_rows
total_rows, to_char(dt.last_analyzed,'YYYY-MM-DD
HH24:MI:SS') last_analyzed_date FROM dba_segments ds,
dba_tables dt WHERE dt.owner = ds.owner and dt.owner =
'schema_user_name' and dt.tablespace_name = 
ds.tablespace_name and dt.table_name = ds.SEGMENT_NAME 
and ds.segment_type = 'TABLE' and dt.table_name in 
('CUBE_INSTANCE', 'MEDIATOR_CASE_INSTANCE','COMPOSITE_
INSTANCE', 'AUDIT_TRAIL', 'WORK_ITEM', 'DLV_MESSAGE',
'XML_DOCUMENT','DOCUMENT_CI_REF')









11.1.4.3.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.db:


wls:/soainfra/serverConfig> describeDump(name='soa.db',appName='soa-infra')
Name: soa.db
Description: SOA Dump for SOA runtime DB usage info.
Mandatory Arguments:
Optional Arguments:

wls:/soainfra/serverConfig> executeDump(name='soa.db',appName='soa-infra')
EXECUTE QUERY 
SELECT dt.table_name table_name,ds.bytes/1024/1024 segment_size_mb, ds.extents
extents_used, dt.num_rows total_rows, to_char(dt.last_analyzed,
'YYYY-MM-DD HH24:MI:SS') last_analyzed_date FROM dba_segments ds,
dba_tables dt WHERE dt.owner = ds.owner and dt.owner ='schema_user_name' 
and dt.tablespace_name = ds.tablespace_name and dt.table_name = ds.SEGMENT_NAME
and ds.segment_type = 'TABLE' and dt.table_name in ('CUBE_INSTANCE', 
'MEDIATOR_CASE_INSTANCE','COMPOSITE_INSTANCE', 'AUDIT_TRAIL', 'WORK_ITEM', 
'DLV_MESSAGE','XML_DOCUMENT','DOCUMENT_CI_REF')
COMMENT: BPEL DB GROWTH DATA.
TABLE_NAME   SEGMENT_SIZE_MB  EXTENTS_USED TOTAL_ROWS LAST_ANALYZED_DATE
-------------------------------------------------------------------------
ResultSet Metadata:weblogic.jdbc.wrapper.ResultSetMetadata_oracle_jdbc_driver_
OracleResultSetMetadata@76a4b0
RECORD #1:
TABLE_NAME: COMPOSITE_INSTANCE
SEGMENT_SIZE_MB:0
EXTENTS_USED:1
TOTAL_ROWS:9
LAST_ANALYZED_DATE:2011-09-30 22:02:25
RECORD #2:
TABLE_NAME:DOCUMENT_CI_REF
SEGMENT_SIZE_MB:0
EXTENTS_USED:1
TOTAL_ROWS:0
LAST_ANALYZED_DATE:2011-09-30 22:02:34
RECORD #3:
TABLE_NAME:WORK_ITEM
SEGMENT_SIZE_MB:0
EXTENTS_USED:1
TOTAL_ROWS:0
LAST_ANALYZED_DATE:2011-09-30 22:02:36
RECORD #4:
TABLE_NAME:AUDIT_TRAIL
SEGMENT_SIZE_MB:0
EXTENTS_USED:1
TOTAL_ROWS:8
LAST_ANALYZED_DATE:2011-09-30 22:02:39


This dump shows the query string and records from the result set.










11.1.4.4 Supported Deployed Composite Metadata Diagnostic Dumps (soa.composite)

Table 11-7 provides details about supported deployed composite metadata diagnostic dumps. The types of information captured include the current composite processed when an incident occurs, MDS artifact references (for example, namespace exports), and abnormal transactions.


Table 11-7 Deployed Composite Metadata Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.composite

	
	
Dump parameters:

compositeName: (Optional) Composite name that includes MDS recorded artifacts to dump. If a value is not specified (null or blank), compositeName assumes a wild card (*).

partition: (Optional) Partition name in which the composite is deployed. If not specified, the partition of the default composite specified in the deployed-composites.xml file is assumed (for example, default, partition_01, and my_partition).

revision: (Optional) Composite revision that includes MDS recorded artifacts to dump. If not specified, the revision of the default composite as specified in the deployed-composites.xml file is assumed. A wild card (*) to match any revision is supported.

zip: (Optional) Whether or not to compress the dump output into a ZIP file. The following values are supported:

- true: (Default value) Compresses dump files into one ZIP file.

- false: Writes dump to a text file and artifacts to the dump path location without compressing them into one ZIP file.

- output: (Optional) Alternate directory location to which to write dump files. If not specified, the diagnostic dump uses the Diagnostic Framework dump path.


	
Dump Mode:

ASYNC_SYNC




	
Per composite metadata from MDS:

	
All the MDS recorded artifacts for the specified composites.


	
The text dump file contains logging information about which composite's MDS artifacts are dumped and to where.


	
All dump files compressed into one ZIP file.


	
User-specified output file location for WLST use.


	
One or more generated scratch_entries.txt files that contain the listings of file and directory entries of the scratch area for the composite. The location of the scratch area is indicated by the composite-revision element in deployed-composites/deployed-composites.xml.












11.1.4.4.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.composite:


wls:/soainfra/serverConfig> describeDump(name='soa.composite'
,appName='soa-infra')
Name: soa.composite
Description: SOA Dump that captures artifacts from MDS, and listing of entries
in each composite's scratch area, dump MDS artifacts for composites that
matches specified composite name, specified partition, specified revision, also
support wild card '*' as composite name/partition/revision, meaning dump MDS
artifacts for composites with any composite name/partition/revision.
Mandatory Arguments:
Optional Arguments:
  Name        Type      Description
  zip         BOOLEAN   Boolean flag (default to 'true') indicating if the dump
                        files need to be compressed into one single zip file,
                        true - dump into a single zip file, false, otherwise.
  revision    STRING    composite revision, e.g. '1.0', '2.0', or wild card
                         '*'- will match any revision. 
  partition   STRING    partition of the composite, default is 'default', 
                        support wild card '*' as partition name, meaning any
                        partition.
  compositeName STRING composite name, e.g., 'OrderProcessing', or wild card
                         '*' - dump MDS recorded artifacts for all the deployed
                        composites in the specified partition.
   output      STRING   Path to output destination, a directory where the
                        dump content will be written to, default to DFW dump
                        path if not specified.

wls:/soainfra/serverConfig> executeDump(name='soa.composite',
 appName='soa-infra'),arg=('compositeName':'WSInMedPubBpelSubFileOut',
'revision':'1.0,'partition':'partition_1','output'':'/home/myhome//COMPOSITE_DUMP_
DIR_3'})
Start dumping composite [name=WSInMedPubBpelSubFileOut, partition=partition_1,
revision= 1.0 ] MDS metadata to :/tmp/soa_dumps1019331262763443905.tmp/
soa_composite4533356433976235311.d/partition_1/WSInMedPubBpelSubFileOut_
rev1.0
Finished dumping composite MDS metadata to :/tmp/soa_dumps
1019331262763443905.tmp/soa_composite4533356433976235311.d/partition_
1/WSInMedPubBpelSubFileOut_rev1.0


In this example, no zip parameter is specified. Because the default value is true, a single dump output file is created at the dump location /home/myhome//COMPOSITE_DUMP_DIR_3.










11.1.4.5 Supported Instance Audit Trail Diagnostic Dumps (soa.composite.trail)

Table 11-8 provides details about supported instance audit trail diagnostic dumps. The type of information captured includes the deployed composite instance audit trail for a given ECID.


Table 11-8 Instance Audit Trail Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.composite.trail

	
	
Dump parameters:

ecid (mandatory). The execution content ID. If not specified, a DumpExecutionException error is thrown.


	
Dump Mode:

ASYNC_SYNC




	
	
The audit trail associated with the ECID (per composite) (therefore, all of its components). This is for the execution of message routing triggered by an inbound message. The audit trail is an XML CLOB obtained by calling the following Facade API in the current runtime context:

oracle.soa.management.facade.Locator.getAuditTrail(ECID ecid)


	
Composite instances information.


	
Component instances information for each composite instance.


	
EDN information from the Facade API.


	
Sensor instances information for each composite instance.












11.1.4.5.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.composite.trail:


wls:/soainfra/serverConfig> describeDump(name='soa.composite.trail'
,appName='soa-infra')
Name: soa.composite.trail
Description: Composite instance audit trail dump for a given ECID
Mandatory Arguments:
   Name        Type       Description
   ecid        STRING     ECID from an incident
Optional Arguments:

wls:/soainfra/serverConfig> executeDump(name='soa.composite.trail',
appName='soa-infra',args=('ecid':'cf1cec292805f383.236c6d88:132bc9b7486:-8000=0
000000000121b'})
BEGIN----------------AUDIT TRAIL::: ECID:cf1cec292805f383.236c6d88:132bc9b7486
:-8000=0000000000121b++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
<audit_trail ecid="cf1cec292805f383.236c6d88:132bc9b7486:-8000=0000000000121b">
<entry instanceId="service:10001" date="20-11-09-39T16:21:46"
timestamp="1317424906775" state="2" actionType="operation" actionName="execute"
subType="binding.ws" type="service"><entityName>MyInputService</entityName>
<compositeInstanceId>10001</compositeInstanceId><compositeName>WSInMedPubBpelSu
bFileOut</compositeName><compositeDN>default/WSInMedPubBpelSubFileOut!1.0
</compositeDN><applicationName>default</applicationName></entry><entry
instanceId="mediator:F7BF03D8EBBA11E0BFEEFB426F4C514D"parentInstanceId=
"service:10001" date="2011-0930T16:21:48"timestamp="131742908689" 
state="2" <type="component"subType="mediator">entityName>MediatorPub
</entityName><compositeInstanceId>10001</compositeInstanceId><compositeName>
WSInMedPubBpelSubFileOut</compositeName><compositeDN>default/
WSInMedPubBpelSubFileOut!1.0</compositeDN><applicationName>default
</applicationName></entry></audit trail>
END--------------AUDIT TRAIL:::
ECID:cf1cec292805f383.236c6d88:132bc9b7486:-8000=0000000000121b

BEGIN------------------FACADE(EDN) +++++++++++++
oracle.soa.management.internal.facade.edn.EDNImpl@14b5caec
END------------------FACADE(EDN) +++++++++++++
BEGIN------------------FACADE(Composite Instances) +++++++++++++
DN: default/WSInMedPubBpelSubFileOut!1.0 > Instance: 10001 creation-date: Fri
Sep 30 16:21:46 PDT 2011 state {-1}: STATE_UNKNOWN
-> componentinstance: MediatorPub type: mediator state: STATE_COMPLETED_
SUCCESSFULLY
DN: partition_3/WSInMedPubBpelSubFileOut!1.0 > Instance: 8 creation-date: Thu
Sep 29 15:04:13 PDT 2011 state (-1): STATE_UNKNOWN
-> componentinstance: BpelSub type: bpel state: STATE_SUSPENDED


For information about obtaining the ECID, see Section 13.1, "Monitoring the Audit Trail and Process Flow of a BPEL Process Service Component."










11.1.4.6 Supported Event Diagnostic Dumps (soa.edn)

Table 11-9 provides details about supported event diagnostic dumps. The types of information captured include Oracle Streams Advanced Queuing (SAQ) logging records and event metadata among currently deployed applications.


Table 11-9 Event Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.edn

	
	
Dump parameters:

dumpEDNDBLOG: Supports the following values:

- true: Dumps all records logged during AQ stored procedure calls (for debugging purposes).

- false: Does not dump EDN database log messages.


	
Dump Mode:

ASYNC_SYNC




	
	
EDN event bus state variables.


	
EDN subscriber/publisher information for all deployed composites, and so on.




All information is written to the dump text file.









11.1.4.6.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.edn:


wls:/soainfra/serverConfig> describeDump(name='soa.edn',appName='soa-infra')
Name: soa.edn
Description: SOA Dump for EDN BusinessEventBus status info, and EDN DB Log
records.
Mandatory Arguments:
Optional Arguments:
   Name         Type       Description
   dumpEDNDBLOG BOOLEAN    SOA Dump for EDN BusinessEventBus status info, and
                           EDN DB Log records.

wls:/soainfra/serverConfig> executeDump(name='soa.edn',appName='soa-infra')

Type:oracle.integration.platform.blocks.event.saq.SAQBusinessEventBus
Configuration:null
Status: running=true started=true
ThreadCount:3
RetryCount:3
In Global: Tx:false
Cluster Info:oracle.integration.platform.blocks.cluster.CoherenceCluster
Interface1mpt@163bd717
SharedEDN:false
OOAO Queue Name:edn_ooao_queue
Java Subscriber Name:edn java subscriber
Subscription Info:
No namespace subscription...
QName subscriptions:
=============================================================
qname={http://schemas.oracle.com/events/edl/ActionOccur}ADEvent
subscriptions=
id=default/WSInMedPubBpelSubFileOut!1.0*soa_7a055d6a-8402-49c2-ac56-5f85cbf3d7f/
BpelSub, consistencyLevel=ONE_AND_ONLY_ONE, filter=XPath Filter: starts-with(/
be:business-event/be:content/ns0:ActionOccurrence/ns0:ParentEntityType/@value,
 'A'), runAsRoles=[$publisher]
id=partition_1/WSInMedPubBpelSubFileOut!1.0*soa_80a169ab1-395a-4b87-9986-9fa2742a8bd3/
BpelSub, consistencyLevel=ONE_AND_ONLY_ONE, filter=XPath Filter: starts-with(/
be:business-event/be:content/ns0:ActionOccurrence/ns0:ParentEntityType/@value,
 'A'), runAsRoles=[$publisher]
EventThreadContextInfo:
EventTargets:
Event:partition_1/WSInMedPubBpelSubFileOut!1.0*soa0a169ab1-395a-4b87-9986-9fa2742a9bd3/
BpelSub:::oracle.fabric.BPELServiceEngine@163bd6b5
Event:default/WSInMedPubBpelSubFileOut!1.0*soa7a055d6a-8402-49c2-ac56-5f85cbf3
d7f/BpelSub:::oracle.fabric.BPELServiceEngine@163bd6b5
EDN DB Log enabled:false


The executeDump command dumps the event bus status variables (1mpt@163bd717) and event publish and subscription information. No log messaging information is dumped because the edn-db-log is set to false. You can enable the edn-db-log at the following URL:


http://host_name:port/soa-infra/events/edn-db-log





	
Notes:

	
You must have the administrator privilege to enable/disable the edn-db-log.


	
Always disable the edn-db-log after a debugging session to disable logging. This prevents excessive database growth in the EDN database log table. If the edn-db-log remains enabled, then debugging messages related to events that are published/enqueued into the database and subscribed to/dequeued from the database continue to be persisted into certain EDN database log tables. This causes the table to grow indefinitely.





















11.1.4.7 Supported Deployed Composite WSDL/Schema Cache Diagnostic Dumps (soa.wsdl)

Table 11-10 provides details about supported deployed composite WSDL/schema cache diagnostic dumps.


Table 11-10 Deployed Composite WSDL/Schema Cache Diagnostic Dumps

	Dump Name	Dump Parameters/Dump Mode	Information Captured
	
soa.wsdl

	
	
Dump parameters:

compositeName: (Optional) Composite name that includes key service definition information (WSDLs) to dump, including WSDLs referenced and XSDs referenced. If a value is not specified (null or blank), compositeName assumes a wild card (*).

partition: (Optional) Partition name in which the composite is deployed. If not specified, the partition of the default composite specified in the deployed-composites.xml file is assumed. A wild card (*) to match any composite is supported.

revision: (Optional) Composite revision that includes the service definition information (from WSDLs) to dump. If not specified, the revision of the default composite as specified in the deployed-composites.xml file is assumed. A wild card (*) to match any revision is supported.


	
Dump Mode:

ASYNC_SYNC




	
	
Composite distinguished name (DN). For example: compositeDN:partition_1/WSInMedPubBpelSubFileOut!1.0*soa_8a169ab1-395a-4b87-9986-9fa2742a8bd3.


	
Is it the default in the series


	
Composite name


	
Composite state (on or off)


	
Composite mode (active or retired)


	
The qualified name and the target namespace for all service definitions (including those from shared WSDLs): javax.wsdl.Definition objects:

- Service name: QName javax.wsdl.Definition.getQName()

- Target namespace: javax.wsdl.Definition.getTargetNamespace()


	
SchemaManager state variables:

- SchemaManager.isPostDeploy()

- SchemaManager.isShared()

- SchemaManager.schemaAddedSinceLastBuild()


	
XML schema definitions referenced by service definitions:

- The message type QName

- The message type SchemaTargetNamespace

- The message type TargetNS












11.1.4.7.1 WLST Command Dump Description and Execution

	
Enter the following WSLT command line syntax to display a dump description and execute a dump of soa.wsdl:


wls:/soainfra/serverConfig> describeDump(name='soa.wsdl',appName='soa-infra')

Name: soa.wsdl
Description: SOA Dump that captures service definition info caches for
             composite(s) that matches specified composite name, specified
             partition, specified revision, also support wild card '*' as 
             composite name/partition/revision, meaning dump service
             definitions WSDL/XSD caches for composites with any composite
             name/partition/revision.
Mandatory Arguments:
Optional Arguments:
   Name        Type       Description
   revision    STRING     composite name, e.g. '1.0', '2.0', or wild card '*'
                          - will match any revision.
   partition   STRING     partition of the composite, default is 'default',
                          support wild card '*' as partition name, meaning
                          any partition.
   compositeName STRING  composite name, e.g., 'OrderProcessing', or wild card
                          '*' - dump cache for all the deployed composites in
                          the specified partition.

wls:/soainfra/serverConfig> executeDump(name='soa.wsdl',appName='soa-infra'
,arg=('compositeName':'WSInMedPubBpelSubFileOut',
'revision':'1.0','partition':'partition_1'})compositeDN:partition_
1/WSInMedPubBpelSubFileOut!1.0*soa_8a169ab1-2060-4b87-9986-9fa2742a8bd3
----------------------------------------------------------------------
is default in series:true
composite application name:partition_1
composite name:WSInMedPubBpelSubFileOut
composite state:on
composite mode:active
WSDLManager Instance:oracle.fabric.common.wsdl.WSDLManager@164ec201
Cached wsdl Definitions for the specified composite: including any shared
wsdls if there are any:
key=http://xmlns.oracle.com/bpel/workflow/taskService
value=QName:{http://xmlns.oracle.com/bpel/workflow/taskService}
TaskServicetarget name space:http://xmlns.oracle.com/bpel/workflow/taskService
key=urn:MyTestWsdl
value=QName:{urn:MyTestWsdl}target name space:urn:MyTestwsdl
key=http://xmlns.oracle.com/adapter/file/LixinSandboxes/WSInMedPubBpelSubFile
Out/FileWrite
value=QName:{http://xmlns.oracle.com/pcbpel/adapter/file/LixinSandboxes/
WSInMedPubBpelSubFileOut/FileWrite}FileWritetarget name space:http:
 //xmlns.oracle.com/pcbpel/adapter/file/LixinSandboxes/
WSInMedPubBpelSubFileOut/FileWrite
count of all cached entries:3
SchemaManager instance:oracle.fabric.common.wsdl.SchemaManager@164ec1f8
SchemaManager.isPostDeploy():true
SchemaManager.isShared():false
SchemaManager.schemaAddressSinceLastBuild():false
Cached schema count:0
WSDLManager instance:oracle.fabric.common.wsdl.WSDLManager@14b5b8b0
cached wsdl definitions for the specified composite: including shared wsdls
if there is any:
---------------------------------------------------------------------------
key=http://xmlns.oracle.com/bpel/workflow/taskService
value=QName:{http://xmlns.oracle.com/bpel/workflow/taskService}
TaskServicetarget name space:http://xmlns.oracle.com/bpel/workflow/taskService
count of all cached entries:1
SchemaManager instance:oracle.fabric.common.wsdl.SchemaManager@145b8cc
SchemaManager.isPostDeploy():false
SchemaManager.isShared():true
SchemaManager.schemaAddressSinceLastBuild():true
Cached schema count:0

WSDLManager instance:oracle.fabric.common.wsdl.WSDLManager@14b58b0
WSDLManager instance:oracle.fabric.common.wsdl.WSDLManager@14b58b0
cached wsdl definitions for the specified composite: including shared wsdls
if there is any:
-------------------------------------------------

key=http://xmlns.oracle.com/bpel/workflow/taskService
value=QName:{http://xmlns.oracle.com/bpel/workflow/taskService}
TaskServicetarget name space:http://xmlns.oracle.com/bpel/workflow/taskService
count of all cached entries:1
SchemaManager instance:oracle.fabric.common.wsdl.SchemaManager@145b8cc
SchemaManager.isPostDeploy():false
SchemaManager.isShared():true
SchemaManager.schemaAddressSinceLastBuild():true
Cached schema count:0












11.1.5 Supported DMS Metrics

DMS metrics with noun types are exposed as Oracle SOA Suite MBeans to use for diagnosing problems. This section describes the supported DMS metrics.

Table 11-11 shows the supported service engine sensors.


Table 11-11 Service Engine Sensors

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/engines/[bpel|workflow|mediator|decision]/message_processing

	
soainfra_message_processing

	
faultedRequestProcessingTime

	
Phase Event


	
	
	
faultedPostProcessingTime

	
Phase Event


	
	
	
requestProcessingTime

	
Phase Event


	
	
	
postProcessingTime

	
Phase Event


	
	
	
activeRequest

	
State


	
/soainfra/engines/bpel/requests/[REQUEST_TYPE]

	
	
active

	
State


	
	
	
scheduled

	
State


	
/soainfra/engines/workflow/Task/service

	
soainfra_wfRequest

	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/Task/[METHOD_NAME]

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/TaskQuery/[METHOD_NAME]

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/TaskMetadata/getTaskDefinition

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/Verification/[METHOD_NAME] (only methods: authenticateUser, getPermissableTaskActions, and canUserPerfomTaskAction)

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/TaskNotification/notifyForTask

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/workflow/AssignmentRules/executeRules

	
	
time

	
Phase


	
	
	
count

	
Event


	
/soainfra/engines/bpel/dispatcher/

	
soainfra_bpel_dipatcher

	
maxThreads

	
State


	
	
	
avgLifeTime

	
State


	
	
	
avgRequestCountPerSecond, and so on

	
State








Table 11-12 shows the supported binding sensors.


Table 11-12 Binding Sensors

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/bindings/[inbound|outbound]/[ws|sdo|jca|b2b]

	
soainfra_binding

	
processRequests

	
Phase


	
	
	
requests

	
Event


	
	
	
errors

	
Event








Table 11-13 shows the supported composite sensors.


Table 11-13 Composite Sensors

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/apps/[APP_NAME]/[COMPOSITE_DN]

	
soainfra_composite

	
status

	
State


	
	
	
instantiated

	
Event


	
	
	
successfulInstanceProcessingTime

	
Phase


	
	
	
faultedInstanceProcessingTime

	
Phase


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[REVERSION]/[COMPONENT_NAME]

/decision/[INTERACTION_PATTERN]/[INTERACTION_PATTERN_NAME]

	
soainfra_decision_interaction

	
executed

	
Event


	
	
	
executionTime

	
Phase


	
/soainfra/apps/[COMPOSITE_DN]/[COMPONENT_NAME]/[ACTIVITY_NAME] (for bpel)

	
soainfra_bpel_activity

	
started

	
Event


	
	
	
executionTime

	
Phase


	
	
	
faultedExecutionTime

	
Phase


	
	
	
Standard deviation (the user interface calculates this as it comes through)

	

	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[VERSION]/[COMPONENT_NAME] /state/

	
soainfra_wfStateEvent

	
[ASSIGNED

|COMPLETED

|ERRORED

|EXPIRED

|SUSPENDED]

	
Event


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[VERSION]/[COMPONENT_NAME] /outcome/

	
soainfra_wfOutcomeEvent

	
[OUTCOME NAME]

	
Event


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[VERSION]/[COMPONENT_NAME] /taskCompletion/

	
soainfra_wfTaskCompletionTime

	
time

	
Phase








Table 11-14 shows the supported reference and service sensors.


Table 11-14 Reference and Service Sensors

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[REVERSION]/[REFERENCE_NAME]

	
soainfra_reference

	
processOutboundMessagesEvents

	
Event


	
	
	
Errors

	
Event


	
	
	
processOutboundMessages

	
Phase


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[REVERSION]/[SERVICE_NAME]

	
soainfra_service

	
processInboundMessagesEvents

	
Event


	
	
	
Errors

	
Event


	
	
	
processInboundMessages

	
Phase








Table 11-15 shows the supported Oracle B2B binding sensors.


Table 11-15 Oracle B2B Binding Sensors

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/bindings/b2b/document_type/[inbound|outbound]/[DOCUMENT_NAME]

/soainfra/bindings/b2b/[inbound|outbound]

	
soainfra_b2b_document

soainfra_b2b_document_dir

	
processMessagesEvents

	
Event


	
	
	
processMessagesErrors

	
Event


	
	
	
processMessages

	
Phase Event


	
	
	
processMessageSize

	
State


	
/soainfra/bindings/b2b/trading_partner/[from|to]/[TRADING_PARTNER_NAME]

/soainfra/bindings/b2b/[from|to]/

	
soainfra_b2b_tradingPartner

soainfra_b2b_tradingPartner_dir

	
processMessagesEvents

	
Event


	
	
	
processMessagesErrors

	
Event


	
	
	
processMessages

	
Phase Event


	
	
	
processMessageSize

	
State


	
/soainfra/bindings/b2b/endpoint/[inbound|outbound]/[END_POINT]

/soainfra/bindings/b2b/[inbound|outbound]/

	
soainfra_b2b_endpoint

soainfra_b2b_endpoint_dir

	
endPointProtocol

	
State


	
	
	
endPointStatus

	
State


	
	
	
processMessagesEvents

	
Event


	
/soainfra/bindings/b2b/agreement/[AGREEMENT_NAME]

	
soainfra_b2b_agreement

	
processMessagesEvents

	
Event


	
/soainfra/bindings/b2b/activeEntities

	
soainfra_b2b_active_entities

	
activeTradingPartners

activeAgreements

activeDocuments

	
State

State

State


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[REVERSION]/[SERVICE_NAME]/[TRADING_PARTNER_NAME]

	
soainfra_service_b2b_tradingPartner

	
processMessagesEvents

	
Event


	
	
	
processMessagesErrors

	
Event


	
	
	
processMessages

	
Phase Event


	
	
	
processMessageSize

	
State


	
/soainfra/apps/[APP_NAME]/[COMPOSITE_NAME]/[REVERSION]/[REFERENCE_NAME]/[TRADING_PARTNER_NAME]

	
soainfra_reference_b2b_tradingPartner

	
processMessagesEvents

	
Event


	
	
	
processMessagesErrors

	
Event


	
	
	
processMessages

	
Phase Event


	
	
	
processMessageSize

	
State








Table 11-16 shows the supported Oracle User Messaging Service sensors.


Table 11-16 Oracle User Messaging Service Event Bridge Metrics

	Noun Path	Noun Type	Sensor	Type
	
/soainfra/eventBridge/rfidBridge

	
soinfra_rfidBridge

	
eventsIn

	
Event


	
	
	
eventsOut

	
Event


	
	
	
eventsProcess

	
Phase Event


	
	
	
errors

	
Event


	
/soainfra/eventBridge/rfidBridge/device/[SERVER_NAME]/[DEVICE_NAME]

	
soainfra_rfidBridge_device

	
eventsIn

	
Event


	
	
	
eventsOut

	
Event


	
	
	
eventsProcess

	
Phase Event


	
	
	
status

	
State


	
/soainfra/eventBridge/rfidBridge/server/[SERVER_NAME]

	
soainfra_rfidBridge_server

	
status

	
State














11.2 Creating Watches and Notifications

You can create Oracle SOA Suite watches and send notifications around diagnosable conditions based on metrics collected from Oracle SOA Suite MBeans. When a watch expression evaluates to true (for example, heap space exceeds a specified amount), a notification is sent.

The message IDs shown in Table 11-17 have been assigned for diagnostic purposes. When you create a watch in Oracle WebLogic Server Administrator's Console, you must follow these naming conventions. The prefix for Oracle SOA Suite-related watches is SOA-message_ID.


Table 11-17 Message Prefixes

	Scenario	Message-ID	Dumps Executed
	
Memory

	
SOA-900000

	
	
soa.env


	
soa.config


	
java.sysprops





	
Deployment hang

	
SOA-900001

	
	
soa.env


	
soa.config





	
Data source

	
SOA-900002

	
	
soa.env


	
soa.config


	
soa.db











You can also link a WLDF notification to the watch. If you link the out-of-the-box Oracle Fusion Middleware Diagnostic Framework notification (named FMWDFW notification), then a set of SOA specific dumps are executed. These dumps provide runtime information about the situation and environment. The list of dumps to execute is determined by predefined XML incident rules files.

Other notifications (like email) can also be linked to the watch.

The following watch automatically triggers dumps of soa.env and soa.config.

To create watches and notifications:

	
Log in to Oracle WebLogic Server Administration Console.


http://host:port/console


	
In the Domain Structure, expand Diagnostics, and select Diagnostic Modules.

The Summary of Diagnostic Modules page appears.

You configure a diagnostic system module to monitor an aspect of a server or server resource. You can configure multiple system modules to monitor different aspects of a server, but only one such module can be active on a server.


	
In the Diagnostic System Modules section, click Module-[Module_Name] (for example, Module-FMWDFW).


	
On the Settings for Module_Name page, select Watches and Notifications > Watches.


	
In the Watches section, click New.

The Create a Diagnostic Watch page is displayed.


	
Enter the following details to create a watch, and click Next.


	Field	Description
	
Watch Name

	
Enter a name for the watch (for this example, SOA-900000#soa-infra#MemoryWatch is entered).

The name of the watch must conform to the following pattern:


message-id#soa-infra#some_other_text


For example, SOA-900000#soa-infra#MemoryWatch.

This is necessary because the watch name coordinates the Diagnostic Framework incident processing actions when watch conditions evaluate to true. Not following this pattern results in Oracle SOA Suite dumps not getting triggered when Oracle SOA Suite incidents are created.

For additional information, see Table 11-17.

If the watch is set up with the FMWDFW notification, the notification handler creates an incident that corresponds to the message-id specified in the watch name.


	
Watch Type

	
Select an option:

	
Collected Metrics: Sets a watch based on metrics collected from MBean attributes. It is recommended that you select this option because it works for the scenarios described in Table 11-1.


	
Server Log: Sets a watch based on data written to server logs. This type is only useful for extending an existing log watch such as StuckThread to include Oracle SOA Suite dumps.


	
Event Data: This option is not applicable because Oracle SOA Suite is not using any WLDF-based instrumentation.





	
Enable Watch

	
Select to enable a watch.








The Configure Watch Rule Expressions page for adding an expression to the watch is displayed.


	
Click Add Expression.

The Add Expression wizard is displayed.


	
In the MBean Server location list, select the Oracle WebLogic Server MBean server for the expression you want to configure (for example, ServerRuntime).


	
Click Next.


	
Select the Select an MBean Type from the following list button.


	
In the MBean Type list, select the MBean to use for collecting diagnostic information (for this example, Oracle WebLogic Server MBean weblogic.management.runtime.JRockitRuntimeMBean is selected).

[image: Description of sca_createwatch4.gif follows]

Description of the illustration sca_createwatch4.gif



	
Click Next.

The Select Instances page is displayed.


	
From the Instance list, select the instance name or specify an instance name pattern to use to identify the metric for the expression.


	
Click Next.


	
Enter the following details to create a watch rule expression, and click Finish.


	Field	Description
	
Message Attribute

	
Select a message attribute (for this example, HeapFreePercent is selected).

The attributes that are displayed for selection are part of the MBean that you selected in Step 11. For example, if you selected:


oracle.dms.name=/soainfra/engines/bpel/request/system.type=soa_infra_bpel_requests


You see assigned attributes such as active_count, active_maxValue, active_minValue, scheduled_count, and others.


	
Operator

	
Select an operator (for this example, < is selected).


	
Value

	
Enter a value (for this example, 100 is specified).








The Configure Watch Rule Expressions page is displayed with the watch rule expression you created.

[image: Description of sca_createwatch1.gif follows]
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Click Next.

The Config Watch Alarm page is displayed.


	
Optionally specify an alarm and the alarm's reset value for the watch.


	
Click Next.

The Configure Watch Notifications page is displayed.


	
In the Available table, select a notification to assign to the watch and click >.

[image: Description of sca_createwatch2.gif follows]

Description of the illustration sca_createwatch2.gif



When a watch rule expression evaluates to true, a notification is triggered. This notification is handled by the Diagnostic Framework if the FMWDFW notification is selected, which links it to the watch. The FMWDFW notification is automatically shipped with Oracle SOA Suite. Oracle recommends that you select this notification because it creates the Oracle SOA Suite dumps described in Section 11.1.4, "Supported Oracle SOA Suite Diagnostic Dumps."

The notification handler creates a problem incident package that contains appropriate SOA dumps in the ADR. The incident package name corresponds to the message ID specified in the watch name. The incident package dumps can be viewed later using standard ADR tools. This feature enables you to take corrective actions for the problem scenario.


	
Click Finish.

The watch you created is displayed at the bottom of the Settings for Module_Name page. In addition, three WLDF watches that are automatically shipped with Oracle WebLogic Server (Deadlock, StuckThread, and UncheckedException) are also displayed.

[image: Description of sca_createwatch3.gif follows]

Description of the illustration sca_createwatch3.gif



	
In the Name column, click the specific watch name to display configuration details about the watch.









11.3 Manually Triggering and Executing Dumps

You can manually execute existing dumps with the WLST command executeDump and create incidents when one has not been automatically created.

To manually execute dumps:

	
Specify the executeDump command to place dump contents in a file (for this example, soa.config is the dump executed).


wls:/soainfra/serverConfig> executeDump(name='soa.config', appName='soa-infra')

Start Dumping deployedCompositesCatalog from MDS
URI:deployed-composites/deployed-composites.xml to: /myhome/fmwhome/user_
projects/domains/mydomain/servers/myserver/adr/diag/ofm/mydomain/
myserver/incident/incdir_9/deployedCompositesCatalog

Finished dumping specified MDS metadata to : /myhome/fmwhome/user_
projects/domains/mydomain/servers/myserver/adr/diag/ofm/mydomain/myserver/incid
ent/incdir_9/deployedCompositesCatalog

Start Dumping soaServiceEnginesConfigurations from MDS
URI:soa/configuration/default to: /myhome/fmwhome/user_projects/
domains/mydomain/servers/myserver/AdminServer/adr/diag/ofm/mydomain/
myserver/incident/incdir_9/soaServiceEnginesConfigurations

Finished dumping specified MDS metadata to : /myhome/fmwhome/user_projects/
domains/mydomain/servers/myserver/AdminServer/adr/diag/ofm/mydomain/
myserver/incident/incdir_9/soaServiceEnginesConfigurations


This creates the following output:




	
Specify the executeDump command to display dump contents to the screen.


executeDump(name='soa.edn')

Type:oracle.integration.platform.blocks.event.saq.SAQBusinessEventBus
Configuration:null
Status: running=true started=true
ThreadCount:3
RetryCount:3
In Global: Tx:false
Cluster Info:oracle.integration.platform.blocks.cluster.CoherenceCluster
Interface1mpt@163bd717
SharedEDN:false
OOAO Queue Name:edn_ooao_queue
Java Subscriber Name:edn java subscriber
Subscription Info:
No namespace subscription...
QName subscriptions:
=============================================================
qname={http://schemas.oracle.com/events/edl/ActionOccur}ADEvent
subscriptions=
id=default/WSInMedPubBpelSubFileOut!1.0*soa_7a055d6a-8402-49c2-ac56-5f85cbf3d7f/
BpelSub, consistencyLevel=ONE_AND_ONLY_ONE, filter=XPath Filter: starts-with(/
be:business-event/be:content/ns0:ActionOccurrence/ns0:ParentEntityType/@value,
 'A'), runAsRoles=[$publisher]
id=partition_1/WSInMedPubBpelSubFileOut!1.0*soa_80a169ab1-395a-4b87-9986-9fa2742a8bd3/
BpelSub, consistencyLevel=ONE_AND_ONLY_ONE, filter=XPath Filter: starts-with(/
be:business-event/be:content/ns0:ActionOccurrence/ns0:ParentEntityType/@value,
 'A'), runAsRoles=[$publisher]
EventThreadContextInfo:
EventTargets:
Event:partition_1/WSInMedPubBpelSubFileOut!1.0*soa0a169ab1-395a-4b87-9986-9fa2742a9bd3/
BpelSub:::oracle.fabric.BPELServiceEngine@163bd6b5
Event:default/WSInMedPubBpelSubFileOut!1.0*soa7a055d6a-8402-49c2-ac56-5f85cbf3
d7f/BpelSub:::oracle.fabric.BPELServiceEngine@163bd6b5
EDN DB Log enabled:false




You can also manually create incidents when one has not been automatically created. For example, this is useful when you notice performance issues and want to create an incident to send to Oracle Support Services. The incident can include SOA dumps, according to the SOA message ID mapping.

This can be performed with the following WLST command:


createIncident(messageId="SOA-90000", appName="soa-infra")


This has the same effect as WLDF watch notification execution, in which the watch has the message ID of SOA-90000 and application name of soa-infra.

For more information about executeDump, see Chapter "Diagnostic Framework Custom WLST Commands" of Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.






11.4 Viewing Incident Packages with ADR Tools

ADRCI is a command-line utility that enables you to investigate problems and package and upload first-failure diagnostic data to Oracle Support Services. ADRCI also enables you to view the names of dump files in the ADR, and to view the alert log with XML tags stripped, with and without content filtering.

ADRCI is installed in the following directory:


MW_HOME/wlserver_10.3/server/adr


For more information about ADRCI, see Chapter "ADRCI: ADR Command Interpreter" of Oracle Database Utilities.

For information about other tools, see Chapter "Managing Diagnostic Data" of Oracle Database Administrator's Guide






11.5 Querying Problems and Incidents

The Diagnostic Framework provides WLST commands that you can use to view information about problems and incidents, including the following:

	
Querying problems across Oracle WebLogic Servers


	
Querying incidents across Oracle WebLogic Servers


	
Viewing dump files associated with an incident on an Oracle WebLogic Server




For more information about these WLST commands, see Section "Understanding the Diagnostic Framework" of Oracle Fusion Middleware Administrator's Guide and Chapter "Diagnostic Framework Custom WLST Commands" of Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.







